Important Regulatory and Safety Notices to Service Personnel

Before using this product and any associated equipment, refer to the “Important Safety Instructions” listed below to avoid personnel injury and to prevent product damage.

Product may require specific equipment, and/or installation procedures to be carried out to satisfy certain regulatory compliance requirements. Notices have been included in this publication to call attention to these specific requirements.

Symbol Meanings

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Protective Earth" /></td>
<td>This symbol identifies a Protective Earth (PE) terminal, which is provided for connection of the supply system’s protective earth (green or green/yellow) conductor.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>This symbol on the equipment refers you to important operating and maintenance (servicing) instructions within the Product Manual Documentation. Failure to heed this information may present a major risk of damage or injury to persons or equipment.</td>
</tr>
<tr>
<td><img src="image" alt="Warning" /></td>
<td>The symbol with the word “Warning” within the equipment manual indicates a potentially hazardous situation which, if not avoided, could result in death or serious injury.</td>
</tr>
<tr>
<td><img src="image" alt="Caution" /></td>
<td>The symbol with the word “Caution” within the equipment manual indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate injury. It may also be used to alert against unsafe practices.</td>
</tr>
<tr>
<td><img src="image" alt="Notice" /></td>
<td>The symbol with the word “Notice” within the equipment manual indicates a situation which, if not avoided, may result in major or minor equipment damage or a situation which could place the equipment in a non-compliant operating state.</td>
</tr>
<tr>
<td><img src="image" alt="Warning Hazardous Voltages" /></td>
<td>This symbol is intended to alert the user to the presence of uninsulated &quot;dangerous voltage&quot; within the product enclosure that may be of sufficient magnitude to constitute a risk of shock to persons.</td>
</tr>
<tr>
<td><img src="image" alt="ESD Susceptibility" /></td>
<td>This symbol is used to alert the user that an electrical or electronic device or assembly is susceptible to damage from an ESD event.</td>
</tr>
</tbody>
</table>

Important Safety Instructions

1) Read these instructions.
2) Keep these instructions.
3) Heed all warnings.
4) Follow all instructions.
5) Do not use this apparatus near water.
6) Clean only with a dry cloth.
7) Do not block any ventilation openings. Install in accordance with manufacturer’s instructions.

8) Do not install near heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.

9) Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The third prong is provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.

10) Protect the power cord from being walked on or pinched, particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

11) Only use attachments/accessories specified by the manufacturer.

12) Unplug this apparatus during lightning storms or when unused for long periods of time.

13) Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as when the power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

14) Do not expose this apparatus to dripping or splashing, and ensure that no objects filled with liquids, such as vases, are placed on the apparatus.

15) To completely disconnect this apparatus from the AC Mains, disconnect the power supply cord plug from the AC receptacle.

16) The mains plug of the power supply cord shall remain readily operable.

17) The QMD-X, MD-X, QMD, or MD (Live Production Engine) chassis is to be rack mounted only.

18) **Warning**

**Indoor Use: Warning:** To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

19) The safe operation of this product requires that a protective earth connection be provided. A grounding conductor in the equipment's supply cord provides this protective earth. To reduce the risk of electrical shock to the operator and service personnel, this ground conductor must be connected to an earthed ground.

20) **Warning:** This apparatus, when equipped with multiple power supplies, can generate high leakage currents. To reduce the risk of electric shock, ensure that each individual supply cord is connected to its own separate branch circuit with an earth connection.

21) **Caution:** These service instructions are for use by qualified service personnel only. To reduce the risk of electric shock, do not perform any servicing other than that contained in the operating instructions unless you are qualified to do so (Engineering Manual only).

22) **Caution:** These apparatus contain Lithium batteries, which if replaced incorrectly, or with an incorrect type, may cause an explosion. Replace only with the same type. Dispose of used batteries according to the manufacturer’s instruction.

23) Service barriers within this product are intended to protect the operator and service personnel from hazardous voltages. For continued safety, replace all barriers after servicing.

24) Certain parts of this equipment still present a safety hazard with the power switch in the OFF position. To avoid electrical shock, disconnect all A/C power cords from the chassis' rear appliance connectors before servicing.

25) This product contains safety critical parts, which, if incorrectly replaced, may present a risk of fire or electrical shock. Components contained within the product’s power supplies and power supply area are not intended to be customer-serviced and should be returned to the factory for repair.
26) To reduce the risk of fire, replacement fuses must be the same type and rating.
27) The safe operation of this equipment requires that the user heed and adhere to all installation and servicing instruction contained within the equipment’s Engineering Manuals.

EMC Notices

United States of America

FCC Part 15

This equipment has been tested and found to comply with the limits for a class A Digital device, pursuant to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

Notice
Changes or modifications to this equipment not expressly approved by Ross Video Limited could void the user’s authority to operate this equipment.

CANADA

This Class “A” digital apparatus complies with Canadian ICES-003.
Cet appareil numerique de la classe “A” est conforme a la norme NMB-003 du Canada.

EUROPE

This equipment is in compliance with the essential requirements and other relevant provisions of CE Directive 93/68/EEC.

INTERNATIONAL

This equipment has been tested to CISPR 22:1997 along with amendments A1:2000 and A2:2002, and found to comply with the limits for a Class A Digital device.

Notice
This is a Class A product. In domestic environments, this product may cause radio interference, in which case the user may have to take adequate measures.

General Handling Guidelines

- Careful handling, using proper ESD precautions, must be observed.
- Power down the system before PCB removal.
A Word About Static Discharge

Throughout the many procedures in this Manual, please observe all static discharge precautions.

Notice

Avoid handling the switcher circuit boards in high static environments such as carpeted areas, and when synthetic fiber clothing is worn. Touch the frame to dissipate static charge before removing boards from the frame, and exercise proper grounding precautions when working on circuit boards.
Warranty and Repair Policy

Ross Video Limited (Ross) warrants its switchers and related options, to be free from defects under normal use and service for a period of ONE YEAR from the date of shipment. Fader handle assemblies are warranted for the life of the product. If an item becomes defective within the warranty period Ross will repair or replace the defective item, as determined solely by Ross.

Warranty repairs will be conducted at Ross, with all shipping FOB Ross dock. If repairs are conducted at the customer site, reasonable out-of-pocket charges will apply. At the discretion of Ross, and on a temporary loan basis, plug in circuit boards or other replacement parts may be supplied free of charge while defective items undergo repair. Return packing, shipping, and special handling costs are the responsibility of the customer.

Software upgrades for switchers may occur from time to time, and are determined by Ross Video. The upgrades are posted on the Ross Video website, and are free of charge for the life of the switcher.

This warranty is void if products are subjected to misuse, neglect, accident, improper installation or application, or unauthorized modification.

In no event shall Ross Video Limited be liable for direct, indirect, special, incidental, or consequential damages (including loss of profit). Implied warranties, including that of merchantability and fitness for a particular purpose, are expressly limited to the duration of this warranty.

This warranty is TRANSFERABLE to subsequent owners, subject to Ross’ notification of change of ownership.

An extended warranty is available. Contact your dealer or Ross Video for details.
Environmental Information

The equipment that you purchased required the extraction and use of natural resources for its production. It may contain hazardous substances that could impact health and the environment.

To avoid the potential release of those substances into the environment and to diminish the need for the extraction of natural resources, Ross Video encourages you to use the appropriate take-back systems. These systems will reuse or recycle most of the materials from your end-of-life equipment in an environmentally friendly and health conscious manner.

The crossed-out wheeled bin symbol invites you to use these systems.

If you need more information on the collection, reuse, and recycling systems, please contact your local or regional waste administration.

You can also contact Ross Video for more information on the environmental performances of our products.
# Company Address

<table>
<thead>
<tr>
<th>Ross Video Limited</th>
<th>Ross Video Incorporated</th>
</tr>
</thead>
<tbody>
<tr>
<td>8 John Street</td>
<td>P.O. Box 880</td>
</tr>
<tr>
<td>Iroquois, Ontario, K0E 1K0</td>
<td>Ogdensburg, New York</td>
</tr>
<tr>
<td>Canada</td>
<td>USA 13669-0880</td>
</tr>
</tbody>
</table>

- General Business Office: (+1) 613 • 652 • 4886
- Fax: (+1) 613 • 652 • 4425
- Technical Support: (+1) 613 • 652 • 4886
- After hours emergency: (+1) 613 • 349 • 0006

E-mail (Technical Support): techsupport@rossvideo.com  
E-mail (General Information): solutions@rossvideo.com  
Website: http://www.rossvideo.com
Contents

Introduction 1

A Word of Thanks ................................................................. 1-1
About This Manual ............................................................... 1-2
Documentation Conventions ............................................... 1-3
Documentation Terms ......................................................... 1-4
Abbreviations ........................................................................ 1-5
Related Publications ............................................................... 1-6
Product Overview ................................................................. 1-7
  Product Highlights .............................................................. 1-7
  Standard Features ............................................................... 1-10
  System Options ................................................................. 1-19
A Word about Technical Support ............................................ 1-32

Control Panel Introduction 2

In This Chapter ........................................................................ 2-1
Control Panel Sections ............................................................ 2-2
  Synergy 4 Control Panel ....................................................... 2-3
  Synergy 3 Control Panel ....................................................... 2-4
  Synergy 2 Control Panel ....................................................... 2-5
  Synergy 1 Control Panel ....................................................... 2-6
Video Flow Through the Switcher ........................................... 2-14
  Synergy 3.5 and 4 Q/MD-X Video Flow ............................... 2-14
  Synergy 2.5 and 3 Q/MD/X Video Flow ............................... 2-16
  Synergy 1.5 and 2 Q/MD/X Video Flow ............................... 2-17
  Synergy 1 Q/MD Video Flow .............................................. 2-19
Using a Keyboard .................................................................... 2-20
  Using the Keyboard in System Control Menus .................... 2-20
  Using the Keyboard in Change Name Menus ....................... 2-21
Switcher Color Scheme ............................................................ 2-22
Resetting the Switcher ............................................................ 2-23
  Full Restart ........................................................................ 2-23
  Global-Store Restart ........................................................... 2-23
  Updating Panel Data ............................................................ 2-24
  Software Reset .................................................................... 2-24
Shutting Down the Synergy Switcher ....................................... 2-27
  Powering Off the Synergy Switcher ..................................... 2-27
  Reinstalling the Frame Door ................................................. 2-28
Switcher Timeout .................................................................... 2-30

Using the Menu System 3

In This Chapter ........................................................................ 3-1
About the System Control Display ......................................... 3-2
Menu System Basics .................................................................................................................. 3-3
Using the Keyboard in System Control Menus ................................................................. 3-5
Positioner Icons ...................................................................................................................... 3-6
Adjusting the Display ............................................................................................................. 3-7
Help Features .......................................................................................................................... 3-8
Help Menu .............................................................................................................................. 3-8
Pop-up Help ............................................................................................................................. 3-8
Installed Options ..................................................................................................................... 3-10
Software Options Menu ........................................................................................................ 3-10
Panel Boards Menu ................................................................................................................. 3-11
Frame Boards Menu ............................................................................................................... 3-12
Screen Capture ....................................................................................................................... 3-13

## Switcher Basics

In This Chapter ....................................................................................................................... 4-1
Before Starting ......................................................................................................................... 4-2
Control Panel Software Reset, Control Panel Method ...................................................... 4-2
Control Panel Software Reset, Menu Method .................................................................. 4-2
Power Fail Indicators .......................................................................................................... 4-3
Power Failure ......................................................................................................................... 4-3
Switcher Personality ............................................................................................................. 4-4
Navigating to the Personality Menu .................................................................................... 4-4
Audio Cut Only ..................................................................................................................... 4-4
Audio Transition MLE Assignment ..................................................................................... 4-5
Auto Recall ............................................................................................................................ 4-5
Auto Remove Key ............................................................................................................... 4-6
Bank 0 Lit ................................................................................................................................ 4-7
Clear Bus Hold on All-All ..................................................................................................... 4-7
Double Press Rate ............................................................................................................... 4-7
DSK Auto Cut ....................................................................................................................... 4-8
Editor Trans Rate ................................................................................................................... 4-8
FTB Display ............................................................................................................................ 4-8
Isolate MultiDSKs .................................................................................................................. 4-9
Key Cut Then Fade ............................................................................................................. 4-9
Keypad Clip Entry ............................................................................................................... 4-10
Log OverDrive Messages ..................................................................................................... 4-10
Matte Limit ........................................................................................................................... 4-11
Mem Bank Cycle Max ......................................................................................................... 4-11
Multiple Custom Controls ................................................................................................. 4-12
Panel Sleep Time ................................................................................................................ 4-12
Pbus Memory ......................................................................................................................... 4-13
Recall Global-Store Mode ................................................................................................. 4-13
Recall MLE-Store Mode ...................................................................................................... 4-13
Roll VTR Mode .................................................................................................................... 4-14
Squeeze & Tease Mode ........................................................................................................ 4-15
Store Mode ........................................................................................................................... 4-16
Swap Keyers Cut & Auto ..................................................................................................... 4-16
Swap PGM/PST Buses ......................................................................................................... 4-17
Swap Trans Cut & Auto ....................................................................................................... 4-17
Time Clock Source ................................................................................................................ 4-17
Time Clock UMD Number .................................................................................................... 4-18
UltraChrome Dflt Color .................................................................................................... 4-18
UltraChrome Dflt Mode ....................................................................................................... 4-18
### Basic Switcher Functions
- General Button Rules ......................................................... 4-22
- Crosspoint Buttons ............................................................... 4-22
- SHIFT Button ........................................................................ 4-22
- Reverse Key Shift Mode ....................................................... 4-24
- Assigning a Bus Map to an Individual Bus ......................... 4-24
- Assigning a Bus Map to Multiple Buses .............................. 4-26
- Flip-Flop Operation ............................................................. 4-26
- Key Bus .................................................................................. 4-28
- Bus Indicators ....................................................................... 4-30
- MLE Tally .............................................................................. 4-30
- Non-Sync Indicators ............................................................. 4-31
- Knobs .................................................................................... 4-32
- Re-entry ................................................................................ 4-33
- Using the Preview Bus .......................................................... 4-35
  - Synergy 1 Preview Bus ....................................................... 4-35
  - Synergy 2, 3 and 4 Preview Bus ........................................ 4-35
- Look Ahead Preview .............................................................. 4-37
- Fade to Black ........................................................................ 4-38
  - Using Fade to Black .......................................................... 4-38
  - Changing Fade to Black Rates ........................................ 4-40
- Using SmartConversion ......................................................... 4-41
  - Converting Video ............................................................. 4-41
  - Overriding Input Format ................................................... 4-41
  - SmartConversion Status .................................................. 4-42
  - Converter Assignments .................................................... 4-43

### Background Transitions

In This Chapter ........................................................................ 5-1

- Transition Group .................................................................. 5-2
  - Synergy 1 Transition Group .............................................. 5-2
  - Synergy 2, 3, and 4 Transition Group .............................. 5-5
  - Using Manual Transitions ............................................... 5-9
  - Using Cut Transitions ..................................................... 5-10
  - Using Dissolves .................................................................. 5-11
  - Working with Next Transitions .................................... 5-12
  - Auto Transitions ............................................................. 5-14
  - Preset Black ........................................................................ 5-17
  - Transition Preview .......................................................... 5-17
  - Key Over ............................................................................. 5-19
  - Transition Limit ............................................................... 5-20

### Pattern Control

In This Chapter ........................................................................ 6-1

- Pattern Control Group ....................................................... 6-2
  - Synergy 4 Pattern Control ................................................ 6-2
  - Synergy 3 Pattern Control ................................................ 6-2
  - Synergy 2 Pattern Control ................................................ 6-3
  - Synergy 1 Pattern Control ................................................ 6-4
Using Wipes ................................................................. 6-8
  Adjusting Matrix Wipes ........................................... 6-9
  Adjusting Wipes ....................................................... 6-10
  User Wipes .............................................................. 6-12
  Squeeze & Tease MD Wipes ...................................... 6-15
Matte Group ................................................................. 6-17
  Synergy 4 Mattes ....................................................... 6-17
  Synergy 3 Mattes ....................................................... 6-17
  Synergy 2 Mattes ....................................................... 6-18
  Synergy 1 Mattes ....................................................... 6-18
Creating Washes .......................................................... 6-22
  Creating a Pattern Border Color or Wash ................ 6-22
  Creating a Matte Fill Color or Wash ......................... 6-25
  Creating a Color Background Color ......................... 6-25
  Using the Utility Bus for Washes ......................... 6-26

Keying ........................................................................ 7

  In This Chapter .......................................................... 7-1
  Introduction to Keying ................................................ 7-2
    Key Group Basics .................................................. 7-2
    MLE Key Groups ................................................... 7-4
    Downstream Key Groups ......................................... 7-4
    Key Functions ....................................................... 7-6
    A Word About FlexiClean ....................................... 7-13
  Effects Control Group ................................................ 7-15
    Synergy 4 Effects Control ...................................... 7-15
    Synergy 3 Effects Control ...................................... 7-16
    Synergy 2 Effects Control ...................................... 7-17
    Synergy 1 ............................................................. 7-17
  Using MLE Keys ........................................................ 7-21
    Performing a Self Key ............................................ 7-21
    Performing an Auto Select Key ............................... 7-23
    Performing an UltraChrome Chroma Key ............... 7-26
    Chroma Key Lighting Tips .................................... 7-42
    Performing a Preset Pattern Key ......................... 7-44
  Split Keys ................................................................. 7-47
    Performing a Split Key ............................................ 7-47
  Using Downstream Keys ........................................... 7-50
    DSK Source Bus Setup .......................................... 7-52
  MultiDSK Option ....................................................... 7-56
    MultiDSK for Downstream Key Groups .................. 7-56
    MultiDSK Operation ............................................. 7-58
    Isolated and Locked MultiDSK Mode ..................... 7-61
  AuxKey Option ........................................................ 7-64
    AuxKey Operation ................................................ 7-64
    Auto Transition Rates .......................................... 7-68
    Setting Auto Transition Rates ............................... 7-68

Key Modifiers ................................................................ 8

  In This Chapter .......................................................... 8-1
  Filling a Key with Matte .......................................... 8-2
**Memory and Disk Functions**  
9

<table>
<thead>
<tr>
<th>In This Chapter</th>
<th>9-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Memory System Group</td>
<td>9-2</td>
</tr>
<tr>
<td>Synergy 4</td>
<td>9-2</td>
</tr>
<tr>
<td>Synergy 3</td>
<td>9-3</td>
</tr>
<tr>
<td>Synergy 2</td>
<td>9-3</td>
</tr>
<tr>
<td>Synergy 1</td>
<td>9-4</td>
</tr>
<tr>
<td>Storing Memory Registers</td>
<td>9-9</td>
</tr>
<tr>
<td>Recalling Memory Registers</td>
<td>9-12</td>
</tr>
<tr>
<td>Memory Lock</td>
<td>9-16</td>
</tr>
<tr>
<td>Naming Memory Registers</td>
<td>9-18</td>
</tr>
<tr>
<td>Effects Dissolve</td>
<td>9-20</td>
</tr>
<tr>
<td>Using Storage Devices</td>
<td>9-25</td>
</tr>
<tr>
<td>Naming a Setup</td>
<td>9-25</td>
</tr>
<tr>
<td>Saving Registers</td>
<td>9-27</td>
</tr>
<tr>
<td>Saving Individual Memory Registers</td>
<td>9-28</td>
</tr>
<tr>
<td>Saving Individual Custom Control Macros</td>
<td>9-30</td>
</tr>
<tr>
<td>Saving Individual S&amp;T 3D Sequences</td>
<td>9-32</td>
</tr>
<tr>
<td>Saving Individual Bus Maps</td>
<td>9-33</td>
</tr>
<tr>
<td>Recalling Registers</td>
<td>9-35</td>
</tr>
<tr>
<td>Recalling Individual Memory Registers</td>
<td>9-37</td>
</tr>
<tr>
<td>Recalling Individual Custom Control Macros</td>
<td>9-39</td>
</tr>
<tr>
<td>Recalling Individual S&amp;T 3D Sequences</td>
<td>9-41</td>
</tr>
<tr>
<td>Recalling Individual Bus Maps</td>
<td>9-43</td>
</tr>
<tr>
<td>Quick Formatting a USB Key</td>
<td>9-44</td>
</tr>
</tbody>
</table>

**Custom Controls**  
10

<table>
<thead>
<tr>
<th>In This Chapter</th>
<th>10-1</th>
</tr>
</thead>
<tbody>
<tr>
<td>Custom Control Overview</td>
<td>10-2</td>
</tr>
<tr>
<td>Synergy 4</td>
<td>10-2</td>
</tr>
<tr>
<td>Synergy 3</td>
<td>10-2</td>
</tr>
<tr>
<td>Synergy 2</td>
<td>10-3</td>
</tr>
<tr>
<td>Synergy 1</td>
<td>10-3</td>
</tr>
<tr>
<td>Custom Control Functionality</td>
<td>10-3</td>
</tr>
<tr>
<td>Programming Control Panel Functions</td>
<td>10-5</td>
</tr>
<tr>
<td>Tips for Creating Custom Controls</td>
<td>10-7</td>
</tr>
<tr>
<td>Relative Custom Controls</td>
<td>10-8</td>
</tr>
</tbody>
</table>
Volume II

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Peripheral Control and More</td>
<td>12</td>
</tr>
<tr>
<td>Still-Store</td>
<td>13</td>
</tr>
<tr>
<td>Clip Control</td>
<td>14</td>
</tr>
<tr>
<td>Squeeze &amp; Tease MD Basic Operation</td>
<td>15</td>
</tr>
<tr>
<td>Position/Crop Functions</td>
<td>16</td>
</tr>
<tr>
<td>Advanced Positioning</td>
<td>17</td>
</tr>
<tr>
<td>Borders</td>
<td>18</td>
</tr>
<tr>
<td>Preprocessor Effects</td>
<td>19</td>
</tr>
<tr>
<td>Sequences and Squeeze &amp; Tease Wipes</td>
<td>20</td>
</tr>
<tr>
<td>Lighting</td>
<td>21</td>
</tr>
<tr>
<td>WARP Effects</td>
<td>22</td>
</tr>
<tr>
<td>Appendix A. Menu Trees</td>
<td>23</td>
</tr>
<tr>
<td>Appendix B. Squeeze &amp; Tease MD Wipes and Sequences</td>
<td>24</td>
</tr>
<tr>
<td>Glossary of Terms</td>
<td>GL</td>
</tr>
<tr>
<td>Index</td>
<td>IX</td>
</tr>
</tbody>
</table>
Introduction

A Word of Thanks

Congratulations on choosing the Ross Synergy Q/MD/X Series multi-definition digital video production switchers. You have purchased the power and versatility of a digital Multi-Level Effects (MLE) switcher that is ready to take on all creative challenges in today’s competitive broadcast environment. You will be pleased at how easily your Synergy Q/MD/X switcher fits into your overall working environment.
About This Manual

This manual covers the operation of the following Synergy Q/MD/X switchers:

- **Synergy 1 Q/MD** (1 MLE)
- **Synergy 1.5 Q/MD** (1 and a half MLE)
- **Synergy 2 Q/MD** (2 MLE)
- **Synergy 2.5 Q/MD** (2 and a half MLE)
- **Synergy 2 Q/MD-X** (2 MLE)
- **Synergy 2.5 Q/MD-X** (2 and a half MLE)
- **Synergy 3 Q/MD-X** (3 MLE)
- **Synergy 3.5 Q/MD-X** (3 and a half MLE)
- **Synergy 4 Q/MD-X** (4 MLE)

If, at any time, you have a question pertaining to the operation of your Ross Synergy Q/MD/X switcher, please contact us at the numbers listed in the front of this manual. Our technical staff are always available for consultation, training, or service.
Documentation Conventions

The following conventions are used throughout this manual:

- Rear panel connectors are indicated in bold-faced upper case letters. For example:
  
  The **AUX 1** connector is …

- Control Panel buttons are indicated in bold-faced upper case letters, using a sans-serif font. For example:
  
  Press **WIPE** to …

- Menu names on the integral display panel are indicated in bold-faced text. For example:
  
  The **Aux Bus Setup Menu** allows you to …

- Menu navigation procedures in this manual set state the buttons you are to press followed by the “⇒” symbol. For example, the following navigation procedure shows you how to navigate from the **Main Menus** to the **Installation Menus**. In this case, you press **Setup** on the **Main Menu 2-2**, then you press **Installation** on the **Setup Menu**.
  
  Press **HOME ⇒ MORE ⇒ Setup ⇒ Installation**.

- Softkey labels on the integral display are indicated in bold-faced text, using a sans-serif font. They are *not* indicated by the function key below the display that you press. For example:
  
  Press **Accept New Name** to register …

- Groups of buttons that make up and areas that is dedicated to a specific function, or set of functions, on the control panel are referred to as groups and shown in bold-faced text. For Example:
  
  Press the **UNDO** button in the **Global Memory System Group** to …

- The “**Operating Tips**” and “**Note**” boxes are used throughout this manual to provide customers with additional useful information. For example:

  **Operating Tip**
  
  You can press the desired crosspoint button on the PGM bus directly to select that button. This applies to both shifted and unshifted crosspoints.

  **Note**
  
  Press **Cancel Recording** to terminate the programming procedure. The macro will *not* be recorded..
Documentation Terms

The following terms are used throughout this manual:

- **“Switcher”** refers to the entire Synergy Q/MD/X Live Production Engine, consisting of its electronics frame and control panel.

- **“Frame”** and **“Electronics Frame”** both refer to the electronics chassis of Synergy Q/MD/X Live Production Engine.

- **“Operator”** and **“User”** refer to the person who uses the Synergy Q/MD/X Live Production Engine.

- **“Control Panel”** both refer to the large multi-button control panel of the Synergy Q/MD/X Live Production Engine.

- **“SDI”** refers to Serial Digital Video, a digital video signal that is distributed via a single coaxial cable with BNC connectors.

- **“Video System”** refers to the mix of interconnected digital equipment (including the edit controller, VTRs, DVEs, etc.) in which the Synergy Q/MD/X Live Production Engine is included.

- **“Storage device”** refers to the hardware used to save and recall setups, configurations and registers of the Synergy Q/MD/X Live Production Engine. Examples of storage devices are the internal hard drive and a USB Drive.

- **“Bottom MLE”** refers to the lowest, or Program/Preset, MLE on each switcher. This MLE is typically the MLE to provides the main program output of the switcher, and includes the Downstream Keyers. On a **Synergy 2 Q/MD-X**, for example, this would be MLE 2.

- **“Half MLE”** refers to the bottom, or Program/Preset, MLE on the Synergy 1.5, 2.5 and 3.5 Q/MD and Q/MD-X switchers. The Mix/DSK option is applied to this MLE.

- **“Full MLE”** refers to the full featured MLEs of a switcher. On a **Synergy 2.5 Q/MD-X**, for example, MLEs 1 and 2 are Full MLEs, because they are fully functional, but MLE 3 is a Half MLE.
Abbreviations

The following abbreviations are used throughout the text:

<table>
<thead>
<tr>
<th>Abbreviation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>A-D</td>
<td>Analog-to-Digital</td>
</tr>
<tr>
<td>AUX</td>
<td>Auxiliary</td>
</tr>
<tr>
<td>CG</td>
<td>Character Generator</td>
</tr>
<tr>
<td>D-A</td>
<td>Digital-to-Analog</td>
</tr>
<tr>
<td>DA</td>
<td>Distribution Amplifier</td>
</tr>
<tr>
<td>DDR</td>
<td>Digital Disk Recorder</td>
</tr>
<tr>
<td>DSK</td>
<td>Downstream Keyer</td>
</tr>
<tr>
<td>DVE</td>
<td>Digital Video Effects</td>
</tr>
<tr>
<td>DVR</td>
<td>Digital Video Recorder</td>
</tr>
<tr>
<td>ID</td>
<td>Identification</td>
</tr>
<tr>
<td>HD</td>
<td>High Definition</td>
</tr>
<tr>
<td>MD</td>
<td>Multi-definition</td>
</tr>
<tr>
<td>MLE</td>
<td>Multi-level Effects</td>
</tr>
<tr>
<td>PGM</td>
<td>Program Bus</td>
</tr>
<tr>
<td>PST</td>
<td>Preset Bus</td>
</tr>
<tr>
<td>PST PATT</td>
<td>Preset Pattern</td>
</tr>
<tr>
<td>PV</td>
<td>Preview</td>
</tr>
<tr>
<td>RU</td>
<td>Rack Unit</td>
</tr>
<tr>
<td>SD</td>
<td>Standard Definition</td>
</tr>
<tr>
<td>TD</td>
<td>Technical Director</td>
</tr>
<tr>
<td>VCR</td>
<td>Video Cassette Recorder</td>
</tr>
<tr>
<td>VDCP</td>
<td>Video Disk Communications Protocol</td>
</tr>
<tr>
<td>VTR</td>
<td>Video Tape Recorder</td>
</tr>
</tbody>
</table>
Related Publications

All Synergy Q/MD/X switchers come with a complete set of system documentation that includes an Operator’s Manual and an Engineering Manual.

For a complete operational overview of the Synergy Q/MD/X product line, refer to the following publication:

- *Synergy Q/MD Engineering Manual, Volume II*, Ross Part Number: 4400DR-001A
Product Overview

Ross Video developed the **Synergy Q/MD/X Live Production Engine** series for live news, live sports, and live production. Because the switcher is the center of the action, it must be powerful, versatile, yet easy to operate. This operational simplicity frees operators to concentrate on the programming, instead of the equipment.

The Synergy Q/MD/X line (our fifth generation of switchers) was designed with the direct input of video professionals experienced in news, sports, and mobile production. Key members of the Synergy Q/MD/X design team are part of an ongoing program where they demonstrate the product, assist with installations, and provide operator training. As a result, the **Synergy Q/MD/X Live Production Engine** continues to advance the Ross Video traditions of power, ease-of use, and logical panel layouts.

Product Highlights

The following list summarizes the key features of the Synergy Q/MD/X series:

- **Fully Digital System** — All switchers in the series are fully digital. This unique concept simplifies the design, minimizes the power requirements, and reduces the overall cost. By requiring all A-D and D-A conversion to be performed outside the system, digital noise stays out of the converters. In addition, customers are guaranteed the latest converter technology, without burdening the cost of the switcher, and with the added option to use those converters for other purposes — as they gradually convert to the digital domain.

- **Multi-Definition** — The Synergy Q/MD/X Live Production Engine allows you to work in either Standard Definition or High Definition, supporting 480i (SD 525), 576i(SD 625), 720p, 1080i, and 1080pSF video formats.

- **Flexible Input Matrix.**
  ~ The Synergy Q/MD frame can be loaded with your choice of 16, 26, or 32 multi-definition video inputs.
  ~ The Synergy Q/MD-X frame can accept up to 96 multi-definition video inputs, in groups of 16 inputs each.

- **Compact Size** — The following table summarizes the housing capacity of the Synergy Q/MD/X lines:

<table>
<thead>
<tr>
<th>Features</th>
<th>Q/MD</th>
<th>Q/MD-X</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frame</td>
<td>3 RU</td>
<td>8 RU</td>
</tr>
<tr>
<td>Multi-Definition Inputs</td>
<td>48¹</td>
<td>96</td>
</tr>
<tr>
<td>Multi-Definition Configurable Outputs</td>
<td>16</td>
<td>48</td>
</tr>
<tr>
<td>DVE Channels</td>
<td>8</td>
<td>16</td>
</tr>
<tr>
<td>Internal Keyers</td>
<td>13</td>
<td>28</td>
</tr>
<tr>
<td>WARP generators</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>Internal Ethernet-connected Media Stores</td>
<td>11</td>
<td>19</td>
</tr>
<tr>
<td>Classes of External Interfaces</td>
<td>19</td>
<td>19</td>
</tr>
</tbody>
</table>
Also available, either as standard features or as options, are Proc Amps, RGB Color Correctors, Utility Buses, FlexiClean, Preview Overlay, Linux OS, and a whole lot more.

- **Mnemonics** — Synergy mnemonics are perfect for mobile and other applications that require different source names from one production to another. Mnemonics are available for every MLE on the Synergy 2, 3, and 4 control panels, as well as the Custom Control button row. Every display can have individual settings for display color, text size and backlighting to provide clear naming and source group separation.

- **Preview Overlay** — This powerful option presents a VTR and video server time code, a count up/down timer, source ID, safe title, and more on the preview monitor output. With the exception of the Synergy 1 Q/MD control panel, which provides access through the switcher menu system, each Synergy Q/MD/X feature is individually selectable via handy control panel buttons.

- **Squeeze & Tease MD** — Squeeze & Tease MD is a high quality, powerful multi-definition 3D DVE that can be built into every full MLE. Great for sophisticated looking boxes, it allows every type of Key to be squeezed or zoomed, cropped, repositioned, and rotated in 3D space. It can also perform 3D Key or Background transitions, build sequences with complex timelines, Keyframe editing, and quick “shot box” sequence recall. Squeeze & Tease MD comes equipped with a positionable light source, preprocessor effects such as defocus, mosaic, posterization, colorization, strobe, picture frame borders, timeline sequences with holds, and a lot more. Up to four channels of Squeeze & Tease MD can be added to every full MLE.

- **Squeeze & Tease MD WARP**. Squeeze & Tease MD WARP adds extensive curvilinear effects to an MLE with Squeeze & Tease MD installed. These effects can be applied to transitions or keys where a planar channel is being used. WARP effects include Globe, Heart, Lens Flare, Page Roll, Ripple, Split, Star, and many more. Creative possibilities are endless as WARP effects can be easily combined with preprocessor, planar transformation, and other effects.

- **UltraChrome™ Advanced Chroma Keying** — Our new UltraChrome chroma Keyer uses new Ross technology to perform detailed Keying in the most demanding applications. Each full MLE includes two UltraChrome chroma Keyers as a standard feature.

- **3 Channel Global-Store™ and Optional 4 Channel MLE-Store**. Three independent channels of stills are available switcher-wide and an additional 4 more per MLE are optionally available. Thousands of stills and logos can be stored in the hard drive, located on the frame CPU Board, and are transferable to other control-room devices via Ethernet using the WebDAV protocol.

- **MediaCache™** — Upgrades the memory of either the Global-Store or MLE-Store to allow the playing of animated logos, moving graphics, and short uncompressed clips.

- **Ethernet Connectivity** — Upgrades can be done from a PC using an Ethernet port on the rear of the frame. Images and animations can be copied from a PC to the hard drive, located on the frame CPU Board, for use by the still stores and MediaCache throughout the switcher. The Ethernet port can also be used to transfer images and animations from the frame hard drive to a PC. This allows images captured on the switcher to be used elsewhere in the studio.

- **Network Still and Clip Server** — Imagine hours of video storage, virtually unlimited stills, and animations all playing out with their companion Key channels. Next, combine
live video and Key capture with Ethernet drag and drop capability, and you have the perfect marriage of video and networkability. Even better, this solution comes bundled with the powerful Video Server Control of the Synergy Q/MD/X.

- **AuxKeys™** — Brand or add titles to Auxiliary Bus outputs or mix between Aux Buses. Feed the result to external monitors or send them back into the switcher to further increase switcher production power. This revolutionary option adds mixing and keying capability to Aux Bus outputs. Mix and Key sources are fed from adjacent Aux Buses that have access to every signal in the switcher. Of particular interest in this application are Global-Store outputs that, with MediaCache enabled, can provide animated logo capability.

- **MultiDSK™** — Time, temperature, and bug logos are often added downstream. This option adds two more downstream Keyers to the Synergy Q/MD/X system, bringing the total number of DSKs in the system to four. The Keyers have full access to the internal crosspoint matrix making every source available as a downstream Key.

**Note**

This option provides two DSKs on the Synergy 1 Q/MD.

- **Powerful MLEs** — Synergy Q/MD/X packs major effects and Keying power into every full MLE. Every full MLE has two fully featured Keyers with luma, linear, preset pattern, and advanced UltraChrome chroma Keyers. Each full MLE has a utility bus input for video-in-border and garbage mask applications and a repositionable clean feed output. Two advanced pattern generators per full MLE include rotary wipes, matrix wipes, heart, star, and pattern rotation. Two additional pattern generators are dedicated to color wash generators. The lower Program/Preset MLE offers basic mix/Key capabilities, with two independent linear DSKs.

**Note**

The Synergy 1.5, 2.5 and 3.5 Live Production Engines do not include this feature.

- **Fully Featured “Program/Preset”** — The bottom MLE, normally referred to as the Program/Preset bus, has full effects capability including wipes and dual DSKs with chroma Keys and preset patterns.

**Note**

The Synergy 1.5, 2.5 and 3.5 Live Production Engines do not include this feature.

- **VTR Control** — Select a VTR on the PST bus, display its current time code on the preview monitor, roll it from the transition area, and take it to air. Fast forward, rewind, and cue to time code are also available at the touch of a button on the control panel.

- **Video Server Control** — Select, play, and monitor server clips by name right from the Synergy Q/MD/X control panel. The clip menu keeps track of clips and allows instant recall and cue.

- **Monitor Wall Control** — This software option adds the ability to interface between your switcher and a multi-image display system, providing advanced monitoring capabilities.

- **Audio Server Control** — This option allows control of audio servers (such as the Digicart by 360 Systems) directly from the switcher panel.
• **Character Generator Control** — This option allows control of character generators. You can load and run effects, load and navigate through a playlist or a CG template, and edit CG text directly from your switcher control panel.

• **Router Control** — This option makes your plant router sources easily selectable directly from the Synergy Q/MD/X system control area. Router mnemonics are supported, with the router 8-character source name being displayed on the system control area, mnemonic displays, and Preview Overly source ID text.

• **Serial Tally Interface**. Interfacing to Under Monitor Display and Tally Systems is easy with this option. The Serial Tally Interface uses industry standard tally protocols to communicate tally information on an RS-422 serial port to other devices.

• **Peripheral Bus II Interface**. This option provides support for Thompson GVG™ Peripheral Bus II Protocol for external device integration. It can coordinate the store and recall of the settings of some still stores, character generators, and device controllers with the store and recall of your Synergy settings.

• **Audio Mixer Interface**. Large or small mixers can be controlled serially from your Synergy Q/MD/X control panel, making an integrated A/V production possible.

• **Robotic Camera System Interface**. Pan, tilt, zoom, focus, shot recall and more, are directly controllable from your control panel when this option is added to Synergy Q/MD/X.

• **Custom Control Macro Buttons**. Several dedicated macro buttons have been positioned close to the operator for powerful single touch control. Recall any combination of switcher memories, button presses, and external device control with our editable macro system.

• **Compatible with Synergy SD Panels**. The Synergy Q/MD/X frame connects to the same control panels as the economical Synergy SD frame.

• **Hot Swappable Cards**. All cards in the Synergy Q/MD/X frame can be safely removed with the power on. If any card is plugged into the wrong slot, the card and system hardware will not be damaged. In addition, Synergy Q/MD/X was designed to support emergency swapping of some circuit boards even during live operation.

• **Upgrades from the Web**. Software, and even some hardware, can be upgraded by downloading files from the Ross Video website.

• **Affordable**. A powerful switcher at a great price!

• **Rugged Construction**. Ross warranties save thousands in operational costs over competitive products. It is no secret that Ross products are tough. They are built to handle years of demanding, continuous use. The Synergy Q/MD/X line is backed by a comprehensive 3-year transferable warranty. The design of our fourth generation fader bars is so good that they are guaranteed for life.

**Standard Features**

The following features are standard in Synergy Q/MD/X switchers:

**Complete Control Panel**

Regardless of what options are ordered, your control panel is always equipped with every button, knob, display and light. This means that your Synergy switcher and your control room will look their very best - even if your budget is tight.

In addition, all input boards are physically identical, for ease of installation and service.
**16 Multi-Definition Serial Digital Inputs**

The full line of Synergy Q/MD switchers come standard with 16 multi-definition serial digital inputs (optionally expandable to either 26 or 32 inputs).

The full line of Synergy Q/MD-X switchers comes standard with 16 multi-definition serial digital inputs (optionally expandable in groups of 16 up to 96).

With all switchers in the series, any input can be assigned to any control panel push button, thus simplifying installation and your ability to customize the panel layout. Inputs can be used for video, alpha channel, chroma Keying, or switcher reference.

Note that if Mnemonics are purchased, different shows can use completely different sets of inputs optimally arranged on the control panel with labeling that follows.

**Aux Buses**

Thirty-two Aux Buses are standard, each of which can be used to route video to monitors, DVE channels, still stores, tape machines, technical areas, etc. These Aux Buses can be mapped to any of the 48 available timed outputs on a Synergy Q/MD-X switcher or 16 available outputs on a Synergy Q/MD switcher.

**16 Configurable Multi-Definition Serial Digital Outputs**

All Synergy Q/MD/X switchers come standard with 16 timed digital outputs (Synergy Q/MD-X switchers are optionally expandable in groups of 16 up to 48). Outputs are fully configurable and can be used as MLE Program, MLE Preview, MLE Clean Feed, Preview Overlay, MultiDSK, Aux Bus, or AuxKey.

The following signals are available from the crosspoint matrix to the output cards in a standard system with no additional I/O cards installed. Each of these output signals can be mapped to any number of Output BNCs.

The following signals are available from the crosspoint matrix to the output cards in a standard system with no additional I/O cards installed. Each of these output signals can be mapped to any number of Output BNCs.

<table>
<thead>
<tr>
<th>Crosspoint Matrix Video Signals</th>
<th>Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>1</td>
</tr>
<tr>
<td>Standard Primary Inputs</td>
<td>16</td>
</tr>
<tr>
<td>Global-Store (and optional MediaCache)</td>
<td>3</td>
</tr>
<tr>
<td>MLE PGM</td>
<td>up to 4 (1 per MLE)</td>
</tr>
<tr>
<td>MLE PV</td>
<td>up to 4 (1 per MLE)</td>
</tr>
<tr>
<td>MLE FlexiClean Clean Feeds</td>
<td>up to 3</td>
</tr>
<tr>
<td>MLE Look Ahead Preview</td>
<td>up to 3</td>
</tr>
<tr>
<td>Preview Overlay (“Preview Matrix”)</td>
<td>1</td>
</tr>
<tr>
<td><strong>Total Sources available:</strong></td>
<td><strong>up to 37</strong></td>
</tr>
</tbody>
</table>

Not included in the above tally are signals generated by the following:

- The optional MultiDSKs DSK 3 and DSK 4
- Processed Aux Bus feeds when the optional AuxKeys are activated
• Additional Synergy Q/MD primary inputs (up to 16 more), if an additional video input card is installed
• Additional Synergy Q/MD-X primary inputs (up to 80 more) if additional video input cards are installed

Every output is fully timed to provide consistent and adjustable output phasing.

** Analog Reference Input **

All Synergy Q/MD/X switchers use an analog reference that consists of a pair of looping reference BNC connectors, in addition to the standard 16 inputs, on the rear panel of the Video Input Board. Tri-level sync is recommended for HD applications. The same looping connector will accept standard color black as a reference in SD applications.

** 3 Channel Global-Store **

Three independent channels of stills are available switcher-wide. Thousands of full screen stills and logos can be stored in the on-board hard drive and are transferable to other control-room devices over Ethernet using drag and drop.

Global-Store comes standard with 256 Megabytes of RAM storage. This translates to at least 30 full screen 1080i images with Key or 189 full screen 480i images with Key. The number of images stored increase considerably when smaller, non-full screen images like logos are stored. Thousands of additional images can be loaded quickly from the system hard drive. When the optional MediaCache™ for Global-Store is enabled, the playout capabilities and storage capacity of the Global-Store are increased considerably.

** Full Multi-Definition MLE Effects Systems **

Standard equipment on the Synergy Q/MD/X switchers includes full MLE (Multi-Level Effect) systems. Both Keyers in a full MLE can matte fill, Key invert, pattern mask, box mask, garbage mask, Self-Key, Linear Key, and Preset Pattern Key. UltraChrome advanced chroma Keying is standard on Key 1 and optional on Key 2. Each full MLE has a dedicated utility bus for video-in-border applications. All full MLEs have powerful internal DVE send/return paths. Up to four channels of optional 3D DVE can be dedicated to each full MLE. Each full MLE provides two wash generators that incorporate extensive wash patterns, matte video effects, and noise effects. Full preview is always available to reduce on-air surprises.

** Added Flexibility with a Half MLE! **

The Synergy Q/MD/X line offers either a fully functional MLE or a convenient program/preset area on the bottom rows of the control panel. The configuration that you choose really comes down to the switching preference of your TDs. Many TDs will switch just above the program/preset most of the time, leaving the program/preset as a quick way to exit out of complex MLE effects. Other TDs prefer instead to switch on the very bottom row, and appreciate the added effects capability that a full MLE provides.

---

** Note **

This section does not apply to the PGM/PST MLE on the Synergy 1.5 and 2.5 Q/MD, and the Synergy 2.5 and 3.5 Q/MD-X. Refer to the section “Added Flexibility with a Half MLE!” on page 1–12.

** Note **

This section applies only to the PGM/PST MLE on the Synergy 1.5 and 2.5 Q/MD, and the Synergy 2.5 and 3.5 Q/MD-X.
Advanced Copy and Swap Functions

The following convenient copy and swap functions are available as standard:

- **Copy MLE** — This feature allows you to copy the contents of an MLE to another MLE location on the switcher.
- **Copy/Swap Key** — This feature allows you to copy or swap the contents of a Keyer with another Key location (in the same MLE, or on a different MLE).
- **Copy Matte** — This feature allows you to copy the contents of a matte generator to any other matte location.
- **Copy Wipe** — This feature allows you to copy a wipe pattern (and all wipe pattern modifiers) from one MLE to another.

Pattern Generators

Each switcher includes, as standard, both advanced and additional pattern generators that are used for wipe transitions and preset patterns:

- **Synergy 1 and 1.5 Q/MD** — Two advanced and two additional
- **Synergy 2 and 2.5 Q/MD** — Four advanced and four additional
- **Synergy 2 and 2.5 Q/MD-X** — Four advanced and four additional
- **Synergy 3 and 3.5 Q/MD-X** — Six advanced and six additional
- **Synergy 4 Q/MD-X** — Eight advanced and eight additional

Half of the advanced generators are used for wipe transitions and PST PATT 1, while the other half are used for PST PATT 2. The additional pattern generators are used for wash generators that are available as MLE inputs or anywhere a matte is used.

The advanced wipe generators come equipped with classic, matrix, rotary, heart, and star wipes. All wipe types can be rotated, bordered, and repositioned. The additional wipe generators are identical to the advanced wipe generators except that matrix capability has been removed.

Matte Generators

Each full MLE has three simple color generators and two complex ones capable of multi-color washes. Any one of the color generators can be assigned to COLOR BKGD1 or 2, Key fill 1 or 2, Key border 1 or 2, or wipe pattern edges. Each full MLE has its own dedicated COLOR BKGD video inputs to make memory recalls of individual MLEs simple and predictable.
**FlexiClean™ Clean Feed Outputs**

Each MLE can have its own fully programmable clean feed output. This provides a second “program” output that is derived from a different location than the standard program output. Typical applications are as follows:

- Bilingual and live-to-tape productions
- Recording shows for later airing without “call in” phone numbers inserted.

The clean feed output can come from before or between the Keyers in the MLE. Each MLE has its own, independently configured clean feed output separate from all other clean feed outputs.

**Clean Feed Modes for Synergy 1 Q/MD with MultiDSK**

The diagram below illustrates the clean feed output configurations available on the Synergy 1 Q/MD with the MultiDSK (DSK 1 and DSK 2) option installed.

**Clean Feed Modes for Full MLEs**

The diagram below illustrates the possible clean feed configuration for the output of the full MLEs on the following switchers:

- Synergy 1.5 Q/MD
- Synergy 2 Q/MD
- Synergy 2.5 Q/MD
- All Synergy Q/MD-X
Clean Feed Modes for Full MLEs with MultiDSK

The diagram below illustrates an example of the clean feed output configurations available on the following with MultiDSK (DSK 3 and DSK 4) installed:

- Synergy 2 Q/MD (the bottom PGM/PST MLE)
- Synergy Q/MD-X (the bottom full PGM/PST MLE)
- Synergy 2 Q/MD-X

Note: For Synergy 3 Q/MD-X, CLEAN FEED 1 would be derived from after the MLE 3 PGM output. Similarly, for the Synergy 4 Q/MD-X, CLEAN FEED 1 would be derived from after the MLE 4 PGM output.

Clean Feed Modes for MultiDSK

Clean Feed Modes for Half MLEs with MultiDSK

The diagram below illustrates the clean feed output configurations available on the bottom PGM/PST MLE with the MultiDSK (DSK 3 and DSK 4) option installed of the following switchers:

- Synergy 1.5 Q/MD
- Synergy 2.5 Q/MD
- Synergy 2.5 Q/MD-X
- Synergy 3.5 Q/MD-X

Preview Overlay

This feature makes it possible to display various types of useful information on the preview output. This information is color-coded, and can be positioned and resized according to user preferences.

On the Synergy 1 Q/MD, you can access the Preview Overlay through the switcher menu system. On all other Synergy Q/MD/X control panels, there are eight buttons in the Preview Overlay area on the switcher control panel that enable display and control over the following types of information:
Source Identification

Source ID displays the name of the current background video, current preset video, and transition type. When the Routing switcher Interface option is installed, router source names are displayed. For example:

VTR 1 -W-> CAM 2

Note that the preview source is shown in green letters, while the program source is shown in purple letters.

VTR Time Code

The VTR Timecode overlay displays the timecode of the VTR, DDR, Video Server, or other external device that is on-air and/or will be transitioned on-air. The device must be controlled from the switcher in order for the timecode information to be available.

BNC C10 ON-Air 00:59:29:59
BNC C06 Preset 00:01:02:03

VTR TC

The timecode is red if it is on-air, yellow if it is selected, but not on-air, and gray if it is not selected or on-air. Only two timecodes can be displayed at the same time on the preview overlay.

The VTR Timecode overlay is made up of three elements, the input BNC of the clip, the on-air status, the timecode of the clip or time remaining in the clip. The timecode of the clip is show when a clip is not playing, and the time remaining when the clip is playing.

When you select VTR TC, VTR TC Position is shown on the display on the Positioner Module, indicating that the positioner can be used to move the VTR Timecode element around on the screen.

Configurable Safe Title, Safe Area and Center Cross Hairs

This places a SMPTE standard safe title, safe area, and center indication over the main preview output, all of which can then be adapted to fit your specific application.

- Safe Title — A box that outlines the area within which the vast majority of home TV sets will be able to read text.
- Safe Area — A box that outlines the region within which viewers should be able to follow action.
- Center Cross Hairs — The cross hairs indicate the center of the picture. This is useful in the alignment of text and other information.

Time Clock

This places a configurable count-down/count-up timer on the main preview output to time shows, commercial durations, or other events. Custom Control buttons on the panel can be assigned to reset, start, stop, or set the clock. This timer can also be made to restart every time a background transition occurs on air.

Mask Preview

This places a thin outline on the main preview output around the current active box mask.
Intuitive Control Panel with Keyboard Port

The Synergy Q/MD/X control panel, that comes standard with all Synergy Q/MD/X systems, has a PC-compatible PS/2 keyboard port that allows you to connect a standard keyboard to your system. The keyboard allows you to complete switcher setups and still management more easily.

Hard Drive, USB Drive and System Control Area

This feature makes it possible to store and recall complete switcher setups including memory functions, switcher personalities, installation parameters, and more, to a USB Drive or the System Hard Drive. This allows operators and technical staff to backup their switcher setups and easily transfer these settings to other Synergy Q/MD/X switchers.

The system hard drive is located on the CPU Board in the Synergy Q/MD/X frame. Switcher settings can also be stored here for quick recall. This is the same hard drive that is used to store stills, logos, animated logos, and short video clips. Memories and graphics files are accessible over the 10/100 Ethernet network port for easy remote load and backup.

Also included in this feature is the large crisp display with dedicated soft-buttons and soft-knobs that are used to configure the switcher and to provide advanced operational features.

Custom Control Macros

This feature brings the power of macros to the switcher operator. A series of button presses can be easily recorded and attached to any of dedicated buttons that are positioned close to the operator on the control panel. Step through complex show openings as easily as pressing one or two Custom Control buttons. This feature eliminates confusing timeline programming.

Custom Control buttons can also be used to control remote devices or other optional switcher features such as:

- Trigger a GPI to advance to the next page of your still store
- Play, stop, or shuttle, up to eight VTRs or video servers
- Set, start, reset, or automate the integrated switcher time-clock
- Trigger a DigiCart™ audio server and tie sound effects to wipes
- Recall a robotic camera scene along with a switcher memory
- Recall an audio mixer setting for an integrated audio follow video production
- Any number of pauses, holds, and events can be added to any macro
- And many additional sophisticated features.

Custom Control macros can be viewed and edited directly on the switcher menu.

When the Mnemonics for Custom Control Macros option is installed, color-coded macro names are presented directly above the buttons. This is especially useful when several banks of macros are in use.

Note

The Mnemonics for Custom Control Macros is not available for the Synergy 1 Q/MD control panel.

100 Event Memory System

Each switcher comes standard with storage for 100 complete switcher snapshots. They are easily stored and recalled at the touch of a single button. If you don’t want to recall the entire switcher at once, you can recall any area of the switcher from a keypad dedicated to that MLE.
All of these memories, including associated attributes, can be stored to the hard disk or a USB drive, providing custom tailored memories for every operator and every show.

For convenience, memories can also be named — such as “SPORTS”. An alphanumeric display in each MLE will tell you what you’ve recalled, or what you’re about to recall.

**Displays and Indicators**

The Synergy Q/MD/X switchers always let you know what is going on. Bright red lights at the end of every bus quickly show what is on air. Yellow non-sync lights warn you that an input is untimed and might cause problems. Lights under the Key transition buttons and in the Keyers glow red when the Key is on air or green when they are active but the MLE is not on air.

Every auto transition rate is constantly visible, including the main transition rates, the dedicated Keyer rates, and the fade to black rate. The last memory number recalled per MLE is also displayed along with an associated eight-character memory name.

**General Purpose Interface**

Each Synergy Q/MD/X switcher is equipped with 10 dedicated GPI inputs and 10 dedicated GPI outputs.

- **GPI inputs** — These allow the switcher to interface with peripheral equipment such as editors. Each GPI input can be assigned to perform simple editing and switching functions such as fade-to-black or an MLE auto-transition. GPI inputs can also trigger Custom Control macros, making it possible to trigger complex timelines. For more complex serial editing capabilities, the Editor and Automation Interface option is available.

- **GPI outputs** — These are used to trigger remote events such as “Still Store Next Page”. They are activated through the Custom Control macro system.

**Tally Outputs**

The Synergy Q/MD/X systems include 36 tally relays located in the control panel conveniently close to your monitors. Any tally can be assigned to any video input (or MLE program output) making 36 enough for most systems. As each tally is assignable, more than one tally can be assigned to the same source. This can simplify system cabling in situations such as when camera tallies must be supplied to both the camera itself and the control room monitor wall.

**Note**

The Synergy 1 Q/MD has a maximum of 16 standard tallies and cannot be upgraded with the 36 additional tallies option.

An optional 36 additional tallies can be ordered for red/green preview tally systems and Aux Bus tally systems that require twice as many tallies, or for cases where more than 36 inputs must be tallied. Refer to the section “System Options” on page 1–19 for details.

**System Manuals**

All Synergy Q/MD/X switchers come with a complete set of system documentation that includes an Operator’s Manual and an Engineering Manual.
10 Meter Control Cable

**Important**
The cable for connecting the Synergy Control Panel to the Synergy Q/MD/X frame is not wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.

A single, 8-pin flat-shielded CAT5 cable, using high speed RS-422 communication, connects the Synergy control panels and Q/MD/X rack frame. The maximum cable length between the control panel and its rack frame is 1,000 feet or 305 meters.

**UltraChrome™ Advanced Chroma Keying**

UltraChrome chroma Keying is available on both Keyers in each full MLE.

Using the menu system, you can control additional chroma suppression, natural shadow insertion and shadow transparency.

To simplify fast-paced live operation, the advanced menu system controls can be disabled. This allows you to quickly set up high quality Keys using a minimum number of dedicated knobs and buttons. A “Chroma Key Memory” button is also available on the panel that instantly recalls a previously stored chroma Key setup.

Chroma Key shadows can either be extracted from the source image or simulated using the optional switcher border generators.

**System Options**

This section lists the options available for the Synergy Q/MD/X Series of Live Production Engines. Note that all options can be easily installed in the field.

**Note**
Refer to the section “Installed Options” on page 3–10 for instructions on how to verify the status of your installed hardware and software options.

**Additional Inputs**

Inputs can be freely assigned to any panel crosspoint button or shifted crosspoint button. They can also be “hidden” and accessed only as alpha channels or they can be “locked out” if they are not used.

**Operating Tip**
If Mnemonics for MLE Sources are purchased, different shows can use completely different sets of inputs optimally arranged on the control panel with labeling that follows.

**Synergy Q/MD**

For the Synergy Q/MD, an additional 10 or 16 inputs can be purchased, for a total of 26 or 32 multi-definition digital inputs.

**Note**
On the Synergy Q/MD frame, you can install either 10 or 16 additional video inputs, but not both.
**Synergy Q/MD-X**

The Synergy Q/MD-X comes standard with 16 multi-definition serial digital inputs plus re-entries. All digital inputs can be used direct to air, as Key alpha channels, or as chroma Key sources.

Additional inputs can be purchased for the Synergy Q/MD-X in groups of 16 up to a maximum of 96 multi-definition digital inputs. Therefore, quantities of 16, 32, 48, 64, 80, or 96 inputs are possible.

**Additional Q/MD-X Outputs**

All Synergy Q/MD-X switchers come standard with 16, multi-definition serial digital outputs. Additional outputs can be purchased in groups of 16 up to a maximum of 48 multi-definition digital outputs. Therefore, quantities of 16, 32, or 48 outputs are possible.

Digital outputs are fully configurable to be program, preview, clean feed, or Aux Bus outputs. It is recommended that you carefully map out your output requirements to determine the number of outputs needed.

---

**MediaCache™ for Global-Store™**

MediaCache enables the playout of animated logos, moving graphics, and short uncompressed clips from the Global-Store. Each output is capable of playing full bandwidth clips independently and simultaneously.

The duration of the clips depend upon the size of the clips being used. Full screen 1080i images will take 5 times the storage of a 480i clip. However, a small, animated logo in 1080i will take much less storage than a full screen 480i clip. Purchase of the MediaCache for Global-Store increases the RAM capacity from 256MB to 1GB. This allows storage of up to 4 seconds of uncompressed 1080i playout or 25 Seconds of 480i playout.

Clips and animations are loaded from the system hard disk to local Still Store RAM at power-up or when new clips are requested. Clips can be dragged and dropped from external computers to Synergy Q/MD/X via Ethernet.

**Panel Remote Port Expander (Adds 3 RS-422 Ports)**

This option connects to any one of the remote ports on the control panel, and provides four serial port outputs, effectively increasing the number of available ports by three. This “smart” port expander (BSS4) works with the Synergy Q/MD/X control panel to seamlessly manage external device traffic.

The additional ports provided by the remote port expander can be assigned and configured for virtually any devices supported. For example, you can assign a VTR, Router, Robotic Camera and an Audio Mixer to a single remote port expander.

---

**Note**

The MediaCache™ option consumes four additional digital outputs. Refer to the section “MediaCache™ for Global-Store™” on page 1–22 for more details, if this applies to your configuration.

---

**Panel Remote Port Expander (Adds 3 RS-422 Ports)**

This option connects to any one of the remote ports on the control panel, and provides four serial port outputs, effectively increasing the number of available ports by three. This “smart” port expander (BSS4) works with the Synergy Q/MD/X control panel to seamlessly manage external device traffic.

The additional ports provided by the remote port expander can be assigned and configured for virtually any devices supported. For example, you can assign a VTR, Router, Robotic Camera and an Audio Mixer to a single remote port expander.

---

**Note**

The 360 Systems Digicart cannot be operated from a remote port expander.

---

Multiple Serial Port Expander (BSS4) units can be connected to a Synergy Q/MD/X control panel at the same time.

The unit is about 4 inches by 6 inches and is designed to easily mount under the console near the Synergy Q/MD/X control panel.
**Network Still & Clip Server Option**

This option adds a fully integrated Still and Clip Server to the system.

**Note**  
The Network Still & Clip Server Option is only available in Standard Definition.

The following features are included:

- 48 hours of clip storage at 12Mb/s in MPEG-2 compression
- Virtually unlimited still storage, incorporating both Key and fill
- Video animation playout with synchronized Key and fill
- Animated logo playout with synchronized Key and fill
- 2 dedicated playout channels
- 1 record/play channel for live capture and/or additional playout
- Ethernet connectivity allowing drag and drop of stills and clips over a network
- Included Synergy Video Server Control Interface

This option is the result of a collaborative effort between 360 Systems and Ross Video to provide a comprehensive networkable, high storage, clip and still store system solution.

**Video Server Control** is included with this option and does not need to be purchased separately. Any number of control panel ports are now activated to control this and any other video server that can be controlled using VDCP (Harris/Louth) Protocol.

Unlike other systems on the market, this solution allows totally synchronized Key and fill playout of clips, animations, and stills. Add the ability to drop in graphics and animations over a network using simple MPEG or Targa files, and this becomes an extremely practical and attractive package.

**AuxKeys, System Wide**

This revolutionary option turns Aux Buses into A/B mixers or mixer/Keyers. The number of AuxKeys available depends on the number of output cards installed in your system.

**Note**  
If the MultiDSK option is installed, the maximum possible number of AuxKeys is reduced.

The use of a single AuxKey can free up an entire MLE in many applications. This is a highly recommended option. Key and mix sources are fed from adjacent Aux Buses that have access to every signal in the switcher. Of particular interest in this application are Global-Store outputs that, with MediaCache enabled, can provide animated logo capability.

AuxKeys can be used two ways:

- Mixer (mix between two inputs on an Aux Bus)
- Mixer/Keyer (mix and Key)

Switcher outputs are assigned to AuxKeys in groups of four. Mix or Key operations can be previewed and clean feed is also available — this acts very much like a standard MLE.

AuxKeys significantly increase the Keying power of the switcher but do so without tying up an MLE. AuxKeys are controlled via configuration menus, Custom Control macro buttons, or by temporarily using the buttons of an MLE.
Applications for AuxKeys include the following:

- **Downstream bug insertion** — This can ensure that a logo remains inserted regardless of what is being done in the MLEs. *This frees up MLE Keyers.*
- **Multi-language applications** — Add CG Keys to clean feed outputs. *This often frees up one or more MLEs.*
- **Multi-client applications** — Add Keys to MLE outputs that present a variation on the main program output. *This often frees up one or more MLEs.*
- **Multicasting** — Produce programming for two regions simultaneously but brand them differently without consuming MLE Keyers and adding production complexity. *This frees up MLE Keyers.*
- **Stadium concourse and box seat monitors** — Add different sponsor branding to different stadium locations. *This frees up MLEs and eliminates the need for external Keyers.*
- **Pre-Keying** — Add Keys to sources before they are brought into the switcher MLEs. Time the AuxKeys early and the MLEs late and sources can be fed back into the switcher as inputs. *This frees up MLEs or unwieldy external Keyers.*
- **Pre-mixing** — Mix between two sources before they are brought into the switcher MLEs. This makes it possible to dissolve inside any number of DVE boxes while only consuming a single MLE. *This effect would normally take one MLE for every DVE box.*
- **Studio Plasmas** — If your set has multiple live plasma displays with images that require Keys to be inserted, AuxKeys are an ideal, cost-effective solution. *This frees up MLEs or external Keyers.*

**MultiDSK™ (DSK 3 and DSK 4)**

**Note**

On the Synergy 1 Q/MD, this is DSK 1 and DSK 2, as the Synergy 1 Q/MD does not have any standard internal DSKs.

This option adds a third and a fourth linear Downstream Keyer to the pair of standard internal DSKs. These Downstream Keyers have access to every Synergy Q/MD/X video source and are fully integrated into the PGM/PST MLE transition system with full preview.

The hardware for this option resides on the Video Output Board where the PGM/PST MLE Program and Preview outputs have been assigned and will consume four additional multi-format Output BNCs in order to supply the DSKs with Video and Key sources.

**Squeeze & Tease MD and Carrier**

The Squeeze & Tease Carrier is equipped with a high performance DSP (Digital Signal Processing) module. This board must be purchased in order to install the Squeeze & Tease MD option.

**Note**

One carrier will support all the hardware for MLEs 1 and 2. A second carrier will support the Q/MD-X hardware for MLEs 3 and 4.
One Squeeze & Tease MD option provides two channels of 3D planar effects. Each MLE can have up to two of these options. The option is available for all MLEs including the PGM/PST MLE.

**Note**

The option is *not* available for the PGM/PST MLE on the following switchers:

- Synergy 1.5 Q/MD
- Synergy 2.5 Q/MD
- Synergy 2.5 Q/MD-X
- Synergy 3.5 Q/MD-X

- The Synergy 1 and 1.5 Q/MD can have up to two of these options providing an impressive 4 channels of 3D DVE.
- The Synergy 2 and 2.5 Q/MD/X can have up to four of these options, providing an impressive 8 channels of 3D DVE.
- The Synergy 3 and 3.5 Q/MD-X can have up to six of these options, providing an impressive 12 channels of 3D DVE.
- The Synergy 4 Q/MD-X can have up to eight of these options, providing an impressive 16 channels of 3D DVE.

**Note**

The Squeeze & Tease MD Carrier Board is required to install the Squeeze & Tease options.

Squeeze & Tease is an extremely popular option that is sold with almost every Ross digital switcher. Some of the features of Squeeze & Tease are as follows:

**Fly ANY kind of Key**

Pressing the FLY KEY button easily activates Squeeze & Tease MD allowing you to transform self Keys, linear Keys, and chroma Keys. A comprehensive and intuitive menu is available where you can set up your desired effects. If you prefer, the 3-axis joystick can also be used to adjust the parameters of your Key.

**Preprocessor Effects**

Preprocessor effects include a wide range defocus with separate H and V controls, mosaic, posterization, colorization, and a strobe effect that allows you to vary the number of on and off frames to provide enhanced creative possibilities. All preprocessor effects are available to be combined simultaneously.

**Planar Transforms with Lighting**

Squeeze & Tease MD has dedicated circuitry incorporating 10-bit processing, superb filtering, and full sub-pixel resolution to manipulate 2D images in 3D space with crystal clear quality.

Planar transforms include squeeze or zoom, crop, reposition, aspect, and rotate. These effects can be applied to images and Keys.

All images and Keys can also have realistic natural lighting applied to them. Squeeze & Tease MD makes it easy with “quick presets”, a positionable light source, and powerful ambient and min/max lighting controls.
Advanced Picture Frame Border Generator

Squeeze & Tease MD can add a picture frame to border over-the-shoulder boxes. This variable width border perfectly tracks all image resizing and special effects. The picture frame generator instantly adds a polished, professional look to your squeeze backs.

This picture frame can be the simple, single color type, or one of many advanced picture frame effects including roman column, tubular, beveled, computer style, tri-color, and more. These picture frame effects have the following adjustable controls:

- hard or variable edge softness
- edge width/scaling
- inside/outside edge softness symmetry
- diagonal, horizontal, and vertical corner joint selection
- full control of all three picture frame color generators

Advanced Planar Controls

The following advanced controls make building the ideal look for your show just that much easier:

- **Front Side/Back Side** in one channel and one Keyer. When you look at the backside of an effect, you can have it automatically select a different video signal on the Key bus. This makes it possible, for example, to rotate between two channels of still store in an over-the-shoulder box in a single Keyer, using only a single channel of Squeeze & Tease MD.

- **Auto Flip**. When you rotate an image in normal mode, the backside appears upside down or mirrored. Turning on Auto Flip ensures that the front side of an image is always presented. This is great for the manipulation of still store and CG text.

- **Internal Key Combiner**. Squeeze backs can be combined and displayed in a single Keyer. This effectively adds additional Keyers to the MLE.

- **Key Combiner Priority Control**. Getting the channels the way you want them is easy with Squeeze & Tease MD. When several squeeze backs are combined in a single Keyer, you can choose fixed priorities, auto-priority, or intersecting planes. Fixed priorities allow you to manually set the priority as Channel 1 or Channel 2 on top. Auto-priority automatically calculates the channel priority based on their relative positions in 3D space. With the intersecting planes choice, channels will literally cut into one another channel hiding the portions that are hidden behind them.

Pre-Built Effects, User-Built Timelines and Key Sequences

Squeeze & Tease MD ships with dozens of prebuilt effects that are ready to take to air. More effects can be downloaded from the Ross Video website. All of these effects can be easily modified to meet your needs. You can also build entirely new effects of your own from scratch.

Effects can be built to start when a macro button is pressed, when an auto transition is pressed, or can be run under manual fader control. Effects can be used as a transition, or as a sequence of Keyframes running inside one or more Keyers.

Mnemonics Controllers and Displays

This option consists of one or two controller boards, depending on the control panel you have, and the actual mnemonics displays. Only one set of controller boards is required to control all mnemonics...
across the entire control panel. The displays can be installed for any combination of MLEs and custom control macro row desired.

Note

This option is not available for the Synergy 1 Q/MD control panel.

Mnemonics are available for each of your MLEs and your Custom Control buttons. Each individual display is completely modifiable. You can change the display color, text size, and backlighting to customize your source names for different applications. When the Routing Switcher Interface option is installed, switcher source names are replaced by router source names.

This option is perfect for mobiles and other applications that require different crosspoint names from one production to another, or when you wish to simplify a production by showing only those sources that will be used in that production and not all of the sources currently connected to the switcher.

XFX Board with MLE-Store, MediaCache, and Dual Border Generator

This option adds an XFX Extra Effects Processor Daughter Card to the Video Processor Board. Each card adds the Multi-Def MLE-Store and Dual Border Generator options to the selected full MLE. You need a single XFX Card per full MLE.

The MLE-Store option adds four channels of Still Store per MLE. These channels are available from the Program, Preset and Key Buses on that MLE. Still Store channels can be paired for video plus Key operation.

MLE-Store comes standard with 256MB of RAM storage, enough for at least 30 full screen 1080i images with Key or 189 full screen 480i images with Key. The number of images stored increase considerably when smaller, non-full screen images like logos are stored.

Thousands of additional images can be loaded from the system hard drive. When the optional MediaCache for MLE-Store is installed, the playout capabilities and storage capacity of the MLE-Store is increased considerably. All images stored in this memory are available simultaneously to all MLE-Store outputs in the MLE.

MediaCache for MLE-Store, like MediaCache for Global-Store, upgrades the 256MB MLE-Store RAM with a 1GB MediaCache RAM. Each MLE-Store output is capable of playing full bandwidth clips independently and simultaneously. When upgraded to MediaCache, this allows storage of up to 4 seconds of uncompressed 1080i playout or 25 Seconds of 480i playout.

Note

MLE-Store has an advantage over the Global-Store in that stills are automatically recalled with MLE memory recalls. The Global-Store feeds sources switcher-wide and are therefore not part of memory recalls.

The Dual Border Generator option provides border, shadow, and outline effects to both Keyers in a full MLE with either hard or “glowing” edges. You can move the border to any position on the screen, even above the Key. Borders are “flown” in real time with the positioner in the same manner as wipe patterns and DVE effects.

The Dual Border Generator can be applied to any kind of Key including Self Keys, Auto-Select Keys, Chroma Keys, and Preset Pattern Keys. Borders are particularly effective for enhancing Squeeze & Tease over-the-shoulder boxes making them appear to “float” over their backgrounds.

Assignable Remote Aux Panels

A Remote Aux Panel is a self-contained switching unit that has its own power supply. It mounts in a 19-inch rack and fills one RU (Rack Unit).
• An **Assignable Remote Aux Panel** controls multiple Aux Bus outputs. The assignable panel for the Synergy 4 Q/MD-X is shown below:

![Synergy 4 Q/MD-X Assignable Remote Aux Panel](image)

• An **Assignable Remote Aux Panel** controls multiple Aux Bus outputs. The Assignable Panel for the Synergy 2.5 Q/MD is shown below:

![Synergy 2.5 Q/MD Assignable Remote Aux Panel](image)

There are a variety of Aux panels available in the product line. *All panels* include dedicated buttons for Preview, Program, Clean Feed, and for accessing multiple Aux Bus Outputs — plus a bright “on-air” LED.

The primary difference between the panels is in the number of source and MLE buttons:

- **Synergy 1 Q/MD** — the panel includes 16 source buttons plus **SHIFT**.
- **Synergy 1.5 Q/MD, 2 Q/MD and 2 Q/MD-X** — each panel includes 17 source buttons plus **SHIFT**, and a button for **MLE 1**.
- **Synergy 2.5 Q/MD, 2.5 Q/MD-X and 3 Q/MD-X** — each panel includes 30 source buttons plus **SHIFT**, and buttons for **MLE 1** and **MLE 2**.
- **Synergy 3.5 Q/MD-X and 4 Q/MD-X** — each panel includes 35 source buttons plus **SHIFT**, and buttons for **MLE 1, MLE 2, and MLE 3**.

The remote panel itself is connected to the rear of the switcher control panel via a single six-conductor Telco control cable that can run up to 1000 feet (305 meters) from the control panel. Typical applications include routing signals to one or more DVE channels, and switching a monitor between various signals (including MLE outputs) — outputs that are *not* the main program output.

- **Note**
  
  You can control up to 12 Aux Buses from a Remote Aux Panel.

- **Note**
  
  The **Synergy 1 Q/MD** control panel does not have an Aux Port, instead, a converter must be installed in **Remote Port 5** and this port assigned to Aux. The converter is included in the Installation Kit.

Although an unlimited number of Aux panels can be connected to each of the Aux connectors of the control panel, a *practical limit* (and to minimize delay) of 8 Aux panels daisy-chained on each connector is recommended.

The following features will affect the positioning of remote Aux panels in relation to the control panel:

- The **Assignable** Aux panel options include a 33-foot (10 meter) cable, but custom lengths, up to a maximum of 1000 feet or 305 meters (as limited by RS-422 specifications), between panels is possible. Contact your Ross Video representative for details.
The communications signal is re-buffered at each Aux panel.

Aux panel assignments are performed using the control panel and menu system. Refer to Chapter 11, “Additional Installation Setups” in the Synergy Q/MD or Q/MD-X Engineering Manual for more information.

Custom Cable for Aux Panel (Per Meter)

The remote Aux panel is connected to the rear of the control panel via a single six-conductor Telco control cable. The remote Aux panels come with a 10-meter control cable as standard. If lengths of other than 10 meters are needed, a custom cable can be ordered (by the meter). Cable runs up to 1000 feet (305 meters) are possible.

Editor and Automation Interface

The Editor and Automation Interface Option allows a Synergy Q/MD/X switcher to interface with all popular editing systems. The option itself is comprised of software plus security codes.

Any MLE or combination of MLEs can be controlled using an RS-232 or RS-422 interface and industry standard editor protocols. The editor can be used to read and write switcher functions including video input selection, push button enable and disable, control settings, and memory registers. If GPI control is not sufficient, and complete control of all switcher parameters from an editor is necessary, this option is required. Refer to the section “General Purpose Interface” on page 1–18 for additional details on GPI triggers.

VTR Remote Control

The VTR Remote Control Option controls VTRs, disk recorders, or other devices that use the Sony BVW-75 Betacam protocol, directly from the switcher panel. The option consists of software plus security codes.

With this option installed, the following functions are available:

- Every MLE transition area includes a ROLL VTR button which, when set to Play mode and pressed, issues a play command to the device selected on the PST or KEY buses. The operator then manually transitions the source to air by moving the fader or by pressing the CUT, AUTO TRANS, or the associated crosspoint on the PGM bus.

- When the ROLL VTR button is set to Arm mode, the switcher is armed to automatically transition the device to air after the preroll interval has elapsed. The transition to air is initiated manually when the operator presses the CUT, AUTO TRANS, or the associated crosspoint.

- VTR Remote Control can be tied into the Custom Control buttons. Any Custom Control button can be attached to functions such as play, stop, rewind, fast forward, frame advance, auto edit and standby off.

- The Global Memory System Group includes the VTR CLIP button which allows you to recall VTR clips (segments) from selected VTRs that are connected to Synergy. A clip
consists of two pieces of information: a physical VTR and a timecode or media ID. Using the VTR Clips Menu, you can select a device (VTR) and store a timecode in one of 100 registers. You can then press VTR CLIP, enter a clip register and cue the VTR (that is associated with the clip). You can then use the ROLL VTR button or your Custom Control buttons to roll the VTR.

**Still Store (Chyron Aprisa™) Interface**

This option enables serial ports for control over the Chyron Aprisa™ 100 Still & Clipstore. It allows a user to randomly access any still or clip under control from Synergy Q/MD/X. Custom Control macros can also be created for quick and direct access to clips and switcher scene recalls.

**Character Generator Interface**

This option enables the serial ports of control over a Character Generator. It allows the user to load and run effects, load and navigate through a playlist, or a CG template, and edit CG text directly from the Synergy Q/MD control panel.

**Small Audio Mixer Interface (16 and fewer Inputs)**

This option enables serial control for enhanced audio follow video from Synergy Q/MD/X over small audio mixers, making an integrated A/V production possible. It allows for audio voice-over control, association of several audio sources to one video source, and control of master and individual audio levels from the Synergy Q/MD control panel.

It is possible to purchase the small but powerful Yamaha 01V96 audio mixer console through any Ross Video distributor. This mixer has up to 16 analog inputs, 16 digital inputs, and a proven interface to our production switchers.

**Large Audio Mixer Interface (more than 16 Inputs)**

This option enables serial control for enhanced audio-follow-video from any Synergy Q/MD/X switcher over large audio mixers, making an integrated A/V production possible. It allows for audio voice-over control, association of several audio sources to one video source, and control of master and individual audio levels from the Synergy Q/MD control panel.

**Ganged Audio Mixers**

This option allows you to connect multiple audio mixers of the same model together and control both of them from the Synergy Q/MD control panel.

**Robotic Camera System Interface**

This option enables serial control over robotic camera systems including pan, tilt, zoom, focus, and scene recalls.

**Routing Switcher Interface**

This option adds routing switcher interface capability to your Synergy Q/MD/X Live Production Engine.

Any number of the inputs can be assigned as a router input. When you select a source fed by a router on the program or preset bus, the router control menu automatically appears. The router menu shows the name you assigned for the source on the switcher, ROUTER1 for example, and the name the router has for the source, VTR12 for example. The router menu also displays every source available
on that router by name and by router input number. The menu knobs allow for fast access to every available source. A single button push automatically assigns the chosen source to the switcher.

If the Mnemonics option is installed, the Synergy Q/MD switcher will replace the default “ROUTER1” name with the “VTR12” name, the one the router uses, on the mnemonic display for the assigned crosspoint.

The Synergy Q/MD Series of switchers can connect to up to any number of different routers, and many different brands of routers, simultaneously.

**Serial Tally Interface**

The [Contribution Serial Tally Protocol Option](#) allows you to set up communication parameters with tally system interface equipment using industry standard protocols. Note that the standard parallel tally interface will continue to operate normally when this option is enabled.

**Peripheral Bus II Interface**

This option enables support for Thomson GVG Peripheral Bus II Protocol for external device integration. Devices that support this protocol (such as some still stores, CGs, and device controllers) will be directed to store their settings when the Synergy Q/MD/X stores its settings, and then do a coordinated recall when Synergy Q/MD/X performs a recall.

**Video Server Control**

The [Video Server Control Option](#) enables control of video servers directly from the Synergy Q/MD control panel. Interfaced servers must use either the Harris (Louth) VDCP, or the Sony (Betacam) protocol.

The Video Server Control option allows you can set up a list of server clips that you want to use on air. You can name them, preview them, trim clip heads and tails and enable (or disable) each clip for use. The menu also includes a timeline that lets you visually review clip parameters, and add in points and out points on Synergy Q/MD/X without affecting the original clip on the server.

Once your clips are set up, you can choose a clip register from the [Global Memory System Group](#), select the video server on Preset and perform preview and cue operation with full transport control capability. On the display in the [System Control Group](#), in addition to the clip timeline, you can select any of your preset clips for use — in any order desired. Clip names and duration are displayed for your convenience.

Every MLE transition area includes a ROLL VTR button which, when set to Play mode and pressed, issues a play command to the device selected on the PST or KEY buses. The operator then manually transitions the source to air by moving the fader or by pressing the CUT, AUTO TRANS, or the associated crosspoint on the PGM bus.

When the ROLL VTR button is set to Arm mode, the switcher is armed to automatically transition the device to air after the preroll interval has elapsed. The transition to air is initiated manually when the operator presses the CUT, AUTO TRANS, or the associated crosspoint on the PGM bus.

Just like VTR Remote Control, Video Server Control can be tied into the [Custom Control](#) buttons.

**Audio Server Control**

The [Audio Server Control Option](#) enables control of audio servers directly from the Synergy Q/MD control panel. For the [360 Systems DigiCart™](#), the interface uses the Digicart native protocol, and allows the Synergy Q/MD/X operator to dial up the hard drive, directory, and clip number.

With the option installed, the following functions are available:
• You can set up a list of Digicart audio clips that you want to use on air, name them, preview them and enable (or disable) each clip for use.

• Once your clips are set up, you can choose a Digicart clip register from the Global Memory System Group, and perform preview, cue and “run” operation directly from the display.

• Just like VTR and Video Server remote control, Audio Server Control can be tied into the Custom Control buttons. This is the preferred way to utilize Audio Server clips, with the ability to associate sound effects with transitions (such as DVE moves), and store them on custom control buttons for single-button audio/video effects.

**Monitor Wall Interface**

This option allows you to control a monitor wall system with your Synergy Q/MD/X switcher. You can create and modify layouts, assign channels, and create dynamic text from your control panel.

**Extended Tallies**

The Synergy Q/MD/X switcher (excluding Synergy 1 Q/MD) includes 36 configurable tally relays, each of which can be assigned to any video input (or MLE program output). The Extended Tallies option provides an additional 36 tallies (bringing the total number to 72). These additional tallies are equally configurable and can be added for red/green preview tally systems that require twice as many tallies.

A preview tally system has a “red” output indicating that a source is on air and a “green” output indicating that a source has been selected on a preset bus. This gives the talent an additional warning as to the director’s next move. “Green” tallies require the Extended Tallies option.

**Redundant Power**

The Redundant Power Supply option provides protection against the failure of an individual power supply shutting down the entire frame. The N+1 mode also allows for the hot-swapping of any power supply without the interruption of the system and can even be done during live broadcasts.

There are two Power Fail indicator lights on the main control panel that will illuminate to show a failure or a problem with a power supply. These lights are as follows:

• Power Failure in the frame
• Power Failure in the control panel

Installing the Redundant Power option does not increase the amount of rack space required by the switcher. The extra power supply mounts in a provided slot inside the frame.

**Synergy Q/MD Series**

In the standard Synergy Q/MD configuration, if the power supply fails, the system will shut down immediately. With the Redundant Power option installed, you gain a second power supply to allow the frame to operate in a N+1 mode. In this mode, any one of the power supplies can power the entire frame if the second power supply fails.

The status of a frame power supply can be determined by the position of the individual power supply switch and the illumination of the green, yellow and red LEDs on each power supply.
**Synergy Q/MD-X Series**

In the standard Synergy Q/MD-X configuration, if one of the three power supplies in the Synergy Q/MD-X frame fails, the frame CPU Board will detect the failure and compensate by shutting down all the frame boards (except the Frame CPU Board) in order to protect the remaining power supplies. With the Redundant Power option installed, you gain a fourth power supply to allow the frame to operate in an N+1 mode. In this mode, any three of the power supplies can power the entire frame if the fourth power supply fails.

The status of a frame power supply can be determined by the position of the main and individual power supply switches and the illumination of the green, yellow and red LEDs on each power supply.

**Spare Parts Kit**

A **Spare Parts Kit** is available which provides switcher parts according to the following criteria:

- the part comes into frequent contact with the user
- the part can be easily damaged or may wear out with excessive use
- the part can be damaged by connecting excessive voltage to an external connector
- the part is used in system power management
- the part can be lost easily

Parts that fall outside of the above criteria are not included.

**Custom Main Panel Cable**

**Important**

The cable for connecting the Synergy Control Panel to the Synergy Q/MD Frame is not wired as a standard CAT5 ethernet cable. If you need a cable of a specific length, contact your Ross Video Representative for ordering information.

The **Main Panel** cable connects the control panel to the electronics frame. It is a shielded 8-pin Telco cable and the ends are finished with RJ-45 connectors. The control panel and frame can be separated by a maximum of 1,000 feet (305 meters).

A 33-foot (10 meter) control panel cable is supplied as standard with the switcher. If cable lengths other than 10 meters are needed, a custom cable can be ordered (by the meter).
A Word about Technical Support

At Ross Video, we take pride in the quality of our products, but if problems occur, help is as close as the nearest telephone.

Our 24 Hour Hot Line service ensures you have access to technical expertise around the clock. After-sales service and technical support is provided directly by Ross personnel. During business hours (eastern standard time), technical support personnel are available by telephone any time. After hours and on weekends, a direct emergency technical support phone line is available. If the technical support personnel who is on call does not answer this line immediately, a voice message can be left and the call will be returned shortly. These people are available to react to any problem and to do whatever is necessary to ensure customer satisfaction.

For Technical Support, call (+1) 613-652-4886 and, for After Hours Emergency, dial (+1) 613-349-0006.
Control Panel Introduction

In This Chapter

This chapter introduces each Synergy Q/MD/X switcher control panel. You will learn the various sections of each panel, and details about the basic functionality of each section. The following topics are discussed in this chapter:

- Control Panel Sections
- Video Flow Through the Switcher
- Using a Keyboard
- Switcher Color Scheme
- Resetting the Switcher
- Switcher Timeout
Control Panel Sections

The following figures show a top view of each Synergy Q/MD/X control panel, with each control panel section highlighted. Legends beneath the illustrations clearly name each section. Explanations that are more detailed are provided following the individual switcher drawings.

Note

Each panel is divided into sections (or “Groups”) according to specific functionality. For simplicity in the drawings below, sections are numbered in an identical manner from switcher to switcher. Similarly, for simplicity in operation, if you learn the sections, features, and functions on one Synergy Q/MD/X switcher, you have effectively learned them for all Synergy Q/MD/X switchers — making it easy to transfer your knowledge from panel to panel.

The following control panels are covered in this section:

- Synergy 4 Control Panel
- Synergy 3 Control Panel
- Synergy 2 Control Panel
- Synergy 1 Control Panel
Synergy 4 Control Panel

The Synergy 4 control panel has 4 MLEs and 16 inputs standard. This is the same control panel that is used with the Synergy 3.5 Q/MD-X Live Production Engine.

Synergy 4 Control Panel — Sectional View

1) System Control Group  8) Aux (Auxiliary) Bus Group  15) MLE Transition Group
2) Global Memory System Group  9) Program/Preset Transition Group  16) MLE Key 1 Group
3) Pattern Control Group  10) Downstream Keyers  17) MLE Key 2 Group
4) Program/Preset Bus  11) Positioner Group  18) Matte Control Group
5) Preview Bus Group  12) Preview Overlay Group  19) Effects Control Group
6) MLE (Multi-Level Effects)  13) Fade to Black Group  20) MLE Memory Group
7) Custom Control Group  14) Mnemonic Displays
Synergy 3 Control Panel

The Synergy 3 control panel has 3 MLEs and 16 inputs standard. This is the same control panel that is used with the Synergy 2.5 Q/MD, or Synergy 2.5 Q/MD-X, Live Production Engine.

Synergy 3 Control Panel — Sectional View

1) System Control Group  8) Aux (Auxiliary) Bus Group  15) MLE Transition Group
2) Global Memory System Group  9) Program/Preset Transition Group  16) MLE Key 1 Group
3) Pattern Control Group  10) Downstream Keyers  17) MLE Key 2 Group
4) Program/Preset Bus  11) Positioner Group  18) Matte Control Group
5) Preview Bus Group  12) Preview Overlay Group  19) Effects Control Group
6) MLE (Multi-Level Effects)  13) Fade to Black Group  20) MLE Memory Group
7) Custom Control Group  14) Mnemonic Displays
Synergy 2 Control Panel

The Synergy 2 control panel has 2 MLEs and 16 inputs standard. This is the same control panel that is used with the Synergy 1.5 Q/MD Live Production Engine.

Synergy 2 Control Panel — Sectional View

1) System Control Group  8) Aux (Auxiliary) Bus Group  15) MLE Transition Group
2) Global Memory System Group  9) Program/Preset Transition Group  16) MLE Key 1 Group
3) Pattern Control Group  10) Downstream Keyers  17) MLE Key 2 Group
4) Program/Preset Bus  11) Positioner Group  18) Matte Control Group
5) Preview Bus Group  12) Preview Overlay Group  19) Effects Control Group
6) MLE (Multi-Level Effects)  13) Fade to Black Group  20) – not available on the S2 –
7) Custom Control Group  14) Mnemonic Displays
The following are more detailed descriptions of each of the control panel section, as itemized in the illustrations above. Remember that the sections are numbered in an identical manner from control panel to control panel.

1. **System Control Group**
   Each switcher includes a System Control Group that is identical on all Synergy Q/MD/X switchers. At the center of the group is the System Control Display, the large LCD screen, that provides a variety of menus for system setup and operational functions. The display changes automatically, depending on the functions that you select on the control panel, or it can be navigated manually. Refer to the section “Using the Menu System” on page 3–1 for more information on using the System Control Group.

2. **Global Memory System Group**
   The Global Memory System Group is used to store and recall switcher memory registers, including all MLEs on the panel. A memory register is a “snapshot” of the switcher settings, and an MLE (or multiple MLEs). The group includes a USB port, a status display, and buttons for remote control. A variety of advanced remote control options allow you to store and recall VTR, Video Server, and Audio Server “clips” using the VTR CLIP button.

   The layout of the Global Memory System Group is almost identical on the Synergy 2, 3 and 4 control panels, with minor exceptions due to the differing number of MLE store...
and recall buttons. Due to the size of the control panel, the location of the group is different on the Synergy 1, but the same functionality exists.

3. Pattern Control Group

The Pattern Control Group is an assignable group of controls that allows you to choose wipe patterns and adjust various parameters of the selected pattern. On the Synergy 2, 3 and 4 control panels, you can press the desired MLE button in the group (or press the WIPE button within an MLE itself), to assign the Pattern Control Group to that MLE.

The group also includes a DVE button that allows you to access DVE effects from your primary DVE using the pattern buttons. The DVE Send and Remote Control Option must be installed.

Refer to the section “Pattern Control Group” on page 6–2 for more information on working with the Pattern Control Group.

4. Program/Preset Bus

The Program/Preset Bus (also referred to as the Background Preset Bus on the Synergy 1) is composed of two rows of crosspoint buttons (one button per video input source) that represent your primary switcher output selection area. On the half MLE switchers (Synergy 1.5, 2.5 and 3.5) this bus is limited to the half MLE functionality.

- **PGM/BKGD** — The crosspoint selected on the PGM (Program) or BKGD (background) bus is the video source currently on air.
- **PST** — The crosspoint selected on the PST (Preset) bus is the source that you are transitioning to — using a cut, dissolve, or wipe transition.

To the right of the bus there are a series of LEDs that show you the status of that bus as follows:

- **ON AIR** — For tally information, ON AIR LEDs (one per bus) light red to indicate when a crosspoint selected on that bus is used as part of the output video.
- **N/S** — For bus status, N/S LEDs (one per bus) light to indicate when a non-synchronous source has been selected on the bus.

On the Synergy 2, 3 and 4 control panels, there are several buttons to the right of the bus. These re-entry buttons allow you to add (or combine) the contents of an entire upstream MLE to the output video content. The number of re-entry buttons depends on the switcher model.

5. Preview Bus Group – (Not available on the Synergy 1)

The Preview Bus Group selects the signal that is displayed on the main preview output of the system. With a preview monitor connected, you can view the program and preset outputs individually. The layout of the group varies based on the differing numbers of MLEs for the switcher models.

6. MLE (Multi-Level Effects) – (Not available on the Synergy 1)

An MLE can be thought of as an individual video layer that can be combined with other images, Keys, and MLEs to form the composite switcher output. Each MLE is composed of three rows of crosspoints (one per video or Key input source).
• At the top, the **Key Bus** (labeled **KEY**) is used to select Key sources that can be Keyed (electronically cut) into the background image of the MLE. The **Key Bus** is *shared* between the two Keyers (Key 1 and 2) of the MLE. Two LEDs at the top right edge of the bus indicate which Keyer the bus is currently assigned to.

• The **Background Bus** (labeled **BKGD**) selects the source that comprises the background video of the MLE. The background is the video that is visually behind all other images (or farthest upstream, electronically).

• The **Preset Bus** (labeled **PST**) selects the source on the MLE that you are transitioning to. The transition can be a Cut, Dissolve, Wipe, or DVE transition.

To the right of the bus there are a series of indicators and buttons that show you the status of that bus as follows:

• **Re-entry** — The Re-entry buttons allow you to add (or combine) the contents of an entire upstream or downstream MLE to the output video content of an MLE. The number of re-entry buttons depends on the model.

• **ON AIR** — For tally information, **ON AIR** LEDs (one per bus) light red to indicate when a crosspoint selected on that bus is used as part of the output video.

• **N/S** — For bus status, **N/S** LEDs (one per bus) light yellow to indicate when a non-synchronous source has been selected on the bus.

### 7. Custom Control Group

The **Custom Control Group** features an array of buttons that can be programmed to perform specific functions such as peripheral device control, switcher memory recalls, or switcher macros.

**Note**

A **Macro** is a series of button presses that can be played back, in succession, at the touch of a single **Custom Control** button.

The **Synergy 1** has a group of **24** custom control buttons, while the **Synergy 2, 3**, and **4** have **17**, **30**, and **35** buttons, respectively, situated above the **Program/Preset Bus**.

### 8. Aux (Auxiliary) Bus Group

The **Aux Bus Group** on the **Synergy 2, 3**, and **4** is comprised of two distinct areas.

• The **Aux Bus** itself is a row of crosspoint buttons that is identical to those on the **Program/Preset** and **MLE** buses. All sources are present, except for re-entry crosspoints. Because each Synergy Q/MD/X switcher includes **32** Aux Buses as standard, this row is *shared* between all outputs. In terms of functionality, the bus is used to select the sources that are routed to specific external destinations, such as DVE inputs, still stores, tape machines, technical areas, etc.

• The **Aux Bus Assign Group** is an array of **12** buttons that determines the output to which the Aux Bus row itself is assigned. For example, if **BANK 1** and **ASSIGN 1** are lit, selecting a video source on the Aux Bus routes that video to the **Aux 1 on Bank 1** output. If **BANK 2** and **ASSIGN 6** are selected, the video source will be routed to the **Aux 6 on Bank 2** output.

The **Aux Bus/Key Bus Group** on the **Synergy 1** serves a dual roll in being both the **Aux Bus** and the **Key Bus**.

• By pressing **BANK 1** and **AUX 1** or **BANK 1** and **AUX 2**, Aux Bus functionality is activated and the **Aux Bus Menu** appears on the display in the **System Control Group**. The bus row is now dedicated to assigning video sources to the selected Aux Bus. On the bus itself, all crosspoints are identical to those on the **Background**
and Preset buses. Because the switcher includes 32 Aux Buses, this row is shared between all outputs. Outputs BANK 1 AUX 1 and BANK 1 AUX 2 can be assigned and selected directly on the bus row, while outputs BANK 1 AUX 3 through BANK 4 AUX 8 must be selected on the menu, but they can be assigned on the bus row.

• By pressing KEY 1 or KEY 2, Key bus functionality is activated. The bus row is now dedicated to selecting Key sources that can be Keyed (electronically cut) into the background. The Key Bus is shared between the two Keyers (Key 1 and 2). The corresponding button (KEY 1 or KEY 2) lights when any button in either the Key 1 group or Key 2 Group is pressed.

The layout of the Aux Bus row is slightly different on each switcher, based on the differing numbers of crosspoints and the specific model of control panel.

9. Program/Preset Transition Group

The Program/Preset Transition Group on the Synergy 2, 3, and 4 control panels, and the Background/Preset Transition Group on the Synergy 1 control panel, allow you to select the type of transition, as well as what you want to transition.

• Next Transition Buttons — The Next Transition buttons allow you to select what you want to take on or off-air during the next transition. You can transition almost any combination of Keys and Background at the same time.
  ~ DSK1 (KEY1) — Toggle this button On, to have DSK 1 (this is KEY1 on a Synergy 1 Q/MD) transitioned on-air or off-air with the next transition. If DSK 1 is on-air, it will be transitioned off-air.
  ~ DSK2 (KEY2) — Toggle this button On, to have DSK 2 (this is KEY2 on a Synergy 1 Q/MD) transitioned on-air or off-air with the next transition. If DSK 2 is on-air, it will be transitioned off-air.
  ~ BKGD — Toggle this button On, to have a transition performed between the Program and Preset buses (these are the Background and Preset buses on a Synergy 1 Q/MD).

• Transition Type Buttons — The Transition Type buttons allow you to select the type of transition you want to perform during the next transition. Refer to the section “Transition Group” on page 5–2 for more information on transition types. You can select between the following:

  ~ DISS — Select this transition type to have a Dissolve performed during the next transition.
  ~ WIPE — Select this transition type to have a Wipe performed during the next transition.
  ~ DVE SEND — Select this transition type to have a DVE effect performed during the next transition. The DVE effect is performed on the Squeeze & Tease MD, internal DVE.

  Note
  If you have a half MLE switcher (Synergy 1.5, 2.5 or 3.5), you will be limited to cuts and dissolves for transition types in this MLE.

  ~ DVE SEND — Select this transition type to have a DVE effect performed during the next transition. The DVE effect is performed on the Squeeze & Tease MD, internal DVE.

Note
External DVE Send support is not yet implemented.
10. Downstream Keyers

The Synergy 2, 3, and 4 control panels include two Downstream Keyers (DSKs) that allow you to Key over output video immediately before the final video output from the switcher.

**Note** The MultiDSK option must be installed in order to perform a Downstream Key on a Synergy 1 Q/MD. MultiDSK only supports Self Keys and Auto Select (Linear) Keys.

The Downstream Keyer Groups on the Synergy 2, 3 and 4 control panels include the following controls or functionality:

- Independent CUT and AUTO TRANS buttons.
- An array of eight crosspoints allows you to quickly select any type of Key source. Choose from Self Key, Auto Select (Linear) Key, Chroma Key, and PST Pattern Key. Crosspoints can be pre-programmed or changed on-the-fly during production.

**Note** If you have a half MLE (Synergy 1.5, 2.5 or 3.5) you will only be able to select the Self Key or Auto Select (Linear) Key as a Key type in this group.

- ON AIR and N/S LEDs.
- An array of DSK modification buttons.

The layout of the Downstream Keyers is identical on the Synergy 3 and 4 panels, while on the Synergy 2, the two DSKs are combined for compactness.

On the Synergy 1, the DSK Group consists of the two DSK Transition buttons, which are reserved for future expansion.

11. Positioner Group

The Positioner Group is an assignable group of controls that allows you to position wipe patterns on screen. By pressing the desired MLE button in the group (or by pressing the WIPE button within an MLE itself), the Positioner Group is assigned to that MLE.

The layout of the Positioner Group is almost identical on all switchers, with minor exceptions due to the differing number of MLE buttons.

12. Preview Overlay Group – (Not available on the Synergy 1)

The Preview Overlay Group allows you to control specific overlay information that appears on the preview monitor, such as VTR time code, a count up/down timer, source ID, and safe title. Displays are individually selectable on the preview monitor for quick reference.

On the Synergy 3 and 4 control panels, the layout and location of the group is identical. On the Synergy 2 control panel, the group is located within the Global Memory System Group. There is no Preview Overlay Group on the Synergy 1. However, the Preview Overlay function is available through the Main Menu.

13. Fade to Black Group

On the Synergy 2, 3, and 4 control panels, the Fade to Black Group allows you to fade or cut the output of the switcher to black. This happens downstream of the DSKs 1 and
2. The display in the group indicates the current fade-to-black transition rate (in frames). On the Synergy 1 control panel there is a single button that allows you to fade to black.

On the Synergy 3 and 4 control panels, the layout and location of the group is identical. On the Synergy 2 control panel, the group is located above Key 2 Group of MLE 1. On the Synergy 1 control panel, the Fade to Black Group is located just above the DSK Group.

Note

If you have the SmartConversion™ Cross Converter option installed you can set up the display in the Fade to Black Group to show the number of free converters. This will be displayed as “###” where the # indicates the number of converters that are free.

14. Mnemonic Displays – (Not available on the Synergy 1)

The optional Mnemonic Display Groups are used to show the names of crosspoint inputs and Custom Control buttons and banks. A variety of colors and font sizes are available and individual displays can be further customized to suit specific requirements.

Names of inputs can have the shifted and non-shifted labels displayed. For details on setting up your mnemonic displays, refer to Chapter 12, “Completing Setup” of the Synergy Q/MD or Q/MD-X Engineering Manual.

Note

Each mnemonic display is located directly above the button it is describing.

15. MLE Transition Group – (Not available on the Synergy 1)

The MLE Transition Group on the Synergy 2, 3, and 4 control panels allow you to select the type of transition, as well as what you want to transition.

Operating Tip

The video output of an MLE, other than the Program/Preset MLE, will not be part of the main PGM output of the switcher unless it is re-entered into the Program/Preset MLE.

- **Next Transition Buttons** — The Next Transition buttons allow you to select what you want to have as the video output of the MLE. You can transition almost any combination of Keys and Background at the same time.
  - ~KEY1 — Toggle this button On, to have Key 1 transitioned on-air or off-air with the next transition. If Key 1 is on-air, it will be transitioned off-air.
  - ~KEY2 — Toggle this button On, to have Key 2 transitioned on-air or off-air with the next transition. If Key 2 is on-air, it will be transitioned off-air.
  - ~BKGD — Toggle this button On, to have a transition performed between the Background and Preset buses.

- **Transition Type Buttons** — The Transition Type buttons allow you to select the type of transition you want to perform during the next transition. Refer to the section “Transition Group” on page 5–2 for more information on transition types. You can select between the following:
  - ~DISS — Select this transition type to have a Dissolve performed during the next transition.
  - ~WIPE — Select this transition type to have a Wipe performed during the next transition.
DVE SEND — Select this transition type to have a DVE effect performed during the next transition. The DVE effect is performed on the Squeeze & Tease MD internal DVE.

Note

External DVE Send support is not supported.

Transitions can be performed manually with the Fader or automatically with the AUTO TRANS button. A display above the Fader or in the MLE Memory System Group indicates the current auto transition rate (in frames).

The layout of the MLE Transition Group is identical on the Synergy 2, 3, and 4 control panels.

16. MLE Key 1 Group

The MLE Key 1 Group allows you to select the Key type and associated parameters for Key 1 of an MLE. Choose between Self Key, Auto Select (Linear) Key, UltraChrome™ Advanced Chroma Key, and PST Pattern Key. Within the group, you can also select a variety of parameters and Key transitions. When any button is selected in the group, the Key Bus for that MLE is assigned to Keyer 1. An ON LED is provided for tally information.

Note

Only one UltraChrom Advanced Chroma Keyer is available per MLE. UltraChrom can be assigned to either Key 1 or Key 2 by selecting CHROMA KEY in the MLE Key Group.

Key 1 appears downstream (visually in front) of the background buses, but upstream (visually in back) of Key 2. The KEY OVER button allows you to change that priority.

The layout of the MLE Key 1 Group is identical on all switchers. On the Synergy 3 and 4 control panels, the location of the group is identical, to the right of the Fader. On the Synergy 2 control panel, the group is located to the left of the Fader. On the Synergy 1, the MLE Key 1 Group is located to the right of the Global Memory System Group.

17. MLE Key 2 Group

The MLE Key 2 Group allows you to select the Key type and associated parameters for Key 2 of an MLE. Choose between Self Key, Auto Select (Linear) Key, UltraChrome™ Advanced Chroma Key, and PST Pattern Key. Within the group, you can also select a variety of parameters and Key transitions. When any button is selected in the group, the Key Bus for that MLE is assigned to Keyer 2. An ON LED is provided for tally information.

Key 2 is downstream (visually in front) of the background buses of the MLE and downstream of Key 1.

The CHAR GEN button allows you pick your favorite CG for immediate Keying.

The layout of the MLE Key 2 Group is identical on all switchers. On the Synergy 3 and 4 control panels, the location of the group is identical, to the right of the Fader. On the Synergy 2 control panel, the group is located to the left of the Fader. On the Synergy 1, the MLE Key 2 Group is located to the left of the Mattes Group.
18. Matte Control Group

The Matte Control Group is an assignable module that allows you to adjust matte, border, and wash generator colors in the selected MLE. By pressing the desired MLE button in the group (or by pressing any matte-related button within an MLE itself), the Matte Control Group is assigned to that MLE.

Although functionality is identical, the location and layout of the Matte Control Group differs for all four control panels due to the number of MLE assignment buttons.

19. Effects Control Group

The Effects Control Group is an assignable module that provides an array of controls that handle all of the frequently used analog-type parameters, such as mask adjustment, border width, and Key clip.

By pressing the desired MLE (or downstream) Keyer button in the group (or by pressing any button within an MLE that has associated adjustable parameters), the Effects Control Group is assigned to that MLE.

The location of the Effects Control Group is virtually identical on all control panels, located just above the Positioner Group. The layout of the group differs due to the number of MLE Keyer assignment buttons and the lack of mask control knobs on the Synergy 1 control panel.

20. MLE Memory Group – (Not available on the Synergy 1 or 2)

On the Synergy 3 and 4 control panels, the MLE Memory System Group allows you to store and recall memory registers within each MLE itself. On the Synergy 1 and 2 control panels, the Global Memory System Group has to be used to store memory registers. Unlike the Global Memory System Group, the MLE Memory System Group applies only to that individual MLE and not to the entire control panel.

In addition to memory register functions, you can also assign MLE transition rates and Key transition rates. A status display above the keypad in the Global Memory System Group can display the current auto transition rate (in frames), Key transition rate (for both Keyer 1 and 2), and current memory register. The location of the group is offset on different MLEs for operational convenience.
Video Flow Through the Switcher

The following diagrams illustrate how video flows through each Synergy Q/MD/X switcher. These drawings illustrate visual and electronic concepts of upstream and downstream for each switcher, and are designed to help you visualize and understand the architecture, *from a production standpoint*, of each switcher.

**Synergy 3.5 and 4 Q/MD-X Video Flow**

The simplified block diagram below illustrates the flow of video through the Synergy 3.5 and 4 Q/MD-X switchers.

The Synergy 3.5 and 4 Q/MD-X are *three and a half* and *four* MLE switchers, respectively, with 16 inputs standard. Video flows *into* each MLE as indicated above, where crosspoints can be selected for effects creation. The following features are standard on all Synergy 3.5 and 4 Q/MD-X switchers:

- **MLE 1, 2, 3 or 4** can be selected *independently* as the switcher output. In this condition, with no re-entry crosspoints selected for any MLE, each MLE obeys the standard rules for the upstream and downstream placement of images.

- **Within MLE 1, 2, and 3, by themselves**, the **Background** and **Preset** buses are the farthest upstream, **Key 1** appears midstream, and **Key 2** appears downstream.

  - Visually, all images on the Background buses appear *behind* both Keyers.
~ In the default state, a Key enabled on **Key 1** appears visually *over* the two Background buses (and all transitions), but visually *under* **Key 2**.

~ In the default state, a Key enabled on **Key 2** appears visually *over* the Background buses and **Key 1**.

~ If the **KEY OVER** button is pressed in **Key 1**, the priority is changed and **Key 1** appears visually *over* **Key 2**.

• Within **MLE 4** itself, the **Program** and **Preset** buses are the farthest upstream, **DSK 1** appears midstream, and **DSK 2** appears downstream.

~ Visually, all images on the program bus appear *behind* both DSKs.

~ A Key enabled on **DSK 1** appears visually *over* the **Program** bus (and all transitions), but visually *under** **DSK 2**. A Key enabled on **DSK 2** appears visually *over* the program bus and **DSK 1**.

~ The **Fade to Black** module is electronically downstream of the entire switcher. Regardless of the MLE selected on air, **Fade to Black** will visually take any switcher MLE to black.

• When **MLE 1** is re-entered *downstream* into **MLE 2, 3 or 4**, the following rules for the placement upstream and downstream images apply:

  | Note | These rules will apply to all MLEs that are re-entered into an MLE that is downstream. For example, **MLE 2** into **3 or 4**, or **MLE 3 into 4**. |

  ~ All images on **MLE 1** (including backgrounds and Keys) appear visually *behind** **MLE 2, 3 and 4**.

  ~ All images on **MLE 2** (including backgrounds and Keys) appear visually *over** **MLE 1, but under** **MLE 3 and 4**.

  ~ All images on **MLE 3** (including backgrounds and Keys) appear visually *over** **MLE 1 and 2, but under** **MLE 4**.

  ~ All images on **MLE 4** (including backgrounds and DSKs) appear visually *over** **MLE 1, 2 and 3**.

• When **MLE 2** is re-entered *upstream* into **MLE 1**, as shown in dotted lines on the illustration above, the following rules for the placement upstream and downstream images are slightly changed, as follows:

  | Note | These rules will apply to all MLEs that are re-entered into an MLE that is upstream. For example, **MLE 3** into **1 or 2**. |

  ~ All images on the re-entered MLE appear visually *under* the two (upstream) Keyers of the destination MLE, regardless of the bus on which the MLE is re-entered. The re-entered MLE moves upstream, or visually behind all downstream MLEs (except itself).
Synergy 2.5 and 3 Q/MD/X Video Flow

The simplified block diagram below illustrates the flow of video through the Synergy 2.5 and 3 Q/MD/X switchers.

The **Synergy 2.5 and 3 Q/MD/X** are two and a half and three MLE switchers, respectively, with 16 inputs standard. Video flows into each MLE as indicated above, where crosspoints can be selected for effects creation. The following features are standard on all **Synergy 2.5 and 3 Q/MD/X** switchers:

- **MLE 1, 2 or 3** can be selected independently as the switcher output. In this condition, with no re-entry crosspoints selected for any MLE, each MLE obeys the standard rules for the upstream and downstream placement of images.

- **Within MLE 1 and MLE 2**, by themselves, the **Background** and **Preset** buses are the farthest upstream, **Key 1** appears midstream, and **Key 2** appears downstream.
  - Visually, all images on the Background buses appear behind both Keyers.
  - In the default state, a Key enabled on **Key 1** appears visually over the two Background buses (and all transitions), but visually under **Key 2**.
  - In the default state, a Key enabled on **Key 2** appears visually over the Background buses and **Key 1**.
  - If the **KEY OVER** button is pressed in **Key 1**, the priority is changed and **Key 1** appears visually over **Key 2**.

- **Within MLE 3** itself, the **Program** and **Preset** buses are the farthest upstream, **DSK 1** appears mid stream, and **DSK 2** appears downstream.
  - Visually, all images on the background buses appear behind both DSKs.
  - A Key enabled on **DSK 1** appears visually over the Background buses (and all transitions), but visually under **DSK 2**. A Key enabled on **DSK 2** appears visually over the Background buses and **DSK 1**.
The **Fade to Black** module is electronically downstream of the entire switcher. Regardless of the MLE selected on air, **Fade to Black** will visually take any switcher MLE to black.

- When **MLE 1** is re-entered downstream into **MLE 2** or **MLE 3** the following rules for the placement of upstream and downstream images apply.

**Note**

These rules will apply to all MLEs that are re-entered into an MLE that is downstream. For example, **MLE 2 into 3**.

- All images on **MLE 1** (including backgrounds and Keys) appear visually **behind** **MLE 2** and **MLE 3**.
- All images on **MLE 2** (including backgrounds and Keys) appear visually **over** **MLE 1** but **under** **MLE 3**.
- All images on **MLE 3** (including backgrounds and DSKs) appear visually **over** **MLE 1** and **MLE 2**.

- When **MLE 2** is re-entered upstream into **MLE 1**, as shown in dotted lines on the illustration above, the rules for the placement upstream and downstream images are slightly changed, as follows:

  - All images on the re-entered MLE appear visually **under** the two destination (upstream) Keyers, regardless of the bus on which the MLE is re-entered. The re-entered MLE moves upstream, or visually behind all downstream MLEs (except itself).

**Synergy 1.5 and 2 Q/MD/X Video Flow**

The simplified block diagram below illustrates the flow of video through the **Synergy 1.5 and 2 Q/MD/X** switchers.
The Synergy 1.5 and 2 Q/MD/X switchers are one and a half and two MLE switchers, respectively, with 16 inputs standard. Video flows into each MLE as indicated above, where crosspoints can be selected for effects creation. The following features are standard on all Synergy 1.5 and 2 Q/MD/X switchers:

- MLE 1 or 2 can be selected independently as the switcher output. In this condition, with no re-entry crosspoints selected, each MLE obeys the standard rules for the upstream and downstream placement of images.

- Within MLE 1, by itself, the Background and Preset buses are the farthest upstream, Key 1 appears midstream, and Key 2 appears downstream.
  ~ Visually, all images on the Background buses appear behind both Keyers.
  ~ In the default state, a Key enabled on Key 1 appears visually over the two Background buses (and all transitions), but visually under Key 2.
  ~ In the default state, a Key enabled on Key 2 appears visually over the Background buses and Key 1.
  ~ If the KEY OVER button is pressed in Key 1, the priority is changed and Key 1 appears visually over Key 2.

- Within MLE 2 itself, the Program and Preset buses are the farthest upstream, DSK 1 appears midstream, and DSK 2 appears downstream.
  ~ Visually, all images on the Background buses appear behind both DSKs.
  ~ A Key enabled on DSK 1 appears visually over the Background buses (and all transitions), but visually under DSK 2. A Key enabled on DSK 2 appears visually over the background buses and DSK 1.
  ~ The Fade to Black module is electronically downstream of the entire switcher. Regardless of the MLE selected on air, Fade to Black will visually take any switcher MLE to black.

- When MLE 1 is re-entered downstream into MLE 2, the following rule for the placement of upstream and downstream images apply:
  ~ All images on MLE 1 (including backgrounds and Keys) appear visually behind MLE 2.
  ~ All images on MLE 2 (including backgrounds and Keys) appear over MLE 1.
Synergy 1 Q/MD Video Flow

The simplified block diagram below illustrates the flow of video through the Synergy 1 Q/MD switcher.

The Synergy 1 Q/MD switcher is a single MLE switcher with 16 inputs. Video flows into the MLE as indicated above, where crosspoints can be selected for effects creation. The following features are standard on the Synergy 1 Q/MD switcher:

- The Background and Preset buses are the farthest upstream, Key 1 appears midstream, and Key 2 appears downstream.
  - Visually, all images on the Background bus appear behind both Keyers.
  - In the default state, a Key enabled on Key 1 appears visually over the Background bus (and all transitions), but visually under Key 2.
  - In the default state, a Key enabled on Key 2 appears visually over the Background bus and Key 1.
  - If the KEY OVER button is pressed in Key 1, the priority is changed and Key 1 appears visually over Key 2.
  - The Fade to Black module is electronically downstream of the entire switcher. Regardless of the combination of Keys selected, Fade to Black will visually take the entire switcher to black.
Using a Keyboard

The Synergy Q/MD/X switchers can accommodate a standard PS/2 Keyboard that connects to the rear of the Control Panel. This keyboard allows you to emulate several system control buttons, as well as allow you to enter, or change, names.

Important

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

Using the Keyboard in System Control Menus

The keyboard can be used in place of the panel keys and knobs to navigate through the menus and select values.

The following table illustrates the functions of the keys on the keyboard as they relate to the control panel buttons:

<table>
<thead>
<tr>
<th>Keyboard</th>
<th>Panel Key</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1 – F6</td>
<td>F1 – F6</td>
<td>Performs whatever the softkey function is above the panel key.</td>
</tr>
<tr>
<td>SysRq &amp; Break</td>
<td>HOME</td>
<td>Returns to the Main Menu 1-2 from whatever menu is currently displayed.</td>
</tr>
<tr>
<td>Esc</td>
<td>UP ONE</td>
<td>Back one menu.</td>
</tr>
<tr>
<td>Tab</td>
<td>MORE</td>
<td>Next screen in selected menu.</td>
</tr>
<tr>
<td>Insert &amp; Delete</td>
<td>Top Knob (1)</td>
<td>Small incremental movement of knob.</td>
</tr>
<tr>
<td>Home &amp; End</td>
<td>Middle Knob (2)</td>
<td>Small incremental movement of knob.</td>
</tr>
<tr>
<td>Page Up &amp; Page Down</td>
<td>Bottom Knob (3)</td>
<td>Small incremental movement of knob.</td>
</tr>
</tbody>
</table>
Using the Keyboard in Change Name Menus

The keyboard allows you to type alphanumeric characters in the various Change Name menus of the switcher.

The following table illustrates the function of the keys on the keyboard as they relate to the control panel buttons in the change name menus. This table is provided as an example only, the corresponding function of the keyboard buttons will vary, depending on the menu you are accessing.

<table>
<thead>
<tr>
<th>Change Name Menus</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyboard</strong></td>
</tr>
<tr>
<td><strong>Alphanumeric Keys</strong></td>
</tr>
<tr>
<td>Alphanumeric keys</td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td></td>
</tr>
<tr>
<td><strong>Function Keys</strong></td>
</tr>
<tr>
<td>F1 &amp; Space Bar</td>
</tr>
<tr>
<td>F2 &amp; \leftarrow</td>
</tr>
<tr>
<td>F3 &amp; \rightarrow</td>
</tr>
<tr>
<td>F4</td>
</tr>
<tr>
<td>F5</td>
</tr>
<tr>
<td>F6 &amp; Enter</td>
</tr>
<tr>
<td><strong>Direction Keys</strong></td>
</tr>
<tr>
<td>Insert &amp; Delete</td>
</tr>
<tr>
<td>Home &amp; End</td>
</tr>
<tr>
<td>\uparrow \downarrow</td>
</tr>
<tr>
<td>Backspace</td>
</tr>
</tbody>
</table>
Switcher Color Scheme

Depending on the control panel option you have, your Synergy control panel may come with a specific color scheme to identify each MLE, and specific MLE selection buttons within the various control panel sections. If you purchased the All White Buttons option for your Synergy control panel, there will be no color identification for the buttons.

For example, on the Synergy 4 control panel, with the Classic Color Buttons option, MLE 2 is completely colored with yellow push buttons. In all control panel sections that include an array of MLE selection buttons (for example, Global Memory System Group, Positioner Group, and DVE Send Group), the MLE 2 button is also colored yellow for clarity, as shown below:

Note

The Synergy 1 control panel has an Aux/Key bus that is yellow.
Resetting the Switcher

If required, the Synergy switcher can be reset manually from the control panel. There are two types of resets:

- A **Full Restart** affects hardware and software simultaneously.
- A **Software Reset** affects software only.
- A **Global-Store Restart** affects the Global-Store and video processor only.

**Full Restart**

This function performs both a hardware and a software reset simultaneously. Switcher memory registers, personality registers, installation registers, and custom control registers are not affected by the reset, but all other switcher parameters (for example, the current state of the panel) are reset. **BLACK** will be selected on all buses.

**Important**

Do not turn the switcher frame power off until you have completed the proper shutdown procedure or you may damage the hard disk. Refer to the section “**Shutting Down the Synergy Switcher**” on page 2-27 for this procedure.

Use the following procedure to perform a full reset of the switcher:

1. Navigate to the **System Shutdown Menu** as follows:
   - Press HOME ✳ MORE✳ System Shutdown.

2. Press Restart.

   The system will prompt you to confirm the restart. Once confirmed, the frame will power down and boot up again.

**Global-Store Restart**

This function resets the Global-Store and video processor. Use this procedure if you are experiencing difficulties with the preview overlay, Global-Store, or as directed by Ross Video Technical Support.

Use the following procedure to perform a Global-Store restart:

1. Navigate to the **System Shutdown Menu** as follows:
   - Press HOME ✳ MORE✳ System Shutdown.
2. Press **Restart Global-Store**.

   The system will prompt you to confirm the restart. Once confirmed, the restart will occur and the switcher will not pass video for a few seconds while the restart takes place.

This completes the procedure for performing a Global-Store restart.

### Updating Panel Data

This function synchronizes the control panel and frame. Use this function after a communication loss between the control panel and frame if your switcher does not appear to recover once communication is restored or as directed by Ross Video Technical Support.

Use the following procedure to update panel data:

1. Navigate to the **System Shutdown Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **System Shutdown**.

2. Press **Update Panel Data**.

   The system will prompt you to confirm the update. Once confirmed, the switcher control panel and frame will synchronize. will occur and the switcher will not pass video for a few seconds while the restart takes place.

This completes the procedure for updating panel data.

### Software Reset

The software reset function can be performed from either the **Global Memory System Group** or any individual **MLE** on the control panel. Both methods are described below.

**Resetting the Switcher from the Global Memory Group**

From the **Global Memory System Group** you can reset either all the MLEs on the system, or each MLE individually.
Use the figure below for reference:

![Global Memory System Diagram]

Use one of the following method to reset a Synergy 2, 3 or 4 control panel from the Global Memory System Group:

- To perform a full reset on all control panels, simultaneously press **ALL** in the **RECALL** column and **ALL** in the **STORE** column.
- To reset MLE 1 on all control panels, simultaneously press **MLE 1** in the **RECALL** column and **MLE 1** in the **STORE** column.
- To reset MLE 2 on all control panels, simultaneously press **MLE 2** in the **RECALL** column and **MLE 2** in the **STORE** column.
- To reset MLE 3 on Synergy 3 and Synergy 4 control panels, simultaneously press **MLE 3** in the **RECALL** column and **MLE 3** in the **STORE** column.
- To reset MLE 4 on Synergy 4 control panels, simultaneously press **MLE 4** in the **RECALL** column and **MLE 4** in the **STORE** column.

Use the following method to reset a Synergy 1 control panel from the Global Memory System Group:

- To perform a full reset on the control panel, simultaneously press the **STORE** and **RECALL** buttons in the Global Memory System Group.
**Resetting the Switcher from an Individual MLE**

From each individual MLE Memory System Group you can reset the MLE individually. Use the figure below for reference:

![Synergy 4 Q/MD-X Individual MLE Reset Function](image)

**Important**

This feature is only available on Synergy 3 and 4 control panels. The Synergy 2 and 1 control panels do not have an MLE Memory System Groups.

~ To reset MLE 1, in the MLE 1 Memory System Group, simultaneously press STORE and RECALL.

~ To reset MLE 2, in the MLE 2 Memory System Group, simultaneously press STORE and RECALL.

~ To reset MLE 3 the MLE 1 Memory System Group, simultaneously press STORE and RECALL.

**Note**

On Synergy 3 and 4 control panels, the PGM/PST MLE can only be reset using the Global Memory System Group.
Shutting Down the Synergy Switcher

This function powers off the switcher, placing the CPU Board into a hibernation mode. In this mode it is safe to turn off all your power supplies and remove the CPU Board.

**Important**

Do not turn the switcher frame power off until you have completed this shutdown procedure or you may damage the hard disk.

Use the following procedure to shut down the Synergy switcher:

1. Navigate to the **System Shutdown Menu** as follows:
   - Press HOME ➔ MORE ➔ **System Shutdown**.

   ![System Shutdown Menu]

2. Press **Shut Down**.

**Caution**

Even though the switcher has been shut down, the power supplies are still active until they are physically switched off.

The system will prompt you to confirm the shutdown. Once confirmed, the frame will power down.

This completes the procedure for shutting down the Synergy switcher.

Powering Off the Synergy Switcher

Once your switcher has been shut down, it is safe to turn the power off.

Use the following procedure to power off your Synergy switcher:

1. Look for the flashing status indicators on the front of the Synergy frame next to the embossed Ross Video logo. If the indicators are not flashing between green and amber, do not continue with this procedure. Refer to the section “Shutting Down the Synergy Switcher” on page 2–27 for information on shutting down your switcher.

2. Remove the switcher frame door. Refer to the **Synergy Q/MD or Q/MD-X Engineering Manual** for information on removing or opening the frame door.

3. Turn off the **Primary** and (if installed) the **Redundant** power switches. Synergy Q/MD-X frames have a single power switch on the fan-chassis on the left side of the frame.

   Control panel power switches are located inside the control panel tub, on the right-hand side. Open the panel tub and turn off the **Primary** and (if installed) the **Redundant**
power switches. *(For Synergy 1 Control Panels Only)* Control panel power switches are located on the rear of the control panel, one on either side.

This completes the procedure for powering off your switcher.

**Reinstalling the Frame Door**

You should never operate your switcher with the frame door removed. Ensure that you reinstall your frame door before using your switcher.

Refer to the following diagram for reference and use the following procedure to reinstall the frame door:

1. With both hands, grasp the sides of the frame door, and, ensuring that the door retainer is under the frame top, hook the grooved bottom edge over the pivoting tongue on the bottom front ledge of the frame.
2. When you are satisfied that the door is resting properly, *firmly* press the top of the door until the latch pops into place and is secure.

3. Check your work.

This completes the procedure for reinstalling the frame door.
Switcher Timeout

If no control panel buttons are touched and no fader arms are moved for a period of 30 minutes, the switcher goes into a “sleep” mode, and all lights are automatically turned off. This function is specifically designed to extend the life of the display and the button lamps.

**Operating Tip**

The factory default timeout interval is 30 minutes, but can be changed. Refer to Chapter 14, “Completing Setup” in the *Synergy Q/MD* or *Q/MD-X Engineering Manual* for more information.

If this timeout occurs, press any button or move any fader (or joystick) to “wake” the switcher and turn on all lights.

**Note**

The switcher does *not* act on a button push when it is coming out of “sleep” mode.

The factory default timeout interval is 30 minutes.
Using the Menu System

In This Chapter

This chapter provides an introduction to the menu system of the Synergy Q/MD/X switcher. The following topics are discussed in this chapter:

- About the System Control Display
- Menu System Basics
- Using the Keyboard in System Control Menus
- Positioner Icons
- Adjusting the Display
- Help Features
- Installed Options
- Screen Capture
About the System Control Display

Each Synergy Q/MD/X control panel includes a **System Control Group** in its top panel.

This group is similar on all Synergy switchers. At the center of the group is the **System Control Display**, a bright LCD screen that provides a variety of menus for various system setup and operational functions. All these menus are interconnected in various branches of the system menu tree.

There are two ways that the display can change:

- The display changes *automatically*, depending on certain functions that you select on the panel. In this way, additional parameters are instantly available to you, as soon as you press a control panel button.
- You can also navigate the menu tree *manually* to reach the desired menu — simply by following the desired path through the menu tree.

The following sections provide details on all buttons and functions in the **System Control Group**.
Menu System Basics

The figure below illustrates the **System Control Group**. This group is *identical* on all Synergy control panels — in both appearance and function. At the center of the group is the **System Control Display**, a bright LCD screen that provides a variety of clear menus for various system setup and operational functions.

![System Control Group](image)

**1. Menu Name**

Each menu is named in the upper left corner. If numbers in parentheses appear after the name, for example **Main Menu (1-2)**, it indicates that the current menu is number *one of two* — and that there are more functions available than can be displayed at one time.

On the **Main Menu** (accessible by pressing **HOME**), note that the software version is displayed below the menu name.

When parentheses are shown, the **MORE** button lights. Press **MORE** to display the second menu in the series. If the numbers **2-2** appear, it indicates that the current menu is number *two of two*. Press **MORE** to return to the first menu in the series.

**Note**

In this manual, multiple menus will be referred to using 1-2 or 2-2 to distinguish the various menus. For example, **Main Menu 1-2** and **Main Menu 2-2**.

**2. Main Area**

The large center area of the display is your main working area for each specific menu. It is typically reserved for status, text, mini “help” messages, descriptions of parameters, entry fields, etc.
3. **Label Area**

Labels on the bottom row represent *functions*, or will route you to further sub-menus. These labels change depending upon the selected mode and menu. A menu function is activated by pressing the corresponding **Softkey**.

**Note**

In this manual, display functions are referred to by their *actual label names*, and not by the softkey that is pressed (below the display). For example, the phrase “... press **Disk**...” will be used, rather than “... press **Softkey #2** ...”

- A label that is underlined indicates that a sub-menu is available for that function. Pressing the button takes you one level down.
- Non-underlined labels are simply functions that you can activate by pressing the associated softkey, or other screens that you can access within the same menu.

4. **Softkeys**

The six **Softkey** buttons below the display correspond to labels that appear in the **Label Area** of the display. Pressing a **Softkey** activates the selected function, or switches to the selected menu.

5. **Scroll Area**

The right-hand section of the display (adjacent to the three **Scroll Knobs**) is reserved for functions that you can adjust conveniently with the scroll knobs. Up to three different adjustable parameters can appear in this section, each of which will be labeled accordingly.

When the three “**Positioner Icons**” appear in this area, you can adjust the selected function or parameter either with the **Scroll Knobs** or with the **Positioner** — for your convenience. Refer to the section “**Positioner Icons**” on page 3–6 for details.

6. **Scroll Knobs**

The three scroll knobs are assignable. Depending upon the selected mode (and menu), the functions of the knobs *change* just like the display labels. When a function requires a knob to adjust a parameter, up to three labels (and their associated functions) will appear in the right-hand section of the display — arranged vertically. Turn the appropriate knob to adjust the associated parameter.

In terms of knob “hierarchy”, the top knob is the **master** and the bottom two knobs are **slaved** to it. When you change the top knob (e.g., scrolling through inputs), the bottom knobs change in sync, showing the parameters for each selection chosen by the top knob. When you change one of the bottom two knobs, only *that* parameter changes.

7. **Menu Control Buttons**

To the left of the display, three buttons are provided to assist with navigating the menu system.

- **HOME** — Press to return the display to the top of the menu tree. **Main Menu 1-2** will be displayed.
- **UP ONE** — Press to take the display up one level in the menu tree. For example, if you press **Disk** to go one level down to the **Disk Menu**, press **UP ONE** to return up one level to the **Main Menu 1-2**.
- **LOCK MENU** — Press to lock the display on the current menu. It will still be possible to go down levels of the menu tree, but you will not be able to go up past the level at which you pressed the **LOCK MENU** button.

8. **MORE Button**

The **MORE** button lights to indicate that additional menus (and functions) are available on the current level. The numbers in the menu name (Main Menu 1-2) will indicate how many additional menus are available. While the **Softkeys** move you vertically through the menu system, **MORE** moves you horizontally.

Press **MORE** to display the next menu in the series, or to return to the first menu from the last.

**Using the Keyboard in System Control Menus**

The keyboard that plugs into the PS/2 port at the back of the control panel can be used in the place of the panel buttons and knobs to navigate through the menus and select values.

**Important**

Do NOT place anything on your keyboard or place your keyboard in a position where any of the keys could be accidently pressed. This could result in the Switcher acting unpredictably.

The following table illustrates the functions of the keys on the keyboard as they relate to the control panel buttons:

<table>
<thead>
<tr>
<th>System Control Menus</th>
</tr>
</thead>
<tbody>
<tr>
<td>Keyboard</td>
</tr>
<tr>
<td>F1 – F6</td>
</tr>
<tr>
<td>SysRq &amp; Break</td>
</tr>
<tr>
<td>Esc</td>
</tr>
<tr>
<td>Tab</td>
</tr>
<tr>
<td>Insert &amp; Delete</td>
</tr>
<tr>
<td>Home &amp; End</td>
</tr>
<tr>
<td>Page Up &amp; Page Down</td>
</tr>
</tbody>
</table>
Positioner Icons

When you select specific installation and operational menus, Positioner Icons appear in the right-hand Scroll Area. Typically, two or three icons are shown, depending upon the selected menu and function.

When these icons appear, you can adjust the selected function or parameter either with the Scroll Knobs or with the Positioner. In addition, when the Positioner Icons appear, the MENU button automatically lights in the Positioner Group — indicating that Positioner control is temporarily assigned to the display, rather than to a selected MLE and positionable function.

A sample menu that includes the three icons is shown below.

A) When the left-right Positioner Icon appears, you can use the top Knob to adjust the selected function, or you can move the Positioner left and right.

B) When the up-down Positioner Icon appears, you can use the middle Knob to adjust the selected function, or you can move the Positioner up and down.

C) When the circular Positioner Icon appears, you can use the bottom Knob to adjust the selected function, or you can twist the Positioner knob clockwise and counter-clockwise.

When you turn the MENU button off, the Positioner once again is assigned to the current panel function and location.

Refer to the section “Control Panel Sections” on page 2–2 for additional information on the Positioner itself, and the three Positioner Icons.
Adjusting the Display

Use the following procedure to adjust the contrast of the display, for user preference as desired:

1. Navigate to the Display Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Display.
2. Press Large Display to adjust contrast of the menu display.

![Display Menu — Large Display](image)

3. Use the Contrast knob to adjust the contrast.
4. Press Mnemonics Displays to display the Mnemonic Display Menu.

![Display Menu — Mnemonic Display](image)

5. Adjust the brightness and contrast of the mnemonic displays as follows:
   • Use the Brightness knob to adjust display brightness.
   • Use the Contrast knob to adjust display contrast.

**Note**

The Synergy 1 control panel does not have mnemonics. Therefore, the Mnemonic Displays softkey is grayed out, and not selectable.

This completes the procedure for adjusting the contrast of the display.
Help Features

The Help Menu provides convenient online assistance as you operate your Synergy Q/MD/X switcher. It provides a list of important “hidden” switcher functions that require two-button combinations to access, such as Keyer and MLE copy functions.

**Help Menu**

Use the following procedure to access the Help Menu:

1. Navigate to the Help Menu as follows:
   - Press HOME ⇒ Help.

2. Use the middle scroll knob to highlight the switcher function that you want more information on.


4. Exit the menu by pressing HOME to return you to the Main Menu, or UP ONE to take you up one level to the Help Menu.

This completes the procedure for accessing the Help Menu.

**Pop-up Help**

The Pop-up Help feature is designed to alert the operator when an illegal function is attempted. When an illegal action is performed, a Pop-up Help window is displayed. This window provides a brief explanation of why the operation cannot be performed, and a reference number that can be used when contacting Ross Technical support.

---

<table>
<thead>
<tr>
<th>Help Menu</th>
<th>Help Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold</td>
<td>Press</td>
</tr>
<tr>
<td>BRCD</td>
<td>BRCD</td>
</tr>
<tr>
<td>Key type</td>
<td>Key type</td>
</tr>
<tr>
<td>Key type</td>
<td>DSK crosspoint</td>
</tr>
<tr>
<td>Key 1/Key 2</td>
<td>Key 1/Key 2</td>
</tr>
<tr>
<td>DSK crosspoint</td>
<td>DSK crosspoint</td>
</tr>
<tr>
<td>WIPE</td>
<td>WIPE</td>
</tr>
<tr>
<td>Matte area</td>
<td>Crosspoint</td>
</tr>
</tbody>
</table>

Use knob 2 to scroll through the list.

---

<table>
<thead>
<tr>
<th>More Info Menu</th>
<th>More Info Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hold</td>
<td>Press</td>
</tr>
<tr>
<td>BRCD</td>
<td>BRCD</td>
</tr>
</tbody>
</table>

To copy a full MLE, hold down the destination MLE’s ‘BRCD’ button (in the Transition area), and hit the source MLE’s ‘BRCD’ button.
The following is an example of a Pop-up window.

```
Pop-up Help Menu
```

**Note**

The **Pop-up** window will *only* display while the related button is pressed. If a button related function is not operating properly, hold down the button to see if there is a related Pop-up window.
Installed Options

Several important menus are available that allow you to verify all of the installed options in your Synergy Q/MD/X switcher — with serial numbers as well as software option codes. The menus also display the revision levels of all system boards, and allow you to install software options.

Important

Serial numbers allow Ross Video to properly track which options have been purchased by each customer. Switchers have serial numbers installed (in flash memory) at the factory.

Refer to the chapter, “Software Upgrades and Options”, of the Synergy Q/MD or Q/MD-X Engineering Manual for instructions on how to install serial numbers, install software options, and store option codes.

The following topics are discussed in this section:

• Software Options Menu
• Panel Boards Menu
• Frame Boards Menu
• Screen Capture

Software Options Menu

The Software Options Menu allows you to view the software that is currently installed on the switcher.

Note

The menu is provided for information only, for information on installing software options, refer to Chapter 6 of the Synergy Q/MD or Q/MD-X Engineering Manual.

Use the following procedure to check the software that is installed on the switcher:

1. Navigate to the Installed Options Menu 1-2 as follows:

   • Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options ⇒ Software Options.

   The main area of the Software Options Menu lists the serial number of the frame at the top. This number is present at the top of all options menus. The main area also provides two columns of information:

   • Option — This column lists the software options than can be installed on the system.
• **Enabled** — This column indicates whether or not the option is installed, or enabled.

**Note**
Verify that the list reflects the exact options that you have purchased. If not, please contact Ross Video Technical Support for further information.

If a serial number appears at the top of the menu, please verify that this number matches the serial number printed on the rear of the Synergy Q/MD/X chassis. If another message is displayed where the serial number should be, take the following action:

• **Unknown** — If unknown appears instead of your serial number, the frame is off or you have lost communication with the frame. If the frame is on and functioning normally, check the control cable connecting the frame to the control panel.

• **000000** — If zeros appears instead of your serial number, a valid serial number is required. Your options will temporarily be activated so that you do not lose switcher functionality, but a valid serial number must be installed permanently. Refer to Chapter 6 of the *Synergy Q/MD or Q/MD-X Engineering Manual* for instructions.

**Important**
Serial numbers are unique, and pertain to your switcher only. The serial numbers cannot be exchanged, or entered on another switcher.

**Note**
All software options are stored in the frame. If control panels are swapped around, the enabled options will stay with the frame, regardless of which panel is connected to it (even for panel-based options such as “VTR Remote Control”).

### Panel Boards Menu

The **Panel Boards Menu** allows you to view the panel boards that are currently installed on the control panel.

Use the following procedure to check the **panel boards** that are installed on the control panel:

1. Navigate to the **Panel Boards Menu** as follows:
   • Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Installed Options** ⇒ **Panel Boards**.

**Installed Options (1-2)**

<table>
<thead>
<tr>
<th>Board</th>
<th>Rev</th>
<th>FPGA Rev</th>
</tr>
</thead>
<tbody>
<tr>
<td>4000-803 Panel CPU</td>
<td>10a</td>
<td>4000-003.bit 1990-12/01 00:49:35</td>
</tr>
<tr>
<td>4530-860 Upper XPT Bus</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>4530-861 Lower XPT Bus</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>4530-862 Global Memory</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>4530-864 Key Switch</td>
<td></td>
<td>2</td>
</tr>
<tr>
<td>4530-805 Trans Switch</td>
<td></td>
<td>2b</td>
</tr>
</tbody>
</table>

**Note** — **Panel Boards Menu**

The main area provides three columns of information that pertain to the boards installed in the panel.

• **Board** — This column lists each circuit board by part number and name.

• **Rev** — This column lists the hardware revision number of each board.

• **FPGA Rev** — This column lists the software revision number of each board.

This completes the procedure for displaying information on control panel boards.
Frame Boards Menu

The Frame Boards Menu allows you to view the frame boards that are currently installed on the frame.

Use the following procedure to check the frame boards that are installed in the chassis:

1. Navigate to the Frame Boards Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installed Options ⇒ Frame Boards.

<table>
<thead>
<tr>
<th>Slot</th>
<th>Board</th>
<th>HWRev</th>
<th>SWRev</th>
<th>BuildInfo</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Frame CPU</td>
<td>4</td>
<td>9.1.a</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Panel(S234)</td>
<td>2k</td>
<td>9.1.a</td>
<td></td>
</tr>
<tr>
<td>C</td>
<td>Input</td>
<td>2h</td>
<td>9.1.a</td>
<td></td>
</tr>
<tr>
<td>K</td>
<td>Output</td>
<td>3</td>
<td>9.1.a</td>
<td></td>
</tr>
<tr>
<td>J</td>
<td>Squeeze &amp; Trance MD</td>
<td>2d</td>
<td>9.1.a</td>
<td></td>
</tr>
<tr>
<td>J</td>
<td>SAT DSP</td>
<td>1b</td>
<td>9.1.a</td>
<td></td>
</tr>
</tbody>
</table>

The main area provides five columns of information that pertain to the boards installed in the frame:

- The Slot column lists each slot on the frame. The slots at the back of the frame are identified with letters, and the slots at the front of the frame are identified with numbers.
- The Board column lists each circuit board by name, including any daughter cards that may be installed on that board.
- The HWRev column lists the hardware revision number of each board and card in the frame.
- The SWRev column lists the revision number of the software that is currently installed on each board or card in the frame.
- The BuildInfo column lists the build, or software compile, date of the software that is currently installed on each board or card in the frame.

This completes the procedure for displaying information on frame boards.
Screen Capture

Switcher users can take screen captures of the Synergy Q/MD/X panel menus. The switcher saves the screen capture as a 16K bitmap file, which you can then import into other applications on your computer.

Use the following procedure to capture an image of the large menu display on the control panel:

1. Insert a USB key into the USB Port on the Synergy Q/MD/X control panel. You must wait 5 seconds after inserting the USB key into the USB Port before you can save a screen capture to it.

2. Navigate to the menu you wish to capture.

3. Take a screen capture as follows:
   - On a Synergy 2, 3 or 4 control panel, simultaneously press FADE RATE and ALL in the Store Area of the Global Memory System Group.
   - On a Synergy 1 control panel, simultaneously press STORE and FADE RATE in the Global Memory System Group.

   The Busy LED will come on, the current menu freezes, and a popup message is displayed indicating that a SCREENXX.BMP file is saved to the USB key.

4. Remove the USB key from the USB Port.

5. On your computer, insert the USB key and open the files in any graphics application that supports bitmap files to view, rename, and reformat the menu screen captures.

This completes the procedure to capture an image of the large menu display on the Synergy control panel.
Switcher Basics

In This Chapter

This chapter presents detailed *basic* switcher operating procedures, rules, and methods.
The following topics are discussed in this chapter:

- Before Starting
- Switcher Personality
- Basic Switcher Functions
- Using the Preview Bus
- Look Ahead Preview
- Fade to Black
- Using SmartConversion
Before Starting

If you are unfamiliar with the operation of a multi-level effects switcher, it is always advisable to check the initial condition of the switcher control panel, and reset the panel if required. By performing a software reset, you can guarantee a base default condition, and eliminate any special configurations that may be present on the panel (as left by the last TD). Two reset methods are provided below for all Synergy Q/MD/X switchers.

Control Panel Software Reset, Control Panel Method

Use the following procedure to perform a software reset of the control panel:

- On a Synergy 2, 3, or 4 Q/MD/X control panel, simultaneously press the following two buttons in the Global Memory System Group on the control panel:
  - ALL (in the RECALL column)
  - ALL (in the STORE column).
- On a Synergy 1 Q/MD control panel, simultaneously press STORE and RECALL in the Global Memory System Group.

Refer to the section “Resetting the Switcher” on page 2–23 for additional information.

Control Panel Software Reset, Menu Method

Use the following procedure to perform a full software reset:

1. Navigate to the Recall Factory Menu 1-2 as follows:
   - Press HOME \rightarrow MORE \rightarrow Setup \rightarrow Installation \rightarrow More \rightarrow Recall Factory.

   Recall Factory Menu 1-2

   This menu lets you reset different parts of the switcher to their factory default settings.

   Personality Memories Switcher Installation Custom Controls Default UTR Clips

2. Press Switcher to restore Switcher Registers (control panel settings) to their default values. The Default Switcher Screen is displayed:

   Default Switcher Screen

   WARNING

   This will reset the switcher, resetting all crosspoints, layers, etc. Are you sure?

   Yes  No
• Press **Yes** to reset all **Switcher Registers**. The control panel will be reset and all crosspoints and keyers will be cleared.

• Press **No** to retain the current set of **Switcher Registers** and exit the menu safely.

The control panel will be reset and all crosspoints and Keyers will be cleared.

**Power Fail Indicators**

The two power fail indicators on the control panel show the current power status of frame and the control panel.

- **PANEL** — The **PANEL** indicator will be lit when a fault has been detected in one of the power supplies in the control panel.

- **FRAME** — The **FRAME** indicator will be lit when a fault has been detected in one of the power supplies in the frame, or a problem has been detected with the cooling fans.

**Note**

The Power Fail indicator will show a problem with the primary power supplies, as well as the secondary power supplies.

**Power Failure**

When the Synergy Q/MD/X switcher loses power, the frame and control panel react in the following fashion:

- A loss of control panel power *only* has no effect on the frame, because the frame stores the current video state. When control panel power is restored, your setups will return to their previous state.

**Note**

Refer to the section “**Important Regulatory and Safety Notices to Service Personnel**” at the beginning of this manual for correct line cord information.

- If the frame is turned off, the panel indicates a frame power failure on the **POWER FAIL** indicators. In addition, the control panel menu displays the Splash Screen. When frame power is restored, the power failure status indicator clears, and the panel returns to the main menu with all control panel settings in factory default state. Refer to the “**Preliminary Functional Check**” section in Chapter 4 of the *Synergy Q/MD* or *Q/MD-X Engineering Manual* for factory default settings.

- When power returns after a loss to both the frame and the control panel, control panel settings will return to the factory default state. Refer to the “**Preliminary Functional Check**” section in Chapter 4 of the *Synergy Q/MD* or *Q/MD-X Engineering Manual* for factory default settings.
Switcher Personality

The Personality Menu provides several functions that determine how certain modes and features operate, providing the operator with the ability to customize these features based on user preference.

Navigating to the Personality Menu

Most of the personality options are accessed via a scrolling list in the Personality Menu. Where options are not accessed via the scrolling list, separate instructions are provided.

Use the following procedure to access their Personality Menu:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select the personality option that you wish to configure (each option is discussed in detail below).

Audio Cut Only

The Audio Cut Only features sets whether audio transitions occur at the same rate as the video transition, or whether the audio transitions cut. Note that this is not a true cut as the speed that one channel is taken off-air and the next channel is taken on-air depends on the Audio Mixer.

When Editor Remote Enable is Enabled, and OverDrive is controlling the switcher, the audio transition rate for the PGM MLE is set from OverDrive.

Use the following procedure to turn the Audio Cut Only feature on:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select AudioCutOnly.
3. Use the Value knob to toggle this feature On or Off.

Note

Personality options pertaining to external device control may also be found in the device chapters of the Synergy Q/MD or Q/MD-X Engineering Manual.

For information on assigning a Bus Map to a bus, refer to the section, “Assigning a Bus Map to an Individual Bus”, in the chapter, “BNC Configuration and Check”, of the Synergy Q/MD or Q/MD-X Engineering Manual.
On — Select this option to have audio transition cut, regardless of the type or rate of the video transition.

Off — Select this option to have audio transition at the same rate as the video transition.

This completes the procedure for turning the Audio Cut Only feature on.

Audio Transition MLE Assignment

Depending on how you want audio transitions to be performed, you can set up the switcher so that it will either perform an audio transition when a transition is performed in any MLE, or only when a transition is performed in the PGM/PST MLE.

Note: This option is not available for the Synergy 1 Q/MD.

Use the following procedure to set up when audio transitions are performed:

1. Navigate to the Personality Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select AudioTrans.
3. Use the Value knob to select when an audio transition is performed. You can choose between the following:
   - Pgm — This option tells the switcher to perform an audio transition only when a Program MLE is transitioned.
   - All — This option tells the switcher to perform an audio transition when any MLE is transitioned.

This completes the procedure for setting when audio transitions are performed.

Auto Recall

The Auto Recall feature allows you to store and recall certain switcher settings, such as Effects Dissolve, with a memory. When the memory is recalled, the settings that were stored with it will also be recalled.

Auto Recall operates differently whether it is being used in the Global Memory System Group, or in the MLE Memory System Group.

Auto Recall in the Global Memory System Group

With the Auto Recall On:

- Memory recalls retrieve the MLE-level saved settings for KEYS ONLY, EFF DISS, and the wipe button associated with a DVE SEND.
- The KEYS ONLY and EFF DISS buttons on the Global Memory System Group will reflect only stored settings saved from the PGM/PST MLE (Program MLE).
- When selected, the INCL DVE button recalls the wipe button associated with a DVE SEND saved on any one MLE.

With Auto Recall Off, you set KEYS ONLY, EFF DISS, and INCL DVE button settings manually before you recall the memory.
Auto Recall in the MLE Memory System Group

With Auto Recall On, memory recalls retrieve the KEYS ONLY and EFF DISS button settings used when that memory was saved.

With Auto Recall Off, you set KEYS ONLY and EFF DISS button settings manually before you recall the memory.

Important

Memory recalls from custom controls will override the current Auto Recall setting to whatever setting was used when the custom control was recorded. To ensure memory recall operations are performed consistently, ensure that the Auto Recall setting is the same as it was when recording the custom control.

Setting Up Auto Recall

Use the following procedure to set the Auto Recall feature:

1. Navigate to the Personality Menu as follows:
   • Press HOME \ MORE \ Setup \ Personality.
2. Use the Option knob to select Auto Recall.
3. Use the Value knob to toggle this feature On or Off:
   • On — Select this option to enable the auto recall feature. The ATTRIB button in the Global Memory System Group will light.
   • Off — Select this option to disable the auto recall feature. This is the default setting.

This completes the procedure for setting the Auto Recall feature. For more information on using Auto Recall with memory recalls, refer to Chapter 9, “Memory and Disk Functions”.

Auto Remove Key

The Auto Remove Key features allows you to have the switcher remove a Keyer from the Next Transition after that Keyer has been transitioned off-air from the Key Group. For example, Key 2 is on-air and it is selected as part of the next transition on the Transition Group. If you cut or dissolve Key 2 off-air from the Key Group, Key 2 will be de-selected for the next transition on the Transition Group. If Key 2 was the only selected item for the next transition, the background will be selected instead.

Use the following procedure to turn the Auto Remove Key feature on:

1. Navigate to the Personality Menu as follows:
   • Press HOME \ MORE \ Setup \ Personality.
2. Use the Option knob to select AutoRemoveKey.
3. Use the Value knob to toggle this feature to Off or On:
   • Off — Select this option to have the switcher not remove the Keyer from the next transition selection if is has just been transitioned off-air from the Key Group.
   • On — Select this option to have the switcher remove the Keyer from the next transition selection if is has just been transitioned off-air from the Key Group.

This completes the procedure for turning the Auto Remove Key feature on.
Bank 0 Lit

The Bank 0 Lit function turns on the BANK light whenever the current memory bank location is in the “zero” bank. This provides the user with a quick visual reference, without having to read the exact memory register location.

Use the following procedure to set the Bank 0 Lit feature:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Bank 0 Lit.
3. Use the Value knob to toggle this feature On or Off:
   • On — Select this option to have the BANK button lit when the current bank location is Bank 0.
   • Off — Select this option to have the BANK button not lit when the current bank location is Bank 0.

This completes the procedure for setting the Bank 0 lit feature.

Clear Bus Hold on All-All

The Clear Bus Hold on All-All features sets whether or not the Bus Hold selection on an bus is cleared when a soft-reset is performed.

Use the following procedure to turn the Clear Bus Hold feature on:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Clear BusHold.
3. Use the Value knob to toggle this feature On or Off:
   • On — Select this option to have the Bus Hold feature cleared on every bus when a software reset is performed.
   • Off — Select this option to have the Bus Hold feature not cleared when a software reset is performed.

This completes the procedure for turning the Clear Bus Hold feature on.

Double Press Rate

The Double Press Rate allows the user to set the time threshold required between two presses of a button. The time variable is set in frames by adjusting the Frames knob on the menu. Double button presses are required for several extended switcher functions.

Use the following procedure to set the Double Press Rate:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Double Press Rate.
3. Use the Value knob to select the number of frames required between two presses of a button.

This completes the procedure for setting the Double Press Rate.
DSK Auto Cut

The DSK Auto Cut mode determines how the DSK behaves when sources are taken on the Program Bus.

Use the following procedure to set how the DSK behaves when sources are taken:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select DSKx Auto Cut (where x is the DSK you wish to configure).
3. Use the Value knob to toggle this feature On or Off:
   • On — Select this option to have the selected DSK automatically taken off-air when any source is selected directly on the Program Bus of the Program/Preset MLE.
   • Off — Select this option to have the selected DSK not automatically taken off-air when any source is selected directly on the Program Bus of the Program/Preset MLE.

This completes the procedure for setting how the DSK behaves when sources are taken.

Editor Trans Rate

The Editor Transition Rates feature sets whether transition rates that are set from an external editor are doubled or not.

Use the following procedure to set the editor transition rate:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Editor Trans.
3. Use the Value knob to select the editor transition rate:
   • Normal — Select this option to have the transition rates that are set from an external editor not changed.
   • Double — Select this option to have the transition rates that are set from an external editor doubled.

This completes the procedure for setting the editor transition rate.

FTB Display

The Fade to Black Display can show two types of information: the fade to black rate or the number of available up/down converters. The latter is only useful if you are using SmartConversion. Refer to the chapter, “SmartConversion™”, in the Synergy Q/MD or Q/MD-X Engineering Manual for information on configuring SmartConversion.

Note

This option is not available for the Synergy 1 Q/MD.

Use the following procedure to set the Fade to Black Display mode:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select FTB Display.

3. Use the Value knob to select the desired setting for the Fade To Black Display. You can choose between the following:
   - **SmrtConv** — Use this option to enable the Fade To Black Display to show the number of available up/down converters.
   - **FTB** — Use this option to enable the Fade To Black Display to show the number of frames that a fade to black will occur over.

This completes the procedure for setting the Fade to Black Display mode.

**Isolate MultiDSKs**

You can isolate the two MultiDSKs to prevent them from being affected by memory recalls and switcher soft-resets. Isolated MultiDSKs also can not be included in Program/Preset-MLE transitions (you can still transition them using the keys in the Dowstream Keyer Group). Refer to the section “Isolated and Locked MultiDSK Mode” on page 7–61 for details on using isolated MultiDSKs.

Use the following procedure to enable and disable isolated MultiDSKs:

1. Navigate to the Personality Menu as follows:
   - Press HOME \ MORE \ Setup \ Personality.
2. Use the Option knob to select ISO MultiDSK.
3. Use the Value knob to select whether the MultiDSKs are isolated. You can choose between the following:
   - **On** — The MultiDSKs are isolated and are not affected by memory recalls, soft-resets, or Program/Preset-MLE transitions.
   - **Off** — The MultiDSKs are not isolated and are not protected from memory recalls, soft-resets, and Program/Preset-MLE transitions.

   **Note**
   If you toggle this option to **On** while a MultiDSK is included in the next transition, the transition will be done as a cut and the MultiDSK(s) will be included in that transition. You will not be able to include the MultiDSKs in any further transitions.

This completes the procedure for enabling and disabling isolated MultiDSKs.

**Key Cut Then Fade**

The Key Cut then Fade feature allows you to change the behavior of the CUT button on the Keyers module. When this feature is active, the CUT button on the Keyers module will cut a key on-air, but dissolve, or fade, the key off-air. This allows you to use the same button to cut a key on-air and then transition is off-air.

If you press **CUT** as the key is being transitioned off-air, a cut is immediately performed to take the key off-air.

Use the following procedure to set the Key Cut then Fade feature:

1. Navigate to the Personality Menu as follows:
   - Press HOME \ MORE \ Setup \ Personality.
2. Use the **Option** knob to select **KeyCutThenDis**.

3. Use the **Value** knob to toggle this feature **On** or **Off**:
   - **On** — Select this option to have the **CUT** button on all **Keyers** modules will cut keys on-air, but dissolve them off-air.
   - **Off** — Select this option to have the **CUT** button on all **Keyers** modules operate normally.

This completes the procedure for setting the Key Cut then Fade feature.

**Keypad Clip Entry**

You can set which keypad is used to enter numeric clip ID information when a server source is selected on a bus. You may choose to delegate the keypad on the MLE of the selected server crosspoint, the Global Memory area keypad, both keypads, or none (effectively disabling numeric clip ID entry).

Use the following procedure to configure Keypad Clip Entry:

1. Navigate to the **Personality Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Personality**.

2. Use the **Option** knob to select **KeypadClipIDs**.

3. Use the **Value** knob to select which keypad is delegated to numeric clip ID entry. You can select from the following:
   - **NONE** — No keypad is delegated for numeric clip id entry. This option effectively disables numeric clip ID entry.
   - **MLE** — The keypad of the MLE where the server crosspoint was selected is delegated for numeric clip ID entry.
   - **GLOBAL** — The Global Memory Area keypad is delegated for numeric clip ID entry.
   - **BOTH** — Both the Global Memory Area keypad and the keypad of the MLE where the server crosspoint was selected are delegated for numeric clip ID entry.

This completes the procedure for configuring Keypad Clip Entry.

**Log OverDrive Messages**

The Log OverDrive Messages features allows you to include interface messages between the switcher and OverDrive in the frame log file.

**Important**

Do not turn this feature **On** unless instructed to do so by Ross Video Technical Support.

Use the following procedure to set OverDrive Logging:

1. Navigate to the **Personality Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Personality**.
2. Use the **Option** knob to select **OverDriveLog**.

3. Use the **Value** knob to toggle this feature **On** and **Off**:

![Note](image)

**Note**: Do not leave the OverDriveLog feature turned On for an extended period of time.

- **On** — Select this option to have the interface messages between the switcher and OverDrive recorded in the log file.
- **Off** — Select this option to not have the interface messages between the switcher and OverDrive recorded in the log file.

This completes the procedure for setting OverDrive Logging.

**Matte Limit**

The **Matte Limit Mode** allows the user to set the matte parameters.

Use the following procedure to set the matte parameters:

1. Navigate to the **Personality Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the **Option** knob to select **Matte Limit**.
3. Use the **Value** knob to toggle this feature **On** or **Off**:
   - **On** — Select this option to have all color adjustments remain within the RGB color space.
   - **Off** — Select this option to allow colors to be adjusted outside of the RGB space.

This is the default setting.

This completes the procedure for setting the matte parameters.

**Mem Bank Cycle Max**

The **Memory Bank Cycle Max** allows the user to set the number of registers that will be cycled through when **BANK** is repeatedly pressed. This feature accommodates efficient recall of your important effects and transitions.

Use the following procedure to set the maximum number of Banks to cycle through:

1. Navigate to the **Personality Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the **Option** knob to select **Mem Bank Cycle Max**.
3. Use the **Value** knob to set the maximum number of Banks to cycle through when pressing the **BANK** button.

This completes the procedure for setting the maximum number of banks to cycle through.
Multiple Custom Controls

The Multiple Custom Controls feature allows you to set whether the switcher can run multiple custom controls simultaneously or only one at a time.

Note

If OverDrive is controlling the switcher, this is locked to Off.

Use the following procedure to set the multiple custom controls feature:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Multiple CCs.
3. Use the Value knob to toggle this feature On or Off:
   • On — Select this option to allow multiple custom controls to run simultaneously. Starting a custom control while a custom control is running does not stop the other custom control and the currently selected one starts.
   • Off — Select this option to allow only one custom control to run at a time. Starting a custom control while a custom control is running stops the running custom control and starts the new one.

This completes the procedure for setting the multiple custom controls feature.

Panel Sleep Time

The Panel Sleep Time feature allows you to set the length of time it takes the panel to go into sleep mode. The panel enters sleep mode when no buttons are touched and no fader is moved for the designated period of time. This feature is specifically designed to extend the life of the displays and button bulbs.

If the panel does go to sleep, press any button or move a fader or joystick to “wake” the switcher and turn on all the lights. Please note:

• The switcher does not act on a button push when coming out of “sleep” mode.
• The factory default time-out interval is 30 minutes.

Use the following procedure to set the length of time before Sleep Mode is activated:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Panel Sleep Time.
3. Use the Value knob to set the length of time in minutes for the panel to fall asleep.

Note

The panel will not “go to sleep” if the panel is left in a Disk related menu such as the Disk Store Menu.

This completes the procedure for setting the Panel Sleep time.
Pbus Memory

The Pbus Memory feature allows you to store or recall memories on a Pbus device when you store or recall memories on the switcher.

Use the following procedure to set whether to store or recall memories on a Pbus device:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select Pbus Memory.
3. Use the Value knob to set the whether the Pbus device stores memories or not. You can choose between the following:
   • No Send — Select this option to have the switcher not tell the Pbus devices to store or recall memories.
   • Send — Select this option to have the switcher tell all connected Pbus devices to perform a memory store or recall when one is performed on the switcher. The memory number is the same as the one used on the switcher.

This completes the procedure for setting whether to store or recall memories on a Pbus device.

Recall Global-Store Mode

The Recall Global-Store Memory Mode sets whether the Global-Store settings are included with memory recalls always, or never.

Use the following procedure to set how Global-Store settings are recalled with a memory:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the Option knob to select RecallGlblSto.
3. Use the Value knob to set the how Global-Store settings are recalled with a memory. You can choose between the following:
   • Never — Select this option to have Global-Store settings never included during memory recalls. The stills loaded in the Global-Store channels are not replaced with those included in the memory.
   • Always — Select this option to have Global-Store settings always included during memory recalls. The stills loaded in the Global-Store channels are replaced with those included in the memory.

This completes the procedure for setting how Global-Store settings are recalled with a memory.

Recall MLE-Store Mode

The Recall MLE-Store Memory Mode sets whether the MLE-Store settings are included with memory recalls always, or never.

Use the following procedure to set how Global-Store settings are recalled with a memory:

1. Navigate to the Personality Menu as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the **Option** knob to select **RecallGlblSto**.

3. Use the **Value** knob to set the how Global-Store settings are recalled with a memory. You can choose between the following:

   - **Never** — Select this option to have MLE-Store settings never included during memory recalls. The stills loaded in the MLE-Store channels are not replaced with those included in the memory.
   - **Always** — Select this option to have MLE-Store settings always included during memory recalls. The stills loaded in the MLE-Store channels are replaced with those included in the memory.

This completes the procedure for setting how Global-Store settings are recalled with a memory.

### Roll VTR Mode

The **Roll VTR Mode** determines how the **ROLL VTR** button behaves when a VTR or Video Server is selected. When you set the Roll VTR Mode, the setting affects all **ROLL VTR** buttons in all MLEs.

Use the following procedure to set the Roll VTR Mode:

1. Navigate to the **Personality Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the **Option** knob to select **Roll VTR Mode**.
3. Use the **Value** knob to select a mode for the **Roll VTR** button. You can select between the following:

   - **Play** — Selecting this mode allows you to play a VTR clip directly by pressing the **ROLL VTR** button. Once pressed, the clip will start to play and will have to be taken on-air manually with the **Fader**, a **Cut**, or **Auto Transition**.
   - **Arm** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air by pressing the **ROLL VTR** button. This can be used to roll multiple VTRs if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a **Cut**, **Auto Transition**, or if you double-press the assigned crosspoint button.
   - **Armed Always** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

   **Important**

   When the OverDrive production controller system is connected to the Synergy switcher, activating the **EDITOR** button turns on all the **Roll VTR** buttons and sets the Roll VTR Mode to **Arm**, disabling the Roll VTR Mode selection in the **Personality Menu**.

   - **Play** — Selecting this mode allows you to play a VTR clip directly by pressing the **ROLL VTR** button. Once pressed, the clip will start to play and will have to be taken on-air manually with the **Fader**, a **Cut**, or **Auto Transition**.
   - **Arm** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air by pressing the **ROLL VTR** button. This can be used to roll multiple VTRs if they are re-entered. Once pressed, the clip will only start to play when it is taken on-air with a **Cut**, **Auto Transition**, or if you double-press the assigned crosspoint button.
   - **Armed Always** — Selecting this mode allows you to have a VTR clip play with the next transition that takes the MLE on-air when you press the assigned crosspoint button.

   **Note**

   If an Auto Transition is performed with the **ROLL VTR** active, and in **Arm** or **Armed Always Mode**, the switcher will apply the **Pre-Roll** time for the VTR before it takes the VTR on-air.

This completes the procedure for setting the Roll VTR Mode.

### Notes on Selecting the Play Mode

When the **ROLL VTR** button is in the **Play Mode**:
• Pressing the button immediately rolls the serial device selected on the PST bus (one device per bus, including one device from a re-entered MLE).

• The transition that brings the device to air must be initiated by the operator with the fader, CUT, or AUTO TRANS buttons.

• The button is momentary. It is lit only when pressed.

**Notes on Selecting the Arm or Armed Always Modes**

When the ROLL VTR button is in the Arm Mode or Armed Always Mode:

• Pressing the button arms the switcher to roll the selected serial device (one device per bus, including one device from a re-entered MLE) on the PST or KEY buses in the next transition.

• When the transition is performed by pressing the crosspoint on the PGM bus, CUT, or AUTO TRANS, the device rolls, and goes to air after the preroll interval has elapsed.

• During preroll, moving the fader, pressing CUT, or double-pressing the crosspoint on the PGM bus overrides the preroll time and takes the VTR to air immediately.

• Pressing the button arms the switcher to roll the selected serial device (one device per bus, including one device from a re-entered MLE) on the PST bus in the next transition.

• When the transition is performed by pressing the crosspoint on the PGM bus, CUT, or AUTO TRANS, the device rolls, and goes to air after the preroll interval has elapsed.

• During preroll, moving the fader, pressing CUT, or double-pressing the crosspoint on the PGM bus will override the preroll time and take the VTR to air immediately.

• On a re-entered MLE, ROLL VTR activates only the first VTR it finds that is about to be brought on-air. The search order is: reentered MLE BKGD (including its own re-entry, if necessary), then re-entered MLE PST, then Key 1, then Key 2 – each, if necessary, with its own re-entry checked.

• If the mode is set to Arm, the button is latching. It remains lit until it is pressed again.

• If the mode is set to Armed Always, the button is always lit. Pressing the Roll VTR button does not disable it. Instead, you must configure the Roll VTR Mode in the Personality Menu or in a custom control macro.

**Squeeze & Tease Mode**

The Squeeze & Tease Mode allows you to configure how Squeeze & Tease MD channel resources are allocated between MLEs. Full MLEs are paired together (MLE 1 is paired with MLE 2, while MLE 3 is paired with MLE 4) and share Squeeze & Tease MD resources. You can define that these resources float between the two MLEs in a pair on an as-needed basis or that the resources are divided equally between the two MLEs and locked to them. Locking resources to an MLE guarantees those resources are always available to that MLE, while floating resources allow one MLE to use extra resources when the other paired MLE is not using them. Channel resources can not be shared across MLE pairs.

Use the following procedure to set the Squeeze & Tease mode:

1. Navigate to the Personality Menu as follows:
   
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the **Option** knob to select **S&T Mode**.

3. Use the **Value** knob to select the desired setting for Squeeze & Tease channel resource sharing. You can choose between the following:
   - **Fixed** — This option splits Squeeze & Tease MD channel resources evenly between MLEs in pairs (each MLE can use a maximum of 4 channel resources). If one MLE in the pair is not using all assigned channel resources, they **are not** available to the other MLE.
   - **Float** — This option allows Squeeze & Tease MD channel resources to be shared between MLEs in pairs. Channel resources not being used by one MLE in the pair **are** available to the other MLE (each MLE can use a maximum of 8 channel resources). This is the default setting.

   **Note** You must set the Squeeze & Tease mode to **Fixed** if you are using the OverDrive production control system.

This completes the procedure for setting the **Squeeze & Tease Mode**.

### Store Mode

The **Store Mode** feature allows you to have the Memory area switch to **Recall** mode or stay in **Save** mode after saving a memory in the Synergy switcher.

Use the following procedure to set the **Store Mode**:

1. Navigate to the **Personality Menu** as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the **Option** knob to select **Store Mode**.
3. Use the **Value** knob to set the store mode behavior. You can choose from the following:
   - **Hold** — Select this option to have the memory area remain in **Store** mode when the **ENTER** button is pressed to store a memory. This is the default setting.
   - **1-Time** — Select this option to have the memory area switch to **Recall** mode when the **ENTER** button is pressed to store a memory.

This completes the procedure for setting the **Store Mode** feature.

### Swap Keyers Cut & Auto

The **Swap Keyers Cut & Auto** feature allows you to swap the behavior of the **CUT** and **Auto TRANS** buttons in the **Key** groups. When this feature is set to swap, the **CUT** button performs an auto transition, and the **AUTO TRANS** button performs a cut.

Use the following procedure to swap the transition buttons on the **Key** groups:

1. Navigate to the **Personality Menus** as follows:
   - Press HOME ⇒ More ⇒ Setup ⇒ Personality.
2. Use the **Options** knob to select **Key Cut/Auto**.
3. Use the **Value** knob to toggle the feature between **Normal** and **Swap**.
   - **Normal** — Select this option to have the transition buttons in all **Key** groups perform standard functions. The **CUT** button performs a cut.
• **Swap** — Select this option to have the **CUT** and **AUTO TRANS** buttons in all **Key** groups swap functions. The **CUT** button performs an auto transition.

This completes the procedure for swapping the transition buttons in the **Key** groups.

### Swap PGM/PST Buses

The Swap Program and Preset Buses feature allows you to swap the functions of the Program bus to the Preset bus on all MLEs. When this feature is turned on, the sources that you select on the preset bus act as if they are being selected on the program bus, and the sources selected on the program bus act as if they are being selected on the preset bus.

Use the following procedure to swap the Program and Preset buses on all MLEs:

1. Navigate to the **Personality Menus** as follows:
   - Press HOME ⇔ More ⇔ Setup ⇔ Personality.
2. Use the **Options** knob to select **SwapPGM/PST**.
3. Use the **Value** knob to toggle the feature between **Normal** and **Swap**.
   - **Normal** — Select this option to have the Program and Preset buses keep their original functions.
   - **Swap** — Select this option to have the Program and Preset buses on all MLEs swapped.

This completes the procedure for swapping the Program and Preset buses on all MLEs.

### Swap Trans Cut & Auto

The Swap Trans Cut & Auto feature allows you to swap the behavior of the **CUT** and **Auto TRANS** buttons in the **Transition** groups. When this feature is set to swap, the **CUT** button performs an auto transition, and the **AUTO TRANS** button performs a cut.

Use the following procedure to swap the transition buttons in the **Transition** groups:

1. Navigate to the **Personality Menus** as follows:
   - Press HOME ⇔ More ⇔ Setup ⇔ Personality.
2. Use the **Options** knob to select **TransCut/Auto**.
3. Use the **Value** knob to toggle the feature between **Normal** and **Swap**.
   - **Normal** — Select this option to have the transition buttons in all **Transition** groups perform standard functions. The **CUT** button performs a cut.
   - **Swap** — Select this option to have the **CUT** and **AUTO TRANS** buttons in all **Transition** groups swap functions. The **CUT** button performs an auto transition.

This completes the procedure for swapping the transition buttons in the **Transition** groups.

### Time Clock Source

The Time Clock Source feature allows you to set the source for the Preview Overlay Time Clock. This source can either be internally generated, or generated from an external UMD device.

An external UMD device must be set up on a Remote port in order for the switcher to receive time clock data.

Use the following procedure to set the time clock source:
1. Navigate to the **Personality Menus** as follows:
   - Press HOME ➔ More ➔ Setup ➔ Personality.
2. Use the **Options** knob to select **TimeClock Src**.
3. Use the **Value** knob to set the time clock source. You can choose from the following:
   - **Internal** — Select this option to have the switcher use the internally generated time clock data.
   - **UMD Input** — Select this option to have the switcher use data from an external UMD device for the time clock. You must use the **Time Clock UMD Number** feature to set which UMD Address that the time clock data should come from.

This completes the procedure for setting the time clock source.

**Time Clock UMD Number**

The Time Clock UMD Number feature allows you to set the specific address of the UMD input that you want to get the time clock data from.

Use the following procedure to set the time clock UMD number:

1. Navigate to the **Personality Menus** as follows:
   - Press HOME ➔ More ➔ Setup ➔ Personality.
2. Use the **Options** knob to select **TimeClock UMD**.
3. Use the **Value** knob to select the address, or UMD input number, that you want to get the time clock data from.

This completes the procedure for setting the time clock UMD source.

**UltraChrome Dflt Color**

The UltraChrome Default Color feature allows you to set the default color that the UltraChrome will be set to when the keyer has been defaulted. Once a different color is set for the UltraChrome, that new color remains until the keyer is defaulted, or until a different UltraChrome color is set manually.

Use the following procedure to set the default chroma key color:

1. Navigate to the **Personality Menus** as follows:
   - Press HOME ➔ More ➔ Setup ➔ Personality.
2. Use the **Options** knob to select **UChrome Color**.
3. Use the **Value** knob to select the default color you want to use for UltraChrome.

This completes the procedure for setting the default chroma key color.

**UltraChrome Dflt Mode**

The UltraChrome Default Mode feature allows you to set the default mode that UltraChrome operates in. Once a different mode is set for the UltraChrome, that mode remains until the keyer is defaulted, or until a different UltraChrome mode is set manually. Refer to the section “Performing an UltraChrome Chroma Key” on page 7-26 for more information on UltraChrome modes.

Use the following procedure to set the default chroma key mode:

1. Navigate to the **Personality Menus** as follows:
• Press HOME ⇒ More ⇒ Setup ⇒ Personality.
2. Use the Options knob to select UChrome Mode.
3. Use the Value knob to select the default mode for UltraChrome. You can choose between the following:
   • Basic — Select this option to have UltraChrome default to Basic mode. In basic mode, UltraChrome provides a simple background/foreground chroma key with adjustment for background spill and edge softness.
   • Advanced — Select this option to have UltraChrome default to Advanced mode. In advanced mode, UltraChrome provides advanced background shadow and translucency control, as well as control over background/foreground transition areas.

This completes the procedure for setting the default chroma key mode.

**Wakeup on Command**

**Wakeup on Command** determines whether the Synergy control panel will wake from sleep when an OverDrive command is received.

**Note**

The Synergy control panel does **not** need to be awake to receive and process commands from OverDrive.

Use the following procedure to set the **Wakeup on Command** mode:

1. Navigate to the **Personality Menu** as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Use the **Option** knob to select **Wakeup on Cmd**.
3. Use the **Value** knob to toggle this feature **On** or **Off**:
   • **On** — Select this option to have the switcher control panel wake from sleep when an OverDrive command is received.
   • **Off** — Select this option to have the switcher control panel remain asleep when an OverDrive command is received. OverDrive can still control the switcher control panel.

This completes the procedure for setting the **Wakeup on Command** mode.

**Squeeze & Tease MD Pattern Button Assign Option**

To use this function, you require the **Squeeze & Tease MD** option installed in an MLE (or MLEs) of your Synergy switcher. For information about obtaining the **Squeeze & Tease MD** option, contact Ross Video Technical Support.

Use the following procedure to assign a pattern button:

1. Navigate to the **Personality Menu** as follows:
   • Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Press **3D Pattern Button Assign** to display the **S&T 3D Wipe/Sequence Assignment Menu**. 
3. Use the **Button** knob to select a **Pattern Control** button. By default the middle **Sequence** selections track the button selections.

4. Use the **Sequence** knob to select a sequence to assign to the chosen button. You may assign the same sequence to several buttons if you wish. In the main menu area, parameters for the selected sequence are displayed.

This completes the procedure for assigning a pattern button.

**Standard Mnemonics**

The **Standard Mnemonics** feature allows you to set the font size, background color and whether or not the displays will show the shifted crosspoint names for the mnemonics. These settings will be the standard settings that are used by the switcher for all the mnemonics. You can override individual mnemonics when you name BNCs or Custom Controls. These mnemonics will then no longer be effected by the standard settings. Refer to the section “**BNC Configuration**” on page 7-2 and the section “**Naming Custom Controls**” on page 10-38 for more information on setting mnemonic overrides.

Display configurations are stored with the switcher setups.

**Note**
The Mnemonics option must be installed in order to set the Standard Mnemonics feature.

Use the following procedure to set the overall appearance of the mnemonics displays:

1. Navigate to the **Personality Menu** as follows:
   - Press **HOME** ⇒ **MORE** ⇒ **Setup** ⇒ **Personality**.
2. Press **Standard Mnemonics** to display the **Standard Mnemonics Menu**.
3. Set the size of the font used in the mnemonic displays as follows:
   - Use the **Font** knob to select the size of the font used. You can select between the following:

**Note**
If names have more than the maximum number of characters per line, the last characters will be dropped.

~~*Small*~~ — Select this option to use a small black font on a color background in the mnemonics. This size allows you to use 6 characters per line, with 2 lines.
Small Invert — Select this option to use a small color font on a black background in the mnemonics. This size allows you to use 6 characters per line, with 2 lines.

Medium — Select this option to use a medium black font on a color background in the mnemonics. This size allows you to use 4 characters per line, with 2 lines.

Medium Invert — Select this option to use a medium color font on a black background in the mnemonics. This size allows you to use 4 characters per line, with 2 lines.

None — Select this option to have no text appear in the mnemonic displays.

4. Set the color of the background or text as follows:
   • Use the Color knob to select the color you want to assign to the background or text. You can select between the following:
     ~ Green — Select this option to use green as the display color.
     ~ Yellow — Select this option to use yellow as the display color.
     ~ Orange — Select this option to use orange as the display color.
     ~ None — Select this option to not use a color for the display.

5. Set the shifted crosspoint display mode for the mnemonics as follows:
   • Use the Xpt Mode knob to select the display mode you want to use. You can select between the following:
     ~ 1 Name — Select this option to show only the names of the crosspoints for the selected bus.
     ~ 2 Names — Select this option to show the names of the crosspoints for the selected bus and the names of crosspoints when the bus is in Shift mode.

This completes the procedure for setting the overall appearance of the mnemonics displays.
Basic Switcher Functions

This section provides basic information and general rules regarding the operation of the Synergy Q/MD/X switcher. The following sections are included:

- General Button Rules
- Crosspoint Buttons
- SHIFT Button
- Reverse Key Shift Mode
- Assigning a Bus Map to an Individual Bus
- Assigning a Bus Map to Multiple Buses
- Flip-Flop Operation
- Key Bus on Synergy 2 to 4 Q/MD/X Control Panels
- Key Bus on Synergy 1 Q/MD Control Panel
- MLE Tally
- Non-Sync Indicators
- Re-entry
- Look Ahead Preview

General Button Rules

All button presses are registered (acknowledged) by the switcher when a selected button lights. Pressing a button can switch a crosspoint (and affect the video output), perform a transition, toggle a function, or have no affect (if the function is not valid for the current setup). The following are a number of rules that must be understood when working with buttons:

- Buttons can be latching (in the case of valid crosspoints and “toggle” functions such as Key parameters), or momentary (in the case of transition buttons such as CUT).

- When you press a button and hold it down, the button lights to acknowledge the press — but after two seconds, it reverts to its proper state for the selected mode. This proper state could be on or off, depending upon the current setup.

- Pressing and holding one button, then pressing another is a valid mode. This sequence is used for functions such as “favorite CG” and DSK setup. Details are provided in each operational section.

Crosspoint Buttons

When a button (or crosspoint) is pressed on the PGM, BKGD, PST, and KEY buses, a video source is selected. Video sources can be internally generated, derived from external sources (and connected to the frame via BNC), or derived from external sources but stored internally, as is the case with the Global-Store.

Note

If you press a crosspoint button that is assigned to an external device, the Device Control Menu is displayed.
Please note the following important rules:

- There are four internally generated sources available:
  - **BLACK** — In a factory default state, this source is placed on the first or left-most crosspoint in a bus row.
  - **SHIFT** — In a factory default state, this source is placed as the last or right-most crosspoint in a bus row.
  - **COLOR BKGD 1** — In a factory default state, this source is placed as the first shifted crosspoint in a bus row.
  - **COLOR BKGD 2** — In a factory default state, this source is placed as the second shifted crosspoint in a bus row.

- There are three other internal sources available:
  - **GlobalStore1** — In a factory default state, this source is placed as the fourth to last crosspoint in a bus row.
  - **GlobalStore2** — In a factory default state, this source is placed as the third to last crosspoint in a bus row.
  - **GlobalStore3** — In a factory default state, this source is placed as the second to last crosspoint in a bus row.

- External sources can be turned off as part of switcher setup, or placed on more than one crosspoint. In the Synergy Q/MD or Q/MD-X Engineering Manual, refer to Chapter 7, “BNC Configuration and Check” for details.

- On each switcher, between the PGM and PST buses only, small crosspoint numbers are silk-screened on the panel itself. These labels are printed in increments of five, and are designed to assist your facility engineer with locating crosspoints — particularly during setup modes.

### SHIFT Button

On each bus (including the KEY bus), the **SHIFT** button is used to access video and Key sources that have been mapped to crosspoints beyond the number of available buttons. The mapping itself is performed during the installation procedure.

Use the following procedure to access a shifted source on any bus:

1. Press and hold the **SHIFT** button.
2. Press the desired crosspoint.
3. Release both buttons.

This completes the procedure for accessing a shifted source on any bus.
The \textit{SHIFT} button plus the selected source both stay lit, as indicated in the sample bus illustration below. On the Synergy 2, 3, and 4 Q/M\textit{D}/X control panels, the mnemonic displays will change when the \textit{SHIFT} button is pressed to indicate the names of the shifted crosspoints.

Synergy 4 Q/M\textit{D}/X — Shifted Crosspoint Selected on PGM

There are a few differences that should be noted about working with shifted crosspoints:

- With a shifted source selected on a bus row, to take an \textit{unshifted} source, simply press its button.
- With a shifted source selected, to take another shifted source, repeat the procedure above.
- If you press \textit{SHIFT} and then decide \textit{not} to select a source, simply release the \textit{SHIFT} button. No change will occur on the bus.

\textbf{Reverse Key Shift Mode}

A special mode called \textbf{Reverse Key Shift} can be activated during switcher setup. Activating the \textbf{Reverse Key Shift} mode makes each MLE Key Bus \textit{shifted all the time} — as its default state.

This acts as a shift-lock, giving you one-button access to the higher-numbered inputs on each Key Bus (without having to press \textit{SHIFT} each time to reach them).

If the \textbf{Reverse Key Shift} mode has been implemented, you may notice that the crosspoint labels on each KEY bus will be \textit{different} from each MLE BKGD and PST bus labels. The name \textit{REV SHIFT} is shown on the mnemonic for the \textit{SHIFT} button when Reverse Key Shift is active.

Consult with your facility engineer to determine if the \textbf{Reverse Key Shift} mode is implemented. For additional information, refer to Chapter 7, “BNC Configuration and Check” of the Synergy \textit{Q/M\textit{D}} or \textit{Q/M\textit{D}/X Engineering Manual}.

\textbf{Assigning a Bus Map to an Individual Bus}

By default, each bus on your switcher is assigned the default bus map. However, you can choose to assign any of the user-configurable mappings to any bus you choose. This is particularly useful for having Aux or Key buses mapped differently than the Program bus.

\begin{center}
\begin{tabular}{|c|c|c|c|c|c|}
\hline
\textbf{Assigning a Bus Map to an Individual Bus} & & & & & \\
\hline
\end{tabular}
\end{center}

\begin{center}
\begin{tabular}{|c|c|c|c|c|c|}
\hline
\textbf{Important} & The OverDrive Production Control System requires that all buses on your switcher are assigned to the same bus map. OverDrive does not support different bus maps on different buses. \\
\hline
\end{tabular}
\end{center}

Use the following procedure to assign a bus map to a bus:

1. Navigate to the \textbf{Personality Menu} as follows:
2. Press **Assign Bus Map** to display the **Assign Bus Maps Menu**.

3. Press **Individual Buses** to display the **Assign Individual Bus Maps Menu**.

<table>
<thead>
<tr>
<th>Bus</th>
<th>Map</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE2 Key 2</td>
<td>MLEx Pgm/Pst</td>
</tr>
<tr>
<td>MLE2 Key 1</td>
<td>MLEx Pgm/Pst</td>
</tr>
<tr>
<td>MLEx Key 1</td>
<td>MLEx Pgm/Pst</td>
</tr>
<tr>
<td>MLEx Key 2</td>
<td>MLEx Pgm/Pst</td>
</tr>
<tr>
<td>MLEx Utility</td>
<td>MLEx Utility</td>
</tr>
<tr>
<td>MultiDSK 3</td>
<td>MultiDSK 3</td>
</tr>
<tr>
<td>MultiDSK 4</td>
<td>MultiDSK 4</td>
</tr>
<tr>
<td>Bank x Aux x</td>
<td>Bank x Aux x</td>
</tr>
<tr>
<td>RemoteAuxPnls</td>
<td>RemoteAuxPnls</td>
</tr>
<tr>
<td>Assign to:</td>
<td>Assign to:</td>
</tr>
</tbody>
</table>

4. Use the **Bus** knob to select the bus you wish to assign the map to. You can assign bus maps to all possible MLEs (1-4), even if your switcher does not have 4 MLEs. You can select from the following:

- **MLEx Pgm/Pst** — Select this option to assign the mapping to the Program and Preset bus of the indicated MLE.
- **MLEx Key 1** — Select this option to assign the mapping to the Key 1 bus of the indicated MLE.
- **MLEx Key 2** — Select this option to assign the mapping to the Key 2 bus of the indicated MLE.
- **MLEx Utility** — Select this option to assign the mapping to the Utility bus of the indicated MLE.
- **MultiDSK 3** — Select this option to assign the mapping to the MultiDSK bus of your switcher.
- **MultiDSK 4** — Select this option to assign the mapping to the MultiDSK bus of your switcher.
- **Bank x Aux x** — Select this option to assign the mapping to the specified Aux bus of your switcher.
- **RemoteAuxPnls** — Select this option to assign the mapping to any Remote Aux panels connected to your switcher.

5. Use the **Map** knob to select the Bus Map you want to assign to a bus. You can select the default mapping or any of the 16 user-configurable mappings.

6. Press **Perform Assign** to assign the selected map to the bus.

This completes the procedure for assigning a bus map to a bus.
Assigning a Bus Map to Multiple Buses

If you need to assign a bus map to all buses on your switcher, all MLE buses, or all Aux Buses, you do not have to do so on an individual basis.

**Important**
The OverDrive Production Control System requires that all buses on your switcher are assigned the same bus map. OverDrive does not support different bus maps on different buses.

Use the following procedure to assign a bus map to multiple buses simultaneously:

1. Navigate to the Personality Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Personality.
2. Press Assign Bus Maps to display the Assign Bus Maps Menu.

3. Select which buses you want to assign a bus map to as follows:
   - **Entire Switcher** — Select this option to assign a new Bus Map to all buses on the switcher.
   - **All MLE Buses** — Select this option to assign a new Bus Map to only the MLE buses of the switcher. MLE buses include the Program/Background, Preset, Key 1, Key 2 and Utility buses.
   - **All Aux Buses** — Select this option to assign a new Bus Map to all of the Aux buses.
4. Use the Map knob to select the bus map you want to assign to the selected buses.

**Note**
If all buses on your switcher are not assigned to the same bus map, the Map knob is initially set to Different.

5. Press Perform Assign. The selected bus map is assigned to the selected buses.

This completes the procedure for assigning a bus map to multiple buses simultaneously.

Button mappings can also be saved to the switcher hard drive or a USB key for later recall. Refer to the section “Using Storage Devices” on page 9–25 for more information.

**Flip-Flop Operation**

All MLEs are configured to operate in flip-flop mode. When you perform a cut, dissolve, or wipe transition between the PGM and PST buses (or between the BKGD and PST buses), the two selected sources exchange places. This is called a flip-flop.
For example, in the figure below, **CAM 1** is selected on the **PGM** bus and **CAM 3** is selected on **PST** bus.

**Buses before Transition**

After the cut, dissolve, or wipe transition is performed, the two buses flip-flop as shown below. **CAM 2** is now selected on **PGM** bus and **CAM 1** is now selected on **PST** bus.

**Buses Flip-flopped, after Transition**

In this manner, with all switcher MLEs, the **PGM** and **BKGD** buses *always* provide the **BKGD** output source for the MLE, and the **PST** bus *always* provides the *next* source to be brought to air with a transition. In addition, after a transition, the **PST** bus *always* shows the source last selected on **PGM**, until you change it.
Key Bus

The Key Bus will appear different depending on the control panel you have. On the Synergy 2, 3, and 4 control panels, there is a dedicated Key bus for each MLE, except the PGM/PST MLE. On the Synergy 1 control panel, the Key bus is shared with the Aux Bus.

**Key Bus on Synergy 2 to 4 Q/MD/X Control Panels**

Each MLE includes a **Key Bus** (a sample of which is shown below):

1. **Key Bus**

   The Key Bus allows you to make Key and fill selections on both MLE Keyers — **Key 1** and **Key 2** (for the upstream MLEs), or **DSK 1** and **DSK 2** (for the Program/Preset MLE). Even though the **Key Bus** buttons are shared between the two Keyers, each Keyer can have its own independent Key and fill selections. This independent operation works as follows:
   
   ~ Pressing any button in a Keyer switches control of the **Key Bus** to that Keyer.
   
   ~ When the **Key Bus** is assigned to Key 1, changing a button on the bus has no effect on Key 2. Similarly, when the bus is assigned to Key 2, changing a button has no effect on Key 1.
   
   ~ When a Keyer has control of the bus, its crosspoint selection will be **brightly** lit on the bus row. The crosspoint selection for the other bus (the one that does **not** have control) will be **dimly** lit.

2. **Key Control Indicators**

   The two Key Control indicators show which Keyer has control of the **Key Bus** buttons.

3. **Key Bus On Air Indicators**

   The Key Bus ON AIR indicators show, when lit, that the video feeding for that Keyer is on air and contributing to the main program output of the switcher. When lit, the source selected on that bus will be tallied.
**Key Bus on Synergy 1 Q/MD Control Panel**

The following illustration is of the **Key Bus**.

![Key Bus Diagram]

1. **Key Bus**

   The **Key Bus** allows you to make Key and fill selections on *both* MLE Keyers — **Key 1** and **Key 2**. Even though the **Key Bus** buttons are *shared* between the two Keyers, each Keyer can have its own independent Key and fill selections. Please note:

   • Pressing any button in a Keyer switches control of the **Key Bus** to *that Keyer*.
   • When the **Key Bus** is assigned to Key 1, changing a button on the bus has no effect on Key 2. Similarly, when the bus is assigned to Key 2, changing a button has no effect on Key 1.

2. **Key Bus Selection Buttons**

   The two **Key Bus Selection Buttons** select which Keyer has control of the **Key Bus** buttons.

3. **Key Bus On Air Indicator**

   The **Key Bus ON AIR** indicators show, when lit, that the video feeding that Keyer is on air and contributing to the main program output. When lit, the source selected on that bus will be tallied.
Bus Indicators

Two indicators are positioned at the end of each bus row to show the status of that bus.

Synergy 3 — Bus Row Indicators

1) On-Air “Tally” Indicator
2) Non-Sync Indicator

1. On-Air “Tally” Indicator

The **ON AIR** “Tally” indicator shows, when lit, that the video selected on that bus is contributing to the main program output. In addition, the source selected on that bus will be tallied. Refer to the section “MLE Tally” on page 4–30 for additional information.

2. Non-Sync Indicator

The **N/S** (Non-Sync) indicator shows, when lit, that the source selected on that specific bus is non-synchronous. Refer to the section “Non-Sync Indicators” on page 4–31 for additional information.

MLE Tally

The **MLE Tally** feature of the switcher allows you to force a selected MLE to always function as if it is on-air — regardless of whether or not it is selected on the **Program/Preset Bus**.

For instance, you may wish to send the output of MLE 1 to an external device, such as a VTR, while the Program/Preset bus is on air. In this configuration, you may want both MLE 1 and the Program/Preset Bus to be tallied. To achieve this, the **MLE Tally** feature must be used.

For more information on selecting a tally function, refer to Chapter 8, “Output Configuration”, in the **Synergy Q/MD or Q/MD-X Engineering Manual**.
Non-Sync Indicators

The N/S (Non-Sync) indicator shows, when lit, that the source selected on the adjacent bus is non-synchronous. This rule applies on all buses (including Aux buses) and the DSKs.

The N/S indicator serves as a warning only, indicating that the timing of the input should be fixed at the source. In this condition, with a non-sync indicator lit, the source is still usable. You can perform cuts, dissolves, and other effects; however, the non-synchronous source will be shifted vertically, and is not synchronous in relation to reference.

Note

The MLEs themselves are always synchronous, with a fixed internal timing. Only individual sources can become non-synchronous.

The following rules apply when working with a non-synchronous video source:

- The N/S indicator will not light in a re-entry situation. For example, if a source on MLE 1 is non-sync, and MLE 1 is re-entered into the program bus of MLE 2, the N/S indicator will not light on the program bus for MLE 2. The MLE is always synchronous, and in this configuration, it is synchronously passing along a non-synchronous source.

- The N/S indicator on an MLE Key Bus is shared between the two MLE Keyers. Note that the N/S indicator works in conjunction with the two green Key Control indicators (which indicate the Keyer that has control of the Key Bus buttons).
If the N/S indicator is on, check the Key Control indicators to determine which specific Keyer is non-synchronous.

### Note

On the Synergy 1 Q/MD, the **Key Bus Selection Buttons** are used to indicate which specific Keyer is non-synchronous.

---

#### Knobs

There are *two types* of rotary knobs used on all Synergy Q/MD/X control panels. These are Continuous Rotation Knobs and End-stop Knobs:

- **Continuous Rotation Knobs** are used *only* in the **System Control Group**, as shown below. These knobs are provided for adjusting setup menu parameters, scrolling various menu lists for switcher configuration, and for certain functional adjustments such as Key clips.

![System Control Group — Continuous Rotation Knobs](image)

- **End-stop Knobs** are used in *all other locations* on the control panel, as shown in the **Mattes Group** illustration below.

![Mattes Group (Synergy 3.5 and 4 Q/MD-X) — End-stop Knobs](image)

Note the following important point regarding **End-stop Knobs**:

- All **End-stop Knobs** provide a definite *tactile* indication of the absolute upper and lower limits of the function being adjusted.

- Each knob (or group of knobs) has *shared functionality* between MLEs. Depending on the mode, a knob can be assigned to different MLEs from moment to moment.

- Because the electrical position of an **End-stop Knob** can be *overwritten* by memory recalls (or by assigning the group to another MLE), the electrical knob position *may not match* the current physical position of the knob. If this is the case, the knob can be adjusted, but you may not have the full range available.

---

### Operating Tip

To fully re-synchronize End-stop Knob physical-to-electrical positions, turn the knob fully clockwise, then fully counter-clockwise. Full-range adjustments can now be made.
Re-entry

On the Synergy 2, 3 and 4 control panels, re-entry crosspoints are used to route a signal from one MLE to another MLE. On the Synergy 3 and 4, the re-entry buttons are located to the right of each main bus row, as shown below on the Synergy 4 panel illustration below. On the Synergy 2, only MLE 2 has re-entry crosspoints. There are no re-entry crosspoints on a Synergy 1 Q/MD.

Re-entry crosspoints perform essentially the same function, depending upon their location on a switcher panel:

- Re-entry buttons on the PGM/PST bus (the highest-numbered bus) allow you to add (or combine) the contents of an entire upstream MLE to the output video. The number of re-entry buttons depends on the quantity of upstream MLEs.
- For the Synergy 3 and 4 control panels, re-entry buttons on the upper MLEs allow you to add (or combine) the contents of an entire upstream or downstream MLE to the output video content of an MLE. In effect, you can re-enter up or down. Again, the number of re-entry buttons depends on the model.
- Re-entry buttons are mutually exclusive with all other buttons on the bus. When selected, the re-entry button lights and any other bus selection(s) are cancelled.

Re-entry allows you to combine images and Keys for more creative layered effects (also known as a “composite” effect).

**Note**

You cannot re-enter an MLE into an MLE that is already re-entered into the first MLE. For example, if MLE 2 is re-entered into MLE 3, you will not be able to re-enter MLE 3 into MLE 2.
For example, MLE 1 by itself is composed of a Key and a Background image.

MLE 1 Effect

MLE 2 by itself is composed of another Key and a black Background.

MLE 2 Effect

When MLE 1 is selected (re-entered) as the BKGD bus crosspoint on MLE 2, the two effects are combined, creating a layered composite effect.

Composite Effect — MLE 1 Re-entered into MLE 2
Using the Preview Bus

The buttons in the Preview Bus Group allow you to preview selected MLE outputs on your preview monitor. These buttons provide a “look-ahead” view of the selected output.

Note

The Synergy 1 Q/MD does not have a dedicated Preview Bus Group. However, you can configure your BNC outputs to allow you to preview all crosspoints selected on the PST bus on a preview monitor.

Synergy 1 Preview Bus

With a PV output properly configured, press any PST Bus button to view the output on your preview monitor. This selection is helpful (and even essential) when you are adjusting Keys and clips.

- In either the Key 1 or Key 2 Group, press the KEY PV button to preview the associated Key source over the source currently selected on the PST Bus. This feature allows you to know the exact state of the switcher after the next transition is performed.

For information on setting up preview BNC outputs, refer to the Synergy Q/MD or Q/MD-X Engineering Manual, Chapter 8, “Output Configuration”.

Synergy 2, 3 and 4 Preview Bus

For Synergy 2, 3 and 4 control panels, two types of buttons are provided as follows:

- **MLE PGM** — These buttons allow you to view the output of the indicated MLE (e.g., MLE 1 PGM or MLE 2 PGM) on your preview monitor. The PGM button selects the output of the entire switcher.

- **MLE PV** — These buttons (e.g., MLE 1 PV or MLE 2 PV) allow you to view crosspoints selected on the indicated PST Bus of an MLE, and the exact state of the MLE after the next transition is performed.

The following figure shows the Preview Bus Group on a Synergy 3.5 and 4 Q/MD-X control panel.

Synergy 4 Preview Bus Group

The following figure shows the Preview Bus Group on a Synergy 2.5 Q/MD, 2.5 and 3 Q/MD-X control panel.

Synergy 3 Preview Bus Group
The following figure shows the Preview Bus Group on a Synergy 2.5 Q/MD, 2.5 and 3 Q/MD-X control panel.

**Synergy 2 Preview Bus Group**

The following operational points apply when working with the Preview Bus:

- Press any MLE PGM button to view the output of the indicated MLE (e.g., MLE 1 PGM or MLE 2 PGM) on your preview monitor. This selection is very helpful when you are adjusting Keys and clips.
- Press the PGM button to select the output of the entire switcher.
- Press any MLE PV buttons (e.g., MLE 1 PV or MLE 2 PV) to view crosspoints selected on the indicated MLE PST bus, and the exact state of the MLE after the next transition is performed.

**Note**

The buttons on the Preview Bus Group do not auto follow. If you select MLE 1 PV on the Preview Bus and then switch crosspoints on MLE 2, the Preview Bus selection remains on MLE 1 PV.
Look Ahead Preview

The Look Ahead Preview feature allows you to view different preview outputs, depending on whether or not the MLE is on air. Look Ahead preview works differently than the Preview Bus found on the control panel, as, instead of displaying the output of just the PGM or just the PV bus, the output on Look Ahead preview will change depending on the on-air status of the MLE.

Any output BNC can be assigned as the Look Ahead preview for any MLE except for the PGM/PST MLE. For example, if you have a Synergy 4 Q/MD-X, you can connect a separate monitor to BNC outputs that are assigned as Look Ahead preview for MLE 1, MLE 2, and MLE 3. This would provide you with a monitor showing either the preview or the program output for MLE 1, MLE 2, and MLE 3, based on whether or not the MLE is on-air.

The output displayed on the Look Ahead preview monitor will be as follows. If the MLE is:

- **Off-Air** — Look Ahead preview will display the PGM output for the assigned MLE. This is what would be displayed if you take this MLE to air.
- **On-Air** — Look Ahead preview will display the PV output for the assigned MLE. This is what would be taken to air if you transition this MLE.

For example, if you have MLE 4 on-air, the Look Ahead preview monitors will display the PGM output for MLE 1, 2, and 3. If you take MLE 3 to air, Look Ahead preview for MLE 1 and 2 will remain unchanged, but the Look Ahead preview for MLE 3 will display the PV output of MLE 3.

Look Ahead preview is configured using the Output Menu, a sample of which is shown below.

![Output Menu 1-2 — Look Ahead Preview](image)

Refer to Chapter 8, “Output Configuration”, of the Synergy Q/MD or Q/MD-X Engineering Manual for detailed instructions on how to set up a Look Ahead preview.
Fade to Black

The following topics are discussed in this section:

- Using Fade to Black
- Changing Fade to Black Rates

Note
For information on how to set which MLEs perform a Fade to Black, refer to Chapter 8, “Output Configuration” of the Synergy Q/MD or Q/MD-X Engineering Manual.

Using Fade to Black

Note
Performing a Fade to Black will not change the audio levels on a Remote Audio Mixer. Instead, Fade to Black turns off the Master Audio Control on the Remote Audio Mixer. On most mixers this means that a light simply goes out.

The Fade to Black function of the Synergy Q/MD/X switcher allows you to cut or fade (auto-transition) the entire switcher output to black, including all downstream Keys and all effects currently on-air. The figures below show the Fade to Black Group on the various Synergy Q/MD/X control panels.

The following figure shows the Fade to Black Group on a Synergy 2.5 Q/MD, 2.5, 3, 3.5 and 4 Q/MD-X control panel.

The following figure shows the Fade to Black Group on a Synergy 1.5, 2 Q/MD, and 2 Q/MD-X control panel.
The following figure shows the **Fade to Black Group** on a **Synergy 1 Q/MD** control panel.

1. **Cut to Black**
   Press **CUT** to instantly cut the switcher output to black. When the switcher is in black, press **CUT** again to cut the switcher back to the previous full on-air program output.

2. **Fade to Black**
   Press **FADE** to fade (auto transition) the switcher output to black, using the assigned fade-to-black rate. When the switcher is in black, press **FADE** again to fade the switcher up from black — back to the previous full on-air program output.

3. **Display**
   The 3-digit display shows the current fade-to-black transition rate, as entered in the **Global Memory System Group**.

   **Note**  
   Once the switcher is in black, it *stays* in black until the **FADE** or **CUT** button is pressed again.

The following operational points apply when working with the **Fade to Black** function:

- When the switcher is in black, the **FADE** button stays lit to indicate that the switcher is in full **Fade to Black** mode. In addition, any on-air tally LEDs and any active Keyer LEDs (that were previously lit in the on-air mode) will *flash* — as an extra “attention-getting” indication of the switcher mode.
If you are performing a long **FADE** (either *to* or *from* black) and you wish to change your mind, there are two options:

- Press **FADE** *again* (during the fade transition) to reverse direction — and return to the starting point (full program or full black).
- Press **CUT** to complete the transition, in the current direction.

## Changing Fade to Black Rates

Use the following procedure to change **Fade to Black** auto transition rates:

1. Note the current Fade to Black auto transition rate, as shown in the **Fade to Black Group** display.

   ![Note]

   The fade-to-black rate will be shown in the **Global Memory System Group** for the Synergy 1.

2. Press **FADE RATE** in the **Global Memory System Group**.

   ![Operating Tip]

   If you want to clear the rate and cancel the procedure, press the **FADE RATE** button *during* the entry process. If you want to enter a *different* rate before pressing **ENTER**, continue to type until the desired value appears.

3. Using the keypad in the **Global Memory System Group**, enter the desired fade-to-black rate in frames (from 1 to 999).

   The rate appears on the top line of the display, and the **ENTER** button lights.

   ![New FTB Rate:015]

   M:015   D:008   F:20

   REG:00  Memory0

   M:015   D:008   F:20

4. Press the **ENTER** button to accept the new rate.

   The display updates as shown below, the **ENTER** light turns off, and the new rate is available for use.

   ![REG:00 Memory0]

   M:015   D:008   F:20

For the **Synergy 2, 3, and 4** control panels, the display in the **Fade to Black Group** also updates.

This completes the procedure for changing the **Fade to Black** auto transition rates.
Using SmartConversion

Synergy Q/MD/X switchers can operate with high-definition (in a wide variety of formats) as well as standard-definition video. To mix video signals, Synergy Q/MD/X switchers require all video signals to be in the same format. This means that mixing standard and high-definition video requires a conversion to one of the formats (such as converting standard-definition to high-definition).

Converting Video

SmartConversion uses an expandable approach to video format conversion. Typically, not all the video sources in your switcher need to be converted simultaneously as it would be a rare case to need all video sources on-air at the same time. Thus, you can have fewer converters than video sources and route only those that need conversion at the present time through the converters. As video sources are taken on and off-air, converters become busy and free depending on the number of sources that need conversion at one time. Optimizing the number of converters to the expected number of simultaneous video conversions you require allows you to realize a significant cost savings over having to purchase one converter for every video input.

SmartConversion utilizes external up/down converters to handle video format conversion. This allows you the freedom to select up/down converters that best meet the needs of your facility. You can add converters at any time and can use up to 32 up/down converters with a Synergy Q/MD/X switcher.

SmartConversion operates automatically with little user intervention required. When you select a source on an MLE or Aux Bus that has not been disabled from using SmartConversion, the Synergy Q/MD/X switcher automatically determines if there is a video format mismatch between the selected source and the MLE or Aux Bus output formats. If there is a video format mismatch, an appropriate Conversion Loop is used to convert the input source to the correct output format to match the MLE or Aux Bus.

Sometimes, you may need to manually specify some SmartConversion settings or see a report of SmartConversion resource usage. These items are quickly accessible at any time during a production via the Smart Conversion Runtime Menu.

Note

SmartConversion must be configured before being used. Refer to the Chapter, “SmartConversion™” in the Synergy Q/MD or Q/MD-X Engineering Manual for more information.

Overriding Input Format

Occasionally, the video stream provided to an input BNC will not match the video format specified for it. Rather than re-defining that input BNC through the Installation Menus, you can override it during production.

Use the following procedure to override the video format of a specific input BNC:

Important

Care should be taken when overriding video formats for sources that are currently on-air. If you are overriding an on-air source, a warning message will be displayed.

1. Double-press the Crosspoint Button on the appropriate MLE or Aux Bus for the video source you wish to access SmartConversion settings for.
The Video Correction Menu 1-2 is displayed.

![Video Correction Menu 1-2]

2. Press Smart Conversion to display the Smart Conversion Runtime Menu.

![Smart Conversion Runtime Menu]

3. Override the input BNC video format using one of the two methods as follows:
   - If the desired video format is listed on the screen as one of the soft-keys, press that key to quickly override the input video format.
   - If the desired video format is not listed, select Other and then use the Type knob to select the correct video format.

   **Note**
   The video format list shows all formats the switcher is capable of operating in at that time based on the current reference format. Refer to the section “Reference” in the Synergy Q/MD or Q/MD-X Engineering Manual, for information on setting the reference format.

This completes the procedure to override the video format of a specific input BNC.

**SmartConversion Status**

You can view the status of all SmartConversion Resources at any time. If you have configured your Synergy Q/MD/X switcher to display the number of free up/down converters in the Fade To Black Display, that number reflects the total number of available converters (without regard to Bus Disabling, Converter Locking, or conversion formats). Refer to the section “Displaying Available Converters” in the Synergy Q/MD or Q/MD-X Engineering Manual for information.

If you want a more detailed report of SmartConversion resource usage, you can view the Converter Status Menu.

Use the following procedure to access the Converter Status Menu:

1. Double-press the Crosspoint Button on the appropriate MLE or Aux Bus for the video source you wish to access Smart Conversion settings for.

   The Video Correction Menu is displayed.
2. Press **Smart Conversion** to display the **SmartConversion Runtime Menu**.

3. Press **Converter Status** to display the **Converter Status Menu**.

<table>
<thead>
<tr>
<th>Converter Status Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Converter</td>
</tr>
<tr>
<td>Brk1Http:1(1:1)</td>
</tr>
<tr>
<td>Brk1Http:2(1:2)</td>
</tr>
</tbody>
</table>

**Converter Status Menu**

The main portion of the menu screen shows a summary of SmartConversion resource usage. The following information is shown:

- **Converter** — The up/down converter (displayed as the Aux Bus that is connected to the up/down converter).
- **Input** — The name of the input source currently being converted. If the source is not currently on-air, this displays the last source that was converted and on-air.
- **In Use** — Displays **Yes** if the current source is on-air and the up/down converter is unavailable for use by another source. Displays **No** if the source is not on-air and the up/down converter is available for use.
- **Locked** — Displays the name of the bus-pair the up/down converter is locked to. If the up/down converter is not locked to a specific bus-pair, **Not Locked** is displayed.
- **Used Converters** — Displays the number of in-use up/down converters out of the total number of each specific video format.

4. Use the **Converter** knob to scroll through the list of all up/down converters.

This completes the procedure to access the **Converter Status Menu**.

**Converter Assignments**

You can also view a report detailing which converters are assigned to which bus. This report presents similar information to the **Converter Status Menu** but entries are itemized by video bus rather than by up/down converter.

Use the following procedure to access the **Converter Allocation Status Menu**:

1. Double-press the **Crosspoint Button** on the appropriate MLE or Aux Bus for the video source you wish to access SmartConversion settings for.

   The **Video Correction Menu** is displayed.

2. Press **Smart Conversion** to display the **Smart Conversion Runtime Menu**.

3. Press **Converter Status** to display the **Converter Status Menu**.

4. Press **Allocation Status** to display the **Converter Allocation Status Menu**.
The main portion of the menu screen shows a summary of SmartConversion resource usage. The information shown is:

- **Bus** — The bus that is using the converter (see next item)
- **Converter** — The up/down converter being used by the specified bus (displayed as the Aux Bus that is connected to the up/down converter).
- **Input** — The name of the input source currently being converted. If the source is not currently on-air, this displays the last source that was converted and on-air.

5. Use the **Bus** knob to scroll through the list of all buses.

<table>
<thead>
<tr>
<th>Converter</th>
<th>Allocation Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE3 Program</td>
<td>MLE3 Program</td>
</tr>
<tr>
<td>MLE3 Preset</td>
<td>MLE3 Preset</td>
</tr>
<tr>
<td>MLE3 K1 Video</td>
<td>MLE3 K1 Video</td>
</tr>
<tr>
<td>MLE4 Program</td>
<td>MLE4 Program</td>
</tr>
<tr>
<td>MLE4 K1 Video</td>
<td>MLE4 K1 Video</td>
</tr>
</tbody>
</table>

**Note**

Only buses that are currently using an up/down converter are shown.

This completes the procedure to access the **Converter Allocation Status Menu**.
Background Transitions

In This Chapter

Background transitions are the most frequently used switcher operation. The simplest transition is a direct selection of the next picture on the PGM bus, performed by pressing another crosspoint. This simple “cut” provides an instantaneous change, but does not allow you to preview the next picture.

Other types of transitions involve the PST bus and the controls in the Program/Preset Transition Group and the MLE Transition Group. For the Synergy 1 Q/MD, 2 Q/MD or Q/MD-X, 3 Q/MD-X and 4 Q/MD-X you can use cuts, dissolves, wipes, as well as DVE “send” transitions and you have a full preview of the upcoming picture. For the Half MLE Q/MD/X switchers, the Synergy 1.5 Q/MD, 2.5 Q/MD or Q/MD-X and the 3.5 Q/MD-X, you are limited to cuts and dissolves in the Program/Preset Transition Group.

The following topics are discussed in this chapter:

- Transition Group
- Using Manual Transitions
- Using Cut Transitions
- Using Dissolves
- Working with Next Transitions
- Auto Transitions
- Preset Black
- Transition Preview
- Key Over
- Transition Limit
Transition Group

Each Synergy Q/MD/X switcher includes one Program/Preset Transition Group that is located in the highest-numbered MLE (the MLE at the bottom) of the control panel. The layout and functionality of the transition group varies depending on whether you have a Synergy 1 or a Synergy 2, 3 or 4, and whether you have a Full MLE or a Half MLE system.

Synergy 1 Transition Group

The single Transition Group on the Synergy 1 Q/MD control panel allows you to perform Background, Key and DSK transitions, along with other functions, from this one location.

The following illustration shows the Program/Preset Transition Group for the Synergy 1 control panel.

1. **Fader Section**

   The **Fader** handle is used to perform manual transitions. The “type” of transition is based on the transition button that is selected in the Transition Parameter Section — Dissolve, Wipe or DVE Send. The **Fader** performs one complete transition when it is moved from one limit to the other. Due to the flip-flop architecture of the switcher, it does not matter at which limit the transition begins. The BKGD bus always remains the program output.

   Two LED indicators (Up arrow, Down arrow) located to the left of the **Fader** show the direction of **Fader** travel during a transition. For full or partial transitions (when the **Fader** is paused part-way through), the arrow that is lit indicates the direction that the **Fader** must be moved in order to complete the transition.

2. **Next Transition Section**

   The **Next Transition Section** includes five buttons that allow you to select the combination of actions that will be included in the next transition. When pressed, the output video is not affected — only the actions in the next transition are affected. All buttons are latching toggles and can be enabled in a number of combinations, as follows:
The **BKGD** button will select a transition between the **BKGD** and **PST** buses. When a manual or auto-transition is performed, the video selected on the **PST** will transition to the **BKGD**.

- The **KEY 1** or **KEY 2** button will select a transition of the first or second MLE Keyer.
  - If the Keyer is currently **Off**, the transition brings on the Key and the **ACTIVE** indicator directly below the button lights red.
  - If the Keyer is currently **On**, the transition removes the Key and the **ACTIVE** indicator directly below the button turns off.

- If you have the MultiDSK option installed these two buttons select a transition of the first or second Downstream Keyer.

  Remember that any combination of actions can be selected. Refer to the section “**Working with Next Transitions**” on page 5–12 for information on the **Next Transition** buttons and the **ACTIVE** indicators.

### 3. Transition Parameter Section

The buttons in the **Transition Parameter Section** allow you to choose the type of transition, the various transition attributes, and initiate the transition itself.

- The **PST BLACK** button is a special two-stage transition that takes the switcher to black (or any other desired source), and then proceeds to the next transition previously indicated.
  - The **Preset Black** effect is the default state of the **PST BLACK** that causes the **BLACK** to be selected on the **PST** Bus, replacing the currently selected PST source. Refer to the section “**Preset Black**” on page 5–17 for details.

- The **ROLL VTR** button allows you to roll or “arm” a serial controlled device (such as a VTR, Video Server, or Audio Server) that has been selected on an MLE. The button is located in all transition groups.

  The function of the **ROLL VTR** button is determined by the **Roll VTR Mode** setting on the **Personality Menu**:
  - If the **Roll VTR Mode** is set to **Play**, pressing **ROLL VTR** immediately plays the serial device(s) selected in the transition area (one device per bus) on the MLE. Here, the button is **momentary**. The transition that brings on the device(s) is initiated manually with the **Fader**, automatically using **CUT** or **AUTO TRANS**, or via an external editor.
  - If the **Roll VTR Mode** is set to **Arm**, pressing **ROLL VTR** arms the switcher for a transition. When the transition is initiated by pressing a crosspoint on the **PGM** bus, with the **Fader**, **CUT** or **AUTO TRANS**, or an external editor command, the device(s) (one device per bus) rolls and is automatically taken to air after the preroll interval has elapsed. In Arm mode, the **ROLL VTR** button is **latching**, and it remains latched until toggled off manually.

---

**Operating Tip**

You can select *more than one* transition to occur during the next transition by pressing the associated buttons simultaneously. For example, if you want to transition Key 2 and the Background simultaneously, press the **KEY 2** and **BKGD** buttons at the same time. Both buttons will light up.
In order to roll a VTR, the following prerequisites must be met first:

~ The device must be connected to the control panel remote port via RS-422 or RS-232 serial communications.

~ The input “type” must be set to VTR, and the proper communications parameters must be set on the Communications Menu.

~ Depending upon the device(s), the VTR Remote Control Option, Video Server Control Option, or the Audio Server Control Option must be installed as appropriate. Any combination of the three options can be installed.

~ The VTR must be chosen on either the PGM, PST, or KEY bus.

**Note**

If the VTR is not selected on either the PGM, PST, or KEY bus and you press ROLL VTR, no action will be taken.

Refer to the section “VTR Clip Control” on page 14–2 for detailed instructions on programming and running VTR, Video Server, and Audio Server clips.

- The TRANS PV (transition preview) button allows you to rehearse any preset-to-background transition without affecting the program output. Refer to the section “Transition Preview” on page 5-17 for details.

- The KEY OVER button allows you to change the priority of the Key 1 and Key 2. Normally, Key 2 will always appear over top of Key 1. Key Over allows you to place Key 1 over Key 2. Refer to the section “Key Over” on page 5-19 for details.

- The TRANS LIMIT button allows you to stop a transition at a preset position, between the two absolute Fader limits. Refer to the section “Transition Limit” on page 5-20 for details.

- The DISS button selects a dissolve as the transition type. When the dissolve is performed, the video on the PST bus gradually mixes into the video on BKGD. At the end of the transition, PST video completely replaces BKGD video and the buses flip-flop. The DISS button is mutually exclusive with the WIPE and DVE SEND buttons. Refer to the section “Using Dissolves” on page 5-11 for instructions.

**Note**

When you press AUTO TRANS in MLE Key Group 1 or 2, the DISS button lights in the Transition Group. Refer to the section “Using MLE Keys” on page 7–21 for more information.

- The WIPE button selects a wipe as the transition. When performed, the video on the PST bus gradually replaces BKGD video using a wipe chosen from the Pattern Control Group. At the end of the transition, PST video completely replaces BKGD and the buses flip-flop. The WIPE button is mutually exclusive with the DISS and DVE SEND buttons. Refer to the section “User Wipes” on page 6–12 for more information.

- The DVE SEND button assigns control of the internal Squeeze & Tease DVE to the Transition Group. The DVE Send button allows you to control the DVE effect with the Fader or AUTO TRANS button. The DVE SEND button is mutually exclusive with DISS and WIPE.

- The CUT button performs an instantaneous “cut” between the PST and BKGD bus sources. The buses flip-flop after the cut is performed. The button itself is *momentary* and stays lit only *during* the transition.
For dissolves, wipes and DVE sends, **AUTO TRANS** performs an automatic transition between the PST and BKGD buses. The button is *momentary* and stays lit only *during* the transition.

**Note**

When you press **AUTO TRANS** in Key 1 Group or Key Group 2, the **AUTO TRANS** button lights in the Transition Group as well.

In the **Global Memory System** group, the bottom left hand field in the display (M:###) indicates the current *auto-transition* rate (in frames). The **Global Memory System Group** is also the location where the rate is programmed.

**Global Memory System Display**

**Synergy 2, 3, and 4 Transition Group**

Each control panel includes *one or more MLE Transition Groups* and a **Program/Preset Transition Group**. The **MLE Transition Groups** are located in the upper MLEs of the control panel, and the **Program/Preset Transition Group** is located with the Program/Preset Bus.

![MLE Transition Group](image)

![Program/Preset Transition Group](image)
1. **Fader Section**

The Fader handle is used to perform manual transitions. The “type” of transition is based on the transition button that is selected in the Transition Parameter Section — Dissolve, Wipe or DVE Send. The Fader performs one complete transition when it is moved from one limit to the other. Due to the flip-flop architecture of the switcher, it does not matter at which limit the transition begins. The BKGD or PGM bus always remains the program output.

Two LED indicators (Up arrow, Down arrow) located to the left of the Fader show the direction of Fader travel during a transition. For full or partial transitions (when the Fader is paused part-way through), the arrow that is lit indicates the direction that the Fader must be moved in order to complete the transition.

Above the Fader (in the Program/Preset Transition Group only), the display indicates the current auto-transition rate (in frames) for the group. This rate is programmed in the Global Memory System Group.

**Note**

When a DSK transition is performed within a DSK Keyer, the display above the Fader briefly updates with the rate of the transition for the selected DSK. Once the transition has completed, the display returns to the MLE transition rate. Refer to the section “Using Downstream Keys” on page 7–50 for details.

2. **Next Transition Section**

The Next Transition Section includes three buttons that allow you to select the combination of actions that will be included in the next transition.

All three buttons are latching toggles and can be enabled in any combination. When pressed, the output video is not affected — only the actions in the next transition are affected.

- **Enable BKGD** to include a transition between the PGM and PST buses (in the Program/Preset Transition Group), or between the BKGD and PST buses (in the MLE Transition Group). When a transition is performed, the video selected on PST transitions to PGM.

- **Enable DSK 1** (in the Program/Preset Transition Group) or **KEY 1** (in the MLE Transition Group) to perform a transition of the first Keyer of the MLE.

  ~ If the Keyer is currently off, the transition brings on the Key, and the ACTIVE LED directly below the button lights red or green.

  ~ If the Keyer is currently on, the transition removes the Key, and the ACTIVE LED below turns off.

Refer to the section “Working with Next Transitions” on page 5–12 for more information on the ACTIVE LEDs.

**Note**

When you press AUTO TRANS in DSK 1, the DSK 1 button lights during the transition interval to indicate a DSK transition in progress. Similarly, when you press AUTO TRANS in MLE Key Group 1, the KEY 1 button lights. Refer to the section “Using MLE Keys” on page 7–21 for more information.
• Enable DSK 2 (in the Program/Preset Transition Group) or KEY 2 (in the MLE Transition Group) to perform a transition of the second Keyer of the MLE.
  ~ If the Keyer is currently off, the transition brings on the Key, and the ACTIVE LED lights red or green.
  ~ If the Keyer is currently on, the transition removes the Key, and the ACTIVE LED turns off.

Remember that any combination of actions can be selected. Refer to the section “Working with Next Transitions” on page 5-12 for information on the three Next Transition buttons and the two ACTIVE LEDs.

3. Transition Parameter Section

The buttons in the Transition Parameter Section allow you to choose the type of transition, various transition attributes, and initiate the transition itself. The arrangement of buttons in the two transition groups is virtually identical, exceptions are noted below:

• The PST BLACK button is a special two-stage transition that takes the switcher to black (or any other desired source), and then proceeds to the next transition previously indicated.
  ~ The Preset Black effect is the default state of the PST BLACK that causes the BLACK to be selected on the PST Bus, replacing the currently selected PST source. Refer to the section “Preset Black” on page 5–17 for details.

• The ROLL VTR button allows you to “play” or “arm” a serial controlled device (such as a VTR, Video Server or Audio Server) that has been selected on an MLE. The button is located in both types of transition groups.

The function of the ROLL VTR button is determined by the Roll VTR Mode setting on the Personality Menu as follows:

  ~ If the Roll VTR Mode is set to Play, pressing ROLL VTR immediately plays the serial device(s) selected in the transition area (one device per bus, including device(s) from a re-entered MLE) on the MLE. Here, the button is momentary. The transition that brings on the device(s) is initiated manually with the Fader, automatically using CUT or AUTO TRANS, or via an external editor.  

  ~ If the Roll VTR Mode is set to Arm, pressing ROLL VTR arms the switcher for a transition. When the transition is initiated by pressing a crosspoint on the PGM bus, with the Fader, CUT or AUTO TRANS, or an external editor command, the device(s) (one device per bus, including device(s) from a re-entered MLE) rolls and is automatically taken to air after the preroll interval has elapsed. In Arm mode, the ROLL VTR button is latching, and it remains latched until toggled off manually.

In order to roll a VTR, the following prerequisites must be met first:

  ~ The device must be connected to the control panel remote port via RS-422 or RS-232 serial communications.
  ~ The input “type” must be set to VTR, and the proper communications parameters must be set on the Communications Menu.

Note: When you press AUTO TRANS in DSK 2, the DSK 2 button lights during the transition interval to indicate a DSK transition in progress. Similarly, when you press AUTO TRANS in MLE Key Group 2, the KEY 2 button lights. Refer to the section “Using MLE Keys” on page 7–21 for more information.
Depending upon the device(s), the VTR Remote Control Option, Video Server Control Option, or the Audio Server Control Option must be installed as appropriate. Any combination of the three options can be installed.

The device must be chosen on the selected MLE — on any bus. Re-entry selections are also permitted.

Refer to the section “VTR Clip Control” on page 14–2 for detailed instructions on programming and running VTR, Video Server, and Audio Server clips.

- The **TRANS PV** (transition preview) button is located in the MLE Transition Group only. This effect allows you to rehearse any preset-to-program transition without affecting the selected program output of the MLE. Refer to the section “Transition Preview” on page 5-17 for details.

- The **KEY OVER** button is located in the MLE Transition Group. This effect allows you to change the priority of Key 1 and Key 2 for an MLE as a transition, rather than as a cut. Refer to the section “Key Over” on page 5-19 for details.

- The **TRANS LIMIT** button (located in the MLE Transition Group only) allows you to stop a transition at a preset position — in between the two absolute Fader limits. Refer to section “Transition Limit” on page 5–20 for details.

- The **DISS** button (located in both transition groups) selects a dissolve as the transition type. When the dissolve is performed, the video on the PST bus gradually mixes into the video on BKGD or PGM. At the end of the transition, PST video completely replaces BKGD or PGM video, and the buses flip-flop. The DISS button is mutually exclusive with the WIPE and DVE SEND buttons. Refer to the section “Using Dissolves” on page 5-11 for instructions.

- The **WIPE** button (located in both transition groups) selects a wipe as the transition. When performed, the video on the PST bus gradually replaces BKGD or PGM video using a wipe chosen from the Pattern Control Group. When finished, PST video completely replaces BKGD or PGM, and the buses flip-flop. The WIPE button is mutually exclusive with the DISS and DVE SEND buttons. Refer to the section “User Wipes” on page 6–12 for more information.

- The **DVE SEND** button (located in both transition groups) assigns control of the internal Squeeze & Tease DVE to the Transition Group. The DVE Send button allows you to control the DVE effect with the Fader or AUTO TRANS button. The DVE SEND button is mutually exclusive with DISS and WIPE.

- The **CUT** button (located in both transition groups) performs an instantaneous “cut” transition between the PST and PGM (BKGD) bus sources. The buses flip-flop after the cut is performed. The button itself is momentary — it does not stay lit.

---

**Note**

When you press AUTO TRANS in DSK 1 or DSK 2, the DISS button in the Program/Preset Transition Group lights during the transition interval to indicate a DSK transition in progress. Similarly, when you press AUTO TRANS in MLE Key Group 1 or 2, the DISS button lights in the MLE Transition Group. Refer to the section “Using MLE Keys” on page 7–21 for more information.

**Note**

The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) can only perform a cut or a dissolve in the Program/Preset Transition Group.
• For dissolves, wipes and DVE sends, **AUTO TRANS** performs an automatic transition between the PST and BKGD buses. The button is *momentary* and stays lit only *during* the transition.

  ~ For Program/Preset auto-transitions, rates are entered in the **Global Memory System Group**.

  ~ For auto-transitions in the **MLE Transition Group**, rates are entered in the **Memory System Group** for that MLE.

• For convenience, the rate is shown in two places, the display above the **Fader** in the Program/Preset Transition Group, and the bottom left hand field in the **Global Memory System Group**.

**Global Memory System Display**

<table>
<thead>
<tr>
<th>Field</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>REG:00</td>
<td>Memory0</td>
</tr>
<tr>
<td>M:015</td>
<td>D:008</td>
</tr>
<tr>
<td>F:20</td>
<td></td>
</tr>
</tbody>
</table>

**Note**

When you press **AUTO TRANS** in DSK 1 or DSK 2, the **AUTO TRANS** button (in the Program/Preset Transition Group) lights during the transition interval to indicate a DSK transition in progress. Similarly, when you press **AUTO TRANS** in MLE Key Group 1 or 2, the **AUTO TRANS** button lights in the MLE Transition Group.

Refer to the section “Auto Transitions” on page 5-14 for additional information, and instructions for changing auto transition rates.

## Using Manual Transitions

A manual transition is performed when you use the **Fader**, in any **Transition Group**, to perform the desired transition. As with an **Auto Transition** or a **Cut**, this transition can involve nearly any combination of **Key 1**, **Key 2** (DSK 1 and DSK 2 on the PGM/PST MLE) and the **Background**. The rate at which the transition is performed is determined by the speed at which you move the fader from one limit to the other.

Use the following procedure to perform a manual background transition:

**Operating Tip**

Remember to set the Preview Bus to the MLE you are working in so that you can see what you are going to take on-air with the next transition. Refer to the section “Using the Preview Bus” on page 4–35 for more information.

1. Select a crosspoint on the **PGM** bus of an MLE.
2. Select a different crosspoint on the **PST** bus of the same MLE.
3. In the **Next Transition Area** of the **Transition Group** for the MLE, select **BKGD** as the next transition.
4. In the **Transition Parameter Area** of the **Transition Group** for the MLE, select either **DISS** (Dissolve) or **WIPE** as the transition type.
5. Move the **Fader** from its current limit to the opposite limit. The speed at which you move the **Fader** determines the manual transition rate.

Remember that during a transition, the two LED indicators (Up arrow, Down arrow) show the direction of **Fader** travel — specifically, the direction that the **Fader** must be moved in order to complete the manual transition.
Using Cut Transitions

A Cut is an instantaneous transition involving any combination of Key 1, Key 2 (DSK 1 and DSK 2 on the PGM/PST MLE) and the Background.

Use the following procedure to perform a background Cut:

1. Select a crosspoint on the PGM bus of an MLE.
2. Select a different crosspoint on the PST bus of the same MLE.
3. In the Next Transition Area of the Transition Group for the MLE, select BKGD as the next transition. This tells the switcher to transition the PST/PGM buses at the next transition.
4. Press CUT. The crosspoints selected on the PGM and PST buses instantly exchange and the buses flip-flop.
5. Press CUT again to repeat the process and restore the original background.

Operating Tip

Remember to set the Preview Bus to the MLE you are working in so that you can see what you are going to take on-air with the next transition. Refer to the section “Using the Preview Bus” on page 4–35 for more information.

Operating Tip

You can also perform a background cut simply by switching inputs on the PGM bus itself. This type of cut does not allow you to preview the what you are cutting on-air.

This completes the procedure for performing a background cut.
Using Dissolves

Auto Transitions can be performed in any MLE. In a Background Dissolve transition, the **PGM (BKGD)** bus video and **PST** bus video signals are gradually mixed together until the **PST** bus video completely replaces the **PGM** bus video.

Use the following procedure to perform a background Dissolve:

1. Select a crosspoint on the **PGM** bus of an MLE.
2. Select a different crosspoint on the **PST** bus of the same MLE.
3. In the Next Transition Area of the Transition Group for the MLE, select **BKGD** as the next transition. This tells the switcher to transition the **PST/PGM** buses at the next transition.

### Operating Tip

Remember to set the Preview Bus to the MLE you are working in so that you can see what you are going to take on-air with the next transition. Refer to the section “Using the Preview Bus” on page 4–35 for more information.

4. Press **DISS** in the Transition Parameter Area of the Transition Group for the MLE.
5. Press **AUTO TRANS** to perform the transition automatically. The transition can also be performed manually using the **Fader**.

### Note

If a very short Auto Transition rate is selected (typically five frames or less), this may appear the same as a cut. This type of transition is often called a soft cut. Refer to the section “Changing MLE Auto Transition Rates” on page 5-16 for information on how to set the transition rate.

During the dissolve, the **ON AIR** indicators at the end of both the **PGM** and **PST** buses will be lit. This is because the **PST** bus video signal is gradually mixing into the **PGM** video signal. At this point both buses are contributing to the switcher output. At the end of the dissolve, after the flip-flop, only the **PGM ON AIR** LED will be lit.
MLE Setup and Monitor Outputs — During the DISSOLVE

At the end of the transition, the PST video completely replaces the PGM video, and the buses flip-flop.

MLE Setup and Monitor Outputs — After the DISSOLVE

Note

You cannot press CUT (in the MLE Transition Group) when the Fader is off limit. Unless the Fader is at one of the limits, a manual transition is in progress and no other transition can be performed until it is complete.

Working with Next Transitions

The Next Transition Area includes three buttons that allow you to select the combination of actions that will be included in the next transition. The section also includes two ACTIVE indicators that show the state of the associated Key.

The figures below illustrate the three “next transition” buttons and LEDs — as they appear in each location on your panel:

The three buttons define what you want to change on your PGM output. Any combination of the Background and two Keys can be changed. You can change one, two, or three elements as desired by pressing the appropriate combination of buttons. The buttons and ACTIVE indicators work as follows:

- If a button is lit, that element will change when the transition is performed, either manually (with the Fader), or automatically (with the AUTO TRANS or CUT button).
When the transition has completed, buttons that are lit will *stay lit* until you change them.

**Note**

A “lit” *Key* button should *not* be confused with the fact that you want a Key to appear on air. Instead, it means that you want to *change* the *state* of the Key. If a Key button is lit, the Key will change states. If the state of the Key is on-air, the associated *ACTIVE* indicator will be lit red or green.

- Each *ACTIVE* indicator has three states:
  - **Off** — When the indicator is *Off*, the associated Key is off-air and is *not* contributing to the output of the MLE or the switcher.
  - **Green** — When the indicator is lit *Green*, the associated Key is contributing to the output of the *MLE only* but is *not* on-air. This means that the Key is active on the MLE, but that MLE is not contributing to the Program output of the switcher.
  - **Red** — When the indicator is lit *Red*, the associated Key is contributing to the Program output of the entire switcher and is on-air.

- The appearance (and state) of each *ACTIVE* indicator is duplicated by the *ON* indicators in the associated MLE Keyer Groups (including the two Downstream Keyer Groups).

**Operating Tip**

The main preview monitor output will *always* show you the next scene. For example, if a Key state is currently *on* and the desired Key button is lit, the preview monitor will not show the Key, as the Key will be *off* for the next transition.

### Eight Steps to Flawless Transitions

Using the three “next transition” buttons, the following are several steps for getting the images you want on-air:

1. Ensure that the correct MLE is selected in the *Preview Bus Group*.
2. Look at your *Program Monitor* and determine what video elements you want to change — the background, Key1, Key2 (or DSK1, DSK2), or a *combination* of these elements.
3. Press the desired next transition button(s) — BKGD, Key1, or Key2 (DSK1 or DSK2).
4. Look at the *Preview Monitor* and confirm that the desired video elements are in the desired states — Keys on, Keys off, proper background video selected.
5. If one of the Key elements is in the wrong state, press its associated next transition button, and re-confirm the new composite image on preview.
6. If you are taking a new Key on-air, ensure that the correct Key source is selected, and that it appears properly on Preview. If required, adjust the Key source(s) accordingly.
7. If the background image is wrong, select the correct image on the PST bus — or alternately, change the state of the BKGD button.
8. Once you have confirmed that the next image is correct on *Preview*, perform the transition — either manually with the *Fader*, or automatically using *CUT* or *AUTO TRANS*. Remember that the next transition buttons stay lit after the transition is complete.
Auto Transitions

The **AUTO TRANS** button is used to start an automatic (smooth) transition between the selected PST and PGM bus signals. Any **Auto Trans** is governed by the following rules:

- An auto transition, once in progress, cannot be reversed.
- To finish an auto transition in progress, you can either press **CUT**, or manually move the **Fader** to the opposite limit. Either action will quickly complete the transition.
- You cannot initiate an **AUTO TRANS** or a **CUT** if the **Fader** is off its upper or lower limit.

![Note](image)

During an auto transition, if the **Fader** is moved, the transition will freeze until the **Fader** is moved to the opposite limit.

The Auto Transition rate for any of the **Transition Groups** can be changed from the **Global Memory System Group** or from the **MLE Memory System Groups** for the upper MLEs.

Setting the Rate From the Global Memory System Group

The Keyer and MLE rates for an MLE can also be set from the **Global Memory System Group**. Use the following procedure to set the transition rates for an MLE from the Global Memory System Group:

1. Press and hold the **DSK RATE** (Key Rate), or **MLE RATE** button on the **Global Memory System Group**. The **MLE** button on the **Recall** area indicated which MLE you are currently setting the rate for.
2. Press the **MLE X** button in the **Store** or **Recall** area of the **Global Memory System Group** to set the rate for that MLE, where **X** represents the MLE number. You cannot use the **ALL** button to set the rate across multiple MLEs at the same time. The selected MLE is shown on the top line of the display.
3. Use the keypad in the center of the **Global Memory System Group** to enter the new duration, in frames. The new rate appears on the top line of the display as you enter it.
4. Press **ENTER** on the **Global Memory System Group** to accept the new rate.

This completes the procedure for setting the transition rates for an MLE from the Global Memory System Group.

Changing Program/Preset Auto Transition Rates

The auto transition rate for the **PGM/PST Transition Group** can only be set from the **Global Memory System Group**. This group can also be used to set the auto transition rate for any of the MLEs.

The **PGM/PST Transition Group** is the only one that displays the auto transition rate above the **Fader**, as shown below.
Use the following procedure to change the auto transition rate in the Program/Preset Transition Group:

1. Press the RATE button for the highest-numbered MLE in the Global Memory System Group. These will be as follows for the corresponding control panels:
   - Synergy 1 — MLE 1 RATE
   - Synergy 2 — MLE 2 RATE
   - Synergy 3 — MLE 3 RATE
   - Synergy 4 — MLE 4 RATE

2. Use the keypad to enter the desired rate in frames — from 1 to 999. The rate appears on the top line of the display as you type and the ENTER button lights up.

3. Press ENTER to accept the new rate.

   The display will return to its normal format and the new auto transition rate will appear in the bottom left corner, as indicated in the illustration below:

To cancel the change after you have started entering it, press the MLE RATE button again.

To enter a different rate after you have started entering it, continue to enter the new rate until the desired value is displayed.

This completes the procedure for changing the auto transition rate in the Program/Preset Transition Group.
Changing MLE Auto Transition Rates

The auto transition rate for the MLE Transition Groups can be set from either the Global Memory System Group or the MLE Memory System Group.

Note

On the Synergy 1 and 2 control panels there is no MLE Memory System Group. For these you will have to use the Global Memory System Group.

MLE Memory System Group

Use the following procedure to change auto transition rates in the MLE Transition Group:

1. Press the MLE RATE button on the corresponding MLE Memory System Group.
2. Use the keypad to enter the desired rate in frames — from 1 to 999. The rate appears on the top line of the display as you type and the ENTER button lights up.

Note

The time duration of a frame rate will vary, depending on the type of video format the switcher is running in. Refer to the section “Using Frame and Field Information” in the Synergy Q/MD or Q/MD-X Engineering Manual for more information.

MLE Memory System Group

Auto Transition Rate

Note

To cancel the change after you have started entering it, press the MLE RATE button again.
To enter a different rate after you have started entering it, continue to enter the new rate until the desired value is displayed.

3. Press ENTER to accept the new rate.

The display will return to its normal format and the new auto transition rate will appear in the bottom left corner, as indicated in the illustration below:

New Auto Transition Rate

This completes the procedure for changing auto transition rates in the MLE Transition Group:
Preset Black

The Preset Black (PST BLACK) function is a special two-stage transition that allows you to take the switcher to black (or any other desired source) with the first transition, and then proceed to the next transition indicated. The function is quite useful for dipping the switcher quickly to black, or transitioning to a commercial.

Note

This feature is only available in the Program/Preset Transition Group.

In a default state, pressing PST BLACK causes the BLACK crosspoint to be selected on the PST bus, replacing the currently selected PST source. The three buttons in the Next Transition Section may change, depending on what is currently on air.

There are three stages to the PST Black transition as follows:

1. When you press PST BLACK, the switcher presets a dissolve to black. If a Key (or both Keys) is on, but they are not set to be transitioned in the next transition (the next transition buttons are not selected), the switcher automatically sets them for you.

2. The first transition dissolves the switcher to black, and dissolves all Keys off. The buttons in the Next Transition Section then change, presetting the switcher with the original preview scene. This scene now appears on Preview.

3. The second transition brings the switcher back up from black to the scene previously shown on Preview — regardless of the combination of background and Key sources selected.

Use the following procedure to perform a Preset Black transition:

1. Setup the PGM and PST shots as you want them.

2. Press PST BLACK. The preview monitor will now show a black picture, and the BLACK crosspoint button will light in the PST Bus.

3. Press AUTO TRANS, or CUT, or use the Fader to perform a transition.

   The PGM will transition to BLACK and the shot that was previously set on the PST Bus will be automatically setup back on the PST Bus.

4. Press AUTO TRANS, or CUT, or use the Fader to perform a transition.

   The PGM that is currently set to BLACK will transition to the PST and the PST BLACK button light turns off.

Operating Tip

After Step 2, a different source other than BLACK can be selected on PST. This would allow you to dip to COLOR BKGD (white, for example) to do a creative “flash-frame” transition. In addition, BLACK can be permanently overridden by holding down the PST BLACK button while selecting the desired source on the PST bus. This override can be stored to disk in the Personality register.

This completes the procedure for performing a Preset Black transition.

Transition Preview

In all MLE Transition Groups, the TRANS PV (transition preview) button allows you to rehearse a complete Preset-to-Program (PST-PGM) transition without affecting the PGM output of the selected
MLE. When TRANS PV is lit, the full transition occurs on the preview side of the MLE, leaving the
PGM output signal undisturbed. In this mode, you can create, rehearse, and preview a transition,
without affecting the program output of the MLE. With TRANS PV engaged, the Fader for the MLE
is effectively disconnected from program.

Use the following procedure to preview a transition using the Transition Preview function:

1. Ensure that your program/preview monitoring is set as needed for the selected MLE.
   Refer to the section “Using the Preview Bus” on page 4–35 for details.
2. Press the desired next transition button(s) — BKGD, Key1, or Key2 (DSK1 or DSK2).
3. Press the desired transition type button — DISS or WIPE, DVE SEND.
4. Ensure that the Fader is at one of the limits.
5. Toggle the TRANS PV button to On (it will be lit).
   The preview monitor now displays the MLE program output.
6. Use the Fader or AUTO TRANS button to preview the current effect.
7. Make any modifications desired to the combination of Keys and/or background scenes
   — without affecting the program side of the MLE. Remember the restrictions set out
   with step 2 above.
8. Finish the transition by moving the Fader to either limit or press the AUTO TRANS
   button.
9. Toggle the TRANS PV button to Off.
   The preview monitor reverts to the standard preview mode.

If you take the transition to air, the same transition will be shown on the PGM signal. The program
output of the MLE shows the exact effect as previewed on the preview monitor (using Transition
Preview mode).

Note

If you wish to preview a transition that involves a Key in your next transition only DISS and WIPE transitions can be previewed.

Note

The TRANS PV button cannot be enabled or disabled when the Fader
(or AUTO TRANS button) is off a limit. This restriction prevents an
effect from popping into or out of the MLE PGM signal.

Note

The Transition Preview mode works regardless of whether the MLE
is on-air or not. It is also highly recommended for previewing
complete effects and, in fact, is critically important for previewing
DVE SEND effects.

Previewing a Transition in the PGM MLE

The PGM MLE does not have a dedicated TRANS PV button. Rather, a combination of buttons must
be pressed to initiate a Transition Preview. This works in the same manner as the Transition Preview
feature described previously, only you must press and hold the transition button while using the Fader
or AUTO TRANS button. A Transition Preview can include any combination of background and
DSKs.
Use the following procedure to utilize the **Transition Preview** in the PGM MLE:

1. Select the desired **Next Transition** button or buttons, depending on which video elements you want to change.
2. Ensure that the **Fader** is at an upper or lower limit. This restriction prevents an effect from **popping** into or out of the MLE program video.
3. Press and **hold** either the **DISS**, **WIPE** or **DVE SEND** button in the **PGM MLE Transition Group**.

   **Note**  
   It is recommended that you wait until the *preview monitor* displays the MLE program output before proceeding to the next step.

4. Use the **Fader** or **AUTO TRANS** button to preview the current effect.
5. Release the transition button you pressed in step 4.

This concludes the procedure to utilize the **Transition Preview** in the PGM MLE.

**Key Over**

The **Key Over** effect changes the visual priority of **Key 1** and **Key 2**. Normally, **Key 1** is created upstream of **Key 2**, meaning that **Key 2** will appear visually over **Key 1**. When the **Key Over** effect is used, **Key 1** will appear visually over **Key 2**.

   **Note**  
   The **Key Over** effect works *only* when both Keys in an MLE are **On**. If only one Key is on, the **KEY OVER** button will not light.

There are two **KEY OVER** buttons per upper MLE. One **KEY OVER** button is located in the **MLE Transition Group**, and the other in the **Key 1 Group**. These two buttons function as follows:

- **Key 1 Group** — The **KEY OVER** button in the **Key 1 Group** changes the visual priority of **Key 1** from upstream of **Key 2** to downstream. This change is handled as a **cut** as follows:

  ~ When the **KEY OVER** button is toggled **Off**, **Key 2** appears visually over **Key 1**.

  ~ When the **KEY OVER** button is **On**, **Key 1** appears visually over **Key 2**.
• **MLE Transition Group** — The **KEY OVER** button in the MLE Transition Group changes the visual priority of the two Keyers of an MLE as an effect, rather than as a cut.

Use the following procedure to perform a **Key Over** transition from the **MLE Transition Group**:

1. Ensure that both MLE Keyers are on.
2. Select the desired **DISS** or **WIPE** transition.
3. Toggle the **KEY OVER** button to **On**.
4. Use the **Fader** or **AUTO TRANS** to perform the transition.

**Note**

The **KEY OVER** button stays lit after the **Key Over** transition has completed to indicate that **Key Over** is active.

The **Key Over** effect can be regarded as another type of **next transition**, that is mutually exclusive with the **BKGD**, **KEY 1**, and **KEY 2** buttons. When **KEY OVER** is pressed, all three **next transition** buttons automatically turn off.

**Transition Limit**

The **TRANS LIMIT** (transition limit) button, located in the **MLE Transition Group**, allows you to stop a transition at a preset position between the two absolute **Fader** limits.

Use the following procedure to set up a **Transition Limit** effect:

1. Ensure that the correct MLE is selected in the **Preview Bus Group**.
2. Move the **Fader** to the upper or lower limit, this will be the start position. The **Fader** must be returned to this position in a subsequent step.
3. Select a dissolve or wipe, or DVE Send as your next transition.
4. Move the **Fader** and stop it at the desired position as follows:
   - **Dissolve** — Visually set the desired mix (superimposition) between the **PGM** and **PST** signals.
   - **Wipe** — Visually set the desired position between the **PGM** and **PST** signals.
   - **DVE Send** — Visually set the desired position or mix (superimposition) between the **PGM** and **PST** signals.
5. Leave the **Fader** at this position and press the **TRANS LIMIT** button in the same **MLE Transition Group**.

   The **TRANS LIMIT** button lights **momentarily**, and the **Fader** position is stored.
6. Move the **Fader** back to the start position selected in Step 2.

This completes the procedure for setting up a **Transition Limit** effect.

The **Transition Limit** effect can now be used for any transition by toggling the **TRANS LIMIT** button **On** prior to performing the transition.

Use the following procedure to perform a transition using the **Transition Limit** effect:

1. Toggle the **TRANS LIMIT** button **On** in the desired **MLE Transition Group**.

   The **Transition Limit** effect will now be applied to the next transition that is performed in that **MLE Transition Group**.
2. Press the **AUTO TRANS** button to perform the transition.
The transition moves to the point set for the Transition Limit and stops.

3. The transition is continued in one of the following two ways:

- **TRANS LIMIT On** — Leave the TRANS LIMIT button turned on. When you press the AUTO TRANS button again, the transition reverses — and returns to the starting point. This method *will not* take the PST source on-air.

- **TRANS LIMIT Off** — Turn off the TRANS LIMIT button. When you use the Fader or AUTO TRANS again, the transition continues to the end of the transition. This method *will* take the PST source on-air.

This completes the procedure for performing a transition using the *Transition Limit* effect.
Pattern Control

In This Chapter

This chapter provides information and instructions for using the Pattern Control Group. The following topics are discussed in this chapter:

- Pattern Control Group
- Using Wipes
- User Wipes
- Squeeze & Tease MD Wipes
- Matte Group
- Creating Washes
- Creating a Pattern Border Color or Wash
- Creating a Matte Fill Color or Wash
- Creating a Color Background Color
- Using the Utility Bus for Washes

Note
This chapter applies only to full MLEs. There are no pattern generators in the lower half MLEs on the Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X, and 3.5 Q/MD-X.
Pattern Control Group

Each switcher includes one **Pattern Control Group**, which is located in the top right-hand area of each control panel. Every MLE (including the Program/Preset MLE) has four pattern generators:

- **Pattern Generator 1** is used for both Wipe transitions and the Preset Patterns in Keyer 1 (or DSK 1) of the MLE. This pattern generator is full-featured — all wipe patterns are available.
- **Pattern Generator 2** is used exclusively by the Preset Pattern Generator in Keyer 2 (or DSK 2) of the MLE. This generator is restricted to the first six columns of patterns, as shown in the Pattern Selection Area.
- Two additional pattern generators are used for Wash and Mask Generators.

**Note**

Because Pattern Generator 1 is shared, if PST PATT is enabled in Keyer 1, you cannot press the WIPE button in the MLE Transition Group. Similarly, if WIPE is enabled and you select a PST PATT Key type in Keyer 1, the WIPE button turns off and the transition type reverts to DISS.

The Pattern Control Group is an assignable group of controls that allows you to choose wipes and adjust wipe parameters. By pressing the desired MLE button (or by pressing WIPE within an MLE itself), the group is assigned to that MLE. In addition, if the DVE Send and Remote Control option is installed, pressing the DVE button turns the group into a DVE “shot box”.

The layout of the Pattern Control Group is almost identical on all switchers, with minor exceptions due to the differing number of MLEs.

**Synergy 4 Pattern Control**

The figure below illustrates the Pattern Control Group for the Synergy 4 control panel:

![](image)

**Synergy 4 — Pattern Control Group**

1) Pattern Assignment Section 3) Pattern Direction Section
2) Pattern Selection Section 4) Pattern Adjustment Section

**Synergy 3 Pattern Control**

The figure below illustrates the Pattern Control Group for the Synergy 3 control panel:
Synergy 2 Pattern Control

The figure below illustrates the Pattern Control Group for the Synergy 2 control panel:

1) Pattern Assignment Section
2) Pattern Selection Section
3) Pattern Direction Section
4) Pattern Adjustment Section
Synergy 1 Pattern Control

The figure below illustrates the Pattern Control Group for the Synergy 1 control panel:

1. Pattern Assignment Section

The Pattern Assignment Section provides a group of buttons that allow you to assign the Pattern Control Group to individual MLEs.

- (Synergy 2, 3 and 4) Press MLE 1 to assign the group to control patterns in MLE 1. The button will also light automatically if the WIPE button is pressed in MLE 1.

- (Synergy 2, 3 and 4) Press MLE 2 to assign the group to control patterns in MLE 2. The button will also light automatically if the WIPE button is pressed in MLE 2.

- (Synergy 3 and 4) Press MLE 3 to assign the group to control patterns in MLE 3. The button will also light automatically if the WIPE button is pressed in MLE 3.

- (Synergy 4) Press MLE 4 to assign the group to control patterns in MLE 4. The button will also light automatically if the WIPE button is pressed in MLE 4.

- The WIPE PP1 button assigns control of the Pattern Control Group to pattern generator 1. This button is automatically selected whenever WIPE is pressed in the Transition Group of an MLE, or when PST PATT is pressed in the Keyer 1 Group of an MLE.

- The PST PATT2 button assigns control of the Pattern Control Group to pattern generator 2. This button is automatically selected whenever PST PATT is pressed in the Keyer 2 Group of the MLE.

- The DVE button allows you to recall selected effects from the internal Squeeze & Tease DVE and change the Pattern Selection Section into a DVE shot box.

- The S&T WIPES button, when lit, alerts you that the Pattern Control Group is now in the Squeeze & Tease “shot box” mode. In this mode, you can select advanced DVE transitions from within an MLE itself. Squeeze & Tease MD must be installed to access these wipes.
2. Pattern Selection Section

The Pattern Selection Section is an array of 40 buttons that each represent an individual wipe pattern. The patterns are numbered from 00 in the top left corner to 39 in the bottom right. The numbers along the left side and bottom will help you identify each wipe number. There are no optional patterns.

To select a wipe, press the desired button. Once selected, the pattern can be modified and used in the assigned MLE. When you select a matrix wipe, the Matrix Menu appears, allowing you to customize the selected matrix wipe as required. Refer to the “User Wipes” section on page 6–12 for instructions.

Each “user” wipe button is essentially a memory register for a hidden wipe pattern that is chosen from the User Wipe Menu. Once selected, the wipe is stored on one of the User Wipe buttons, just like a normal wipe. “User Wipes” section on page 6–12 for complete instructions.

An option can be installed that will add to the functionality of Pattern Selection as follows:

- When the Squeeze & Tease MD Option is installed and the DVE SEND button is pressed (in the Transition Group), the Pattern Selection Section changes into a Squeeze & Tease shot box.

3. Pattern Direction Section

The Pattern Direction Section buttons control the direction and modification of the selected wipe. With the DVE Send and Remote Control Option installed, the NORM, REV and FLIP FLOP buttons control the direction of the DVE effect.

Note: The NORM and REV directions are mutually exclusive. Only one direction can be applied at a time.

- Press NORM to set the wipe direction to normal. The new picture is revealed from the black area (as shown on the pattern button) to the white area.
  - When DVE SEND is pressed in an MLE Transition Group, press NORM to run the DVE effect forward. The video on the PGM bus will transition off with the effect, revealing the PST bus.

- Press REV to set the direction of the wipe to reverse. The new picture is revealed from the white area to the black area. When DVE SEND is pressed in an MLE Transition Group, press REV to run the DVE effect in reverse. The video on PST will transition on with a DVE effect, covering up the PGM bus.

- Press FLIP FLOP to set the wipe direction to “flip flop” (also known as Normal/Reverse). Wipe direction is normal for the first transition, reverse for the second, then normal for the third, etc. When DVE SEND and then FLIP FLOP are pressed, the DVE effect will run forward with the first transition, then reverse with the next transition.

- The HMULT button allows you to horizontally multiply the number of wipe patterns that are visible on screen.
  - Press this button up to 5 times to cycle through several different levels of horizontal multiplication. The button lights when horizontal multiplication is active.
  - Press and hold the button for 1 second to clear both the horizontal multiplication and vertical multiplication.
• The **VMULT** button allows you to vertically multiply the number of wipe patterns that are visible on screen.
  ~ Press this button up to 5 times to cycle through several different levels of vertical multiplication. The button lights when vertical multiplication is active.
  ~ Press and *hold* the button for 1 second to clear both the vertical multiplication and the horizontal multiplication.

• The **SET USER** button calls up the **User Wipe Menu**. This menu is used to select user wipes and assign them to one of the eight (seven on the **Synergy 1** and **2**) available “user” wipe buttons in the **Pattern Selection Section**. “**User Wipes**” section on page 6–12 for complete instructions.

### 4. Pattern Adjustment Section

The **Pattern Adjustment Section** provides two buttons and four “end-stop” knobs that modify the selected pattern.

- The **ASPECT** button enables the use of the **ASPECT** knob.
  ~ When the **ASPECT** button is **On**, “closed” patterns with both horizontal and vertical edges can have their aspect ratios adjusted. Circles can be adjusted into ovals, squares into rectangles, etc.
  ~ When the **ASPECT** button is **Off**, all aspect ratio adjustment is removed and the pattern returns to its default shape.

- The **BORDER** knob allows you to adjust wipe pattern borders from no border to full-screen borders.
  ~ Turn the knob **clockwise** to increase border width.
  ~ Turn the knob **counter-clockwise** to decrease the border width.

- The **SOFT** knob allows you to adjust pattern edge softness from hard-edge to full soft-edge.

---

**Operating Tip**

Because the electrical position of an **End-stop Knob** can be *overwritten* by memory recalls (or by assigning the group to another **MLE**), the electrical knob position *may not match* the current physical position of the knob. In these situations, turn the knob **fully clockwise**, then **fully counter-clockwise** and then make your adjustments.

**Note**

If you adjust the **ASPECT** of one pattern, then select another pattern that you cannot adjust the aspect ratio for, and then return to the original pattern, the adjustment you made to the **ASPECT** will remain.

**Note**

You cannot combine wipe pattern borders and XFX borders. Refer to the section “**Bordering Keys**” on page 8–8 for more information on XFX borders.
~ Turn the knob clockwise to increase edge softness.

~ Turn the knob counter-clockwise to decrease the edge softness.

**Note**

| ![Image](image.png) | When controlling preset patterns (**PST PATT**), the knob performs the same function as the **GAIN** knob in the **Effects Control Group** — softening the Key edge and adjusting how the pattern blends into the background. The control is duplicated here for operator convenience. |

• The **ROT** button enables the use of the **ROTATION** knob.

  ~ When the **ROT** button is **On**, most wipe patterns can be rotated a full 360 degrees.

  ~ When the **ROT** button is **Off**, all rotation is removed and the pattern returns to the default rotation.

• When the **ROT** button is lit, the **ROTATION** knob can be used to adjust the rotation of certain patterns.

  ~ Turning the knob clockwise rotates the selected pattern clockwise.

  ~ Turning the knob counter-clockwise rotates the selected pattern counter-clockwise.
Using Wipes

Wipes can be performed in any full MLE. In a *background wipe* transition, the video signal from the PGM (or BKGD) bus is gradually replaced with the video signal from the PST bus, according to a wipe pattern pre-selected from the Pattern Selection Section in the Pattern Control Group.

**Note**

The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X, and 3.5 Q/MD-X) can only perform a Cut or a Dissolve in the Program/Preset Transition Group, but not a wipe. In this situation, you will have to use one of the upper MLEs if you want to perform a wipe.

Use the following procedure to perform a wipe:

1. Setup your shot on the PGM (BKGD on the upper MLEs) bus.
2. Setup the shot you want to wipe to on the PST bus of the same MLE.
3. Toggle the BKGD button to On (or lit) in the Next Transition Section of the MLE Transition Group.

   The figure below illustrates a sample MLE setup and the associated monitor outputs — before the wipe.

   ![MLE Setup and Monitor Outputs — Before the WIPE](image)

4. Toggle the WIPE button to On in the Transition Parameter Section of the Pattern Control Group. This action automatically assigns the Pattern Control Group to the MLE.
5. Select a wipe by pressing the associated button in the Pattern Selection Section.
6. Press the NORM, REV, or FLIP FLOP button in the Pattern Direction Section to select the direction for the wipe.
7. Use the BORDER knob to add a slight border to the wipe so that the transition is easier to see.

**Operating Tip**

You can use the Fader to hold the transition at a point. This will allow you to see your changes when you are setting up borders, softness, rotation, or aspect.

8. Perform the transition either manually, by moving the Fader from limit to limit, or automatically, by pressing the AUTO TRANS button.
During the transition, the **PST** bus video signal gradually replaces the **PGM** signal using the selected wipe, as shown below.

**MLE Setup and Monitor Outputs — During the WIPE**

At the end of the transition, the **PST** video signal completely replaces the **PGM** video signal, and the buses flip-flop.

**MLE Setup and Monitor Outputs — After the WIPE**

During the wipe, the **ON AIR** indicators at the end of both the **PGM** (or **BKGD**) and **PST** bus rows will be lit. This indicates that *both* buses are contributing to the output of the switcher. At the end of the wipe, after the transition, only the **ON AIR** indicator for the **PGM** bus will be lit.

Wipe borders can be modified to be any matte color. Refer to the section “**Matte Group**” on page 6–17 for details.

**Adjusting Matrix Wipes**

When you select a matrix wipe from the **Pattern Selection Section**, you can adjust various parameters to control the appearance of the wipe.

**Matrix Tile Size**

The Matrix Tile Size feature allows you to set the shape of the tiles in the matrix, as well as the number of tiles used.

Use the following procedure to adjust the tile size of a matrix:

1. Press **Home ⇒ Effects ⇒ Patterns ⇒ Matrix Tile Size.**
Matrix Tile Size Menu

2. Select the shape of the tiles used in the matrix as follows:
   • **Square** — Press **Square** to use square tiles in the matrix.
   • **Tall** — Press **Tall** to use rectangular tiles in the matrix taller than they are wide.
   • **Wide** — Press **Wide** to use rectangular tiles in the matrix that are wider than they are tall.

3. Use the middle knob to select the number of tiles that are used in the matrix. The available selection depends on the shape of the tile selected.

This completes the procedure for adjusting the tile size of a matrix.

### Adjusting Wipes

When you select a wipe, you can adjust various parameters to control the appearance of the wipe.

#### Wipe Modulation

The Wipe Modulation feature allows you to add a ripple affect to the pattern wipe. You can adjust the height and width of ripples both vertically and horizontally, as well as animate the ripples.

Use the following procedure to adjust the wipe modulation:

1. Press **Home** ⇒ **Effects** ⇒ **Patterns** ⇒ **Wipe Modulation**.
2. Toggle **Modulation** to **On**.
3. Adjust the ripples on the left and right sides of the pattern as follows:
   - **Vertical Params** — Press **Clear** on the **Wipe Modulation Menu** to return all the pattern modulation setting to the default values.
   - **Vertical Params** — Press **Vertical Params** on the **Wipe Modulation Menu**.
     - Use the **Amplitude** knob to adjust the height of ripples.
• Use the **Wavelength** knob to adjust the width of the ripples used, or the number of the ripples.

4. Adjust the ripples on the top and bottom sides of the pattern as follows:

   • Press **Horizontal Params**
   • Use the **Amplitude** knob to adjust the height of ripples.
   • Use the **Wavelength** knob to adjust the width of the ripples used, or the number of the ripples.

5. Animate the ripples as follows:

   • Toggle **Animate** to **On**.

   **Operating Tip**
   
   Toggling **Animate** to **Off** while the pattern is moving freezes the pattern without affecting the rate.

   • Press **Vertical Params**.
   • Use the **Rate** knob to adjust the speed that the ripples move along the vertical sides of the pattern. A positive value moves the ripples right to left and negative values move the ripples left to right. A value of **0** causes the ripples not to move.

   • Press **Horizontal Params**.
   • Use the **Rate** knob to adjust the speed that the ripples move along the horizontal sides of the pattern. A positive value moves the ripples top to bottom and negative values move the ripples bottom to top. A value of **0** causes the ripples not to move.

This completes the procedure for adjusting the wipe modulation.

**Wipe Rotation**

The Rotation features allows you to set the pattern, or wipe, to a specific angle (User Rotation), or apply a moving rotation, or spin, to the pattern (Continuous or Transition Rotation).

You can apply multiple rotation types to the same pattern at the same time.

Use the following procedure to adjust the rotation of a pattern:

1. Press **Home** ➔ **Effects** ➔ **Pattern Options** ➔ **Pattern Rotation**.

   **Pattern Rotation**
   
   ![Pattern Rotation Menu]

2. Toggle **Rotation** to **On** on the **Pattern Rotation Menu**.

3. Apply a continuous rotation to the pattern as follows:

   • Press **Continuous Rotation** on the **Pattern Rotation Menu**.
Use the **Speed** knob on the **Pattern Rotation Menu** to select the rate at which the pattern continuously rotates. Selecting a positive value rotates the pattern clockwise, and selecting a negative value rotates the pattern counter-clockwise.

4. Apply a transitional rotation to the pattern as follows
   - Press **Transition Rotation** on the **Pattern Rotation Menu**.

Use the **Rotation** knob on the **Pattern Rotation Menu** to select the amount of rotations of the pattern that occur during a transition. Selecting a positive value rotates the pattern clockwise, and selecting a negative value rotates the pattern counter-clockwise.

5. Apply a fixed rotation to the pattern as follows:
   - Press **User-Controlled Rotation** on the **Pattern Rotation Menu**.

   Use the **Degrees** knob on the **Pattern Rotation Menu** to adjust the rotation of the pattern.

This completes the procedure for adjusting the rotation of a pattern.

**User Wipes**

The **User Wipe** feature allows you to select from over 60 additional wipes (that are normally hidden from view on the panel). Once selected, you can place the “user” wipe on one of the eight (seven on
the Synergy 1 and 2) available **User Wipe** buttons in the **Pattern Selection Section** of the **Pattern Control Group**. The user wipes that you select are then available through the specific **User Wipe** buttons.

The **User Wipe** buttons are essentially “presets” that can be programmed with your favorite User Wipes. Once set up, the user wipe buttons can be used in the same manner as the other wipe pattern buttons.

**Note**

A User Wipe is *not* a standard wipe with pattern modifiers applied — *that* function would be performed with memory presets.

Use the following procedure to assign a **User Wipe**:

1. Navigate to the **User Wipes Menu** as follows:
   - Press **HOME** ⇒ **Effects** ⇒ **Patterns** ⇒ **User Wipes**.

   ![User Wipes Menu](image)

2. Assign a wipe to a user wipe button as follows:
   - Use the **User Wipe** knob to select the desired User Wipe button that you want to assign the wipe to.
   - Use the **Category** knob to select the category of wipe you want to use (**Classic** or **Rotary**, **Matrix** or **Special**).
   - Use the **Pattern** knob to select the wipe you want to assign to the selected User Wipe button.

This completes the procedure to assign a user wipe. To use the wipe in production, select a **User Wipe** button as you would any of the other wipes in the **Pattern Selection Section**.

**Classic Wipes**

The figure below illustrates the available “Classic” User Wipes.
Classic Wipes – Visual Representations and Wipe Numbers

**Note**

The numbers under the wipe patterns indicate the *wipe number* as selected using the bottom knob in the scroll area of the User Wipe Menu.

The graphical representations of the wipes *do not* correspond with the patterns on the actual Keys in the Pattern Control Group.

---

**Rotary Wipes**

The figure below illustrates the available “Rotary” User Wipes.

**Note**

The numbers under the wipe patterns indicate the *wipe number* as selected using the bottom knob in the scroll area of the User Wipe Menu.

The graphical representations of the wipes *do not* correspond with the patterns on the actual Keys in the Pattern Control group.

---

**Matrix Wipes**

The figure below illustrates the available “Matrix” User Wipes.
Special Wipes

The figure below illustrates the available “Special” User Wipes.

![Special Wipes](image)

The available Special User Wipes are a star, heart, and spade.

Squeeze & Tease MD Wipes

The Squeeze & Tease MD Wipe function allows you to perform push-offs, pull-ons and other similar DVE transitions from within an MLE itself.

**Important**

Background Squeeze & Tease MD Wipes apply the Squeeze & Tease MD border settings that were set when the wipe was created. Refer to Chapter 18 “Borders” for information on Squeeze & Tease MD borders.

Use the following method to activate the Squeeze & Tease MD wipes function:

1. Press DVE SEND and WIPE at the same time in the selected MLE.

Both buttons illuminate, if a free Squeeze & Tease channel is available in that MLE. In the Pattern Control section, the S&T WIPES button lights, the selected MLE button lights, and the array of 40 wipe buttons becomes a Squeeze & Tease “shot box” — allowing you a choice of 40 different transitions. The S&T WIPES button alerts you that the section is now in Squeeze & Tease “shot box” mode.

Refer to Appendix B, “Squeeze & Tease MD Wipes and Sequences” in the for a list of included Squeeze & Tease MD wipes.

Select your foreground and background sources in the normal way, and experiment to discover the patterns that you like the best. Both manual and auto-transitions function just like a standard wipe.

Please note:

- The Squeeze & Tease MD WARP Option is required on all MLEs on which you want to perform the Squeeze & Tease MD wipe (or 3D sequence) function.
• When enabled, the mode selects a free channel, or two free channels as required. If channels are not available, you cannot select a Squeeze & Tease MD wipe.

• You can perform a Squeeze & Tease MD wipe individually on BKGD, KEY 1 or KEY 2, but no combination of the transition selections are allowed.

• BKGD and KEY transitions only require one Squeeze & Tease channel to perform a Squeeze & Tease MD wipe. Wipes involving Auto Select keys require two channels.

• Color backgrounds cannot be used with Squeeze & Tease MD background wipes.

• If you want to perform a Squeeze & Tease MD wipe on Key 1, for example, and Key 1 is already performing a Fly Key, the Squeeze & Tease MD wipe is allowed. If the keyer is not flying a key, the system temporarily borrows a single Squeeze & Tease channel (or two channels if you request an Auto Select key).

**Note**  
The Transition Preview and KEY OVER modes are not available when performing Squeeze & Tease wipes.
Matte Group

Each switcher includes one Matte Group, whose layout differs slightly with the switcher model. The Matte Group provides a set of assignable controls that allow you to select specific matte generators and adjust colors for selected wipe patterns, borders, washes, and matte fills.

Synergy 4 Mattes

The figure below illustrates the Matte Group for the Synergy 3.5 and 4 Q/MD-X control panel:

![Synergy 4 Mattes Diagram]

1) Matte Assignment Section  
2) Matte Destination Section  
3) Matte Color Knobs  
4) Wash Section

Synergy 3 Mattes

The figure below illustrates the Matte Group for the Synergy 2.5 Q/MD, and 2.5 and 3 Q/MD-X control panel:

![Synergy 3 Mattes Diagram]

1) Matte Assignment Section  
2) Matte Destination Section  
3) Matte Color Knobs  
4) Wash Section
Synergy 2 Mattes

The figure below illustrates the Matte Group for the Synergy 1.5 and 2 Q/MD, and 2 Q/MD-X control panel:

![Synergy 2 Mattes Diagram]

1) Matte Assignment Section 3) Matte Color Knobs
2) Matte Destination Section 4) Wash Section

Synergy 1 Mattes

The figure below illustrates the Matte Group for the Synergy 1 Q/MD control panel:

![Synergy 1 Mattes Diagram]

1) – not available on the S1 – 3) Matte Color Knobs
2) Matte Destination Section 4) Wash Section

1. Matte Assignment Section

The Matte Assignment Section allows you to assign the Matte Group to individual MLEs. Buttons are selected automatically (as detailed below), or they can be selected manually as desired.

- (Synergy 2, 3 and 4) Press MLE 1 to assign the group to control MLE 1 matte colors. The button also lights automatically if the WIPE, BORD, or MATTE FILL buttons are pressed in MLE 1.
- (Synergy 2, 3 and 4) Press MLE 2 to assign the group to control MLE 2 matte colors. The button also lights automatically if the WIPE, BORD, or MATTE FILL buttons are pressed in MLE 2.
• (Synergy 3 and 4) Press MLE 3 to assign the group to control MLE 3 matte colors. The button also lights automatically if the WIPE, BORD, or MATTE FILL buttons are pressed in MLE 3.

• (Synergy 4) Press MLE 4 to assign the group to control MLE 4 matte colors. The button also lights automatically if the WIPE, BORD, or MATTE FILL buttons are pressed in MLE 4.

Note There are no matte generators in the lower half MLE of the Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X, and 3.5 Q/MD-X switchers.

2. Matte Destination Section

The five buttons in the Matte Destination Section allow you to select one of five different matte generators for each full MLE. Each matte generator is capable of generating one background or fill color. The buttons are selected automatically (as outlined below), or they can be selected manually as desired.

It is important to note that the two background matte generators (accessed by pressing BKGD 1 KEY 1 or BKGD 2 KEY 2) are completely independent for each MLE. This feature provides you with exceptional creative capacity for on-line production and for all memory recall situations.

• Press BKGD 1 KEY 1 to select matte generator 1. This is a shared matte generator that is automatically selected when the following buttons are pressed in the selected MLE:
  ~ COLOR BKGD 1 (on the bus row)
  ~ MATTE FILL (in Keyer 1)
  ~ Key Types (in Keyer 1)

When BKGD 1 KEY 1 is selected, you can adjust the color used for the COLOR BKGD 1, Key 1 matte fill, and Key 1 preset pattern border on the MLE using the three Matte Color knobs. You can also press a Wash button and assign a color wash to the destination.

Note If PST PATT is selected in either the Key 1 or Key 2 Group for the MLE, you cannot select MATTE FILL.

• Press BKGD 2 KEY 2 to select matte generator 2. This is a shared matte generator that is automatically selected when the following buttons are pressed in the selected MLE:
  ~ COLOR BKGD 2 (on the bus row)
  ~ MATTE FILL (in Keyer 2)
  ~ Key Types (in Keyer 2)

When BKGD 2 KEY 2 is selected, you can adjust the color used for the COLOR BKGD 2, Key 2 matte fill, or Key 2 preset pattern border on the MLE using the three Matte Color knobs. You can also press a Wash button and assign a color wash to the destination.

Note If PST PATT is selected in either the Key 1 or Key 2 Group for the MLE, you cannot select MATTE FILL.
• Press **BORD 1** to adjust the border color of **Key 1**. The **Dual Border Generator** option must be installed in the selected MLE. The button is automatically selected when a border is enabled in Key 2. Refer to the section “**Bordering Keys**” on page 8–8 for more information.

• Press **BORD 2** to adjust the border color of **Key 2**. The **Dual Border Generator** option must be installed in the selected MLE. The button is automatically selected when a border is enabled in Key 1. Refer to the section “**Bordering Keys**” on page 8–8 for more information.

**Note**  
The **XFX Extra Effects Dual Border Generator** option must be installed.

• Press **PATT** to select the main matte generator for pattern border colors. This generator is independent of the other generators in the **Matte Destination Section**. The button is automatically selected when you press **WIPE** in an MLE.

**Note**  
The **XFX Extra Effects Dual Border Generator** option must be installed.

When pressed, the **Color Selection Menu** is displayed. From this menu, or using the three **Matte Color** knobs, you can adjust the color of the pattern border. You can also press a **Wash** button and assign a color wash to the destination.

3. **Matte Color Knobs**  
The three **Matte Color** end-stop knobs allow you to adjust the color of the selected matte generator — in the selected MLE. Each knob is an “end-stop” knob.

**Operating Tip**  
Because the electrical position of an **End-stop Knob** can be *overwritten* by memory recalls (or by assigning the group to another MLE), the electrical knob position *may not match* the current physical position of the knob. In these situations, turn the knob *fully clockwise*, then *fully counter-clockwise* and then make your adjustments.

• Adjust the **HUE** knob to change the color of the selected matte generator. A full 360 degrees of hue adjustment is provided.

• Adjust the **SAT** knob to change the color saturation of the selected matte generator. Saturation can be adjusted from 0 (monochrome, or no saturation) to 100 percent (full color saturation).

• Adjust the **LUM** knob to change the luminance of the selected matte generator. Luminance can be adjusted from 0 (minimum brightness) to 100 percent (maximum brightness).

4. **Wash Section**  
The two buttons in the **Wash Section** allow you to create **washes** (or “blends”) between different colors.

• Press **WASH 1** to enable wash background 1 for the selected destination matte generator.
• Press **WASH 2** to enable wash background 2 for the selected destination matte generator.

When a wash button is lit, the selected wash replaces the current single matte color. When the button is off, the original *single* matte color is restored. Once a wash is created, the wash can be applied to one (or more) of the destination matte generators.
Creating Washes

A wash allows you to apply a gradient fill, or wash, to any border, color background, or pattern effect in any full MLE.

For example, you can apply a wash to any of the following effects in any full MLE:

- **WIPE** — You can create a wash for a pattern border color.
- **COLOR BKGD (1 or 2)** — You can create a wash on the PGM or PST bus row to create a wash for a full screen color background.
- **MATTE FILL** — In Keyer 1 or 2, you can create a wash for a Key matte fill.
- **PST PATT** — In Keyer 1 or 2 you can create a wash for a Key preset pattern border fill signal.

Creating a Pattern Border Color or Wash

Use the following procedure to create a pattern border color:

1. Ensure that your preview monitor is set to the desired MLE.
2. In the selected MLE, press **WIPE**.
3. In the **Pattern Control Group**, choose the desired wipe pattern, wipe direction, and wide modifiers (such as aspect ratio, border width, border softness, and border rotation). “**Pattern Control Group**” section on page 6–2 and section “**Using Wipes**” on page 6–8 for instructions.
4. In the **Matte Group**, the MLE chosen in step 2 will be automatically selected, along with the **PATT** destination button, indicating that the **Matte Group** is assigned to the indicated MLE and that the matte generator for pattern border colors is active. Note that there is no **MLE** button on a **Synergy 1** control panel as there is only one MLE.
5. Pressing **WASH 1** (or **WASH 2**, the procedure is the same) displays the **BKGD Gen Menu**

**Note**

There are no wash generators in the lower half MLE of the **Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X**, and **3.5 Q/MD-X** switchers.
6. Press **BKGD Type** to display the **Wash Background Type Menu**.

   - **BKGD Type**

   - **MLE 3 Wash 1**

   - **Type**: Pattern

   - **Video**

   - **Pattern Control Area Being Used for Wash**

   - **Wash Background Type Menu**

7. Use the **Type** knob to choose the wash type. You can select from the following:
   
   - **Noise** — The video is filled with simulated digital noise. Proceed to step 8 to adjust colors as desired.
   
   - **SuperBlack** — The video is filled with a black signal.
   
   - **Pattern** — You can use the **Pattern Control Group** to select the “pattern” for the wash. All patterns, except matrix wipes, are available, including the user wipes. In addition, all pattern modifiers (SOFT, ROT, HMULT, etc.) can be used.

   - **Note**

     The default **WASH 1** pattern is a blue-to-black vertical wash (button 00 in the **Pattern Control Group**), with black on the bottom. The default **WASH 2** pattern is a silver-to-black vertical wash (button 00 in the **Pattern Control Group**), with black on the bottom.

   - **Note**

     When selecting a pattern for the wash generator, none of the **Pattern Assignment** buttons will be lit, and the message, “PATTERN CONTROL AREA BEING USED FOR WASH” appears on the **System Control Display**.

   - **Video** — Two other scroll options appear. Use the middle knob to select the bus where the video source that you want passed through the matte channel originates from. You can choose from the following:
     
     - **Key 1** — This selects the video source on the Key 1 bus.
     
     - **Key 2** — This selects the video source on the Key 2 bus.
     
     - **Program** — This selects the video source on the Program bus.
     
     - **Preset** — This selects the video source on the Preset bus.
     
     - **Utility** — This selects the Key bus of the associated MLE on the switcher, and places it into “Utility Bus” mode. You can then select any video source on the bus as your wash video. Refer to the section “**Using the Utility Bus for Washes**” section on page 6–26 for details.

   Use the bottom knob to choose from the following:

   - **Wash** — This selection applies a gradient matte fill of the source selected.

   - **Video** — This selects the straight video source, with no matte effects applied.
8. Press **Modify Color 1** to display the **Color Selection Menu** for Color 1.

**Note**

If **MATTE LIMIT** is selected as ON in the **Personality Menu**, RGB will not be shown in the **Wash Color Menu** and all color adjustments will be within the HSL color space. However, colors can be adjusted in the RGB color space by setting the **MATTE LIMIT** to OFF. The system default is OFF. Refer to the section “Switcher Personality” on page 4–4 for more information.

9. Adjust Color 1 as desired.

**Operating Tip**

You can also adjust the wash color in the **Matte Group**, using the dedicated **HUE**, **SAT** and **LUM** knobs. Both sets of controls work simultaneously.

10. Press **Edit Color 2** to display the **Color Selection Menu** for Color 2.

11. Adjust Color 2 as desired.

**Note**

If you use the **Border** knob in the **Pattern Control Group** to apply a border to the pattern wash, **Color 2** will be applied to the border and **Color 1** will be applied to the outside and the region between the borders. If you use the **Border** knob to set the border size to 0, **Color 2** will be applied to the center region and **Color 1** will be applied to the outside.

The change between a border and no-border is sudden as the color in the center of the pattern changes.

12. Press **UP ONE** to return to the **BKGD Gen Menu**.

13. Press **Default Colors** to set all adjusted colors back to factory default values.

This completes the procedure for designing a wash.
When WASH 1 or WASH 2 is lit, the selected wash color is applied — replacing the matte single color of the matte generator. When WASH 1 or WASH 2 is turned off, the matte generator returns to its previous single color. If WASH 1 or WASH 2 is re-enabled for the selected matte generator, the wash is re-applied.

Creating a Matte Fill Color or Wash

Use the following procedure to create a matte fill color:

1. Ensure that your preview monitor is set to the desired MLE.
2. In the selected MLE, set up a Key using Keyer 1 or Keyer 2.
3. Press MATTE FILL in the desired Keyer.
4. In the Matte Group, the MLE chosen in step 2 will be automatically selected, along with the BKGD 1 KEY 1 or BKGD 2 KEY 2 button (depending upon which Keyer was selected in step 2).
   - Use the three Matte Color Knobs to adjust the matte fill color.
   - If desired, press WASH 1 or WASH 2 to assign a wash color to the matte fill, and set up your wash as per steps 5 to 13 inclusive of the previous “Creating a Pattern Border Color or Wash” section.

This completes the procedure for creating a matte fill color.

Creating a Color Background Color

Use the following procedure to create a full screen color background:

1. Ensure that your preview monitor is set to the desired MLE.
2. Press COLOR BKGD 1 or COLOR BKGD 2 on the bus row of the selected MLE to display the Background Color Menu.

   Background Color Menu — RGB Selection

The adjustments you made to the wash will only apply to the MLE that you were working in. For example, if you adjust Wash 1 in MLE 1, this will not affect Wash 1 in MLE 2. Each MLE stores these two wash setups independently.
3. In the Matte Group, the MLE chosen in step 2 will be automatically selected, along with the BKGD 1 KEY 1 or BKGD 2 KEY 2 button (depending upon which COLOR BKGD button was pressed in step 2).

- Press HSL to display and adjust colors using a Hue / Saturation / Luminance display.
- Press RGB to display and adjust colors using a Red / Green / Blue display.

**Note**

If MATTE LIMIT is set to ON in the Personality Menu, RGB will not be shown in the Background Color Menu and all color adjustments will be within the HSL color space. However, colors can be adjusted outside of the RGB space by setting the MATTE LIMIT to OFF. The system default is OFF. Refer to the section “Switcher Personality” on page 4–4 for more information.

- Use the three Matte Color Knobs to adjust the color background.
- If desired, press WASH 1 or WASH 2 to assign a wash color to the background, and set up your wash. Refer to steps 5 to 13 inclusive of the section “Creating a Pattern Border Color or Wash” on page 6–22.

**Note**

The default color background colors are as follows:

- COLOR BKGD 1 is RED
- COLOR BKGD 2 is BLUE

This completes the procedure for creating a full screen color background.

**Using the Utility Bus for Washes**

Every full MLE on the Synergy Q/MD/X switcher has a Utility Bus which can be used for placing any video source into wipes borders and washes. To do this, ensure that you have set up your scene as desired, with the WIPE, MATTE FILL, or COLOR BKGD selected. This will automatically give you access to the BKGD Gen Menu, as shown below.

**Note**

As there is only one Utility bus per MLE, the same video will be used regardless of where on that MLE you use a wash. For example, if you use a Utility Bus wash in your wipe border AND as a matte fill in a Self Key, the video will be identical.
1. Press **BKGD Type** to display the **Wash Background Type Menu**.

![Wash Background Type Menu]

2. Use the **Type** knob to select **Video** as the type of wash.

![Wash Menu — Video Type Selected]

3. Set the switcher to Utility Bus Mode as follows:
   - Use the **Video Bus** knob to select **Utility**.

   **Note**
   When you select **Utility** the switcher will go into **Utility Bus Mode**. Depending on the MLE you are applying the Video Wash to, the **Key** Bus or **PST** Bus will be used to select your video source.

   - Use the **Fill Type** knob to select the appearance of the video being used for the wash. You can select between the following:
     ~ **ColorWash** — This option applies a gradient matte fill to the source selected.
     ~ **Video** — This option applies the straight video source, with no matte effects applied.

4. Select the video source you want to use for the wash as follows:
   - *(for upper MLEs with Key buses)*

     When in Utility Bus mode, both the **KEY1** and **KEY2** indicators, above the **Key** bus of the selected MLE, will flash. This Key Bus can now be used to select *any* of the video sources available as your wash video.

   **Note**
   To exit this Utility Bus Mode for an upper MLE you can select a Key as your next transition. The **KEY1** and **KEY2** indicators will stop flashing.
• (for bottom Program/Preset MLEs)

When applying a Utility Bus wash to the lower Program/Preset MLE, there is no visual aide, as there are no corresponding DSK indicators. However, the PST bus can be used to select any of the video sources available as your wash video. Simply press and hold the lit WIPE button, and press the desired crosspoint on the PST bus. You can use the same procedure to identify the source currently being used.

Please note the following important notes regarding Utility Bus mode and washes:

• To exit from Utility Bus mode, simply press any Key button in the Transition area, or any of the Key type or modifier buttons in either Keyer on the affected MLE.

• Performing an MLE reset or a switcher reset in the Global Memory System group will exit Utility Bus mode.

• The same Utility Bus can be used to apply video to a mask. Refer to the section “Masking Keys” on page 8–3 for details.
Keying

In This Chapter

This chapter provides instructions for using the MLE Keyers and Downstream Keyers of the Synergy Q/MD/X switcher. The following topics are discussed in this chapter:

- Introduction to Keying
- Effects Control Group
- Using MLE Keys
- Performing a Self Key
- Performing an Auto Select Key
- Performing an UltraChrome Chroma Key
- Performing a Preset Pattern Key
- Split Keys
- Using Downstream Keys
- DSK Source Bus Setup
- MultiDSK Option
- MultiDSK for Downstream Key Groups
- MultiDSK Operation
- AuxKey Option
- AuxKey Operation
- Auto Transition Rates

Note

Refer to the Synergy Q/MD/X Operation Manual, Volume II for detailed Keying instructions with the Squeeze & Tease MD option installed.
Introduction to Keying

The **Keying** function allows you to insert (or electronically cut) portions of one scene into another, or to place titles over background images. Two signals are essentially required for a Key:

- The “**Key**” signal (also known as an *alpha* signal) is used to electronically cut a hole in the background video.
- The “**fill**” signal (also known as the *Key foreground*) is used to electronically fill the hole left by the Key with video.

Visually, Keys appear as *layers*, which can be built up to create the desired composite image. When working with Keys, the following rules apply:

- All MLEs can generate two individual Keys, which appear downstream of the background images of that MLE. The priority of those Keys can be changed within the MLE itself.
- Each of the two DSKs (Downstream Keys) generates a single Key, which appears visually downstream of all Program/Preset video images.
- In the **Synergy 1 Q/MD** you can generate two Keys simultaneously on-air.
- In the **Synergy 1.5 Q/MD, 2 Q/MD, and 2 Q/MD-X** you can generate four Keys simultaneously on-air (two in MLE 1 and two in the DSKs).
- In the **Synergy 2.5 Q/MD, 2.5 Q/MD-X, and 3 Q/MD-X** you can generate six Keys simultaneously (two in MLE 1, two in MLE 2, and two in the DSKs).
- In the **Synergy 3.5 Q/MD-X and 4 Q/MD-X** you can generate eight Keys simultaneously (two in MLE 1, two in MLE 2, two in MLE 3, and two in the DSKs).

**Note**

The **Half MLE** switchers (**Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X**), although having a full complement of Keyers, have limited functionality in the DSKs.

Refer to the section “**Video Flow Through the Switcher**” on page 2–14 for additional information on basic video flow, MLE priority, and layering.

**Key Group Basics**

Each switcher includes two Key groups per MLE.

- In the upper MLEs, the Key groups are named **MLE # Key 1** and **MLE # Key 2** (e.g., **MLE 2 Key 1** and **MLE 2 Key 2**).
- In the **Program/Preset MLE**, with the exception of the **Synergy 1 Q/MD**, the groups are named **Downstream Keyer 1** and **Downstream Keyer 2**.

Please note the following **basic** rules regarding the two Key groups:

- For all Key types (except Preset Patterns), the **Key Bus** is used to select Key alpha and fill sources. For Preset Pattern Keys, the alpha signal is chosen by selecting a wipe pattern in the **Pattern Control Group**.
- Even though the **buttons** on the **Key Bus** are shared between the two Keyers, two sets of independent Keying electronics allow each **Keyer** to have its own Key and fill selections.
• Two indicators at the top right edge of the bus indicate which Keyer currently controls the bus.

Note: All standard rules for the Key Bus ON AIR and N/S indicators apply. Re-entry crosspoints can also be selected as a Key source. Refer to the section “Control Panel Sections” on page 2–2 for complete descriptions.

• All Key 1 Groups are identical from MLE to MLE — in function, appearance, and operation. When any button is pressed in the Key 1 Group, the KEY1 indicator (above the Key Bus) lights to show that Key 1 has control of the Key Bus. Also, when Key 1 has control, the Key source button chosen for that Keyer will be bright, and the button selected for Key 2 will be dim.

• All Key 2 Groups are identical from MLE to MLE — in function, appearance, and operation. When any button is pressed in the Key 2 Group, the KEY 2 LED lights to show that Key 2 controls the Key Bus. Also, when Key 2 has control, the Key source button chosen for that Keyer will be bright, and the button selected for Key 1 will be dim.

• There is only one button that differs between the two Key groups, and this button is in the same position in each group:
  ~ The Key 1 Group has the KEY OVER button.
  ~ The Key 2 Group has the CHAR GEN button.

• Functionally (besides the different buttons listed above), there are two differences between the two Key groups as follows:
  ~ Key 1 (and DSK 1 on a full MLE) shares its preset pattern generator with the Wipe Generator for the MLE. This pattern generator is full-featured — all wipe patterns are available. Note that matrix wipes are not yet available.
Key 2 (and DSK 2 on a full MLE) has exclusive use of its preset pattern function. This generator is restricted to the first six columns of wipe patterns (as shown in the Pattern Selection Section). Matrix wipes are not available.

**Note**

Because pattern generator 1 is shared, if PST PATT is enabled in Keyer 1, you cannot press the WIPE button in the Transition Group of that full MLE. Similarly, if WIPE is enabled and you select PST PATT in Keyer 1, WIPE will turn off and DISS will be used instead.

### MLE Key Groups

The figure below illustrates the two MLE Key Groups for the all Synergy Q/MD/X control panels.

![MLE Key Groups Diagram](image)

Synergy 4 — MLE 1 Keyers

1) Key Type Section  3) Key Modifier Section 2  5) Key Transition Section
2) Key Modifier Section 1  4) Key Preview Section

The controls in each MLE Key Group allow you to choose Key types and Key modifiers, and insert the Keys over a background using a cut or an automatic transition. Except for the KEY OVER and CHAR GEN buttons, the controls in the two groups are identical.

**Note**

Refer to the section “Key Functions” on page 7–6 for complete descriptions of each section and button identified above.

### Downstream Key Groups

The Downstream Keyer groups allow you to control all of the DSKs installed on the switcher. If you have the MultiDSK™ option installed, you will control these two additional Keyers from the Downstream Keyer Group as well.

Depending on the Synergy switcher you have, the Downstream Keyer Group will be appear differently.

**Synergy 3 and 4 DSK**

The figure below illustrates the Downstream Keyer Groups for the Synergy 2.5 Q/MD, 2.5, 3, 3.5 and 4 Q/MD-X control panels:
On the Synergy 3 and 4 control panels, each DSK has its own individual group. Both groups (DSK 1 and DSK 2) are identical. Because each DSK is contained within a group of its own, a Key Modifier Assignment Section is not required.

Note
Refer to the section “Key Functions” on page 7–6 for complete descriptions of each section and button identified above.

Synergy 2 DSK

The figure below illustrates the Downstream Keyers Group for the Synergy 1.5 and 2 Q/MD, and 2 Q/MD-X control panel:

On the Synergy 2 control panel, both DSKs are combined into one compact group. Each group has its own individual Key Bus, Key Preview, and Key Transition sections, but the two Key Modifier sections are shared between the two DSKs.
**Synergy 1 DSK**

The figure below illustrates the Downstream Key Group for the Synergy 1 control panel. The two DSK TRANS buttons allow you to auto-transition to the DSKs.

---

**Note**

The MultiDSK™ (DSK 1 and DSK 2) option must be installed in order to perform a Downstream Key on a Synergy 1 Q/MD switcher. Refer to the section “MultiDSK Option” on page 7–56 for more information.

---

*Synergy 1 — Downstream Keyers*

Two transition buttons are provided for initiating an Auto Transition of either DSK 1 or DSK 2.

**Key Functions**

This section provides detailed explanations of each area and button located in the MLE Key Groups and Downstream Key Groups, as described and illustrated above. Differences between the two groups are noted in the text, but in almost all cases, button functionality is identical.

1. **Key Type Section (MLE Key Groups only)**

---

**Note**

In the MLE Key Groups, the Key type is chosen in the Key Type Section, while the Key source is selected on the Key Bus. In the DSKs, the Key type is selected by holding down the DSK Source bus button and pressing the desired Key type in any Key Type Section of the MLE Keyer. The Key source is selected by holding down the DSK bus button and pressing the desired source on the PST bus of the PGM/PST MLE. This bus effectively doubles as a Key bus for the DSKs.

---

The Key Type Section provides four buttons that select the type of Key that will be inserted over background video. These four buttons are present only in the MLE Key Groups — not in the DSKs.

- Press **SELF KEY** to select a “Self” Key type, also known as a luminance Key. With a Self Key, the luminance (or brightness) values of the Key source itself (as selected on the Key Bus of the MLE) are used to cut the hole.
  
  The Key hole is typically filled with the same video signal as the Key cutter, or the hole can be filled with color matte. Self Keys are often used to Key images from a title camera or occasionally from a VTR.
  
- Press **AUTO SELECT** to choose an “Auto Select” Key type, also known as a linear Key.
With Auto Select Keys, two signals are used to cut and fill the hole — a Key (alpha) signal and a fill signal. These signals originate from devices such as character generators, still stores, and graphics systems.

When you choose an Auto Select Key and press a Key source (on the Key Bus of the MLE), the switcher automatically selects both the alpha and fill signals. These signals were linked together during the installation procedure. Refer to Chapter 7, “BNC Configuration and Check”, of the Synergy Q/MD or Q/MD-X Engineering Manual for details.

- Press CHROMA KEY to select an UltraChrome™ Chroma Key type. With a Chroma Key, the hole is cut based on a selected color value (hue), rather than on a luminance value or an alpha signal. The color is then electronically removed and replaced with background video from another image.

**Note**

Similar to Self Keys, the Chroma Key hole is filled from the same video source as the Key cutter, except that the fill is composed of all colors that remain after the selected Chroma Key color is removed. The hole can also be filled with color matte. Chroma Keys are typically used to Key the weather caster over a weather map, or to cleanly layer full-color images into a composite scene.

**Note**

Unlike analog switchers, that require separate RGB signals to perform a Chroma Key, with Synergy Q/MD/X switchers you can Chroma Key on any Key source that you select on the Key Bus.

**Operating Tip**

Pressing the button that is currently lit in the Key Type Section is a quick way to activate the menu for that Keyer for adjustment, when both Keyers are in use.

- Press PST PATT to select a “Preset Pattern” Key type. The hole is cut based on a pattern that you select in the Pattern Control Group (using pattern generator 1 or 2). The pattern (which acts just like the auto select alpha signal of a Key) is filled with video from the Key Bus.

**Note**

Of the four Key types, Preset Pattern Keys have minor differences between Key 1 and Key 2:

~ **Key 1** — The pattern generator for Key 1 is full-featured, but it is shared with the Wipe Generator. If you press PST PATT in Key 1, you cannot press WIPE in the Transition Group of the MLE. Similarly, if you have WIPE selected in the Transition Group of the MLE and you press PST PATT, the WIPE button turns off.

**Note**

The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot perform a Chroma Key in the DSKs for the bottom MLE.

**Note**

The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot perform a Preset Pattern Key in the DSKs for the bottom MLE.
Key 2 — The pattern generator for Key 2 is not shared with other functions. It is restricted to the first six columns of wipe patterns. Matrix wipes are not available.

Note

In the MLE Key Groups, the Key type is chosen in the Key Type Section, while the Key source is selected on the Key Bus. In the DSKs, the Key type is selected by holding down the DSK Source button and pressing the desired Key type in the Key Type Area on any MLE Keyer. The Key source is selected by holding down the DSK Source button and pressing the desired source on the PST bus of the PGM/PST MLE. This bus effectively doubles as a Key bus for the DSKs.

2. Key Modifier Section 1 (All groups)

The buttons in Key Modifier Section 1 allow you to modify the Key that is currently selected.

- Press MATTE FILL to fill the selected Key hole with a matte color (or wash) — instead of the Key foreground video from the Key Bus. All Key types except Preset Pattern Keys can be filled with matte color. Use the controls in the Matte Group to choose the hue, luminance, saturation, and (if desired) complex wash color for the matte. Refer to the section “Matte Group” on page 6–17 for matte fill and color wash instructions.

Note

The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot perform a Matte Fill in the DSKs for the bottom MLE.

- The KEY MEM (memory) function applies to Auto Select and Chroma Keys only (only applies to Auto Select Keys on the DSK of a Half MLE). This function allows you to store and recall one set of favorite adjustments per Key type.
  ~ For each Auto Select Key, one memory register only is provided that stores the clip and gain settings of the Key.
  ~ For Chroma Keys, one memory register is provided for the entire switcher. This register stores one set of Chroma Key clip, gain, hue, reject, and suppress settings.

The Key Memory function is switcher-wide. This means that you can store a new Auto Select or Chroma Key setting in one MLE, and when you enable the same Key source in a different MLE, both settings will be identical — visually and electronically.

The KEY MEM button affects each Key type as follows:

- Auto Select Keys
  For Auto Select Keys, the KEY MEM button turns on automatically when you press AUTO SELECT and choose an Auto Select Key source on the Key Bus. This function recalls the Key settings from memory, no matter where the Key is enabled on the switcher. With the button lit, clip and gain settings are locked. If you press KEY MEM to turn off the light, you unlock clip and gain, allowing you to make temporary adjustments to the linear settings for the Key. Turning the button back on again restores the default Key source settings from memory.
Although the default clip and gain settings were set during the switcher installation process, you can also use the **KEY MEM** button to store *new* default values for the selected linear Key source. Refer to the section “Performing an Auto Select Key” on page 7–23 for details.

**UltraChrome™ Chroma Keys**

For Chroma Keys, press **KEY MEM** to recall all settings from the Chroma Key memory register. When you select a Chroma Key source, the **KEY MEM** button does *not* come on automatically. You can also use the **KEY MEM** button to store a *new* set of Chroma Key values. Refer to the section “Performing an UltraChrome Chroma Key” on page 7–26 for more information.

- Press **MASK** to activate the **Mask** controls in the **Effects Control Group**. These controls allow you to selectively eliminate unwanted portions of a Key signal, similar to the “crop” function found on many DVEs. You can independently mask the top, bottom, left, or right edges of the Key, using a box, a pattern, or a Utility Bus mask. All Key types except Preset Pattern Keys can be masked. Refer to the section “Effects Control Group” on page 7–15 for information and instructions.
- Press **KEY INV** to invert the polarity of the selected Key signal. For example, if a Self Key source (such as a title camera) has white letters on a black background, the white letters normally cut the hole. When **KEY INV** is pressed, the signal polarity is reversed and the black background cuts the hole. This function is often used to Key black text that is printed on a white background. All Key types can be inverted.

### 3. Key Modifier Section 2 (All groups)

The buttons in **Key Modifier Section 2** provide *additional* modification options for the selected Key.

- The **FLY KEY** button enables and disables the Squeeze & Tease MD function, allowing you to apply DVE effects to any of the four Key types, when enabled. The button lights *automatically* when **PST PATT** is pressed, but must be pressed manually to fly a CHROMA KEY, AUTO SELECT or SELF KEY.

**UpNote**

The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot perform a Fly Key in the DSKs for the bottom MLE.

Once enabled, you can control the size of the flying image, horizontal and vertical position, and much more. This optional feature is available for all MLEs, including the DSK. The **FLY KEY** button will not light if the option is not installed in an MLE.

Press **BORD** to add a border behind the selected Key type. The border can appear as a simple *surrounding* border or as a detached shadow. Border width, color and transparency are all adjustable. The **BORD** button will not light if the option is not installed in an MLE. Refer to the section “Bordering Keys” on page 8–8 for instructions.

**UpNote**

The XFX Extra Effects Dual Border Generator option must be installed.

- Press **SHDW** to add a drop shadow behind the selected Key type, with variable width, color and transparency.
4. Key Preview Section

The buttons in the Key Preview Section differ slightly between the Key groups, as follows:

- (All groups) Press and hold KEY PV to shortly take control of the MLE (or DSK) preview monitor output, to show how the Key would appear if CUT or AUTO TRANS is pressed. The button is also useful to simply activate a Keyer for adjustment, when both Keyers are in use. KEY PV is non-latching, and must be held down to view the preview for the Key.

Double-pressing the KEY PV button displays the alpha signal for the selected key on the preview monitor. Self, Auto, and UltraChrome key types are supported. The alpha signal preview is latching (the KEY PV button flashes when this feature is active) and remains active until any KEY PV button is pressed.

The Key Preview function itself is necessary because each Keyer does not have a button similar to the TRANS PV on the Transition Group (which rehearses transitions without affecting output). Key Preview can also be used as a last-minute check before taking a Key to air, and also when you want to quickly identify which Key is which on an MLE, when both Keys are on-air simultaneously.

- (MLE Key 1 Group only) Press KEY OVER to change the priority of the two Keyers with a cut. Normally, Key 2 is over (visually on top of) Key 1. However, when KEY OVER is lit, Key 1 is over Key 2.

- (MLE Key 2 Group only) Press CHAR GEN to select your most frequently used “favorite” character generator, without having to hunt for it on the Key Bus. When pressed, the Key type and Key source are automatically selected, KEY MEM is turned On, and Key modifiers are turned Off to provide a clean CG Key.

- (All groups) The ON LED has three states:
  - Off — When the LED is off, the Keyer is turned off and not contributing to the output of the MLE or switcher.
  - Green — When the LED is lit green, the Keyer is turned on but contributing to the output of the MLE only — not the program output of the entire switcher.
~ **Red** — When the LED is lit red, the Keyer is turned on and contributing to the program output of the entire switcher.

| Note | The state of the **ON** LED is duplicated by the **ACTIVE** LED of the associated Key in the **MLE Transition Group** (directly under the **KEY 1** or **KEY 2** “next transition” button). |

- (DSK groups only) The **N/S** LED, when lit, indicates that the selected Key alpha or fill signal is non-synchronous.

5. **Key Transition Section (All groups)**

The buttons in the **Key Transition Section** provide you with two methods for taking the selected Key on or off air:

- Press **CUT** to instantaneously “cut” the Key on or off air.
  - If the Key is currently Off, press **CUT** to cut the Key on.
  - If the Key is On, press **CUT** to cut it off air.

The **CUT** button itself is **momentary** — it does not stay lit. Refer to the section “**Key Cut Notes**” on page 7–71 for important rules regarding the **CUT** button.

- Press **AUTO TRANS** to smoothly transition the Key on or off air, using a dissolve (from 1 to 999 frames).
  - If the Key is currently off, press **AUTO TRANS** to dissolve the Key on.
  - If the Key is on, press **AUTO TRANS** to dissolve the Key off air.

The **AUTO TRANS** button is **momentary** — it stays lit only **during** the transition. Refer to the section “**Setting Auto Transition Rates**” on page 7–68 for more information on changing auto transition dissolve rates.

| Note | When you press **AUTO TRANS** in DSK 1, DSK 2, MLE KEY 1, or MLE KEY 2, the following actions occur to show a Key transition is in progress:
  - The **DISS** button (in the **Program/Preset Transition Group** or **MLE Transition Group**) lights.
  - The **DSK 1**, **DSK 2**, **KEY 1**, or **KEY 2** button lights (as appropriate).
  - The display above the Fader (in the **Program/Preset Transition Group only**) briefly updates with the rate of the selected transition for the DSK.

Refer to the section “**Using MLE Keys**” on page 7–21 for more information.
6. DSK Source Bus (DSK Groups on Synergy 2, 3 and 4 only)

The Downstream Key Groups do not include a Key Type section. Instead, each DSK includes an eight-button DSK Source Bus, as shown below (with sample Key source names):

![DSK Source Bus Diagram]

Synergy 4 — DSK Source Buttons

Each of the eight crosspoints in the DSK Source Bus functions as mini storage registers for all parameters of a Key, including Key type, source, modifiers, clips, etc. The default states for each DSK can be stored using the DSK Setup Menu. Refer to the section “Storing DSK Crosspoint Assignments” on page 7–54 for details.

During on-air operation, when a DSK Source Bus crosspoint is pressed, all Key parameters are instantly called up. Refer to the section “Using Downstream Keys” on page 7–50 for additional information.

**Note**

You do not have to program identical sources on each DSK Source Bus. For example, crosspoint 1 on DSK 1 can have CG 1, while crosspoint 1 on DSK 2 can have CG 2. Effectively, you can program 16 different Key sources spanning the two DSKs.

**Operating Tip**

Although the crosspoints are typically programmed during switcher installation, the simple programming procedure can be performed during switcher operation — if you need to quickly program a Key source for use in the current production. Refer to the section “DSK Source Bus Setup” on page 7–52 for details.

7. Key Modifier Assignment Section (Synergy 2 DSK Group only)

Because of its compact size, the Synergy 1.5 and 2 Q/MD, and 2 Q/MD-X DSK Group contains only one set of Key modifiers, instead of one per DSK. As a result, two buttons are required for assigning the modifiers.

![DSK Key Modifier Assignment Buttons Diagram]

Synergy 2 — DSK Key Modifier Assignment Buttons
• Press DSK 1 to manually assign the buttons in Key Modifier Sections 1 and 2 to DSK 1. The button will automatically light if any button associated with DSK 1 is pressed.
• Press DSK 2 to manually assign the buttons in Key Modifier Sections 1 and 2 to DSK 2. The button will automatically light if any button associated with DSK 2 is pressed.

A Word About FlexiClean

FlexiClean allows you to set up your outputs to provide you with a second “program” output that is derived from a different location in the video stream than the standard program output. This feature is most commonly used for bilingual and live-to-tape production such as a call-in show where the rebroadcast does not show the phone numbers.

On any MLE, the FlexiClean output can be generated from before or between the Keyers, as illustrated below. The point from which the feed is derived is software-configurable.

FlexiClean Modes — Upper MLEs

FlexiClean can be taken from either before or between the two Keyers in an upper MLE. This allows you to have the clean feed of the PGM/BKGD of the MLE without the two MLE Keyers, or with Key 1 only.

Note

FlexiClean operates the same way on the DSKs of the PGM/PST MLE for all Synergy Q/MD/X switchers.

If you have the MultiDSK (DSK 3 and DSK 4) option installed on a Synergy 1.5, 2, 2.5 Q/MD, and 2, 2.5, 3, 3.5, 4 Q/MD-X, the FlexiClean output can be configured to pull the output from before each DSK, independently, as illustrated below.

Synergy 4 FlexiClean Modes — Program/Preset MLE with MultiDSK
If you have the MultiDSK (DSK 1 and DSK 2) option installed on a Synergy 1 Q/MD, the FlexiClean output can be configured to pull the output from before each Key and DSK, independently, as illustrated below.

Consult with your facility engineer to determine how your Synergy Q/MD/X switcher is configured. Refer to Chapter 8, “Output Configuration”, of the Synergy Q/MD or Q/MD-X Engineering Manual for more information.
Effects Control Group

The Effects Control Group allows you to quickly adjust a number of the values for different effects that are usually accessed through the menu system. For example, if you are using a Self Key, the Self Key Setup Menu is displayed with the top knob being assigned to Clip and the middle knob as Gain. These menu driven knobs perform the same function as the Clip and Gain knobs in the Key section of the Effects Control Group.

Each of Synergy Q/MD/X control panels have a slightly different layout for the Effects Control Group.

Synergy 4 Effects Control

The following figure illustrates the Effects Control Group for the Synergy 3.5 and 4 Q/MD-X panel:

- **Effects Control Assignment Section**
- **Mask Section**
- **Border Control Section**
- **Key Control Section**
- **Chroma Key Section**

![Synergy 4 — Effects Control Group](image_url)
Synergy 3 Effects Control

The following figure illustrates the Effects Control Group for the Synergy 2.5 Q/MD, and 2.5 and 3 Q/MD-X panel:

1) Effects Control Assignment Section
2) Mask Section
3) Border Control Section
4) Key Control Section
5) Chroma Key Section
Synergy 2 Effects Control

The following figure illustrates the Effects Control Group for the Synergy 1.5, 2 Q/MD and 2 Q/MD-X control panel:

![Synergy 2 Effects Control Diagram]

Synergy 1 — Effects Control Group

1) Effects Control Assignment Section
2) Mask Section
3) Border Control Section
4) Key Control Section
5) Chroma Key Section

Synergy 1

The following figure illustrates the Effects Control Group for the Synergy 1 control panel:

![Synergy 1 Effects Control Diagram]

Synergy 1 — Effects Control Group

1) Effects Control Assignment Section
2) – not available on the S1 –
3) Border Control Section
4) Key Control Section
5) Chroma Key Section

1. Effects Control Assignment Section

The Effects Control Assignment Section provides a group of buttons that allow you to assign the Effects Control Group to individual MLEs. Buttons are selected automatically or they can be selected manually.
• (Synergy 1 and 2) Press KEY 1 to assign the group to control Keys, borders, and masks in the MLE 1 Key 1 Group. The button lights automatically if any button is pressed in the Key 1 Group.

• (Synergy 1 and 2) Press KEY 2 to assign the group to control Keys, borders, and masks in the MLE 1 Key 2 Group. The button lights automatically if any button is pressed in the Key 2 Group.

• (Synergy 3 and 4) Press MLE 1 KEY 1 to assign the group to control Keys, borders, and masks in the MLE 1 Key 1 Group. The button will also light automatically if any button is pressed in MLE 1 Key 1 Group.

• (Synergy 3 and 4) Press MLE 1 KEY 2 to assign the group to control Keys, borders, and masks in the MLE 1 Key 2 Group. The button will also light automatically if any button is pressed in MLE 1 Key 2 Group.

• (Synergy 3 and 4) Press MLE 2 KEY 1 to assign the group to control Keys, borders, and masks in the MLE 2 Key 1 Group. The button will also light automatically if any button is pressed in MLE 2 Key 1 Group.

• (Synergy 3 and 4) Press MLE 2 KEY 2 to assign the group to control Keys, borders, and masks in the MLE 2 Key 2 Group. The button will also light automatically if any button is pressed in MLE 2 Key 2 Group.

• (Synergy 3 and 4) Press MLE 3 KEY 1 to assign the group to control Keys, borders, and masks in the MLE 3 Key 1 Group. The button will also light automatically if any button is pressed in MLE 3 Key 1 Group. On the Synergy 3 control panel, this button controls the DSK 1 Group.

• (Synergy 3 and 4) Press MLE 3 KEY 2 to assign the group to control Keys, borders, and masks in the MLE 3 Key 2 Group. The button will also light automatically if any button is pressed in MLE 3 Key 2 Group. On the Synergy 3 control panel, this button controls the DSK 2 Group.

• (Synergy 2) Press DSK 1 to assign the group to control Keys, borders, and masks in the DSK 1 Group. The button lights automatically if any button in DSK 1 is pressed.

• (Synergy 4) Press MLE 4 KEY 1 to assign the group to control Keys, borders, and masks in the MLE 4 DSK 1 Group. The button will also light automatically if any button is pressed in MLE 4 DSK 1 Group.

• (Synergy 2) Press DSK 2 to assign the group to control Keys, borders, and masks in the DSK 2 Group. The button will also light automatically if any button in DSK 2 is pressed.

• (Synergy 4) Press MLE 4 KEY 2 to assign the group to control Keys, borders, and masks in the MLE 4 DSK 2 Group. The button will also light automatically if any button is pressed in MLE 4 DSK 2 Group.

2. Mask Section

Note: There is no Mask Area in the Effects Control Group of the Synergy 1 Q/MD control panel.

The controls in the Mask Section allow you to eliminate unwanted portions of a Key signal, similar to the crop function. To activate the Mask Area, press the MASK button in each Keyer Group to access the Mask Setup Menu, and toggle the Mask softkey to On.
All types of Keys can be masked. Each Key has its own individual mask that is stored in memory.

When the MASK button is lit and a Box mask is turned on, the controls are active. If the button or softkey is turned off, the controls are disabled and any mask that was previously applied is removed from the Key. If the MASK button is re-enabled for that Key, the previous mask is recalled from memory and re-applied.

- Use the TOP knob to trim (eliminate) the top edge of the Key.

- Use the BOTTOM knob to trim the bottom edge of the Key.

- Use the LEFT knob to trim the left edge of the Key.

- Use the RIGHT knob to trim the right edge of the Key.

- Press FORCE to force the area inside the mask region to the foreground, essentially forcing it to Key in 100% — regardless of the current clip and gain settings. In post production, this function is typically used to clean up a Key and, in the case of Chroma Keys, to mask blue eyes and allow them to Key though.
• Press **INVERT** to reverse the polarity of the mask. With the button toggled off, the mask is applied from the outside edges towards the inside of the Key. With the button on, the mask is applied from the inside edges towards the outside.

![INVERT Off and INVERT On buttons](image)

3. **Border Control Section**

The three knobs in the **Border Control Section** allow you to adjust Key border parameters. The controls are identical for all switchers. The knobs are activated by enabling the **BORD, SHDW** or **OUTL** button in any Keyer or DSK. The knobs work in parallel with controls on the Border Menu.

- Use the **GLOW** knob to adjust the “glow level” of the Key border, shadow or outline, ranging from a hard edge to a soft edge.
- Use the **WIDTH** knob to adjust the “border size” for border, shadow and outline effects.
- Use the **DENSITY** knob to adjust the “density” (transparency) of the Key border, shadow or outline.

4. **Key Control Section**

The knobs in the **Key Control Section** allow you to adjust Key clip and gain levels. Both controls are activated for all Keys (except PST PATT fly Keys), but for Auto Select Keys, the **KEY MEM** button must be off in order to adjust clip and gain.

- Use the **CLIP** knob to adjust the luminance or **threshold** level of the Key. Only the areas of the source video that are **higher** than the setting of the threshold will cut a hole in the background video.
- Use the **GAIN** knob to adjust the gain of the Key. The control acts on all Keys (except PST PATT fly Keys) and **softens** the Key edge, allowing you to adjust the way that the Key blends into the background. For Auto Select (linear) Keys, the adjustment ensures the correct Key transparency.
- Use the **GLOW** knob to adjust the “glow level” of the edge of the Key, ranging from a hard edge to a soft edge.

5. **Chroma Key Section**

- **Note**: The **Chroma Key** knobs are not used for UltraChrome™ on the Synergy Q/MD/X switchers.
Using MLE Keys

This section provides detailed instructions for using Keys. Prior to proceeding, ensure that you have thoroughly read the section “Key Functions” on page 7–6.

There are four primary kinds of Keys that can be performed on any upper MLE. These are as follows:

• **Self Key** — A Self Key is a Key that uses the luminance, or brightness, values of the source video as both the alpha signal and the fill video. Refer to the section “Performing a Self Key” on page 7–21 for more information.

• **Auto Select Key** — An Auto Select Key is a linear Key that uses a separate alpha signal and fill video. These two video signals are linked together when you set up your BNC inputs. Refer to the section “Performing an Auto Select Key” on page 7–23 for more information.

• **Chroma Key** — An UltraChrome™ Chroma Key is a Key that cuts the hole based on a selected color. The color is removed from the Key, allowing the background video to show. Refer to the section “Performing an UltraChrome Chroma Key” on page 7–26 for more information.

• **Preset Pattern Key** — A Preset Pattern Key is a Key that cuts the hole based on a **Wipe** that you select from the **Pattern Control Group**. Refer to the section “Performing a Preset Pattern Key” on page 7–44 for more information.

---

**Important**

Self Keys, Auto Select Keys, and Chroma Keys require two channels of DVE to fly. Preset Pattern Keys require only a single channel. However, flying a Preset Pattern Key locks the additional DVE channel of the assigned Squeeze & Tease 3D card to the same MLE.

**Note**

Refer to the section “Using Downstream Keys” on page 7–50 for information on performing a Downstream Key.

---

Performing a Self Key

A Self Key is one in which the luminance (or brightness) values of the Key source itself are used to cut the hole.

Use the following procedure to perform a Self Key on an MLE Keyer:

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “Using the Preview Bus” on page 4–35 for details.
2. Select an input on the **BKGD** bus of an MLE. This provides the background over which the Key will appear.
3. Press **KEY1** in the **MLE Transition Group** for the same MLE as you set the Background for. This will assign the Key bus to **Key 1**.
4. On the **Key Bus** of the MLE, select the desired (luminance) Key source (such as a title camera or VTR).

---

**Operating Tip**

Pressing **KEY2** instead of **KEY1** would assign the Key bus to **Key 2**.
5. Press SELF KEY, in the MLE Key 1 Group of the MLE, to display the Self Key Setup Menu.

In the main area, Key Fill and Key Alpha sources are listed along with the location of the Keyer.

6. Adjust the clip and gain of the Key as follows:
   - Use the Clip knob in the Display Section or the CLIP knob in the Effects Control Section to adjust clip level.
   - Use the Gain knob in the Display Section or the GAIN knob in the Effects Control Section to adjust gain (softness).

7. If desired, adjust the transparency of the Key by toggling the Transparency softkey On. On the display, the Transparency Field appears.

   - Use the Transparency knob to adjust transparency from opaque (0%) to fully transparent (100%)

8. Select additional Key modifiers as desired, using the controls in Key Modifier Areas. Modifiers include:
   - MATTE FILL (Not available on the DSKs for the Half MLE switchers)
   - KEY INV
   - MASK
   - FLY KEY (Squeeze & Tease MD only)
   - Border Effects (XFX Extra Effects Dual Border Generator only)

Refer to the chapter 8, “Key Modifiers” for more information.

9. If desired, preview the Key by pressing KEY PV.
10. Use the proper **KEY 1** or **KEY 2** “next transition” button (in the **MLE Transition Group**) to select the Key to be taken on (or off) air during the next transition. Refer to the section “**Working with Next Transitions**” on page 5–12 for complete instructions on the three “next transition” buttons.

11. Take the selected Key On or Off-air as follows:

   - **CUT** — Press **CUT** (in the **MLE Key Group**) to cut the Key on (or off) air. Refer to the section “**Key Cut Notes**” on page 7–71 for additional rules.

   - **AUTO TRANS** — Select an auto transition rate, then press **AUTO TRANS** (in the **MLE Key Group**) to dissolve the Key on (or off) air. Refer to the section “**Setting Auto Transition Rates**” on page 7–68 for instructions on selecting Key dissolve rates. Refer to the section “**Key Auto Transition Notes**” on page 7–71 for additional rules.

   If you select a different self Key source, you will need to re-clip the source as outlined above. There is only one memory register per MLE Keyer for self Keys.

   **Note**
   
   The system allows you to enable the **FLY KEY** button (**Squeeze & Tease MD**) for a Self Key, provided that the other MLE Keyer is not flying an Auto Select Key. You can also fly two Self Keys in an MLE at a time.

**Performing an Auto Select Key**

An Auto Select (or “linear”) Key is one in which two signals are used to cut and fill the hole — a Key (alpha) signal, and a fill signal. These signals originate from devices such as character generators, still stores, DVEs and graphics systems.

Use the following procedure to perform an Auto Select Key in an MLE Keyer

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “**Using the Preview Bus**” on page 4–35 for details.

2. Select an input on the **BKGD** bus of an MLE. This provides the background over which the Key will appear.

3. Press **KEY1** in the **MLE Transition Group** for the same MLE as you set the Background for. This will assign the Key bus to **Key 1**.

   **Operating Tip**
   
   Pressing **KEY2** instead of **KEY1** would assign the Key bus to **Key 2**.

4. On the **Key Bus** of the MLE, select the desired (luminance) Key source (such as a title camera or VTR).
5. Press **AUTO SELECT** in the **MLE Key 1 Group** of the MLE, to display the **Auto Key Setup Menu**.

![Auto Key Setup Menu](image)

The menu lists the individual **Key Fill** and **Key Alpha** sources (which are linked during switcher installation), the **location** of the selected Keyer, and whether or not the alpha signal for the Key is **shaped** (also determined during installation).

**Note**

On the control panel, the **KEY MEM** button turns on automatically to indicate that **Clip** and **Gain** are locked. This state is also reflected by the “**Locked**” labels on the display.

6. The **Clip** and **Gain** settings of the Key were set during the installation process. Typically, they should not need to be adjusted. If you do need to adjust them temporarily, turn off the **KEY MEM** button. The display changes to indicate that clip and gain are now **unlocked**.

![Auto Key Setup Menu — Clip and Gain Unlocked](image)

Adjust clip and gain as follows:

- Use the **Clip** knob in the **Display Section** or the **CLIP** knob in the **Effects Control Section** to adjust clip level.
- Use the **Gain** knob in the **Display Section** or the **GAIN** knob in the **Effects Control Section** to adjust gain (softness).

**Note**

To return the clip and gain values to the default settings of 90.8% and 44.8% respectively, press the **Make Key Linear** softkey. If you turn **KEY MEM** back on again, the previously stored values are recalled from memory.

7. If desired, adjust transparency by toggling the **Transparency** softkey **On**.

On the display, the **Transparency Field** appears.

- Use the **Transparency** knob to adjust transparency from opaque (0%) to fully transparent (100%).
8. Select and adjust additional Key modifiers as desired, using the controls in Key Modifier Sections 1 and 2. Modifiers include:
   • MATTE FILL (Not available on the DSKs for the Half MLE switchers)
   • KEY INV
   • MASK
   • FLY KEY (Squeeze & Tease MD only)
   • Border Effects (XFX Extra Effects Dual Border Generator only).
   Refer to the section “Key Modifiers” on page 8–1 for more information.

9. If desired, preview the Key by pressing KEY PV.

10. Use the proper KEY 1 or KEY 2 “next transition” button (in the MLE Transition Group) to select the Key to be taken on (or off) air during the next transition. Refer to the section “Working with Next Transitions” on page 5–12 for complete instructions on the three “next transition” buttons.

11. Take the selected Key On or Off-air as follows:
   • CUT — Press CUT (in the MLE Key Group) to cut the Key on (or off) air. Refer to the section “Key Cut Notes” on page 7–71 for additional rules.
   • AUTO TRANS — Select an auto transition rate, then press AUTO TRANS (in the MLE Key Group) to dissolve the Key on (or off) air. Refer to the section “Setting Auto Transition Rates” on page 7–68 for instructions on selecting Key dissolve rates. Refer to the section “Key Auto Transition Notes” on page 7–71 for additional rules.

Auto Select Key Operating Tips

Note the following important point when working with an Auto Select Key:

• If you select a different linear Key source, the KEY MEM button will automatically turn on.

• You cannot enable the FLY KEY button (Squeeze & Tease MD only) for an Auto Select Key, if the other MLE Keyer is already flying a Key of any type (Self, Auto Select, Chroma, or Preset Pattern). In addition, you can only fly one Auto Select Key in an MLE at a time.

To Store New Clip and Gain Settings

If the KEY MEM button is off, you can adjust the Clip and Gain settings of the Key on a temporary basis. In this mode, if you want to permanently store the new clip and gain settings, use the following procedure:

1. Ensure that the KEY MEM button is toggled Off.
2. Adjust the Clip and Gain for the desired appearance.
3. Press and hold the AUTO SELECT button.
4. Press KEY MEM.
5. Release both buttons.

This procedure re-locks the clip and gain values, and stores the new settings in memory.

Important There is no undo function. If you re-store clip and gain, you cannot recall previous values unless you recall settings from memory.
Performing an UltraChrome Chroma Key

This section provides instructions for performing an UltraChrome™ Chroma Key on the Synergy Q/MD/X switchers. Two UltraChrome Chroma Keys come standard in every full MLE.

<table>
<thead>
<tr>
<th>Note</th>
</tr>
</thead>
<tbody>
<tr>
<td>UltraChrome is not available on the DSKs of a half MLE switcher.</td>
</tr>
</tbody>
</table>

A Chroma Key is a Key in which the hole is cut based on a color value (hue), rather than on a luminance value or an alpha signal. The color is electronically removed and replaced with background video from another source. Remember that with Synergy Q/MD/X switchers, you can Chroma Key on any source selected on the Key Bus except for the internally generated color backgrounds.

Choosing an UltraChrome Operating Mode

The UltraChrome Chroma Keyer operates in one of two modes: Basic and Advanced.

<table>
<thead>
<tr>
<th>Important</th>
</tr>
</thead>
<tbody>
<tr>
<td>The extra controls available in Advanced mode are disabled when you switch to Basic mode and enabled when you switch to Advanced mode. This change can result in undesirable on-screen effects so exercise caution when switching modes.</td>
</tr>
</tbody>
</table>

Basic mode allows you to define two areas of the image being keyed: a background and a foreground. The background is the part of the image that will be removed, allowing any underlying image to show through, while the foreground is any part of the image that will be kept. Basic mode allows you to modify the colors used to define the background and foreground as well as some control over background “spill” onto your foreground subject and edge softness to help the foreground object blend into any underlying video. Beginning users and those who have simple Chroma Key needs should choose Basic mode. This mode allows you to quickly create an excellent Chroma Key with little need for fine-tuning many options.

To create an UltraChrome Chroma Key in Basic mode, proceed to the section “Creating an UltraChrome Chroma Key in Basic Mode” on page 7–26.

Advanced mode allows much more control over the Chroma Keying process. Background areas can be defined as translucent areas and shadow areas, while transition areas are where the background and foreground areas meet. Advanced users and those with more demanding Chroma Key needs may use Advanced mode. This mode allows you to control all aspects of the Chroma Keying process and gives you fine-tuning ability of properties such as shadows and transparency.

To create an UltraChrome Chroma Key in Advanced mode, proceed to the section “Creating an UltraChrome Chroma Key in Advanced Mode” on page 7–32.

Creating an UltraChrome Chroma Key in Basic Mode

Use the following procedure to create a Chroma Key in Basic mode on an MLE Keyer:

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “Using the Preview Bus” on page 4–35 for details.

2. Select an input on the BKGD bus of the MLE. This provides the background over which the Chroma Key will appear.
3. Press **KEY1** in the **MLE Transition Group** for the same MLE as you set the background for. This will assign the Key bus to **Key 1**.

   **Operating Tip**

   Pressing **KEY2** instead of **KEY1** would assign the Key bus to **Key 2**.

4. On the **Key Bus**, select the desired Chroma Key source (typically, a camera or a graphics system).

5. Press **CHROMA KEY** in the **MLE Key 1 Group** to display the **UltraChrome Menu 1-2**.

6. Press **Color Pick** to display the **Color Pick Menu**.

   ![UltraChrome: MLE 3 Key 1 (1-2) Menu](image)

   **UltraChrome: MLE 3 Key 1 (1-2)**

   Key Video: DB1 SS2

   The basic and advanced key modes can produce different keys, with the advanced mode allowing for finer tuning of the background.

   Choose the color of the background to be removed upon key initialization.

   Color:

   - Basic
   - Advanced
   - Cyan
   - Green
   - Yellow

   **Color Pick Menu**

   This menu is used to set the UltraChrome operating mode and to select the primary background color to be removed.

7. Use the **Mode** knob to select **Basic** mode.

8. Select a color to key out, or remove, as follows:

   - Use the **Color** knob to select the primary color (background) to be removed. You can select from the following:
     - **Red** — Select this option to have red removed from the video signal.
     - **Magenta** — Select this option to have magenta removed from the video signal.
     - **Blue** — Select this option to have blue removed from the video signal.
     - **Cyan** — Select this option to have cyan removed from the video signal.
     - **Green** — Select this option to have green removed from the video signal.
     - **Yellow** — Select this option to have yellow removed from the video signal.

9. Press **Initialize Key**. The selected color will now be keyed out, or removed.

   **Note**

   Every time **Initialize Key** is pressed, the switcher will reset all the Chroma Key parameters to their default values for the video.

10. If you need to adjust or fine-tune the Chroma Key, refer to the section “Adjusting an UltraChrome Chroma Key in Basic Mode” on page 7–29 for more information.

11. Select and adjust additional Key modifiers as desired, using the controls in **Key Modifier Sections 1** and **2**. Modifiers include:

   - **MATTE FILL**
   - **MASK**
• **FLY KEY** (Squeeze & Tease MD only)

• **Border Effects** (XFX Extra Effects Dual Border Generator is required)

Refer to the section “**Key Modifiers**” on page 8–1 for more information.

12. Use the proper **KEY 1** or **KEY 2** “next transition” button (in the **MLE Transition Group**) to select the Key to be taken on (or off) air during the next transition. Refer to the section “**Working with Next Transitions**” on page 5–12 for complete instructions on the three “next transition” buttons.

13. Take the selected Key On or Off-air as follows:

• **CUT** — Press **CUT** (in the **MLE Key Group**) to cut the Key on (or off) air. Refer to the section “**Key Cut Notes**” on page 7–71 for more information.

• **AUTO TRANS** — Select an auto transition rate, then press **AUTO TRANS** (in the **MLE Key Group**) to dissolve the Key on (or off) air. Refer to the section “**Setting Auto Transition Rates**” on page 7–68 for instructions on selecting Key transition rates. Refer to the section “**Key Auto Transition Notes**” on page 7–71 for additional rules.

This completes the procedure for creating a Chroma Key in Basic mode on an MLE Keyer. You may wish to refer to the section “**Chroma Key Lighting Tips**” on page 7–42 for information and tips on perfecting your chroma key set.

**Using the Alpha and Color Map Previews in Basic Mode**

Adjusting a Chroma Key can be difficult when looking at the actual video signals as some adjustments have very subtle effect on the image. Using an Alpha or Color Map preview gives you a visual representation of the various parts of your Chroma Key and makes for easier adjustments. The Alpha and Color Map previews use the Preview bus of the selected MLE to show a representation of the Alpha (used by the Keyer to mix the key with the underlying background video) or a color-coded representation of the different UltraChrome regions. The Preview bus will display the representation in the foreground of the Preview (but not over top of the Preview Overlay) while the feature is set to **On**.

The Color Map Preview, when in Basic Mode, shows three different colored regions that represent the elements that the UltraChrome Chroma Keyer breaks an image into. The table below summarizes this breakdown.

**Color Map Legend**

<table>
<thead>
<tr>
<th>Color</th>
<th>UltraChrome Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Black</td>
<td>Foreground</td>
</tr>
<tr>
<td>Blue</td>
<td>Spill Suppression</td>
</tr>
<tr>
<td>Gray</td>
<td>Background</td>
</tr>
</tbody>
</table>

Use the following procedure to display Alpha or Color Map previews in Basic mode.

1. Create an UltraChrome Chroma Key as you did in the section “**Creating an UltraChrome Chroma Key in Basic Mode**” on page 7–26.

2. If the **UltraChrome Menu 2-2** is not displayed, press **MORE** to display it.

3. Press **Color Map** to toggle this feature **On** or **Off**.
UltraChrome — Color Map

- **On** — When the Color Map is turned on, the 3 different elements that the UltraChrome Chroma Keyer breaks an image down to are displayed as colored regions on the Preview bus of the selected MLE. The Color Map is not displayed on air with the Chroma Key.

- **Off** — When the Color Map is turned off, the Chroma Key is shown on the Preview bus of the selected MLE without the Color Map feature.

4. Press **Alpha** to toggle this feature **On** or **Off**.

UltraChrome — Alpha

- **On** — When the Alpha is turned on, a preview of the generated Alpha channel is displayed. The Alpha is not displayed on air with the Chroma Key.

- **Off** — No preview is displayed.

Important

The Alpha and Color Map signal views for the Chroma Key are mutually exclusive. For example, if you toggle the Color Map **On**, the Alpha signal view for the Chroma Key will automatically be set to **Off**.

This completes the procedure for displaying Alpha or Color Map previews in Basic mode.

**Adjusting an UltraChrome Chroma Key in Basic Mode**

Adjusting the values of a Chroma Key can be done at any time after you have initialized the Key. The following procedure assumes that you have already created the Key in **Basic** mode and are now attempting to improve the appearance of it.

Use the following procedure to adjust the appearance of an UltraChrome Chroma Key in Basic mode:

1. Create an UltraChrome Chroma Key using Basic mode as described in the section “Creating an UltraChrome Chroma Key in Basic Mode” on page 7–26.
2. If the **UltraChrome Menu 1-2** is not displayed, press the lit **Chroma Key** button to display it.

3. Press **Background** to display the **UltraChrome Background Menu**.

   ![UltraChrome Background Menu](image)

4. Use the **Gain** knob to adjust the Background gain as follows:
   - Increasing the gain value causes the Background to appear more opaque (i.e., less of the selected Background color is removed).
   - Decreasing the gain value causes the Background to appear more transparent (i.e., more of the selected Background color is removed).

5. Press **Foreground** to display the **UltraChrome Foreground Menu**.

   ![UltraChrome Foreground Menu](image)

6. Adjust which colors (hues) make up the Foreground, or keyed on, part of the image as follows:
   - Use the **Clip** knob to adjust the Foreground clipping.
     - Increasing the clip value removes lower-saturated colors from the Foreground image.
     - Decreasing the clip value includes lower-saturated colors in the Foreground image.
   - Use the **Hue** knob to select the central, or base, color for the Foreground.
     - Increasing the hue value moves counter-clockwise around the color wheel while selecting a base color.
     - Decreasing the hue value moves clockwise around the color wheel while selecting a base color.
   - Use the **Reject** knob to include or reject adjacent hues to the base.

   ![Operating Tip](image)
~ Increasing the reject value decreases the amount of adjacent hues that are included in the Foreground.

~ Decreasing the reject value increases the amount of adjacent hues that are included in the Foreground.

7. Press Spill Suppress to display the UltraChrome Spill Suppress Menu.

8. Use the Range knob to remove any color cast in your foreground image that is a result of Background color “spilling” over into the Foreground (e.g., if there is a green color cast in your Foreground when using a green screen background).
   - Increasing the range value causes more of the Foreground colors to be corrected for Background color spill.
   - Decreasing the range value causes fewer of the Foreground colors to be corrected for Background color spill.

9. Press Edge Softness to display the UltraChrome Edge Softness Menu.

10. Use the Softness knob to add edge softening to the Foreground image and alpha channel. This may help blend the Foreground image with the underlying background video.
Increasing the softness value increases the amount of softness applied to the Foreground edges and alpha channel.

Decreasing the softness value decreases the amount of softness applied to the Foreground image and alpha channel. A value of 0.0% turns off edge softening.

This completes the procedure for adjusting the appearance of an UltraChrome Chroma Key in Basic mode. You may also wish to refer to the section “Chroma Key Memory” on page 7–42 for more information on storing the Chroma Key settings, on a per-source basis and the section “Chroma Key Lighting Tips” on page 7–42 for information on achieving consistent Chroma Keys.

Creating an UltraChrome Chroma Key in Advanced Mode

Use the following procedure to create a Chroma Key in Advanced mode on an MLE Keyer:

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “Using the Preview Bus” on page 4–35 for details.

2. Select an input on the BKGD bus of the MLE. This provides the background over which the Chroma Key will appear.

3. Press KEY1 in the MLE Transition Group for the same MLE as you set the background for. This will assign the Key bus to Key 1.

4. On the Key Bus, select the desired Chroma Key source (typically, a camera or a graphics system).

5. Press CHROMA KEY in the MLE Key 1 Group to display the UltraChrome Menu 1-2.

6. Press Color Pick to display the Color Pick Menu.

<table>
<thead>
<tr>
<th>UltraChrome — Color Pick Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color: Red, Magenta, Blue</td>
</tr>
<tr>
<td>Basic: Advanced, Off, Green</td>
</tr>
<tr>
<td>Key, Shadow, Translucency, Transition, Background</td>
</tr>
</tbody>
</table>

This menu is used to set the UltraChrome operating mode and to select the primary background color to be removed.

7. Use the Mode knob to select Advanced mode.

8. Select a color to key out, or remove, as follows:
   - Use the Color knob to select the primary color to be removed. You can select between the following:
     - Red — Select this option to have red removed from the video signal.
     - Magenta — Select this option to have magenta removed from the video signal.
     - Blue — Select this option to have blue removed from the video signal.
Cyan — Select this option to have cyan removed from the video signal.

Green — Select this option to have green removed from the video signal.

Yellow — Select this option to have yellow removed from the video signal.

9. Press **Initialize Key**. The selected color will now be keyed out, or removed.

10. If you need to adjust or fine-tune the Chroma Key, refer to the section “**Adjusting an UltraChrome Chroma Key Using Advanced Mode**” on page 7–35 for more information.

11. Select and adjust additional key modifiers as desired, using the controls in **Key Modifier Sections 1** and 2. Modifiers include:
   - MATTE FILL
   - MASK
   - FLY KEY (Squeeze & Tease MD only)
   - Border Effects (XFX Extra Effects Dual Border Generator only)

   Refer to the section “**Key Modifiers**” on page 8–1 for more information.

12. Use the proper **KEY 1** or **KEY 2** “next transition” button (in the **MLE Transition Group**) to select the Key to be taken on (or off) air during the next transition. Refer to the section “**Working with Next Transitions**” on page 5–12 for complete instructions on the three “next transition” buttons.

13. Take the selected Key On or Off-air as follows:
   - **CUT** — Press **CUT** (in the **MLE Key Group**) to cut the Key on (or off) air. Refer to the section “**Key Cut Notes**” on page 7–71 for more information.
   - **AUTO TRANS** — Select an auto transition rate, then press **AUTO TRANS** (in the **MLE Key Group**) to dissolve the Key on (or off) air. Refer to the section “**Setting Auto Transition Rates**” on page 7–68 for instructions on selecting Key transition rates. Refer to the section “**Key Auto Transition Notes**” on page 7–71 for additional rules.

This completes the procedure for creating an UltraChrome Chroma Key in Advanced mode. You may wish to refer to the section “**Chroma Key Lighting Tips**” on page 7–42 for information and tips on perfecting your chroma key set.

**Using the Alpha and Color Map Previews in Advanced Mode**

Adjusting a Chroma Key can be difficult when looking at the actual video signals as some adjustments have very subtle effect on the image. Using an Alpha or Color Map preview gives you a visual representation of the various parts of your Chroma Key and makes for easier adjustments. The Alpha and Color Map previews use the Preview bus of the selected MLE to show a representation of the Alpha (used by the Keyer to mix the key with the underlying background video) or a color-coded representation of the different UltraChrome regions. The Preview bus will display the colored representation in the foreground of the Preview (but not over top of the Preview Overlay) while the feature is set to **On** and the Chroma Key is on-air.
The Color Map Preview, when operating in Advanced mode, shows the five different elements that the UltraChrome Chroma Keyer breaks an image down to as colored regions. The table below summarizes this breakdown.

**Color Map Legend**

<table>
<thead>
<tr>
<th>Color</th>
<th>UltraChrome Element</th>
</tr>
</thead>
<tbody>
<tr>
<td>Red</td>
<td>Background and Shadow</td>
</tr>
<tr>
<td>Green</td>
<td>Translucent</td>
</tr>
<tr>
<td>Black</td>
<td>Foreground</td>
</tr>
<tr>
<td>Blue</td>
<td>Spill Suppression</td>
</tr>
<tr>
<td>Gray</td>
<td>Transition</td>
</tr>
</tbody>
</table>

Use the following procedure to display Alpha or Color Map previews in Advanced mode:

1. Create an UltraChrome Chroma Key as you did in the section “Creating an UltraChrome Chroma Key in Advanced Mode” on page 7–32.
2. If the UltraChrome Menu 2-2 is not displayed, press MORE to display it.
3. Press Color Map to toggle this feature On or Off.

- **On** — When the Color Map is turned on, the five different elements that the UltraChrome Chroma Keyer breaks an image down to are displayed as colored regions on the Preview bus of the selected MLE. The Color Map is not displayed on air with the Chroma Key.

**Important**

The Color Map and Alpha signal views for the Chroma Key are mutually exclusive. For example, if you toggle the Color Map On, the Alpha signal view for the Chroma Key will automatically be set to Off.

- **Off** — When the Color Map is turned off, the Chroma Key is shown on the Preview bus of the selected MLE without the Color Map feature.

4. Press Alpha to toggle this feature On or Off.
On — When the Alpha is turned on, a preview of the generated alpha channel is displayed. The Alpha is not displayed on air with the Chroma Key.

Off — No preview is displayed.

Important

The Color Map and Alpha signal views for the Chroma Key are mutually exclusive. For example, if you toggle the Color Map On, the Alpha signal view for the Chroma Key will automatically be set to Off.

This completes the procedure for displaying Alpha or Color Map previews in Advanced mode.

**Adjusting an UltraChrome Chroma Key Using Advanced Mode**

Adjusting the values of a Chroma Key can be done at any time after you have initialized the Key. The following procedure assumes that you have already created the Key in Advanced mode and are now attempting to improve the appearance of it.

**Adjusting the Background, Shadow, Translucent, and Transition Areas of an UltraChrome Chroma Key**

An UltraChrome Chroma Key, when created in Advanced mode breaks the image into five elements, four of which determine, or partially determine, which part of the image is keyed out (removed). Those four elements are: Background, Shadows, Translucent Areas, and Transition areas.

- **Background** — Background elements are those pixels in the source video that are the same color as the one you chose to key out. Note that the Shadow and Translucent areas (see below) are completely contained within the Background area.

- **Shadow** — Shadow elements are those pixels in the source video with colors that are within the Background range but with lower luminance values. You modify the Shadow range to cover darker areas of the background (e.g., where the foreground is casting a shadow on the background screen).

- **Translucent** — Translucent elements are those pixels in the source video that are in the Background range but with higher luminance values than the Shadow range. You can control the upper-end of the Translucency range by selecting a wider hue-range to constrain the area. You can also control transparency of the Translucent area.

- **Transition** — Transition elements are those pixels in the source video with colors that are not within any of the previous three ranges and are also not considered part of the Foreground area. These are typically the pixels near the edge of the foreground where it blends into the background.

Use the following procedure to adjust the Background, Shadow, Translucent, and Transition range values of an UltraChrome Chroma Key:

1. Create an UltraChrome Chroma Key using Advanced mode as described in the section “Creating an UltraChrome Chroma Key in Advanced Mode” on page 7–32.
2. If the UltraChrome Menu 1-2 is not displayed, press the lit Chroma Key button to display it.
3. Press **Shadow** to display the **UltraChrome Shadow Menu**.

![UltraChrome Shadow Menu](image)

Shadow adjustments allow you to extract a shadow from the background. This would be the actual shadow that the foreground subject is casting onto the screen.

4. Adjust the luminance range that are considered shadows as follows:
   - Use the **Range** knob to adjust the range of Shadow colors.
     ~ Increasing the range value widens the Shadow area by including lower-luminance background colors. The increased range comes as a result of colors moving from the translucent area to the Shadow area.
     ~ Decreasing the range value narrows the Shadow area by excluding higher-luminance colors. These excluded colors move back into the Translucent area.
   - Use the **Gain** knob to adjust the Shadow appearance.
     ~ Increasing the gain value creates darker shadows.
     ~ Decreasing the gain value creates lighter shadows.

5. Press **Translucency** to display the **UltraChrome Translucency Menu**.

![UltraChrome Translucency Menu](image)

Translucency settings allow you to adjust the appearance of clear items such as eye-glass lenses.

6. Adjust the range of Translucent colors and their appearance as follows:
   - Use the **Range** knob to adjust the range of Translucent colors.
     ~ Increasing the range value widens the Translucent area by including more hues from the background range (the lower-end of the range is defined by the Shadow range you just set).
     ~ Decreasing the range value narrows the Translucent area by excluding hues.
   - Use the **Gain** knob to adjust the appearance of the translucent colors.
     ~ Increasing the gain value causes the translucent colors to appear more opaque.
7. Press **Transition** to display the **UltraChrome Transition Menu**.

```
<table>
<thead>
<tr>
<th>Color</th>
<th>Initialize</th>
<th>Shadow</th>
<th>Translucent</th>
<th>Transition</th>
<th>Background</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick</td>
<td>Key</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

The Transition area is the range of pixels that are left-over (i.e. not in the Shadow or Translucent areas). The Transition settings allow you to adjust the appearance of the Transition area.

8. Use the **Gain** knob to adjust the appearance of Transition colors.
   - Increasing the gain value makes the transition area pixels more opaque.
   - Decreasing the gain value makes the transition area pixels more transparent.

9. Press **Background** to display the **UltraChrome Background Menu**.

```
<table>
<thead>
<tr>
<th>Color</th>
<th>Initialize</th>
<th>Shadow</th>
<th>Translucent</th>
<th>Transition</th>
<th>Background</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pick</td>
<td>Key</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

The Background area will typically need only very minor adjustment as most of the modification has been made by adjusting the Shadow and Translucent areas. However, changing this range may help expand or decrease these areas as they are completely contained in the Background range.

10. Adjust the range of hues and saturation levels that are included as part of the background as follows:
   - Use the **Sat Range** knob to adjust for any saturation variances in the background color (the primary color you selected to remove). Not all chroma key backgrounds are lit uniformly so this adjustment lets you add or remove different saturation levels of background color to compensate.
   - Increasing the saturation range value causes a wider range of color saturation to be included in the background, and therefore, keyed out.
   - Decreasing the saturation range value causes less of a color saturation range to be included in the background (i.e. only color saturations close to the nominal value are included in the background).
• Use the **Positive Hue** knob to expand the hues included in the background counter-clockwise around the color wheel. The description will change to indicate the hues that will be added based on your selected primary color.

• Use the **Negative Hue** knob to expand the hues included in the background counter-clockwise around the color wheel. The description will change to indicate the hues that will be added based on your selected primary color.

**Effects of Positive and Negative Background Hue Adjustments**

This completes the procedure for adjusting the background, shadow, translucent, and transition range values of an UltraChrome Chroma Key

**Adjusting the Foreground, Spill Suppress, Edge Softness, and Luminance of an UltraChrome Chroma Key**

The remaining two elements that an UltraChrome Chroma Key breaks an image into are the Foreground and Spill Suppression elements.

• **Foreground** — Foreground elements are those pixels that are not within the Background, Shadow, Translucent, or Transition ranges. This is the area with colors that will not be keyed out and will remain solid.

• **Spill Suppression** — Spill Suppression elements are those pixels in the Foreground that have a noticeable tint of the Background color. This typically occurs around the edges of subjects as glow from the background blue or green-screen “spills” onto them.

There are two final adjustments that you can make to an UltraChrome Chroma Key: Edge Softness, and Luminance.

• **Edge Softness** — Edge Softness lets you apply varying degrees of softening to the foreground edges to help it blend in with the underlying background image.

• **Luminance** — Luminance allows you to control the overall brightness of Shadow, Translucent, and Transition areas as well as partial reflections to more closely match the foreground brightness.

Use the following procedure to adjust the Foreground, Spill Suppress, Edge Softness, and Luminance values of an UltraChrome Chroma Key:

**Note**

Every time **Initialize Key** is pressed, the switcher will reset all the Chroma Key parameters to their optimal default values for the video.

1. Create an UltraChrome Chroma Key using Advanced mode as described in the section “Creating an UltraChrome Chroma Key in Advanced Mode” on page 7–32.

2. If the **UltraChrome Menu 1-2** is not displayed, press the lit **Chroma Key** button to display it.

3. Press **MORE** to display the **UltraChrome Menu 2-2**.
4. Press **Foreground** to display the **UltraChrome Foreground Menu**.

![UltraChrome — Foreground Menu](image)

The knobs associated with this menu directly control the range in which colors are considered Foreground colors, and thus, Keyed fully on. Once the color pick process has been completed, use this menu to fine-tune the Foreground image.

5. Adjust which colors (hues) make up the foreground, or keyed on, part of the image as follows:

- Use the **Clip** knob to adjust the foreground clipping.
  - Increasing the clip value removes lower-saturated colors from the Foreground image.
  - Decreasing the clip value includes lower-saturated colors in the Foreground image.

- Use the **Hue** knob to select the central, or base, color for the Foreground.
  - Increasing the hue value moves counter-clockwise around the color wheel while selecting a base color.
  - Decreasing the hue value moves clockwise around the color wheel while selecting a base color.

- Use the **Reject** knob to include or reject adjacent hues to the base.
  - Increasing the reject value decreases the amount of adjacent hues that are included in the Foreground.
  - Decreasing the reject value increases the amount of adjacent hues that are included in the Foreground.

**Operating Tip**

You may wish to select a hue to set a base color to keep before using the other knobs to expand or contract the range of colors that will be kept in the foreground image.
6. Press **Spill Suppress** to display the **UltraChrome Spill Suppress Menu**

7. Remove any color cast in your foreground image that is a result of background color “spilling” over into the foreground (e.g., if there is a green color cast in your foreground image when using a green screen background) as follows:

   - Use the **Clip** knob to adjust spill suppress clipping.
     ~ Increasing the clip value removes higher-saturated colors from spill suppress correction.
     ~ Decreasing the clip value includes higher-saturated colors in spill suppress correction. If your foreground image contains bright-colored areas that are suffering from background spill, decrease the clip value to have it corrected.
   - Use the **Hue** knob to select the central, or base, color for spill suppress correction. If the color spill does not appear to be the same color as the background, use this control to adjust which hue is considered to be “spilled” into the foreground.
     ~ Increasing the hue value moves counter-clockwise around the color wheel while selecting a base color.
     ~ Decreasing the hue value moves clockwise around the color wheel while selecting a base color.
   - Use the **Reject** knob to include or reject adjacent hues to the base.

**Operating Tip**

Use the **Hue** and **Reject** knobs first and then, if you cannot remove enough Background Spill from the Foreground of your image, use the **Clip** knob to reduce the clip value.

**Note**

You cannot rotate the Foreground area so that it falls in an area that is the same as the Background.
~ Increasing the reject value increases the amount of adjacent hues that are included in spill correction.

~ Decreasing the reject value decreases the amount of adjacent hues that are included in spill correction.

8. Press **Edge Softness** to display the **UltraChrome Edge Softness Menu**.

9. Use the **Softness** knob to add edge softening to the Foreground image and alpha channel. This may help blend the Foreground image with the underlying background video.

   - Increasing the softness value increases the amount of softness applied to the Foreground edges and alpha channel.
   - Decreasing the softness value decreases the amount of softness applied to the Foreground image and alpha channel. A value of 0.0% turns off edge softening.

10. Press **Luminance** to display the **UltraChrome Luminance Menu**.

    This menu allows you to adjust the overall brightness of shadow, translucent, and transition areas to change the appearance of reflections from semi-transparent objects and to match shadow and transition area brightness with the foreground brightness.

11. Adjust the overall brightness of the Translucent Background area as follows:

   - Use the **Reflections** knob to change the brightness of semi-transparent reflections (e.g., reflections in eyeglass lenses).
      
      ~ Increasing the reflections value increases the brightness of semi-transparent reflections.
      
      ~ Decreasing the reflections value decreases the brightness of semi-transparent reflections.

   - Use the **Bkgd Luma** knob to change the overall brightness of shadow, translucent, and transition areas. Use this to match shadow, translucent and transition brightness with foreground brightness.
~ Increasing the **Bkgd Luma** value increases the brightness of background, translucent, and transition areas.

~ Decreasing the **Bkgd Luma** value decreases the brightness of background, translucent, and transition areas.

This completes the procedure for adjusting the Foreground, Spill Suppress, Edge Softness, and Luminance values of an UltraChrome Chroma Key.

**Chroma Key Memory**

For Chroma Keys, the **KEY MEM** button is used as a memory register for storing one set of values for the entire switcher. Unlike Auto Select Keys, when you press **CHROMA KEY**, the **KEY MEM** button does not come on automatically.

The following rules apply:

- To store Chroma Key settings, ensure that your Key is set up as desired. Press and *hold* the **CHROMA KEY** button, then press **KEY MEM**. This procedure stores the settings in memory. They are now available for recall in any Keyer on the switcher.

- To recall stored settings, ensure that **CHROMA KEY** is selected. Press the **KEY MEM** button. The button lights momentarily, and the stored settings are recalled to the panel.

**Important**

There is no *undo* function for Chroma Key Memories. If you recall Chroma Key settings by pressing **KEY MEM**, you cannot recall the previous values unless you recall them from a memory register.

**Chroma Key Lighting Tips**

Achieving a good, clean Chroma Key is often considered one of the most challenging exercises in a studio. There are several elements that contribute to an effective Chroma Key, including lighting, distance of the talent from the background, type of background used, and the type of camera used. However, lighting is often considered the most important. Here are a few lighting hints which you may find helpful when setting up your Chroma Key.

**Lighting the Background**

- There are several different kinds of lights typically used to light Chroma Key backgrounds. The most common are cyclorama lights, soft lights, scoops, fluorescent lights, HMIs, and umbrella lights.

  For the most part, the one thing that they all have in common is the fact that they are “fill” type lights, as opposed to “Key” lights. These lights provide an even, diffused, flat light, which is critical in lighting Chroma Key backgrounds.

- For best results, lights are usually hung in an even pattern from a grid above the background, but space requirements may dictate the lights be positioned on stands beside the background. If side lighting is used, ensure the lights are positioned at equal distances from the background being lit, in order to achieve balance.

- The number of lights used to light a background is directly related to the size of the background surface. Therefore, a larger, longer surface requires more lights than a smaller one. But whatever size of surface you are lighting, the most important point to remember is the background should be lit as evenly as possible to avoid “hot spots” in the Chroma Key.

- When lighting the background, experienced lighting directors will first of all eyeball the background for hot spots, adjusting and re-adjusting the lights, but then check their work...
using either a waveform monitor or a light meter. Waveform monitors are the most useful since they display a graphical representation of the video level and any small variation in light level is immediately apparent. On the other hand, a light meter in the hands of an experienced professional can achieve the same results.

- Generally speaking, best Chroma Key results are achieved with an even level of light on the background in the area of an even 180 foot-candles. However, conditions specific to your application may dictate a value outside of that range.

- If you only have access to Key type lights, you can simulate the effect of fill lights by bouncing a Key light off of a reflector and then on to the Chroma Key background. Also, you can use diffused glass, gels, or scrims to soften the light from a Key light. If you use any of these methods it is important to note that you will lose a significant amount of the original light intensity.

**Lighting the Foreground (Talent)**

- You can maximize the quality of your Chroma Key if you separate the foreground (talent) from the background by 6 – 8 feet. This enables you to light the foreground and the background separately, thus reducing or avoiding “spill” and/or shadows.

  Separation also allows you more flexibility in how you light your talent. You may still choose to use a flat lighting technique, but with separation, the option exists to light your talent using a more dramatic 3-light, “Rembrandt style of lighting”, typically used in other lighting applications. This style is characterized by 3 lights – a Key, a fill, and a back light.

- If spill does occur between the background and the foreground, a blue “halo” or “matte line” appears around the talent. This can be reduced or eliminated by using a yellow, straw, or amber colored light for the back light. It washes out or neutralize the blue reflection from the background on the back of the talent.

- As a general rule, it is good practice to light the foreground and the background to approximately the same number of foot-candles, but this is often varied when dramatic lighting effects are required for the talent.

- Be careful not to mix lights with different color temperatures on the same set (either foreground or background). The human eye and brain are able to deal with the subtle differences in color temperatures, but cameras are not as capable. If you must use lights with different color temperatures, make sure you use colored gels to compensate for the differences. Otherwise, you may experience holes in your Chroma Key that will be very difficult to remove.

**Additional Chroma Key Tips and Considerations**

Along with lighting, there are a number of other studio elements that should be taken into account when setting up your Chroma Keys. They include the background material itself, the camera and its setup, Keying from a pre-recorded signal on VTR, and using compressed video sources.

- Green and blue are the two most common colors used for Chroma Keying backgrounds and are equally effective. Blue was initially chosen because it is the complimentary color to flesh tone and, therefore, the easiest to Key out. Modern technology allows almost any color to be used, but blue and green are still the most widely used.

- There are a number of different materials commonly used as Chroma Key backgrounds and each has its benefits. The most common are paper, fabric, and paint. Paper is not as durable but can be more cost effective and more easily set up than the other two. Paint takes time and must be applied in several coats to ensure a deep, complete covering;
while fabric also takes time and must be mounted and hung properly. Contact your television set and lighting distributor for details on the material that best meets your budget and application.

- If you are creating your Chroma Key on a studio set, it is generally accepted that the quality of your Chroma Key is directly related to the quality of the camera shooting the scene. The background video can come from any number of sources and may be quite acceptable, but the foreground video is what is being Keyed and where your attention is most focused. Therefore, the camera must be as high a resolution and low in noise as your budget will allow. In the end, low cost cameras may never produce “acceptable” Chroma Key results no matter how well the lighting has been configured.

- As well, never shoot a Chroma Key with the detail turned on in your camera. Detail adds noise to the video signal and makes it much more difficult for the Chroma Key circuits to process the video. Turning on the camera detail is not the solution to a low light level—more lights are!

- And finally, a few other points for your consideration. Avoid using foreground Chroma Key sources from 4:1:1 formats, highly compressed material (more than 4 to 1), or composite analog recordings. The technical nature of their formats and storage algorithms defeat the Chroma Key circuits and will seldom deliver acceptable results.

### Performing a Preset Pattern Key

A Preset Pattern Key is one in which the hole is cut based on a wipe pattern that you select in the **Pattern Control Group**. The pattern (which acts just like the alpha signal used with an **auto select** Key) is filled with video from the **Key Bus**.

#### Note

The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot perform a **PST PATT** (Preset Pattern) Key in the DSKs for the bottom MLE.

There are a few rules that must be considered when applying a **PST PATT** Key, as follows:

- If you perform a Preset Pattern Key in **Key 1** of a full MLE, the pattern generator is **full-featured** (except matrix wipes) but it is shared with the **Wipe Generator** for that MLE.
  - If you press **PST PATT** in **Key 1** of a full MLE, you cannot press **WIPE** in the **Transition Group** of the same MLE.
  - If **WIPE** is selected in the **Transition Group** of a full MLE and you press **PST PATT** in **Key 1**, the **WIPE** button is turned off and **DISS** is automatically lit.

- If you perform a Preset Pattern Key in the **Key 2** of a full MLE, the pattern generator is **not shared**, but it is restricted to the first six columns of wipes. Matrix wipes are not available.

Use the following procedure to perform a Preset Pattern Key on a full MLE Keyer:

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “**Using the Preview Bus**” on page 4–35 for details.
2. Select an input on the **BKGD** bus of an MLE. This provides the background over which the Key will appear.

3. Press **KEY1** in the **MLE Transition Group** for the same MLE as you set the Background for. This will assign the Key bus to **Key 1**.

![Operating Tip]

Pressing **KEY2** instead of **KEY1** would assign the Key bus to **Key 2**.

4. On the **Key Bus** of the MLE, select the desired Key source. This is the video signal that will appear inside the pattern.

5. Press **PST PATT** in the **MLE Key 1 Group** of that MLE to display the **PST Key Setup Menu**.

![Note]

The **Fly Key** mode is automatically enabled if the **Squeeze & Tease MD** option is installed. Toggle the **FLY KEY** button **Off** to perform a Preset Pattern Key.

![Pattern Control Group]

In the main area, the menu lists the two individual **Key Fill** and **Key Alpha** sources, plus the **location** of the selected Keyer.

![Note]

If you are using **Key 1** of a full MLE, **Wipe Gen 1** will be selected automatically. If you are using **Key 2** of a full MLE, **Wipe Gen 2** will be selected automatically.

6. Select a pattern for the Preset Pattern Key in the **Pattern Control Group**.

7. Adjust the wipe parameters in the **Pattern Control Group**. You can adjust the following:
   - ASPECT
   - BORDER
   - SOFT
   - ROTATION
   - NORM
   - REV

8. Adjust the size and softness of the Key as follows.
   - Use the **Size** knob to adjust the size of the pattern.
• Use the **Softness** knob to adjust softness of the edges of the pattern.

### Operating Tip

The **CLIP** and **GAIN** knobs in the **Effects Control Group** will mimic the **Size** and **Softness** knobs on the menu.

9. Select and adjust additional Key modifiers as desired, using the controls in the **Key Modifier Sections 1** and **2**. Modifiers include the following:
   - **KEY INV**
   - **MASK**
   - **POSITIONER**
   - **FLY KEY** (Squeeze & Tease MD only)

### Important

The **FLY KEY** function (**Squeeze & Tease MD** only) can be regarded as a modifier, but it is important to note that it creates a different type of Key when used in conjunction with preset patterns. When **FLY KEY** is enabled, the system creates a bordered box around the selected pattern — which can then be manipulated in 2D space. Special Fly Key modifiers are enabled (such as size, position, mirror, and crop), but **Preset Pattern** modifiers (clip, gain, aspect, border, and soft) are disabled.

10. If desired, preview the Key by pressing **KEY PV**.

11. Use the proper **KEY 1** or **KEY 2** “next transition” button (in the **MLE Transition Group**) to select the Key to be taken on (or off) air during the next transition. Refer to the section “**Working with Next Transitions**” on page 5–12 for complete instructions on the three “next transition” buttons.

12. Take the selected Key On or Off-air as follows:
   - **CUT** — Press **CUT** (in the **MLE Key Group**) to cut the Key on (or off) air. Refer to the section “**Key Cut Notes**” on page 7–71 for additional rules.
   - **AUTO TRANS** — Select an auto transition rate, then press **AUTO TRANS** (in the **MLE Key Group**) to dissolve the Key on (or off) air. Refer to the section “**Setting Auto Transition Rates**” on page 7–68 for instructions on selecting Key dissolve rates. Refer to the section “**Key Auto Transition Notes**” on page 7–71 for additional rules.

If you select a different self Key source, you will need to re-clip the source as outlined above. There is only *one* memory register per MLE Keyer for self Keys.

### Note

You can fly two Preset Pattern Keys at a time in a full MLE (one in Key 1 and one in Key 2) using the **FLY KEY** button (**Squeeze & Tease MD** only). You can also fly a Chroma Key or a Self Key or a Preset Pattern Key. However, you cannot enable the **FLY KEY** button if the other MLE is already flying an **Auto Select Key**.
Split Keys

A Split Key allows you to assign a different fill source for a Key than the Key/fill associations that are set up during installation or the fill sources that are selected by the Key Type. Split keys are typically used for creative montages and for Keying moving video inside Key shapes.

There are two different Split Key functions:

- **Split Key** — Split Key allows you to hold (retain) the alpha signal of a Key, and assign a new video source to fill the hole. A typical application is when you fill the alpha signal from a character generator with the live output from a VTR or camera.

- **Split Video** — Split Video allows you to hold a (non-alpha) Key cutter, and select a new video source to fill the hole. A typical application is when you fill the luminance Key signal from your title camera with the live output from a VTR or another MLE.

In both cases, a new fill source is assigned while the hole cutter is held. The following methods allow you to perform Split Keys or Split Video quickly, and without having to return to the installation menus and change your Key/fill associations.

**Performing a Split Key**

The Split Key function allows you to temporarily hold the alpha signal of a Key, and assign a new video source to fill the hole.

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “Using the Preview Bus” on page 4–35 for details.
2. Select an input on the BKGD bus of the MLE. This provides the background over which the Key will appear.
3. Press KEY1 in the MLE Transition Group for the same MLE as you set the Background for. This will assign the Key bus to Key 1.
4. On the Key Bus, select the desired Key source.
5. Press and hold the AUTO SELECT button and select the new fill source on the Key Bus.
6. Release both buttons.

The display now shows the selected Key alpha plus the new “split” fill video source.

---

**Note**

The Split Key function is a temporary assignment. If, after setting up the Split Key, you press any button on the Key Bus, the split is released and you must set up the split again.

---

**Operating Tip**

The switcher allows you to perform a split key on any DSK. To perform a DSK split key, hold down the desired DSK crosspoint, then press a crosspoint on any bus except the Preset Bus.

Pressing KEY2 instead of KEY1 would assign the Key bus to Key 2.
7. Adjust the **Clip** and **Gain** of the Key as desired. Refer to the section “Performing an Auto Select Key” on page 7–23 for more information.

<table>
<thead>
<tr>
<th>Auto Key Setup</th>
<th>( 90.0s) Clip Locked</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE 2 Key 1</td>
<td>( 44.0s) Gain Locked</td>
</tr>
<tr>
<td>Key Fill: BNC CHG (CHG) &lt;Split&gt;</td>
<td></td>
</tr>
<tr>
<td>Key Alpha: BNC C12 (C12)</td>
<td></td>
</tr>
<tr>
<td>Transparency On/Off</td>
<td>Make Key Linear</td>
</tr>
</tbody>
</table>

This completes the procedure for performing a Split Key.

**Performing a Split Video**

The **Split Video** function allows you to hold a luminance Key cutter, and assign a new video source to fill the hole.

| Note | If, after setting up the split, you select another Key type, the split is released and you must set it up again if desired. Pressing **AUTO SELECT** again does not re-establish the split. |

*The Split Video function is a temporary assignment. If, after setting up the Split Video, you press any button on the **Key Bus**, the split is released and you must set up the split again.*

Use the following procedure to perform a Split Video:

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “Using the Preview Bus” on page 4–35 for details.
2. Select an input on the **BKGD** bus of the MLE. This provides the background over which the Key will appear.

| Operating Tip | The switcher allows you to perform a split video on any DSK. This function holds the luminance Key cutter, and assigns a new video source to fill the hole. To perform a DSK split video, hold down the desired DSK crosspoint, then press a crosspoint on any bus except the **Preset Bus**. |

3. Press **KEY1** in the **MLE Transition Group** for the same MLE as you set the Background for. This will assign the Key bus to **Key 1**.

| Operating Tip | Pressing **KEY2** instead of **KEY1** would assign the Key bus to **Key 2**. |

4. On the **Key Bus**, select the desired Key source.
5. Press and **hold** the **SELF KEY** button and select the new fill source on the **Key Bus**.
6. Release both buttons.
The display now shows the selected Key alpha plus the new “split” fill video source.

![Sample Split Video Menu Display]

7. Adjust the **Clip** and **Gain** of the Key as desired. Refer to the section “Performing an Auto Select Key” on page 7–23 for more information.

**Note**

If, after setting up the split, you select another key type, the split is released and you must set it up again if desired. Pressing **SELF KEY** again does not re-establish the split.

This completes the procedure for performing a Split Key.
Using Downstream Keys

A Downstream Key (DSK) is performed in much the same way as an MLE Key. There are, however, a few important similarities and differences, as follows:

- All rules for the FLY KEY button (Squeeze & Tease MD only) apply in the two DSKs:
  ~ You can only fly one Auto Select Key in the Program/Preset MLE at a time. If one DSK is already flying an Auto Select Key, you cannot enable the FLY KEY button in the other DSK.
  ~ In the Program/Preset bus of every full MLE, you can fly any combination of Preset Pattern Keys, Chroma Keys or Self Keys, one in DSK 1 and the other in DSK 2.
- There is no KEY OVER button in the DSKs (DSK 2 is always over DSK 1).

When you select a source on the DSK 1 or 2 source bus, the DSK Auto Key Setup Menu is displayed.

This menu displays all the source and Key information that has been set up for that DSK source. The following information is displayed on the menu:

- **Top Line** — Key Type (e.g., Auto Key, Self Key, etc.)
- **Second Line** — DSK Key number (1 or 2)
- **Third Line** — Key Fill, with associated name and BNC
- **Fourth Line** — Key Alpha, with associated name and BNC
- **Fifth Line** — Key Bus crosspoint (labelled as DSK Button)

Use the following procedure to perform a Downstream Key:

1. Ensure that your program/preview monitoring is set as needed for the selected MLE. Refer to the section “Using the Preview Bus” on page 4–35 for details.
2. Ensure that the desired Key sources are programmed on the DSK Source Bus of the desired DSK.

These eight DSK source crosspoints are typically set during installation, but they can also be programmed during production. Refer to the section “DSK Source Bus Setup” on page 7–52 for details.
3. Select an input on the BKGD bus of an MLE. This provides the background over which the Key will appear.

4. Press DSK1 in the MLE Transition Group for the Program/Preset MLE. This will assign switcher resources this Keyer.

   ![Operating Tip]
   Pressing DSK2 instead of DSK1 would assign switcher resources to DSK 2.

5. Select a Source in the Downstream Keyer 1 Group to display the DSK Menu.

   ![Note]
   The Key Setup Menu that appears will depend on the Key Type that was stored in the DSK Source that you selected.

   ![Sample DSK 1 Self Setup Menu]
   
<table>
<thead>
<tr>
<th>Key Setup Menu</th>
<th>(50,30)</th>
<th>Clip</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key Fill:</td>
<td>BNC CHE</td>
<td>CHEE</td>
</tr>
<tr>
<td>Key Alpha:</td>
<td>BNC CHE</td>
<td>CHEE</td>
</tr>
<tr>
<td>DSK Button:</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>Transparency</td>
<td>On/Off</td>
<td></td>
</tr>
<tr>
<td>Make Key</td>
<td>Linear</td>
<td></td>
</tr>
</tbody>
</table>

   ![Operating Tip]
   To reveal the actual Preset Bus source for any DSK Source button, simply hold down any one of the DSK Source Bus buttons. The PST bus source crosspoint will light. This feature provides a quick and accurate way to verify your downstream Key sources prior to taking them on-air.

6. Adjust the Key depending on the Key Type that has been assigned to the Source you selected. You can select between the following Key types:

   - **Self Key** — Refer to the section “Performing a Self Key” on page 7–21 for more information on using this Key type.
   - **Auto Select Key** — Refer to the section “Performing an Auto Select Key” on page 7–23 for more information on using this Key type.
   - **Chroma Key** — (Not available on the Half MLE switchers) Refer to the section “Performing an UltraChrome Chroma Key” on page 7–26 for more information on using this Key type.
   - **Preset Pattern Key** — (Not available on the Half MLE switchers) Refer to the section “Performing a Preset Pattern Key” on page 7–44 for more information on using this Key type.

7. Press KEY PV to preview the Key.
8. Select the desired Key transition:
   • Press **CUT** (in the DSK Key Group) to cut the Key on (or off) air. Refer to the section “Key Cut Notes” on page 7–71 for additional rules.
   • Press **AUTO TRANS** (in the DSK Group) to dissolve the Key on (or off) air. Refer to the section “Setting Auto Transition Rates” on page 7–68 for details on how to set the auto transition rate.

   **Note**
   When you press **AUTO TRANS** in the Downstream Keyer 1 or 2 Groups, the following actions occur to show a transition in progress:
   - The DISS button (in the Program/Preset Transition Group) lights.
   - The DSK 1 or DSK 2 button lights (as appropriate).
   - The status display above the Fader (in the Program/Preset Transition Group only) briefly displays with the transition rate of the selected DSK.

9. Use the proper DSK 1 or DSK 2 “next transition” button (in the Program/Preset Transition Group) to select the Key to be taken on (or off) air during the next transition. Refer to the section “Working with Next Transitions” on page 5–12 for complete instructions on the three “next transition” buttons.

10. Take the selected DSK On or Off-air as follows:
   • **CUT** — Press **CUT** (in the MLE Key Group) to cut the Key on (or off) air. Refer to section “Key Cut Notes” on page 7–71 for additional rules.
   • **AUTO TRANS** — Select an auto transition rate, then press **AUTO TRANS** (in the MLE Key Group) to dissolve the Key on (or off) air. Refer to the section “Setting Auto Transition Rates” on page 7–68 for instructions on selecting Key dissolve rates. Refer to the section “Key Auto Transition Notes” on page 7–71 for additional rules.

This completes the procedure for performing a Downstream Key.

**DSK Source Bus Setup**

Unlike the upper MLE Keyers, there is no Key Bus on the Program/Preset MLE. Instead, each Downstream Keyer Group has a series for Source buttons on the DSK Source Bus. When programmed, each Source button will have the Key Type and input crosspoint stored in it. By selecting a Source button, the programmed Key Type and crosspoint will be recalled in that Keyer. Although this is typically performed during switcher setup, you can assign Key types and crosspoints during production as required. Often, one of the Key Bus buttons is left open for just this purpose.

**Important**
Individual DSK Sources can be locked during setup, preventing a user from assigning new Key types or crosspoints to the locked Sources. Refer to the section “Locking/Unlocking a DSK Source Button Setup” on page 7–54 for more information on locking a DSK Source.
Assigning DSK Source Types

Use the following procedure to program a crosspoint on the DSK Source Bus of a DSK:

1. Press and hold the Source button that you want to program a Key Type to.

2. Press any one of the four Key type buttons (SELF KEY, AUTO SELECT, CHROMA KEY, or PST PATT) in any MLE Keyer.

3. Release both buttons. The Key type is now stored in memory for the selected button.

This completes the procedure for assigning a DSK Source Type.

Assigning DSK Source Crosspoints

Use the following procedure to assign a crosspoint to a Source button.

1. Press and hold the Source button that you want to program a crosspoint to. The source that is currently assigned to that Source button will light on the PST Bus of the Program/Preset MLE.

2. Select the desired source on the PST Bus of the Program/Preset MLE (the bottom MLE).

3. Release both buttons. The Key source is now stored in memory for the selected Source button.

4. Press the Source button that you just programmed, look at the display, and verify that the Key type and source are correctly programmed.

Important

Recalling a setup from memory that includes a DSK will overwrite the programmed DSK button that the memory was originally stored in (unless it was locked on installation).
Storing DSK Crosspoint Assignments

The DSK Setup Menu allows you to store the default states for each Downstream Keyer. The menu captures all eight crosspoints for the selected DSK, and stores the crosspoints, Key types, and Key type settings in the installation file of the switcher. The menu also allows you to lock DSK Source buttons so that they cannot be changed during normal switcher operation.

Operating Tip

When you reset the DSK (refer to the section “Resetting the Switcher” on page 2–23), the default DSK states are restored.

Use the following procedure to store a DSK crosspoint assignment:

1. Ensure that your DSK Source buttons are programmed as desired. If not, refer to the section “DSK Source Bus Setup” on page 7–52.

2. Navigate to the DSK Setup Menu as follows:
   • Press HOME ➔ MORE ➔ Setup ➔ Installation ➔ DSK.

3. Select which Downstream Keyer to display as follows:
   • Toggle the Show softkey to select which DSK you wish to display.
     ~ DSK1 — Select this option to display Downstream Keyer 1.
     ~ DSK2 — Select this option to display Downstream Keyer 2.

4. Assign the current state of the DSKs as the default state as follows:
   • Press Grab All DSKs to save the current DSK Source Bus setup as the default settings. If the switcher is reset, these settings will be retained.

This completes the procedure for storing a DSK crosspoint assignment.

Locking/Unlocking a DSK Source Button Setup

You can lock the current settings for any of the DSK Source buttons so that they can be selected, but not altered unless unlocked. This allows you to ensure that certain DSK Sources will remain unchanged, or will not be changed by accident.

Note

If you have the MultiDSK option installed, DSK XPT 8 (Source 8) will show DSK 3 or DSK 4 and cannot be locked.
If you attempt to alter a DSK Source that has been locked, the following pop-up is displayed:

![DSK Lock Pop-up](image)

Use the following procedure to lock or unlock a DSK Source button:

1. Navigate to the DSK Setup Menu as follows:
   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ DSK.

   ![DSK Setup Menu](image)

2. Lock or unlock a DSK Source button as follows:
   - Use the top knob to select the desired DSK Source button (1 through 8) that you want to lock or unlock.
   - Use the middle knob to select either Unlock or Lock.

3. Press Grab All DSKs to store the current settings.

This completes the procedure for locking or unlocking a DSK Source button.
MultiDSK Option

The MultiDSK™ option adds two additional Downstream Keyers to the Synergy 1.5, 2 and 2.5 Q/MD, and 2, 2.5, 3, 3.5, and 4 Q/MD-X switchers, and two Downstream Keyers to the Synergy 1 Q/MD switcher.

When the external Downstream Keyers option is configured, two of the internal downstream Keyer buttons will have changed functionality. To accommodate this, a Key Caps Kit is included with your option package. For new customers who purchase a new Synergy switcher with an external downstream Keyer options package, the appropriate Key caps are installed in the panel before shipping.

Refer to the section “Using Downstream Keys” on page 7–50 for more information on performing a Downstream Key.

MultiDSK for Downstream Key Groups

The addition of the MultiDSK option alters the functionality and appearance of some of the buttons on the control panel.

Synergy 3 and 4 MultiDSK

When the MultiDSK™ option is installed, the KEY PV and SOURCE 8 buttons on Downstream Keyer 1 become DSK3 ON and DSK3 SELECT. On Downstream Keyer 2 they will become DSK4 ON and DSK4 SELECT. These buttons allow you to take the DSK on-air and assign a crosspoint and Key type to the DSK.

Synergy 4 — Downstream Keyer Group

The new buttons for the MultiDSK option operate as follows:

- The DSK3 ON button allows you to transition Downstream Keyer 3 on and off-air. When the Key is on-air, the DSK3 ON button will light. Only dissolves can be performed using this button.
- The DSK4 ON button allows you to transition Downstream Keyer 4 on and off-air. When the Key is on-air, the DSK4 ON button will light. Only dissolves can be performed using this button.
- The DSK3 SELECT button allows you to assign a crosspoint to Downstream Keyer 3. Unlike DSK 1 or 2, only linear Keys, Self Keys and Auto Select Keys can be performed in DSK 3.

Operating Tip

The Key Preview function that was available through the KEY PV button is now performed by holding down the appropriate SOURCE (1 – 7) button for three to five seconds.
• The **DSK4 SELECT** button allows you to assign a crosspoint to **Downstream Keyer 4**. Unlike DSK 1 or 2, only linear Keys, Self Keys and Auto Select Keys can be performed in DSK 4.

**Synergy 2 MultiDSK**

When the MultiDSK™ option is installed, the **KEY PV** and **SOURCE 8** buttons on **DSK 1** become **DSK3 ON** and **DSK3 SELECT**. On **DSK 2** they will become **DSK4 ON** and **DSK4 SELECT**. These buttons allow you to take the DSK on-air and assign a crosspoint and Key type to the DSK.

The new buttons for the MultiDSK option operate is as follows:

**Operating Tip**  
The **Key Preview** function that was available through the **KEY PV** button is now performed by holding down the appropriate **SOURCE** (1 – 7) button for three to five seconds.

• The **DSK3 ON** button allows you to transition **Downstream Keyer 3** on and off-air. When the Key is on-air, the **DSK3 ON** button will light. Only dissolves can be performed using this button.

• The **DSK4 ON** button allows you to transition **Downstream Keyer 4** on and off-air. When the Key is on-air, the **DSK4 ON** button will light. Only dissolves can be performed using this button.

• The **DSK3 SELECT** button allows you to assign a crosspoint to **Downstream Keyer 3**. Unlike DSK 1 or 2, only linear Keys, Self Keys and Auto Select Keys can be performed in DSK 3.

• The **DSK4 SELECT** button allows you to assign a crosspoint to **Downstream Keyer 4**. Unlike DSK 1 or 2, only linear Keys, Self Keys and Auto Select Keys can be performed in DSK 4.
Synergy 1 MultiDSK

When the MultiDSK™ option is installed, the DSK1 TRANS and DSK2 TRANS buttons will allow you to dissolve the Keys on and off-air.

Synergy 1 — Downstream Keyer Group

The new buttons for the MultiDSK option operate as follows:

- The DSK1 TRANS button allows you to transition Downstream Keyer 1 on and off-air. When the Key is on-air, the ON indicator below the DSK1 button in the Transition Group will be lit.
- The DSK2 TRANS button allows you to transition Downstream Keyer 2 on and off-air. When the Key is on-air, the ON indicator below the DSK2 button in the Transition Group will be lit.

MultiDSK Operation

Although the operation of the MultiDSKs is similar to that of the existing Downstream Keyers 1 and 2 on the Synergy 2 Q/MD through 4 Q/MD-X, there are some notable differences as follows:

- Pressing DSK3 ON or DSK 4 ON will initiate a transition that is performed at the auto transition rate that is set on the External DSK Menu.
- To initiate a Cut of a MultiDSK Key, hold down the DSK3 SELECT or DSK4 SELECT button and press CUT in the Downstream Keyer Group.
- A MultiDSK Key can only perform a Cut or Dissolve transition. If the MultiDSK Key is included with a Wipe transition, the MultiDSK Key will perform a Dissolve.
- When you press DSK3 SELECT or DSK4 SELECT, the MultiDSK Setup Menu is displayed.

MultiDSK Setup

Use the following procedure to setup a MultiDSK Key:

1. Navigate to the MultiDSK Setup Menu as follows:

   Operating Tip
   You can also access the MultiDSK Setup Menu by pressing the DSK SELECT button in the Downstream Keyer Group.

   - Press HOME ⇒ Effects ⇒ MORE ⇒ MultiDSK.
2. Press **Key Setup** to display the **Key Setup Menu**.

3. Adjust the Key settings for the MultiDSK Key as follows:
   - Use the **Key Type** knob to select the type of linear Key you want to assign to the selected DSK. You can select between the following:
     - **Self Key** — Select this option to assign the Self Key Type to the selected Key.
     - **Auto Key** — Select this option to assign the Auto Select Key Type to the selected Key.
   - Use the **Input** knob to select the BNC input you want to assign to the selected Key.

4. Press **Clip Gain** to display the **Clip Gain Menu**.

5. Adjust the Clip and Gain of the Key as follows:
   - Use the **Clip** knob to adjust clip level of the Key.
   - Use the **Gain** knob to adjust gain (softness) of the Key.

6. Toggle the **Key Invert** softkey to turn this feature **On** or **Off**.
   - **Off** — Select this option to keep the default Key setup.
   - **On** — Select this option to invert the polarity of the hole cut for the Key.

---

**Note**

To switch between the two MultiDSKs, press the appropriate **DSK3** or **DSK4 SELECT** button in the **Downstream Keyer Group**. For the **Synergy 1 Q/MD**, press **DSK1** or **DSK2** in the **Transition Group**.
7. Adjust the transparency of the Key as follows:
   - Toggle the **Transparency** softkey **On** to display the Transparency Menu.
   - Use the **Transparency** knob to adjust the transparency of the Key from opaque (0%) to fully transparent (100%).

8. Toggle the **Key Mem** softkey to turn this feature **On** or **Off**. Refer to the section “**Key Functions**” on page 7–6 for more information on Key Memory.
   - **Off** — Select this option to turn Key Memory Off.
   - **On** — Select this option to turn Key Memory On.

9. Press **MORE** to display the **MultiDSK Setup Menu 2-2**.

```
<table>
<thead>
<tr>
<th>MultiDSK Setup (2-2)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>DSK 3</td>
<td>( 43)</td>
</tr>
<tr>
<td>DSK 4</td>
<td>( 8)</td>
</tr>
</tbody>
</table>
```

**MultiDSK Setup — Key Setup Menu**

10. Adjust the Transition Rate of the selected MultiDSK Key as follows:

   - Press **Trans Rate** to display the Transition Rate Menu.

   - Use the **DSK 3** knob to set the time, from 1 to 999 frames, for a transition to be performed in MultiDSK Key 3.
   - Use the **DSK 4** knob to set the time, from 1 to 999 frames, for a transition to be performed in MultiDSK Key 4.

This completes the procedure for setting up a MultiDSK Key.

**MultiDSK and Next Transitions**

- **Note** The Synergy 1 Q/MD has **DSK1** and **DSK2** buttons in the Transition Group to allow you to include the MultiDSK Keys in the next transition.

The MultiDSKs DSK 3 and DSK 4 can be included with your next transition that is performed in the Program/Preset MLE. This allows you to transition any combination of the Background, DSK 1, DSK 2, DSK 3 and DSK 4 on or off-air in a single transition.
Use the following procedure to include DSK 3 and DSK 4 in the next transition:

1. Ensure that the crosspoints you want to take on-air, including the DSK Sources, are properly selected.
2. Press and hold the combination of the BKGD, DSK1 and DSK2 buttons you want to include in the next transition in the MLE Transition Group for the Program/Preset MLE.

3. Press the DSK 3 SELECT and the DSK 4 SELECT buttons.

4. Perform the transition in the MLE Transition Group of the Program/Preset MLE.
5. Press any combination of the BKGD, DSK1 and DSK2 buttons to deselect DSK 3 and DSK 4 from the next transition.

This completes the procedure for including DSK 3 and DSK 4 in the next transition.

**Isolated and Locked MultiDSK Mode**

MultiDSKs operate in one of three modes that determine how they are affected by memory recalls, switcher soft-resets, and Program/Preset MLE transitions. The three modes are:

- **Isolated** — MultiDSKs are isolated from the switcher and do not change states or configuration regardless of any memory-recalls or switcher soft-resets. They can also not be include in Program/Preset MLE transitions.
- **Locked** — MultiDSK configurations are locked and are not affected by memory-recalls. Program/Preset MLE-transitions may include MultiDSKs and switcher soft-resets take MultiDSKs off-air but retain crosspoint and key-type settings to allow the MultiDSKs to be quickly returned to air.
- **Standard** — MultiDSKs are fully unlocked and are affected by memory recalls, switcher soft-resets, and can be included in Program/Preset MLE transitions.

**Note**

Isolated mode state is stored in a Personality register while Locked mode state is stored in an Installation register. Take care when recalling registers from disk if you wish to recall both Isolated and Locked mode states.
**Isolated MultiDSK Mode**

Use **Isolated** mode when you wish to completely isolate the MultiDSKs from the rest of the switcher. Isolated MultiDSKs are not affected by certain actions that you perform on the switcher as follows:

- **Memory Recalls** — Memory registers that were saved with MultiDSK sources and configurations will not overwrite the current MultiDSK settings when recalled. The non-MultiDSK settings in the memory registered will be recalled.

- **Switcher Soft-Reset** — Performing a switcher soft-reset (pressing ALL + ALL) will not return the MultiDSKs to a default state. All MultiDSK settings including the selected source, key type, and on-air status will be preserved.

- **Program/Preset MLE Transitions** — You can not include MultiDSKs in Program/Preset MLE transitions. You must transition the MultiDSKs on and off-air using only the buttons in the Downstream Keyer Group. Refer to the section “MultiDSK Operation” on page 7–58 for information on performing MultiDSK transitions separately from the Program/Preset MLE.

**Isolated** mode is set through a **Personality Menu** option. Refer to the section “Isolate MultiDSKs” on page 4–9 for information on enabling and disabling this mode.

**Locked MultiDSK Mode**

Use **Locked** mode when you do not wish to fully isolate the MultiDSKs but do wish to preserve their settings when certain actions are performed on the switcher as follows:

- **Memory Recalls** — Memory registers that were saved with MultiDSK sources and configurations will not overwrite the current MultiDSK settings when recalled. The non-MultiDSK settings in the memory registered will be recalled.

- **Switcher Soft-Reset** — Performing a switcher soft-reset (pressing ALL + ALL) will not return the MultiDSKs to a default state. All MultiDSK settings including the selected source and key type will be preserved. However, the MultiDSKs will be cut off-air to allow the switcher to appear fully defaulted. Since none of the MultiDSK settings were changed, you can quickly bring the MultiDSKs back on-air without having to reconfigure them.

- **Program/Preset MLE Transitions** — You can include MultiDSKs in Program/Preset MLE transitions. Refer to the section “MultiDSK and Next Transitions” on page 7–60 for information on including MultiDSKs in a Program/Preset MLE transition.

Use the following procedure to set the MultiDSKs to **Locked** mode:

1. Navigate to the **DSK Setup Menu** as follows:

   - Press HOME ⇒ MORE ⇒ Setup ⇒ Installation ⇒ DSK.
2. Lock or unlock the MultiDSKs as follows:
   • Use the top knob to select DSK 3.
   • Use the middle knob to set the **Locked** mode of DSK 3. You can choose from the following:
     - **Unlock** — DSK 3 (MultiDSK 1) is not set to **Locked** mode.
     - **Lock** — DSK 3 is set to **Locked** mode.

3. Repeat step 2 but select DSK 4.

4. Press **Grab All DSKs** to store the current settings.

This completes the procedure for setting the MultiDSKs to **Locked** mode.

---

**Standard MultiDSK Mode**

**Standard** mode does not provide any protection for MultiDSK settings. This is the default mode of the MultiDSKs. Specifically, as opposed to **Isolated**, or **Locked** mode:

- **Memory Recalls** — Memory registers that were saved with MultiDSK sources and configurations will overwrite the current MultiDSK settings when recalled.

- **Switcher Soft-Reset** — Performing a switcher soft-reset (pressing **ALL - ALL**) will return the MultiDSKs to a default state along with the rest of the switcher.

- **Program/Preset MLE Transitions** — You can include MultiDSKs in Program/Preset MLE transitions. Refer to the section “**MultiDSK and Next Transitions**” on page 7–60 for information on including MultiDSKs in a Program/Preset MLE transition.

You set **Standard** mode by disabling the other two modes. Refer to the section, “**Isolate MultiDSKs**”, in the chapter, “**Completing Setup**”, of the *Synergy Q/MD or Q/MD-X Engineering Manual* for information on disabling **Isolated** mode and the section “**Locked MultiDSK Mode**” on page 7–62 for information on disabling **Locked** mode.
**AuxKey Option**

This revolutionary option turns Aux Buses into A/B Mixers or Mixer/Keyers.

**Note**

The number of AuxKeys™ available depends on the number of output cards installed in your system.

The use of a single AuxKey can free up an entire MLE in many applications. Key and Mix sources are fed from adjacent Aux Buses that have access to every signal in the switcher. Of particular interest in this application are Global-Store™ outputs that, with the optional MediaCache™ enabled, can provide animated logo capability.

AuxKeys can be used as either a Mixer (Mix between two Aux Buses) or a Mixer/Keyer (Mix and Key). Switcher outputs are assigned to AuxKeys in groups of four. Mix or Key operations can be previewed and clean feed is also available, similar to a standard MLE.

AuxKeys significantly increase the Keying power of the switcher but do so without tying up an MLE. AuxKeys are controlled via configuration menus, Custom Control macro buttons, or by temporarily using the buttons of an MLE.

Applications for AuxKeys include the following:

- **Downstream bug insertion.** This can ensure that a logo remains inserted regardless of what is being done in the MLEs. *This frees up MLE Keyers.*
- **Multi-language applications.** Add CG Keys to clean feed outputs. *This often frees up one or more MLEs.*
- **Multi-client applications.** Add Keys to MLE outputs that present a variation on the main program output. *This often frees up one or more MLEs.*
- **Multicasting.** Produce programming for two regions simultaneously but brand them differently without consuming MLE Keyers and adding production complexity. *This frees up MLE Keyers.*
- **Stadium concourse and box seat monitors.** Add different sponsor branding to different stadium locations. *This frees up MLEs and eliminates the need for external Keyers.*
- **Pre-Keying.** Add Keys to sources before they are brought into the switcher MLEs. Time the AuxKeys early and the MLEs late and sources can be fed back into the switcher as inputs. *This frees up MLEs or unwieldy external Keyers.*
- **Pre-Mixing.** Mix between two sources before they are brought into the switcher MLEs. This makes it possible to dissolve inside any number of DVE boxes while only consuming a single MLE. *This effect would normally take one MLE for every DVE box.*
- **Studio Plasmas.** If your set has multiple live plasma displays with images that require Keys to be inserted, AuxKeys are an ideal, cost-effective solution. *This frees up MLEs or external Keyers.*

**AuxKey Operation**

The AuxKey feature turns MLE 1 into an Aux Mixer/Keyer when active. In the AuxKey mode, you set up transitions using the **Background, Preset** and **Key** buses of MLE 1, and use the **MLE 1 Transition Group** to perform transitions.

There are two kinds of AuxKeys, Aux Mixers and Aux Mixer/Keyers. Depending on which one is assigned to the aux bus you are using you will have different functionality.
**Aux Mixers**

Aux Mixers provide simple background dissolves or cuts between the Background and Preset buses of MLE 1. When working with Aux Mixers, the following restrictions apply:

- You can only perform a **Dissolve** type Auto Transition or a **Cut**.
- The transition rate for the MLE is set from the **Aux Mix Setup Menu**.
- You can only preview your next shot by connecting a preview monitor to the **Aux Preview** output.

**Aux Mixer/Keyers**

Aux Mixer/Keyers provide the same background transition functionality as the Aux Mixers, plus a single Auto Select Key. When working with Aux Mixer/Keyers, the following restrictions apply:

- You can only perform a **Dissolve** type Auto Transition or a **Cut**.
- You can only perform a combination of **Key 1** and **Background** transitions.
- You can only perform an **Auto Select** Aux Key.
- You can only preview your next shot by connecting a preview monitor to the **Aux Preview** output.
- You cannot **Fly** the Aux Key.
- The transition and Key rates for the MLE are set from the **Aux Mix Setup Menu**.

**Performing an Aux Mixer/Keyer Transition**

Use the following procedure to perform an Aux Mixer/Keyer transition.

1. Ensure that your program/preview monitoring is set as needed for the AuxKey. Refer to the Chapter, “**Output Configuration**” in the **Synergy Q/MD or Q/MD-X Engineering Manual** for more information.
2. Select the **Aux Bus Bank** that the AuxKey has been assigned to.
3. Press and hold the **Aux Bus Assign** button that the AuxKey has been assigned to.

As you hold the Aux Bus Assign button, MLE 1 will go into **AuxKey Mode**, the active buttons in **MLE 1** will flash, and the **Aux Mix Key Setup Menu** is displayed.

**Operating Tip**

You can double-press the **ASSIGN** button to latch **MLE 1** in AuxKey Mode.

- **Aux Mix Key Setup**
  - **Aux Key #4**
  - **Output Group:** 1: BNC 13-16
  - **Aux Assign:** Embed 1004
  - **Key Fill:** BNC Off (CDM)
  - **Key Alpha:** Black

<table>
<thead>
<tr>
<th>Clip/Gain</th>
<th>Trans Rate</th>
<th>Make Key</th>
<th>Linear</th>
</tr>
</thead>
<tbody>
<tr>
<td>(90.0%)</td>
<td>Clip</td>
<td>(44.8%)</td>
<td>Gain</td>
</tr>
</tbody>
</table>

**Aux Mix Key Setup Menu**
4. Select the desired sources on the BKGD, PST and Key 1 buses of MLE 1.

Note: If you set up your AuxKey as an Aux Mixer only, you will not be able to select a source on the Key bus.

5. Select your next transition using the BKGD and KEY1 buttons in the MLE 1 Transition Group.

6. Press Clip/Gain to display the Clip/Gain Menu.

7. Adjust the clip and gain values of the AuxKey as follows:
   - Use the Clip knob to adjust clip level.
   - Use the Gain knob to adjust gain (softness).

Operating Tip: To return the clip and gain values to the default settings of 90.8% and 44.8% respectively, press Make Key Linear.

8. Press Trans Rate to display the Transition Rate Menu.
9. Adjust the transition rate as follows:

**Note**

The time duration of a frame rate will vary, depending on the type of video format the switcher is running in. Refer to the section “Using Frame and Field Information” on page 2–15 of the Synergy Q/MD or Q/MD-X Engineering Manual for more information.

- Use the **Aux MLE Rate** knob to set the rate, in frames, for a **Background** transition.
- Use the **Aux Key Rate** knob to set the rate, in frames, for a **Key** transition.

**Note**

If the next transition includes the **Background** then the **Aux MLE Rate** will be used, even if a **Key** is included. The **Aux Key Rate** applies to **Key only** transitions.

10. Perform the desired transition as follows:

**Note**

If you are performing a **Key only** transition you can use the **CUT** and **AUTO TRANS** buttons in the **MLE 1 Key 1 Group**.

- **CUT** — Press **CUT** in the **MLE 1 Transition Group** to cut to the next shot.
- **AUTO TRANS** — Press **AUTO TRANS** in the **MLE 1 Transition Group** to dissolve to the next shot.

11. Press any **AuxBus Assign** button to exit **AuxKey Mode**.

**Note**

If you are using a **Synergy 1** control panel, press either **Key 1** or **Key 2** in the **Assign Area** (above the Key Bus) to exit **AuxKey Mode**.

This completes the procedure for performing an Aux Mixer/Keyers Transition.
Auto Transition Rates

The **AUTO TRANS** button in each **MLE Keyer Group** (including the **Downstream Keyer Groups**) is used to perform an automatic (smooth) transition that takes that Key on, or off-air.

There are two different rates that are applied to auto transitions for MLEs, Keys and Downstream Keys as follows:

- **MLE Rate** — The MLE Rate is the rate that is applied to all Auto Transitions that are performed in the **MLE Transition Groups**. On the **Synergy 1.5 Q/MD through 4 Q/MD-X** the MLE Transition Rate for the **Program/Preset MLE** is shown just above the fader in the **MLE Transition Group** of the **Program/Preset MLE** and on the display in the **Global Memory System Group**. On the **Synergy 1 Q/MD** the MLE Transition Rate is shown in the display in the **Global Memory System Group**.

  The MLE Rate appears as **M:###** on the display in the **Global Memory System Group**.

**Operating Tip**

The MLE Rate for an upper **Background/Preset MLE** can be set from the **MLE Memory System** in the same manner as you set it for the **Program/Preset MLE**.

- **Key Rate** — The Key Rate is the rate that is applied to all Auto Transitions that are performed in the **MLE Keyer Groups**, including the **Downstream Keyer Groups**. The Key Transition Rate for the **Program/Preset MLE** is shown on the display in the **Global Memory System Group**.

  The Key Rate appears as **D:###** on the display in the **Global Memory System Group**.

**Operating Tip**

The Key Rate for an upper **Background/Preset MLE** can be set from the **MLE Memory System** in the same manner as you set it for the **Program/Preset MLE**.

**Setting Auto Transition Rates**

You can set the transition rate for MLEs, and Keyers, including Downstream Keyers. Whenever an auto transition is performed in either of the groups, the current auto transition rate will be applied. For example, with an MLE Rate of 20 frames and a Key Rate of 15 frames, you could dissolve in a Key at 20 frames (using the **AUTO TRANS** button in the **MLE Transition Group**), and dissolve out the Key at 15 frames using the **AUTO TRANS** button in the **MLE Key Group**.

**Changing DSK Auto Transition Rates**

This section describes how to change the Key Rate for a Downstream Keyer. Refer to the section “**MultiDSK Setup**” on page 7–58 for information on setting the Key Rate for a MultiDSK Keyer, including DSK 1 and DSK 2 on the **Synergy 1 Q/MD**.
Use the following procedure to change the Key Rate for the Downstream Keyers:

1. Press DSK RATE in the Global Memory System Group to select a new Transition Rate for the Downstream Keyers.

2. Enter the new auto transition rate from 1 to 999 on the keypad in the Global Memory System Group. The new rate will appear on the top line of the display, as shown below, and the ENTER button will be lit.

   Note
   The time duration of a frame rate will vary, depending on the type of video format the switcher is running in. Refer to Chapter 2, “System Architecture” in the Synergy Q/MD or Q/MD-X Engineering Manual for more information.

3. Press ENTER to accept the new rate.

   Operating Tip
   If you do not want to change the auto transition rate at this time, press any of the RATE or STORE buttons to cancel entering a new rate. If you want to enter a different rate prior to pressing ENTER, simply continue to type until the desired value appears.

This completes the procedure to change the Key Rate for the Downstream Keyers.

**Changing MLE Key Auto Transition Rates**

This section describes how to change the Key Rate for an MLE Keyer.

Use the following procedure to change the Key Rate for the MLE Keyers:

1. Press KEY RATE in the MLE Memory System Group of the MLE you want to change the Key rate for.

   Note
   For the Synergy 1, 1.5 and 2 Q/MD, and 2 Q/MD-X the KEY RATE button is located in the Global Memory System Group.

2. Enter the new auto transition rate from 1 to 999 on the keypad in the MLE Memory System Group. The new rate will appear on the top line of the display, as shown below, and the ENTER button will be lit.

   Note
   The time duration of a frame rate will vary, depending on the type of video format the switcher is running in. Refer to Chapter 2, “System Architecture” in the Synergy Q/MD or Q/MD-X Engineering Manual for more information.
3. Press ENTER to accept the new rate.

This completes the procedure to change the Key Rate for an MLE Keyers.

**Changing MLE Auto Transition Rates**

This section describes how to change the MLE Auto Transition Rate.

Use the following procedure to change the MLE Auto Transition Rates:

1. Press MLE RATE in the MLE Memory System Group of the MLE you want to change the MLE rate for.

2. Enter the new auto transition rate from 1 to 999 on the keypad in the MLE Memory System Group. The new rate will appear on the top line of the display, as shown below, and the ENTER button will be lit.

3. Press ENTER to accept the new rate.

**Operating Tip**

If you do not want to change the auto transition rate at this time, press any of the RATE or STORE buttons to cancel entering a new rate. If you want to enter a different rate prior to pressing ENTER, simply continue to type until the desired value appears.
This completes the procedure to change the MLE Rate.

**Key Auto Transition Notes**

Please note the following important points regarding Key auto transitions:

- An auto transition, once in progress, cannot be paused practically.

- **•** To “escape” from an auto transition in progress, you can either press **CUT** during the transition, or manually pull the **Fader** in the proper direction. The “cut” action instantly completes the transition.

- **•** In a single MLE, you cannot initiate an auto transition if the **Fader** is off its upper or lower limit. If this effect is required, use a re-entry setup on the panel. Refer to the table “**Keyer Transition Summary Table**” on page 7–72 for more information.

- **•** In a single MLE, you cannot initiate a Keyer auto transition if an auto transition in the **MLE Transition Group** is already in progress. If this effect is required, use a re-entry setup on the panel.

- **•** If the **TRANS LIMIT** function is enabled and the transition is at the selected limit, you cannot initiate a Keyer auto transition. Rather, use a re-entry setup on the panel.

- **•** The **CUT** and **AUTO TRANS** buttons of a Keyer are linked to those in the **MLE Transition Group**. When you press **AUTO TRANS** in a Keyer, the **DISS, AUTO TRANS** and appropriate “Key” next transition button lights in the **MLE Transition Group** — to indicate a Key transition in progress. When the transition is finished, the buttons return to their previous states.

- **•** You can transition the Key with two different rates, depending on whether you press the **AUTO TRANS** button in the **Keyer** or in the **MLE Transition Group**.

- **•** You cannot **wipe** a Key using the buttons in the **Key 1** or **Key 2 Group**. This function must be performed in the **MLE Transition Group**.

**Note**

The **Half MLE** switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot perform a **WIPE** in the **DSKs**.

**Key Cut Notes**

Key “cut” transitions (using the **CUT** buttons in the **MLE Keyer Groups** and **DSK Groups**) can be performed when the Fader is off its upper or lower limit. However, auto transitions (using the Keyer **AUTO TRANS** buttons) cannot be performed at all when the fader is off a limit, or when an auto transition is in progress.
The table below summarizes the functions of each Keyer button in several specific MLE fader and Keyer modes.

**Keyer Transition Summary Table**

<table>
<thead>
<tr>
<th>Fader Mode</th>
<th>Auto Transition Mode</th>
<th>Next Transition Keyer Mode</th>
<th>AUTO TRANS</th>
<th>CUT</th>
</tr>
</thead>
<tbody>
<tr>
<td>On limit</td>
<td>Transition in progress</td>
<td>Keyer part of transition</td>
<td>Locked out</td>
<td>Completes the auto transition</td>
</tr>
<tr>
<td>On limit</td>
<td>Transition in progress</td>
<td>Keyer not part of transition</td>
<td>Locked out</td>
<td>Cuts the Key on or off, as appropriate</td>
</tr>
<tr>
<td>Off limit</td>
<td>n/a</td>
<td>Keyer part of transition</td>
<td>Locked out</td>
<td>Locked out</td>
</tr>
<tr>
<td>Off limit</td>
<td>n/a</td>
<td>Keyer not part of transition</td>
<td>Locked out</td>
<td>Cuts the Key on or off, as appropriate</td>
</tr>
</tbody>
</table>
In This Chapter

This chapter provides basic instructions for using key modifiers in the MLE Keyers and Downstream Keyers of the Synergy Q/MD/X switchers. The following topics are discussed in this chapter:

- Filling a Key with Matte
- Masking Keys
- Using a Box Mask
- Using a Pattern Mask
- Using a Utility Bus Mask
- Inverting Keys
- Flying Keys
- Bordering Keys
Filling a Key with Matte

All key types *except* Preset Pattern Keys (either flown or not) can be filled with matte.

| Note | The Half MLE switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot perform a MATTE FILL in the DSKs. |

Use the following procedure to fill a key with matte color:

1. Set up the desired key type and source, and clip and gain values. Refer to the section “Introduction to Keying” on page 7–2.
2. In the selected MLE Keyer (or Downstream Keyer), press MATTE FILL. The key hole is filled with the current color of the matte generator.
3. Use the HUE, SAT and LUM controls in the Matte Group, or the knobs in the System Control Group to modify matte hue, saturation, and luminance.
4. If desired, press WASH 1 or WASH 2 to add a custom wash color to your key.
5. Add additional key modifiers as required, then select the desired manual or auto transition in the normal manner.

Refer to the section “Matte Group” on page 6–17 and the section “Creating Washes” on page 6–22 for details on setting up matte colors and washes.
Masking Keys

The Synergy Q/MD/X is capable of doing three types of masks, a Box mask, a Utility Bus mask, and a Pattern mask. All key types can be masked, with the only restriction being that a pattern mask cannot be performed on a Preset Pattern key. Refer to the appropriate sections below.

Use the following procedure to mask a key:

1. Set up the desired key type and source, and clip and gain values. Refer to the section “Introduction to Keying” on page 7–2 for more information.

2. Navigate to the Mask Menu as follows:

   - Press HOME \(\Rightarrow\) Effects \(\Rightarrow\) MORE \(\Rightarrow\) Mask.

3. Toggle the Mask On/Off (softkey F6) to On to activate the mask feature.

   This completes the procedure to mask a key.

Using a Box Mask

Use the following procedure to adjust the elements of the Box Mask:

1. Navigate to the Box Mask Menu as follows:

   - Press HOME \(\Rightarrow\) Effects \(\Rightarrow\) MORE \(\Rightarrow\) Mask \(\Rightarrow\) Box Mask.
2. Press **Posn/Size** to adjust the position and size of the mask.
   - Use the **X** knob to adjust the horizontal position of the mask.
   - Use the **Y** knob to adjust the vertical position of the mask.
   - Use the **Size** knob to adjust the size of the mask.
3. Press **Top/Left** to adjust the position of the top and left edges of the mask.
   - Use the **Left** knob to adjust the left edge of the mask.
   - Use the **Top** knob to adjust the top edge of the mask.
4. Press **Bottom/Right** to adjust the position of the bottom and right edges of the mask.
   - Use the **Right** knob to adjust the right edge of the mask.
   - Use the **Bottom** knob to adjust the bottom edge of the mask.
5. Toggle the **Force** softkey to **On** to “force” the masked signal portion onto the screen.
6. Toggle the **Invert** softkey to **On** to invert or “reverse” the mask.

This completes the procedure for adjusting the elements of the **Box Mask**.

### Using a Pattern Mask

Use the following procedure to select the pattern for the mask:

1. Navigate to the **Pattern Mask Menu** as follows:
   - Press **HOME ⇒ Effects ⇒ MORE ⇒ Mask ⇒ Pattern Mask**.

   ![Pattern Mask Menu](image)

2. Using the **Pattern Control Group**, select the pattern for the mask, as desired.
   - Use the **Size** knob to adjust the size of the mask.
   - Use the **Softness** knob to adjust the softness of the mask edges.
3. Toggle the **Force** softkey to **On** to “force” the masked portion of the signal onto the screen.
4. Toggle the **Invert** softkey to **On** to invert or “reverse” the mask.

   ![Operating Tip](image)

This completes the procedure for selecting the pattern for the mask.
Using a Utility Bus Mask

Use the following procedure to select the key bus video source:

1. Navigate to the Utility Bus Mask Menu as follows:
   • Press HOME ⇒ Effects ⇒ MORE ⇒ Mask ⇒ Pattern Mask ⇒ Utility Bus Mask.

   Utility Bus Mask Menu

   This action selects the Key bus of the associated MLE, and places it into “Utility Bus” mode. You can now select the desired key bus video source as your mask video.

2. Use the Utility Xpt knob to select the video source that you want to feed your mask.

   Note

   You cannot assign a Color Background to the Utility Bus Mask.

3. Toggle the Force softkey to On to “force” the masked portion of the signal onto the screen.

4. Toggle the Invert softkey to On to invert or “reverse” the mask.

5. Toggle the Mask softkey to Off to de-activate the Mask feature.

This completes the procedure for selecting the key bus video source.
Inverting Keys

All key types except Chroma keys can be inverted.

Use the following procedure to invert a key:

1. Set up the desired key type and source, and clip and gain values as outlined in the section “Introduction to Keying” on page 7–2.

2. In the selected MLE Keyer (or Downstream Keyer), press KEY INV. The polarity of the selected key is now reversed.

3. Re-adjust the clip and gain settings of the key as required. This step is often necessary when a key is inverted.

4. Add additional key modifiers as required,

5. Select the desired manual or auto transition for the key.

This completes the procedure for inverting a key.
The **Fly Key** allows you to apply DVE effects to any of the four Key types, with the ability to control the size, horizontal position and vertical position of the Key. Refer to the section “**Flying Keys**” on page 15–17 for information on how to Fly a Key.

**Note**

The **Squeeze & Tease MD** option _must_ be installed in order to Fly a Key.
Bordering Keys

The Key Border function allows you to place borders, shadows and outlines around any key type on the switcher. The XFX Extra Effects Dual Border Generator option must be installed. The border buttons will not light if the option is not installed in an MLE.

Note: You cannot combine wipe pattern borders and XFX borders. Refer to the section “Pattern Control Group” on page 6–2 for more information on wipe pattern borders.

The following figures show samples of the three types of borders that can be created by the XFX Extra Effects Dual Border Generator:

- Press BORD to add a border behind the selected key type. The border can surround the key, or it can appear as a detached shadow that can be offset to any distance and direction. Border width, softness and density are all adjustable. If the Ghost function is enabled, the key fill is turned off.

- Press SHDW to add a drop shadow behind the selected key type. Shadow softness and density are adjustable. If the Ghost function is enabled, the key fill is turned off.

- Press OUTL to add an outline around the selected key type, with variable width, color, and density. With OUTL selected, the key fill is completely transparent.

- Press BORD OFF to turn off a selected border type.

Bordering a Key

Use the following procedure to border or outline a key:

1. Ensure that the XFX Extra Effects Dual Border Generator option is installed in the selected MLE.

   Note: Refer to Chapter 6 in the Synergy Q/MD or Q/MD-X Engineering Manual for instructions on how to verify the status of your installed hardware and software options.

2. Set up the desired key type and source, and clip the key using the controls in the Effects Control Group.
3. In the selected MLE Keyer (or Downstream Keyer), press **BORD, SHDW** or **OUTL** to enable the border generator and display the **Border Menu**.

**Note**

If you do not have enough XFX Border resources available, the message, “XFX MD Border Feature Disabled (unavail)” appears on the menu.

4. Press **CENTER** in the **Positioner Group** to reset all border parameters to their default values. This step is an excellent starting point when adjusting borders, shadows and outlines.

5. Press **Position** to display the **Position Menu**.

```
Border Menu — Position

<table>
<thead>
<tr>
<th>Border</th>
<th>MLE 1 Key 1</th>
<th>MD Border Feature Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Glow</td>
<td>Ghost</td>
</tr>
</tbody>
</table>
```

6. Adjust the border position and width as follows:
   - Use the **Horizontal** knob to adjust the horizontal position.
   - Use the **Vertical** knob to adjust the vertical position.
   - Use the **Width** knob to adjust the width of the border or outline.

**Operating Tip**

You can also use the **Positioner** or the controls in the **Effects Control Group** to adjust the Border parameters.

7. Press **Glow & Density** to display the **Glow and Density Menu**.

```
Border Menu — Glow and Density

<table>
<thead>
<tr>
<th>Border</th>
<th>MLE 1 Key 1</th>
<th>MD Border Feature Enabled</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>Glow</td>
<td>Ghost</td>
</tr>
</tbody>
</table>
```

8. Adjust glow (softness) and density (transparency) of the border as follows:
   - Use the **Glow** knob to adjust the glow, from hard edge (0%) to soft edge (100%).
   - Use the **Density** knob to adjust the density, from opaque (100%) to fully transparent (0%).

**Operating Tip**

To create the widest possible border, set both the **WIDTH** and **GLOW** controls to their maximum settings.
9. Press the **Ghost On/Off** softkey to toggle the key fill as follows:
   - **ON** – The key fill is removed.
   - **OFF** – The key fill is displayed.

**Note**

It is not possible to perform the “Ghost” function on a Chroma Key.

10. Adjust border color using the controls in the **Mattes Group**.
   - When **BORD** in **Key 1** or **DSK 1** is selected, **BORD 1** is automatically selected in the **Mattes Group**.
   - When **BORD** in **Key 2** or **DSK 2** is selected, **BORD 2** is automatically selected in the **Mattes Group**.

**Operating Tip**

You can also create a **wash** as the border color. Refer to the section “Creating Washes” on page 6–22 for instructions.

This completes the procedure for bordering or outlining a key.

Use the following procedure to create a drop shadow on a key:

1. In the selected **MLE Keyer** (or **Downstream Keyer**), press **SHDW** to enable the border generator and display the **Shadow Menu**.

2. Press **CENTER** in the **Positioner Group** to reset all parameters to their default values. This step is an excellent starting point when adjusting shadows.

3. Press **Position** to display the **Position Menu**.

4. Adjust the border position as follows:
   - Use the **Horizontal** knob to adjust the horizontal position.
   - Use the **Vertical** knob to adjust the vertical position.

5. Press **Glow & Density** to display the **Glow and Density Menu**.

**Note**

It is not possible to perform the “Ghost” function on a Chroma Key.
6. Adjust glow (softness) and density (transparency) of the drop shadow as follows:
   - Use the **Glow** knob to adjust the glow, from hard edge (0%) to soft edge (100%).
   - Use the **Density** knob to adjust the density, from opaque (100%) to fully transparent (0%).

   **Operating Tip**
   To create the widest possible border, set both the **WIDTH** and **GLOW** controls to their maximum settings.

7. Press the **Ghost On/Off** softkey to toggle the key fill as follows:
   - **ON** – The key fill is removed.
   - **OFF** – The key fill is displayed.

   **Note**
   It is not possible to perform the “Ghost” function on a Chroma Key.

8. Adjust shadow color using the controls in the **Mattes Group**.
   - When **SHDW** in Key 1 or DSK 1 is selected, **BORD 1** is automatically selected in the **Mattes Group**.
   - When **SHDW** in Key 2 or DSK 2 is selected, **BORD 2** is automatically selected in the **Mattes Group**.

   **Operating Tip**
   You can also create a **wash** as the border color. Refer to the section “Creating Washes” on page 6–22 for instructions.

This completes the procedure to add a drop shadow to a key.

Note the following important points regarding the **Fly Border** function:
   - All types of keys can be bordered, however, note that some preset patterns keys may exhibit a repeated border if the border is positioned too far away from the key source.
   - Be sure to press the **CENTER** button (in the **Positioner Group**) before adjusting your borders initially. This action resets all parameters to their default values.
   - All border settings are stored and recalled to disk. In addition, the borders are copied when using the **MLE Copy** and **Key Copy** functions. Refer to the section “Copy and Swap Functions” on page 12–72 for details.
   - If a border is positioned below the key source, it reacts within the same field as the moving video. If the border is positioned above the key, it reacts one field later than the moving video.
• Use the controls in the **Positioner Group** to move two borders simultaneously. Press **BORD 1** and **BORD 2** simultaneously, and use the **Positioner** in the normal way.

**Programming a Favorite CG**

This procedure allows you to select a “favorite” CG that you want to place on the **CHAR GEN** button in the **Key 2 Group** of each MLE. The feature is designed so that you can quickly select a “clean” CG in the **Auto Select** mode, with no key modifiers enabled. (Note that there is no **CHAR GEN** button in the DSKs.)

Use the following procedure to program the “favorite” CG button:

1. Press and **hold** the **CHAR GEN** button in the Keyer of **any** MLE.
2. On the **Key Bus** of the selected MLE, press the button for your most frequently used CG.
3. Release both buttons. The selected CG is now stored in memory, and will be recalled each time **CHAR GEN** is pressed — in any MLE.

This completes the procedure for programming the “favorite” CG button.

Please note:

• If you have a simple or complex key type already set up when you press **CHAR GEN**, the entire keyer is cleared. In addition to the favorite CG, the system will automatically select **AUTO SELECT** and **KEY MEM** (provided the Auto Select key with the appropriate Key Memory values has been set up in the installation).

• The “favorite” CG programming function is global. Regardless of where you program the function, all **CHAR GEN** buttons (in all MLEs) will now recall the selected CG.
Positioner Group

The Positioner Group is an assignable module that allows you to manipulate the position of wipe patterns and masks, depending upon the selected mode, as well as quickly adjust menu values.

Synergy 4

The figure below illustrates the Positioner Group for the Synergy 4 Q/MD-X control panel:

Synergy 3

The figure below illustrates the Positioner Group for the Synergy 3 Q/MD/X control panel:


**Synergy 2**

The figure below illustrates the **Positioner Group** for the **Synergy 2 Q/MD/X** control panel:

![Synergy 2 Control Panel](image)

1) Positioner Assignment Section  
2) Positioner  
3) Positioner Function Section 1  
4) Positioner Function Section 2

---

**Synergy 1**

The figure below illustrates the **Positioner Group** for the **Synergy 1 Q/MD** control panel:

![Synergy 1 Control Panel](image)

1) – Not on the Synergy 1 panel –  
2) Positioner  
3) Positioner Function Section 1  
4) Positioner Function Section 2

---

1. **Positioner Assignment Section (Synergy 2, 3, and 4 Q/MD/X control panels)**

   The **Positioner Assignment Section** provides a group of buttons that allow you to assign the **Positioner Group** to individual MLEs.

   - Press **MLE 1** to assign the group to control positionable functions in **MLE 1**. The button will also light *automatically* if the **WIPE**, **FLY KEY**, or **DVE SEND** buttons are pressed in **MLE 1**.

   - Press **MLE 2** to assign the group to control positionable functions in **MLE 2**. The button will also light *automatically* if the **WIPE**, **FLY KEY**, or **DVE SEND** buttons are pressed in **MLE 2**.
• *(Synergy 3 and 4 only)* Press MLE 3 to assign the group to control positionable functions in MLE 3. The button will also light automatically if the WIPE, FLY KEY, or DVE SEND buttons are pressed in MLE 3.

• *(Synergy 4 only)* Press MLE 4 to assign the group to control positionable functions in MLE 4. The button will also light automatically if the WIPE, FLY KEY or DVE SEND buttons are pressed in MLE 4.

2. **Positioner**

The 3-axis Positioner (also known as a joystick) allows you to manipulate the position of various functions selected in the MLE.

• When the MENU button is toggled Off, the positioner allows you to manipulate the position of wipe patterns, borders, and flying keys (depending upon the selected mode). The Positioner controls the specific switcher location that is selected in the Positioner Assignment Section, and the specific function that is selected in Positioner Function Section 2.

Joystick control in these modes is illustrated below:

Most commonly, the positioner is used as follows:

~ Move the Positioner left and right to control the horizontal position of wipes and flying keys on screen.

~ Move the Positioner up and down to control the vertical position of wipes and flying keys on screen.

~ Twist the Positioner top knob clockwise and counter-clockwise to change the position (size) of the flying key in or outbox mask.

• When the MENU button is toggled On, the current settings of the Positioner are temporarily ignored — but stored in memory. The Positioner now applies to the current menu, with the ability to duplicate the function of the three menu knobs. This function only applies to selected installation and operational menus that display the three “Positioner Icons” in the right-hand Scroll Area. (Typically, two or three icons are shown, depending upon the current menu function).

When you select a menu that includes the Positioner Icons, the MENU button automatically lights.

When the Positioner Icons appear on a menu, you can adjust the selected function or parameter either with the scroll knobs or with the Positioner. A sample menu that includes the three icons is shown below.
Box Mask Menu — with Positioner Icons

a) The left-right **Positioner Icon** allows you to move **Positioner left** and **right** to emulate the functions of the top knob.

b) The up-down **Positioner Icon** allows you to move the **Positioner up** and **down** to emulate the functions of the middle knob.

c) The circular **Positioner Icon** allows you to twist the **Positioner knob clockwise** and **counter-clockwise** to emulate the functions of the bottom knob.

When you turn the **MENU** button off, the **Positioner** once again is assigned to the current panel function and location.

3. Positioner Function Section 1

- Enable **MENU** to assign **Positioner** control to menu functions, temporarily disabling control over positionable functions. When the button is turned off, **Positioner** control (for a selected MLE and function) is restored.

**Note**

When you select a menu that includes the three **Positioner Icons**, the **MENU** button **automatically** lights.

- Press **CENTER** to return the wipe, or flying key to its default position, typically removing all X, Y, and Z-axis offsets from the image.

4. Positioner Function Section 2

- Press **PATT** to switch **Positioner** control over to the selected pattern generator of the MLE. There is only one **PATT** button in the group, yet there are **two** advanced pattern generators per MLE. To determine which pattern generator is controlled, check the Pattern Control Group:
  ~ If **WIPE PP1** is lit, pattern generator 1 is controlled.
  ~ If **PST PATT2** is lit, pattern generator 2 is controlled.

**Note**

The **Half MLE** switchers (Synergy 1.5 Q/MD, 2.5 Q/MD, 2.5 Q/MD-X and 3.5 Q/MD-X) cannot apply a **PST PATT** in the DSKs, or a **WIPE** in the bottom MLE.
- Press **FLY KEY 1** to switch **Positioner** control over to the selected MLE **Key 1 Group** or **DSK 1 Group**. The **Squeeze & Tease Menu** automatically appears. If **FLY KEY** is enabled and the **Positioner** is on (the **Squeeze & Tease MD** option must be installed), the key can be sized and positioned.

- Press **FLY KEY 2** to switch **Positioner** control over to the selected MLE **Key 2 Group** or **DSK 2 Group**. The **Squeeze & Tease Menu** automatically appears. If **FLY KEY** is enabled and the **Positioner** is on (the **Squeeze & Tease MD** option must be installed), the key can be sized and positioned.
Memory and Disk Functions

In This Chapter

This chapter provides instructions for using the Global Memory System, USB Drive, and the Hard Drive functions of the Synergy Q/MD/X switcher.

The following topics are discussed in this chapter:

• Global Memory System Group
• Storing Memory Registers
• Recalling Memory Registers
• Memory Lock
• Naming Memory Registers
• Effects Dissolve
• Using Storage Devices
Global Memory System Group

The **Global Memory System Group** is used to store and recall switcher memory registers — for all MLEs on the panel. Within the group, you can also enable some of the remote control functions of the switcher, control a variety of MLE transition rates, and recall VTR “clips” from memory.

A memory register is a “snapshot” of an MLE (or multiple MLEs). Up to 100 registers can be stored and recalled. A register can be as simple as the contents of one keyer of an MLE, or as comprehensive as the contents of the entire switcher, including all MLEs, Aux Buses, DVE settings, and Global-Store settings.

**Note**

On the **Synergy 3** and **4** control panels, you can also store and recall memory registers within each MLE itself, using the **MLE Memory Group**. This group of buttons pertains only to that individual MLE — not to the entire panel.

For simplicity in the drawings, sections are numbered in an identical manner from switcher to switcher.

**Synergy 4**

The figure below illustrates the **Global Memory System Group** for the **Synergy 4** control panel.
Synergy 3

The figure below illustrates the Global Memory System Group for the Synergy 3 control panel.

Synergy 3 Global Memory System Group

1) Display  
2) Recall Section  
3) Keypad  
4) Store Section  
5) Remote Section  
6) Include Section  
7) USB Port

Synergy 2

The figure below illustrates the Global Memory System Group for the Synergy 2 control panel.

Synergy 2 Global Memory System Group

1) Display  
2) Recall Section  
3) Keypad  
4) Store Section  
5) Remote Section  
6) Include Section  
7) USB Port  
8) Preview Overlay Group
Synergy 1

The figure below illustrates the **Global Memory System Group** for the **Synergy 1** control panel.

1. Display

The **Display** provides five data fields. All rates are indicated in frames:

- **REG:##** — Indicates the current memory register number.
- **Memory#** — Displays the current memory.

On the **Synergy 1** control panel, the following three fields are found on the second line of the display:

- **M:###** — Indicates the Background/Preset MLE transition rate.
- **K:###** — Indicates the transition rate for both keyers.
- **F:##** — Indicates the Fade to Black transition rate.

On the **Synergy 2**, **3** and **4** control panels, the following three fields are found on the second line of the display:

- **M:###** — Indicates the Program/Preset MLE transition rate.
- **D:###** — Indicates the transition rate for both DSKs.
- **F:##** — Indicates the Fade to Black transition rate.

2. Recall Section

The **Recall Section** allows you to recall switcher memory registers into selected MLEs. Refer to the section “Recalling Registers” on page 9-35 for complete instructions on memory recall operations.

- **(Synergy 1 only)** Press **RECALL** to enable the MLE for the next recall operation.

- **(Synergy 2, 3 and 4)** Press **ALL** to enable all MLEs for the next recall operation. The **ALL** button lights. When a bank and register are entered on the keypad, information is recalled from memory and loaded into each MLE.

- **(Synergy 2, 3 and 4)** Press **MLE 1** to enable only MLE 1 for the next recall operation.
~ (Synergy 3 and 4) To recall MLE 1 plus another MLE, press the desired MLE buttons simultaneously, e.g., MLE 1 + MLE 3.

- (Synergy 2, 3 and 4) Press MLE 2 to enable only MLE 2 for the next recall operation.

~ (Synergy 3 and 4) To recall MLE 2 plus another MLE, press the desired MLE buttons simultaneously, e.g., MLE 2 + MLE 3.

- (Synergy 3 and 4) Press MLE 3 to enable only MLE 3 for the next recall operation. To recall MLE 3 plus another MLE, press the desired MLE buttons simultaneously.

- (Synergy 4 only) Press MLE 4 to enable only MLE 4 for the next recall operation. To recall MLE 4 plus another MLE, press the desired MLE buttons simultaneously.

- Press UNDO to undo the last memory recall operation, restoring the MLE(s) to its state immediately before the recall. For example, if you had a “fly key” effect set up and then accidentally recalled a register that included a simple wipe, pressing UNDO would immediately restore the fly key effect.

UNDO turns on immediately after a memory recall has been performed, giving you a chance to undo the operation. The UNDO button will remain On and allow the user nine button presses to initiate the undo. On the tenth button press, the UNDO light turns Off and the recall can not be undone. The fader bar does not affect the UNDO status.

**Important**

If you have edited a sequence before loading a memory, the edited sequence will be lost. Pressing UNDO will reload the sequence from its previously saved state.

- (Synergy 2) Press RECALL DVE to recall a specific DVE effect from the primary DVE. The DVE Send and Remote Control Option must be installed.

- Enable KEYS ONLY to recall all memory register data except for the BKGD and PST crosspoints. This function allows you to retain (or hold) crosspoints, but change the keys that are layered on top.

**Note**

When KEYS ONLY is On, the next recall operation is “armed” to perform a Keys Only function.

When Off, the next recall operation recalls keys and crosspoints.

- Enable EFF DISS (effects dissolve) to change the way that effects are recalled. When the button is lit (armed), and an effect is recalled, the system first recalls all non-dissolving values, such as crosspoint selection or wipe pattern selection, and then affects a dynamic change (or slew) from the starting position to the recall position of all dissolving analog functions such as clip levels and pattern positions.
(Synergy 1) This is done at a rate set by the MLE RATE in the Recall Memory area.

(Synergy 2) This works in conjunction with the lit MLE button(s) in the Recall Section. There are no MLE Memory Groups on the Synergy 2 control panel.

(Synergy 3 and 4) In the Global Memory System Group, the button applies only to the PGM/PST MLE, because that MLE does not have an MLE Memory Group.

(Synergy 3 and 4) In the individual MLE Memory Groups, the button only applies to the associated MLE.

Note that when EFF DISS is lit, the next recall is “armed” for an effects dissolve. When the register is recalled, the effect slews from its current settings to the recalled settings. When EFF DISS is off, the switcher cuts to the next register.

Refer to the section “Effects Dissolve” on page 9-20 for instructions.

3. Keypad

The Keypad allows you to enter transition rates, fade rates, switcher memory registers, DVE register numbers, and VTR clip numbers.

- Use buttons 0 through 9 for all numeric entry requirements, such as transition rates, fade rates, switcher memory registers, banks, DVE registers, and VTR clips.

- Press and hold the BANK button and press a number between 0 and 9 to select the bank of switcher memory registers that you want to store or recall. (For example, press and hold the BANK button and then press 4 to select bank 4)

Ten banks of ten registers each are provided, for a total of 100 registers:

- Bank 0 (registers 00 to 09)
- Bank 1 (registers 10 to 19)
- Bank 2 (registers 20 to 29)
- Bank 3 (registers 30 to 39)
- Bank 4 (registers 40 to 49)
- Bank 5 (registers 50 to 59)
- Bank 6 (registers 60 to 69)
- Bank 7 (registers 70 to 79)
- Bank 8 (registers 80 to 89)
- Bank 9 (registers 90 to 99)

You can also press the BANK button repeatedly, to advance by one bank per press. (For example, pressing BANK, BANK would change register 21 to 31, then 41.)

Refer to the section “Storing Memory Registers” on page 9-9 and the section “Recalling Memory Registers” on page 9-12 for memory function instructions.

- Press ENTER to conclude all numeric entry procedures, such as storing memory registers, entering transition rates, fade rates, DVE registers, and VTR clips. The
button lights immediately when keypad buttons are pressed to indicate that an entry is pending.

Note

ENTER is not required for memory recall functions — allowing you to quickly press just the bank and desired register — for rapid recalling of your setups.

4. Store Section

The Store Section allows you to store snapshots of the MLE and enter selected transition rates. Refer to the section “Storing Memory Registers” on page 9-9 for complete memory instructions.

- **(Synergy 1 only)** Press STORE to enable the MLE for the next storage operation.

- **(Synergy 2, 3 and 4)** Press ALL to enable all MLEs for the next storage operation. The ALL button lights. When a bank and register are entered on the keypad, information is stored into memory from each MLE.

- **(Synergy 2, 3 and 4)** Press MLE 1 to store just the contents of MLE 1 in a memory register.
  
  ~ **(Synergy 3 and 4)** To store MLE 1 plus another MLE, press the desired MLE buttons simultaneously, e.g., MLE 1 + MLE 3.

- **(Synergy 2, 3 and 4)** Press MLE 2 to store just the contents of MLE 2 in a memory register.
  
  ~ **(Synergy 3 and 4)** To store MLE 2 plus another MLE, press the desired MLE buttons together, e.g., MLE 2 + MLE 3.

- **(Synergy 3 and 4)** Press MLE 3 to store just the contents of MLE 3 in a selected memory register. To store MLE 3 plus another MLE, press the desired MLE buttons simultaneously, e.g., MLE 3 + MLE 1.

- **(Synergy 4 only)** Press MLE 4 to store just the contents of MLE 4 in a selected memory register. To store MLE 4 plus another MLE, press the desired MLE buttons simultaneously, e.g., MLE 4 + MLE 3 + MLE 2.

Note

The ALL, MLE 1, MLE 2, MLE 3 and MLE 4 buttons can also be used with the buttons in the Recall Section to reset the entire switcher, or selected MLEs. Refer to the section “Resetting the Switcher” on page 2-23 for more information.

- **(Synergy 1 only)** Press MLE RATE to change the transition rate performed in the Transition Group. Refer to the section “Auto Transitions” on page 5-14 for details.

- **(Synergy 2 only)** Press MLE 1 RATE to change transition rates for MLE 1 effects (in the MLE 1 Transition Group). This button is located in the Global Memory System Group because the Synergy 2 does not have an MLE Memory Group. Refer to the section “Auto Transitions” on page 5-14 for details.

- **(Synergy 2 only)** Press MLE 2 RATE to change transition rates for MLE 2 (Program/Preset) effects. Refer to the section “Auto Transitions” on page 5-14 for details.
• (Synergy 3 only) Press **MLE 3 RATE** to change transition rates for MLE 3 (Program/Preset) effects. Refer to the section “Auto Transitions” on page 5-14 for details.

• (Synergy 4 only) Press **MLE 4 RATE** to change transition rates for MLE 4 (Program/Preset) effects. Refer to the section “Auto Transitions” on page 5-14 for details.

• (Synergy 1 and 2) Press **KEY RATE** to change transition rates for both MLE 1 Key Groups (the rate is identical). This button is located in the Global Memory System Group because the Synergy 1 and 2 do not have an MLE Memory Group. Refer to the section “MLE Key Groups” on page 7-4 for more information.

• Press **FADE RATE** to change the fade-to-black transition rate for the switcher. Refer to the section “Fade to Black” on page 4-38 for more information.

• (Synergy 2, 3 and 4) Press **DSK RATE** to change the downstream key transition rates. The rate is identical for DSK 1 and DSK 2. Refer to the section “Changing DSK Auto Transition Rates” on page 7-68 for more information.

5. Remote Section

The **Remote Section** includes buttons for toggling remote control from external devices.

• Press **EDITOR** to toggle remote control from an external edit controller. The Editor Interface Option must be installed. When lit, remote control is enabled (but local operations can still be performed). When off, the switcher is entirely “local.” Refer to the section “Editor Interface” on page 12-25 for details.

• Press **GPI** to toggle remote control from external GPI sources. The button controls GPI input pulses — output pulses are not affected. When the button is lit, remote GPI control is enabled. When the button is off, external GPI control is disabled. Refer to the section “GPI Control” on page 12-2 for details.

6. Include Section

The **Include Section** governs what specific category of information is recalled to the panel when a memory register is recalled.

• When lit, **ATTRIB** indicates that the Auto Recall option in the Personality Menu is enabled, and the switcher will recall the Key Only and Effects Dissolve settings as part of a memory recall operation.

• Enable **INCL DVE** to recall the DVE effect number (if any) that was stored in the selected memory register.
  ~ When **On** (lit), the next recall operation is “armed” to recall the DVE effect associated with your primary DVE into the selected MLE. The button stays **On** until manually turned **Off**.
  ~ When **Off**, all data except for the DVE effect will be recalled to the selected MLE. This function allows you to **retain** a selected DVE effect, yet recall a memory register into the MLE.

• Press **VTR CLIP** to recall clips (segments) from a selected serial controlled device that is connected to Synergy via RS-422 communications. Devices include VTRs, Video Servers, and Audio Servers. The VTR Remote Control, Video Server Control, or Audio Server Control option must be installed, respectively. Any combination of options can be installed.
A VTR clip consists of two pieces of information: a physical VTR connected to the system and a timecode register. When a clip is recalled from memory, the VTR can be cued to the timecode and then rolled from the switcher panel itself. Refer to the section “Clip Control Overview” on page 14-2 for details.

**Note**

The Digicart (360 Systems) protocol has been added to the Synergy Q/MD/X switchers. This function allows you to trigger audio clips from the Digicart in the same manner that you trigger VTR clips.

### 7. USB Port

The USB Port is used to store and recall seven categories of switcher registers, using a USB Drive.

**Caution**

Do NOT remove the USB Key before the LED on the USB Port goes out. Doing so may destroy the data on your USB Key.

- **Memory Registers** are “snapshots” of the various MLEs.
- **Custom Control Registers** are the functions that you have programmed into the Custom Control group, such as VTR and DVE remote control commands.
- **Personality Registers** are user-configurable registers that apply to your particular style of operation. Data such as DSK Setup and Favorite CG Setup is stored here.
- **VTR Clip Registers** store VTR clip register information (in timecode format).
- **Installation Registers** store all switcher setup and configuration settings.
- **3D Sequence Registers** store all of the S&T MD 3D sequences.
- **Bus Maps** store all 16 of the user defined bus maps.

### 8. Preview Overlay Group (Synergy 2 only)

The Preview Overlay Group allows you to control specific overlay information that appears on the preview monitor, such as VTR time code, a count up/down timer, source ID, safe title, etc. Displays are individually selectable on the preview monitor for quick reference. Refer to the section “Preview Overlay Group” on page 12-13 for full details.

### Storing Memory Registers

This section provides instructions for storing memory registers in *two locations* on the Synergy Q/MD/X switcher:

- Storing Registers Using the Global Memory System
- Storing Registers Using the MLE Memory Group (Synergy 3 and 4 only)

The Synergy Q/MD/X switcher allows you to store 100 complete panel setups. Each register can be regarded as having separate compartments for individual MLEs. When viewed this way, you can store 100 unique MLE setups on the Synergy 1, 200 unique MLE setups on the Synergy 2, 300 setups on the Synergy 3, and 400 setups on the Synergy 4 — however, you are limited to 100 setups for each MLE. When you store an MLE, you store everything — all transitions, rates, crosspoints, borders, keys, fader position, transition limits, clip levels, wash colors, pattern multipliers, DVE registers, **EFF DISS, KEYS ONLY**, and **INCL DVE** button settings — everything.
In addition, underlying data is also stored. For example, if you store an MLE that includes one or more keys, not only is the key data stored for the current on-air keys, but also the underlying data (e.g., clip and gain) is stored for keys that are not currently on-air.

When you store memories at the Global Memory System level, the Key Only and Effects Dissolve settings are saved in the selected MLE Memory System as well.

Still-Store settings are also stored. Global-Store settings are stored each time a memory register is saved (allowing you to recall different Global-Store settings when recalling the same memory register to different MLEs) and MLE-Store settings are stored on a per-MLE basis when an MLE is stored. Refer to the section “Recalling Still-Store Settings” on page 9–15 for more information on recalling Still-Store settings.

Storing Registers Using the Global Memory System

Use the following procedure to store switcher memory registers using the Global Memory System Group:

1. Set up the desired effect in one or more MLEs.
2. In the Store Section of the Global Memory System Group, select the MLE (or group of MLEs) that you wish to store.
   - Press ALL to enable all MLEs for the next storage operation.
   - Press the corresponding MLE button to store just the desired MLE.
   - (Synergy 3 and 4) To store two MLEs, press the desired MLE buttons together, e.g., MLE 2 + MLE 3.
   - (Synergy 4) To store three MLEs, press the desired MLE buttons together, e.g., MLE 1 + MLE 3 + MLE 4.
3. On the keypad, enter the desired storage register. If required, select a memory register bank (the 10’s digit). There are two methods to do this:
   - If the desired bank is already selected, you only have to select the register (from 0 to 9).
• Press **BANK** repeatedly, to advance by *one bank per press*.
• Press and *hold* **BANK**, then press the desired bank (0 to 9).

Once you select the bank, the number appears on the display (in the 10’s digit column) and the **ENTER** button lights.

• Select the register within the bank (the 1’s digit), by pressing the number (from 0 to 9).

**Note**

If you wish to cancel the entire storage procedure at any point, simply turn off the lit buttons in the **Store Section** by pressing a button in the **Recall** column, or any of the buttons used for changing transition rates.

If you want to enter a *different* memory bank or register prior to pressing **ENTER**, simply continue to type until the desired value appears.

4. Press **ENTER** to complete the procedure.

The register is now stored in memory and the **ENTER** button light turns off.

### Storing Registers Using the MLE Memory Group

For **Synergy 3** and **4** switchers, use the following procedure to store switcher memory registers using any **MLE Memory Group**. This function is the *same* as pressing an individual MLE button in the **Store Section** of the **Global Memory System Group**.

Use the following procedure to store a register in an **MLE Memory Group**:

**Important**

Storing a setup in a specific register *overwrites any previous information* that may have been contained in that register. There is no “undo” function for storage.

1. Set up the desired effect in an MLE.
2. In the **Memory Group** of that MLE, press **STORE**.
3. On the keypad, enter the desired storage register. If required, select a memory register bank (the 10’s digit). There are two methods to do this:

**Operating Tip**

If the desired bank is *already* selected, you only have to select the register (from 0 to 9).

• Press **BANK** repeatedly, to advance by *one bank per press*.
• Press and *hold* **BANK**, then press the desired bank (0 to 9).

Once you select the bank, the number appears on the display (in the 10’s digit column) and the **ENTER** button lights.

• Select the register within the bank (0 to 9). The number appears on the display (in the 1’s digit column).
4. Press **ENTER** to complete the procedure.

The MLE is now stored in memory and the **ENTER** button light turns off.

Refer to the next section for important information regarding DVEs and Aux Bus assignments.

## Recalling Memory Registers

This section provides instructions for recalling memory registers from two locations on the Synergy Q/MD/X switcher:

- Recalling Registers Using the Global Memory System
- Recalling Registers Using the MLE Memory Group (**Synergy 3** and **4** only)

The procedure is very similar to the storage procedure; however, you have several options for the “type” of data that you wish to recall. The following two sections provide instructions for each recall situation.

### Recalling Registers Using the Global Memory System

For all Synergy switchers, use the following procedure to recall switcher memory registers using the **Global Memory System Group**:

1. In the **Recall Section** of the **Global Memory System Group**, select the MLE (or group of MLEs) that you wish to recall.

   - Press **ALL** to enable all MLEs for the next recall operation.
   - Press the corresponding **MLE** button to recall just the desired MLE.
   - (**Synergy 3 and 4**) To recall two MLEs, press the desired MLE buttons together, for example, **MLE 2 + MLE 3**.
   - (**Synergy 4**) To recall three MLEs, press the desired MLE buttons together, for example, **MLE 1 + MLE 3 + MLE 4**.

2. (Optional) Using the buttons in the **Include** and **Recall** sections, select the type of data that you want to include in the recall operation. These buttons arm the function for each data category. They can be enabled in any combination.

   - Enable **ATTRIB** to activate the **Auto Recall** option in the **Personality Menu**. The switcher will recall the **KEY ONLY** and **EFF DISS** settings as part of a memory recall operation.

   **Note** **KEY ONLY** and **EFF DISS** settings are only recalled if the Auto Recall option is enabled.
• Enable **KEYS ONLY** to recall all memory register information except for PGM/PST (or BKGD/PST) bus crosspoints.
  ~ For Synergy 1 and 2 panels, the “**Keys Only**” function in the **Global Memory System Group** works with the lit MLE button(s) in the **Recall Section**.
  ~ For Synergy 3 and 4 panels, the “**Keys Only**” function in the **Global Memory System Group** applies only to the PGM/PST MLE. You enable the “**Key Only**” function for the BKGD/PST MLEs from the **MLE Memory System Group**.

• Enable **VTR CLIP** to recall VTR, Video Server or Audio Server clip data from a selected memory register. Registers include a physical serial controlled device (such as a VTR, Video Server, or Audio Server) and a timecode. If the device is a server, additional information such as an ID is also stored.
  The **VTR Remote Control**, **Video Server Control**, or **Audio Server Control** option must be installed. Any combination of options can be installed.

• Enable **EFF DISS** to recall all non-dissolving values first, and then slew any stored analog functions from their current settings to the recalled settings. Refer to the section “**Using Auto Recall**” on page 9–21 for information on using Effects Dissolve with the **Auto Recall** feature enabled.
  ~ For Synergy 1 and 2 control panels, the “**Effects Dissolve**” function in the **Global Memory System Group** works with the lit MLE button(s) in the **Recall Section**.
  ~ For Synergy 3 and 4 control panels, the “**Effects Dissolve**” function in the **Global Memory System Group** applies only to the PGM/PST MLE. You enable the “**Effects Dissolve**” function for the BKGD/PST MLEs from the **MLE Memory System Group**.

3. On the keypad, enter the desired register to recall:

   • If required, select the bank. Two methods are available:
     ~ Press **BANK** repeatedly, to advance by **one bank per press**.
     ~ Press and **hold BANK**, then press the number of the desired bank (from 0 to 9).
   Once you select the bank, the number appears on the display (in the 10’s digit column).

   ![Note]
   If the desired bank is already selected, you need only select the register (from 0 to 9) to immediately recall the setup.

   • Select the register within the bank (the 1’s digit) by pressing the number (from 0 to 9). The number appears on the display and the effect is recalled.

   ![Note]
   You do not need to press **ENTER** to recall a register.

Refer to the section “**Recalling Still-Store Settings**” on page 9–15 and the section “**Recall Register Notes**” on page 9-15 for important information regarding the recall procedure itself, and the use of **UNDO**.
Recalling Registers Using the MLE Memory Group

Note

This section applies to Synergy 3 and 4 control panels only.

Use the following procedure to recall switcher memory registers using any MLE Memory Group. This function is the same as pressing an individual MLE button in the Recall Section of the Global Memory System Group.

1. Press **RECALL** in an MLE Memory System Group.

2. (Optional) Using the buttons in the Include Group, select the type of data that you wish to include in the recall function. These buttons “arm” the recall function, and can be enabled in any combination:
   - Enable **ATTRIB** to activate the Auto Recall option in the Personality Menu. The switcher will recall the KEY ONLY and EFF DISS settings as part of a memory recall operation.

   Note
   Key Only and Effects Dissolve settings are only recalled if the Auto Recall option is enabled.

   • Enable **KEYS ONLY** (in the MLE Memory Group) to recall all memory register information except for BKGD/PST crosspoints. The function applies to the associated MLE only.
   • Enable **VTR CLIP** (in the Global Memory System Group) to recall VTR, Video Server, or Audio Server clip data from a selected memory register. Registers include a physical serial controlled device (such as a VTR, Video Server, or Audio Server) and a timecode. If the device is a server, additional information such as an ID is also stored. The VTR Remote Control, Video Server Control, or Audio Server Control option must be installed. Any combination of options can be installed.
   • Enable **EFF DISS** (in the MLE Memory Group) to recall all non-dissolving values first, and then slew any stored analog functions from their current settings to the recalled settings. The effects dissolve function applies to the associated MLE only.

3. On the keypad (in the MLE Memory Group), enter the desired register:
   - If required, select the bank. Two methods are available:
     ~ Press **BANK** repeatedly, to advance by one bank per press.
     ~ Press and **hold BANK**, then press the number of the desired bank (from 0 to 9).
   
   Once you select the bank, the number appears on the display (in the 10’s digit column).

   Note
   If the desired bank is already selected, you need only select the register (from 0 to 9) to immediately recall the setup.

   • Select the register within the bank (the 1’s digit), by pressing the number (from 0 to 9). The number appears on the display and the effect is immediately recalled.

   Note
   You do not need to press **ENTER** to recall a register.
Refer to the sections “Recalling Still-Store Settings” and “Recall Register Notes” for important information regarding the recall procedure itself, and the use of UNDO.

**Recalling Still-Store Settings**

Still-Store settings are saved to the memory register each time you perform a store operation. Every register stores separate MLE-Store and Global-Store settings for each MLE on your switcher.

**MLE-Store** — These settings are stored independently for each MLE. Recalling one, multiple, or all MLEs from a memory register also recalls the appropriate MLE-store settings for each MLE included in the memory recall.

**Global-Store** — These settings are stored independently for each MLE, but since there is only a single Global-Store, the settings recalled depend on the MLEs you include in the recall operation. The Global-Store settings recalled are those stored with the highest numbered MLE that you are recalling. For example (on a Synergy 3 panel), if you set the Global-Store settings and store MLE 1 in memory register 10, the Global-Store settings are saved with the MLE 1 settings. If you change the Global-Store settings and then store MLE 2 in the same memory register 10, the new Global-Store settings are saved with the MLE 2 settings. When you recall memory register 10, the Global-Store settings that are recalled will depend on the MLEs you select for recall as follows:

- Selecting only MLE 1 recalls the Global-Store settings stored with MLE 1.
- Selecting only MLE 2 only recalls the Global-Store settings stored with MLE 2.
- Selecting MLE 1 and MLE 2 recalls the Global-Store settings stored with MLE 2.
- Selecting All clears all Global-Store settings because you did not store MLE 3 to this memory register. Since no Global-Store settings were saved for MLE 3, the settings are cleared. Remember, the Global-Store settings are recalled from the highest numbered MLE included in the recall.

Since Global-Store settings may be recalled differently depending on how a memory register is recalled, there is an option to disable the recall of Global-Store settings when recalling memory registers. Refer to the section, “Global-Store Memory Recall Mode”, in the chapter, “Completing Setup”, of the Synergy Q/MD or Q/MD-X Engineering Manual.

**Recall Register Notes**

Please note the following important points regarding memory register recall:

- If you accidentally recalled the wrong register, press UNDO to restore the MLE (or group of MLEs) to its state immediately before the recall. The UNDO button will remain On and allows the user nine button presses to initiate the undo. On the tenth button press, the UNDO light turns Off and the recall can not be undone. The fader bar does not affect the UNDO status.
- Recalling a register changes the displays in both the Global Memory System Group itself, and in any individual MLE Memory System Group display that is affected by the recall.
- When a register is recalled that includes an off-limit Fader, the system brings the effect back as a temporary “Transition Limit.” You can use a standard AUTO TRANS to complete the transition, or return the transition to its starting point.

**Note**

Any actual Transition Limit functions are recalled as originally programmed, whether or not the TRANS LIMIT button is lit.

For temporary Transition Limit functions, the “physical” and “electrical” Fader positions may not match when a register is recalled.
• If you recall a register and the display indicates **Memory # BAD** and simultaneously all buttons in the affected keypads blink, this indicates that the memory location is corrupted. Press *any button* on the blinking keypad to clear the message and stop the blinking. The switcher will *not act* on this button press.

**Operating Tip**

It is possible to recall a memory *while retaining* a current video crosspoint. This is accomplished by holding down the crosspoint of the video that you want to keep, and then recalling the desired memory. This feature applies to both key buses, as well as the background and preset buses.

• If you attempt to recall a register that requires more Squeeze & Tease resources than you have freely available, a pop-up message will appear asking if you want to free the necessary resources to complete the recall. If your switcher does not have enough Squeeze & Tease resources to complete the recall even after freeing all in-use resources, the register will not be recalled and the pop-up message will indicate that there are not enough resources to recall the register. The order of resource freeing is:
  ~ Channels allocated for wipes
  ~ Channels allocated for Keyer 2 of the other MLE in the MLE-Pair.
  ~ Channels allocated for Keyer 1 of the other MLE-Pair.

• If you recall a register that includes a Still-Store image that is not present on your switcher, the memory will be recalled without the image and any image loaded in that Still-Store channel will remain. A pop-up message will appear to inform you that the still image was not found.

• If you attempt to recall a register that requires an XFX card to proceed (XFX borders or MLE Store images) and no XFX card is present or the appropriate XFX software option is not installed, the register will be recalled without the XFX effect and a pop-up message will indicate the required XFX card or software option.

**System Reset Notes**

Remember that the buttons in the **Store** and **Recall Sections** in the **Global Memory System Group**, as well as the **STORE** and **RECALL** buttons in each **MLE Memory System Group**, can be used to reset the entire switcher or individual MLEs. Refer to the section “**Resetting the Switcher**” on page 2-23 for more information.

**Memory Lock**

The **Memory Lock** function allows you to protect memory locations in active memory (on-line memory). With a memory lock enabled, you cannot overwrite the selected memory location until the location is unlocked.

There are two ways to perform a memory lock function:

• Memory Lock Using the Global Memory Group
• Memory Lock Using the Name Memories Menu
Memory Lock Using the Global Memory Group

Use the following procedure to enable and disable Memory Locks using the controls in the Global Memory System Group:

1. (Synergy 2, 3 and 4) In the Global Memory System Group, press and hold the ALL button in the Store Section for one second. The ALL buttons in the Store and Recall Sections both light to indicate that the Memory Lock programming mode is active.

(Synergy 1) In the Global Memory System Group, press and hold the STORE button for one second. The STORE and RECALL buttons both light to indicate that the Memory Lock programming mode is active.

2. Enter the Bank and Register on the keypad (in the Global Memory System Group), that you want to lock (or unlock).

The display on the Global Memory System Group will indicate the lock status of the selected register, as shown below.

Global Memory System Group — Lock Status

- UNLOCKED indicates that the selected register is unlocked. The register can be overwritten.
- LOCKED indicates that the selected register is protected. The register cannot be overwritten.

3. Enter the register number again to toggle the lock status. You do not need to re-enter the Bank number as you are already in that Bank.

Note: The first press selects the register and displays its status, while the second press (of the same register number) toggles the lock status (locked or unlocked).

4. Repeat steps 2 and 3 to lock or unlock additional registers.

5. Press ENTER to exit the Memory Lock programming mode.

This completes the procedure for enabling and disabling Memory Locks using the Global Memory System Group.

Please note the following important points regarding the Memory Lock feature:

- If you attempt to store into a locked register, the keypad flashes and the keypad display indicates Memory [n] LOCKED. Press any button on the keypad to stop the flashing.
- If you lock a memory register, it is locked for all memory groups on the entire switcher.
- A locked memory register will be overwritten when a register is recalled from a storage device.
- When you store and recall from a storage device, the Memory Lock attribute is stored and recalled along with the register and its contents.
- When you recall an individual memory from a storage device to a locked memory location on the switcher, you are prompted to cancel or proceed.
- The status of registers being locked or unlocked also appears on the Name Memories Menu.
**Memory Lock Using the Name Memories Menu**

Use the following procedure to enable and disable Memory Locks using the Name Memories Menu:

1. Navigate to the Name Memories Menu as follows:
   - Press HOME ⇒ ATTRIBUTES ⇒ Memories Setup.

   ![Name Memories Menu](image)

   - **Name Memories Menu**
     - This menu allows you to name any of the 100 available memory registers (on a per-MLE basis), and change the Lock/Unlock status of the individual registers, or banks.

2. Select the memory register you want to lock or unlock as follows:
   - Use the top knob to select the MLE on which you want to change the Lock/Unlock status of a register.
   - Use the middle knob to select the Bank and Register that you wish to change.

3. Toggle the **Locked Yes/No** softkey to the desired mode, either locked (Yes) or unlocked (No). The selected mode appears in the **Register Status Display**.

4. Repeat steps 2 and 3 to change additional registers.

5. Press **Lock Bank** to lock all the memories in the currently selected bank. For example, when (00) is selected, pressing **Lock Bank** will lock all registers from (00) to (09) and Yes will be highlighted under Locked for each of the registers within the bank. Pressing **Unlock Bank** will remove the lock from the registers within the bank.

   This completes the procedure for enabling and disabling Memory Locks using the Name Memories Menu.

**Naming Memory Registers**

The Name Memories Menu allows you to name (or rename) any of the 100 available memory registers on a per-MLE basis. This means that register 10 on MLE 1 can have a different name than register 10 on MLE 2.

Use the following procedure to name a memory register:

1. Navigate to the Name Memories Menu as follows:
   - Press HOME ⇒ ATTRIBUTES ⇒ Memories Setup.
2. Select the memory register you want to name as follows:
   - Use the top knob to select the MLE on which you want to name a memory register.
   - Use the Bank knob to select the bank and register that you wish to change.

3. Press Rename to display the Change Memory Name Menu.

4. Enter (or edit) the desired register name as follows:
   - Use the Memory knob to select the desired register (0 through 99). As you scroll through the registers, the Current Name field tracks each name.
   - Use the Horizontal knob to move the highlight horizontally.
   - Use the Vertical knob to move the highlight vertically.
   - Use the Space, Prev Letter, Next Letter, and Default softkeys to edit the name.

   OR

   Use one of the preset names as follows:
   - Press Preset Names to display the Preset Names Menu.

5. Press Accept New Name on the Change Memory Name Menu to conclude the process.

6. Press UP ONE to return to the Name Memories Menu, where all new (or edited) memory names appear.
7. Repeat steps 2 through 6 to name additional registers.

Note

All register names appear in the individual Memory Register Displays along with the register number.

This completes the procedure for naming a memory register.

Effects Dissolve

The EFF DISS (Effects Dissolve) button allows you to “slew” a switcher setup from its current setting to a new recalled setting. Two setups are required to perform an effects dissolve — essentially, a source effect and a destination effect. The switcher interpolates between the two settings at a given rate to create a smooth two Keyframe effect. In DVE terms, an Effects Dissolve is a two-keyframe effect whereby the switcher interpolates between two different settings (a source effect and a destination effect) at a given rate. The Effects Dissolve function is valid for recall operation only. Storage operation is not affected.

Only analog functions (such as clip levels and pattern positions) slew between a current setting and a new recalled setting. However, when the EFF DISS button is armed and the recall function is performed, the switcher first recalls all non-dissolving values before beginning the effects dissolve. This means that everything that is not an analog value (e.g., key priorities, crosspoints, patterns, next transition data) is recalled in the first frame of the effects dissolve, followed by all analog values in the second frame.

By presetting the switcher with the correct backgrounds and priorities (immediately prior to performing the effects dissolve), the Effects Dissolve feature guarantees the correct ending position for your effects.

Note

An Effects Dissolve can be performed on as many MLEs as desired, simultaneously — based on the number of MLEs selected for the recall function and “armed” for the Effects Dissolve. You can also slew as many functions within each MLE as desired.

The duration of the Effects Dissolve is governed by the transition rate that is programmed into the destination register. For example:

- Effect #1 is a box wipe that is positioned in the upper left of the screen. It is stored in register 1 with a transition rate of 10 frames.

- Effect #2 is a box wipe that is positioned in the upper right of the screen. It is stored in register 2 with a transition rate of 45 frames.

  If you cut to register 1 and then recall register 2 with an Effects Dissolve, the box wipe moves from the upper left to the upper right at a 45-frame duration.

- Effect #3 is a circle wipe that is positioned in the center of the screen. It is stored in register 3 with a transition rate of 30 frames.

  If you cut to register 1 and then recall register 3 with an Effects Dissolve, the system cuts to the circle wipe and then moves it from the upper left to the center at a 30-frame duration. Note that the box wipe did not change into a circle wipe.
Using Auto Recall

The Auto Recall feature allows you to have memory attributes, such as Effects Dissolve (EFF DISS) saved with the memory so that when the memory is recalled, and Auto Recall is active, Effects Dissolve will be toggled On.

**Note**
The Auto Recall feature toggled to Off by default. Refer to Chapter 12 “Completing Setup” in the Synergy Q/MD or Q/MD-X Engineering Manual for your switcher, to learn how to set the Auto Recall feature.

Global-Level Memory Auto Recall

With the Auto Recall feature toggled to On:

- Memory recalls retrieve the MLE-level saved settings for KEYS ONLY, EFF DISS, and the wipe button associated with a DVE SEND.
- The KEYS ONLY and EFF DISS buttons on the Global Memory System will reflect only stored settings saved from the PGM/PST MLE (program MLE).
- When selected, the INCL DVE button recalls the wipe button associated with a DVE SEND saved on any one MLE.
- With Auto Recall feature toggled to Off, you set KEYS ONLY, EFF DISS, and INCL DVE button settings manually before you recall the memory.

MLE-Level Memory Auto Recall

With Auto Recall feature toggled to On, memory recalls retrieve the KEYS ONLY and EFF DISS button settings used when that memory was saved.

With Auto Recall feature toggled to Off, you set KEYS ONLY and EFF DISS button settings manually before you recall the memory.

Creating a Basic Effects Dissolve

Use the following procedure to perform an Effects Dissolve:

**Note**
On the Synergy 3 and 4 control panels, you can perform the Effects Dissolve function in the “local” MLE Memory System Group for the associated MLE or in the Global Memory System Group for the PGM/PST MLE only.

On the Synergy 1 and 2 control panels, the EFF DISS button is located in the Global Memory System Group only — because the Synergy 1 and 2 do not have an MLE Memory System Group. Here, you can perform the function for all MLEs.

1. Program the first Keyframe in your effect (the source effect) — for example, select the position, cropping and orientation of the image. (For information on positioning and cropping an image, refer to chapter 16, “Position/Crop Functions” ).
The following illustration displays the first Keyframe in the effect.

![Source Effect — First Keyframe](image)

2. Enter the desired transition rate in the associated **MLE Memory System Group**.

3. Store the effect in the desired memory register. Refer to the section “**Storing Memory Registers**” on page 9–9 for more information on storing to memory. Remember that the transition rate determines the duration of the effects dissolve — how long it takes to slew to this setup.

4. Program the second Keyframe in your effect (the destination effect) — for example, select the position, cropping and orientation of the image.

   The following illustration displays destination Keyframe in the effect:

   ![Source Effect](image) ![Destination Effect](image)

   **Destination Effect — Second Keyframe**

5. Enter the desired transition rate in the associated **MLE Memory System Group**.

6. Store the effect in the desired memory register. Refer to the section “**Storing Memory Registers**” on page 9–9 for more information on storing to memory. Remember that the transition rate determines the duration of the effects dissolve — how long it takes to slew to this setup.

7. Recall the first setup from memory. Refer to the section “**Recalling Memory Registers**” on page 9–12 for more information on recalling a memory.

8. To perform the effects dissolve, press **EFF DISS** and recall the second setup from memory. The system first recalls all non-dissolving values (with a cut) and then slews all analog values.
9. Press **EFF DISS** and recall the first setup from memory if you want to slew back to the first setup or to any additional registers that have been properly stored in preparation for the effects dissolve function. You can slew or cut between as many setups as desired, simply governed by the **EFF DISS** button and the way that the effect was programmed.

| Operating Tip | Pressing another memory button while an effects dissolve is in progress will cause the dissolve to stop and transition from its current state (between the original two memories) to the new memory. |
| Note | In the previous example, both the source and destination effects are saved. It is not always necessary to save both the source and destination effect. You can slew from a current setting to a recalled setting that has been previously programmed. |

This completes the procedure for performing an **Effects Dissolve**.

**Working with Channels**

The following table can be used to predict how the **Effects Dissolve** will behave when working with various combinations of channels.

| Important | Channels will not interpolate across Keyers. You cannot perform an Effects Dissolve from one Keyer to another. |

**Effects Dissolve Behavior Table**

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>The source effect has <em>two</em> channels and the destination effect has <em>two</em> channels.</td>
<td><strong>Channel 1</strong> will interpolate to the destination effect for <strong>Channel 1</strong>. <strong>Channel 2</strong> will interpolate to the destination effect for <strong>Channel 2</strong>. Note: This will occur no matter what video sources are assigned to <strong>Channels 1</strong> and <strong>2</strong>.</td>
</tr>
<tr>
<td>The source effect has <em>two</em> channels, and the destination effect has only <em>one</em> channel.</td>
<td>The channel that is not contained in the destination effect will be cut off air at the start of the transition and the other channel will interpolate.</td>
</tr>
</tbody>
</table>
The source effect has one channel and the destination effect has two channels. The channel that is not contained in the source effect will cut on (to its final state) at the start of the transition and the other channel will interpolate.

The source effect has only one channel in use, and the destination effect has a different channel in use. The source channel will interpolate to the destination effect of the second channel (both must be in the same Keyer).

### Effects Dissolve Behavior Table

<table>
<thead>
<tr>
<th>Scenario</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>The source effect has one channel and the destination effect has two channels.</td>
<td>The channel that is not contained in the source effect will cut on (to its final state) at the start of the transition and the other channel will interpolate.</td>
</tr>
<tr>
<td>The source effect has only one channel in use, and the destination effect has a different channel in use.</td>
<td>The source channel will interpolate to the destination effect of the second channel (both must be in the same Keyer).</td>
</tr>
</tbody>
</table>
Using Storage Devices

This section provides instructions for storing and recalling Synergy Q/MD/X registers on a storage device, such as the internal hard drive of the switcher or a USB key. Refer to the section “Storing Memory Registers” on page 9-9 for general information on memory registers of the Synergy Q/MD/X system. For general information on recalling memory registers, refer to the section “Recalling Memory Registers” on page 9-12.

The following procedures enable you to name, store, and recall memory registers and custom controls macros to a storage device:

- Naming a Setup
- Saving Registers
- Saving Individual Memory Registers
- Saving Individual Custom Control Macros
- Saving Individual S&T 3D Sequences
- Saving Individual Bus Maps
- Recalling Registers
- Recalling Individual Memory Registers
- Recalling Individual Custom Control Macros
- Recalling Individual S&T 3D Sequences
- Recalling Individual Bus Maps

Note

You cannot store to or recall from a storage device while a custom control function is playing.

Naming a Setup

The Synergy Q/MD/X switcher stores and recalls registers, sequences, and custom controls to and from a storage device by grouping them together in sets.

Use the following procedure to name a set:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.
2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.
3. Press Dest/Source (to display the Dest/Source Menu).
4. Select the set that you want to name as follows:
   • Use the top knob to select the device. You can select between the following:
     ~ **Hard Drive** — This option allows you to name the files on the internal hard drive.
     ~ **USB** — This option allows you to name the files on a USB key plugged into the switcher panel USB port.
   • If you are saving to the internal hard drive, use the **Set Names** knob to select the **Setup** you want to name.

5. Press **Store** to display the **Disk Store Menu 1-2**.

6. Press **MORE** to display the **Disk Store Menu 2-2** and select the files you want to name.

7. Press **Name Setup** to display the **Setup Names Menu**.

8. Enter (or edit) the desired setup name as follows:
   • Use the **Setup Number** knob to select the desired register (**0** through **99**).
   • Use the **Horizontal** knob to move the highlight horizontally.
   • Use the **Vertical** knob to move the highlight vertically.
   • Use the **Space**, **Prev Letter**, **Next Letter** and **Default** softkeys to edit the name as required.
   
   **Operating Tip**
   A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs. Refer to the section “Using a Keyboard” on page 2-20 for details.

   • Use the **Setup Number** knob to select the desired register (**0** through **99**).

**Note**
The set number shows the setup you selected on the **Dest/Source Menu**. To change the setup number you are naming, use the **Setup Number** knob.

   • Use the **Horizontal** knob to move the highlight horizontally.
   • Use the **Vertical** knob to move the highlight vertically.
   • Use the **Space**, **Prev Letter**, **Next Letter** and **Default** softkeys to edit the name as required.

9. Press **Accept New Name** to finish naming the set.

10. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for naming your setups.
Saving Registers

For archive purposes, and simply to keep safe backup copies of your valuable switcher setups, it is recommended that you store your setups and registers to a storage device.

Use the following procedure to save registers to a storage device:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.
2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.

   ![Disk Menu]

   The Current Switcher Setup Chosen item indicates which setup on which drive is being used to store or recall the setups.
3. Press Dest/Source to display the Dest/Source Menu.

   ![Dest/Source Menu]

4. Select the storage device that you want to use to store the files as follows:
   - Use the top knob to select the device you want to store the files to. You can select between the following:
     - Hard Drive — This option allows you to store the files on the internal hard drive. There are 100 (00 through 99) setups available to store files.
     - USB — This option allows you to store the files on a USB key plugged into the switcher panel USB port. There are 100 (00 through 99) setups available to store files.
   - If you are saving to the internal hard drive, use the Set Names knob to select a Setup, or location, for the storage of the files.
5. Press **Store** to display the **Disk Store Menu 1-2**.

Notice that the **Storing To** item below the Menu name indicates the current storage device and setup that the file will be stored to.

A **File Icon** above a softkey label (such as **Memories**), indicates that the current storage device contains a file of that type. If you store a register that has been previously saved in the current Setup, you will be asked if you wish to overwrite that register.

6. Select the category of registers that you want to store:
   - Press **All** to store all categories of registers to a storage device.
   - Press **Memories** to store only **Memory Registers** to a storage device.
   - Press **Custom Controls** to store only **Custom Control Registers** to a storage device.
   - Press **Personality** to store only **Personality Registers** to a storage device.
   - Press **VTR Clips** to store only **VTR Clip Registers** to a storage device.
   - Press **Installation** to store only **Installation Registers** to a storage device.
   - Press **3D Sequences** to store only **3D Sequence Registers** to a storage device.
   - Press **Bus Maps** to store only **Bus Map Registers** to a storage device.

7. If you are using a USB key, do not remove it from the USB port until the save is finished.

This completes the procedure for storing your setups to a storage device.

**Saving Individual Memory Registers**

Use the following procedure to save individual memory register files to a storage device:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the **Disk Menu** as follows:
   - Press **HOME** ⇒ **Disk**.

This completes the procedure for storing your setups to a storage device.
The Current Switcher Setup Chosen item indicates which setup on which drive is being used to store or recall the setups.

3. Press Dest/Source to display the Dest/Source Menu.

4. Select the storage device that you want to use to store the files as follows:
   - Use the top knob to select the device you want to recall the files from. You can select between the following:
     - Hard Drive — This option allows you to store the files on the internal hard drive.
     - USB — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   - If you are saving to the internal hard drive, use the Set Names knob to select a Setup, or location, for the storage of the files. There are 100 (00 through 99) setups available to store files on the internal hard drive.

5. Press Store Individual to display the Disk Store Individual Items Menu.

   Notice that the Storing To item below the Menu name indicates the current storage device and setup that the file will be stored to.

6. Press Memory Register to display the Disk Store Memory Register Menu.

   The Memory Legend indicates the meaning of the icons that appear by the files.
7. Select the source and destination for the files as follows:
   • Use the From switcher knob to select the current switcher memory location that you wish to save.
   • Use the To disk knob to select the register on the storage device to save the file to.
8. Press Store Item to store the memory register file to the register you selected. If you store a register that has been previously saved in the current Setup, you will be asked if you wish to overwrite that register.
   When the file is saved, a file icon will appear beside the storage device location where the memory register is saved.
9. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for storing your individual memories to a storage device.

**Saving Individual Custom Control Macros**

Use the following procedure to copy and save individual custom control macro files from the switcher to a storage device:

> **Important**

Custom control bank setups are not stored when you save a custom control macro. If you store a macro that calls macros in other banks and then recall it on a switcher with a different bank setup, the macros on the other banks will **not** be available.

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.
2. Navigate to the Disk Menu as follows:
   • Press HOME ⇒ Disk.

   ![Disk Menu](image)

   **Disk Menu**

   The Current Switcher Setup Chosen item indicates which setup on which drive is being used to store or recall the setups.
3. Press Dest/Source to display the Dest/Source Menu.

   ![Dest/Source Menu](image)

   **Dest/Source Menu**
4. Select the storage device that you want to use to store the files as follows:
   • Use the top knob to select the storage device you want to store the files to. You can select between the following:
     ~ **Hard Drive** — This option allows you to store the files on the internal hard drive.
     ~ **USB** — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   • If you are saving to the internal hard drive, use the **Set Names** knob to select a **Setup**, or location, for the storage of the files.

5. Press **Store Individual** to display the **Disk Store Individual Items Menu**.

```
Disk Store Individual Items
Storing To: Hard Drive - SETUP (02)  To disk:
From switcher:

<table>
<thead>
<tr>
<th>Memory</th>
<th>CustCtrl</th>
<th>SAT 3D</th>
<th>Bus</th>
<th>Store</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
<td>Macro</td>
<td>Sequence</td>
<td>Map</td>
<td>item</td>
</tr>
</tbody>
</table>
```

Notice that the **Storing To** item below the Menu name indicates the current storage device and setup that the file will be stored to.

6. Press **CustCtrl Macro** to display the **Disk Store Individual Custom Control Macro Menu**.

```
Disk Store Individual Items – Custom Controls
Custom Control Legend:
* = custom control contains macro
# = normal custom control button
d = custom control exists on disk

<table>
<thead>
<tr>
<th>Memory</th>
<th>CustCtrl</th>
<th>SAT 3D</th>
<th>Bus</th>
<th>Store</th>
</tr>
</thead>
<tbody>
<tr>
<td>Register</td>
<td>Macro</td>
<td>Sequence</td>
<td>Map</td>
<td>item</td>
</tr>
</tbody>
</table>
```

The **Custom Control Legend** indicates the meaning of the icons that appear by the files.

7. Select the source and destination for the files as follows:
   • Use the **From switcher** knob to select the current switcher custom control location that you wish to save.
   • Use the **To disk** knob to select the location on the storage device to which to save the custom control macro.

8. Press **Store Item** to store the custom control file to the location you selected. If you store a custom control that has been previously saved in the current Setup, you will be asked if you wish to overwrite that register.

When the file is saved, a file icon will appear beside the storage device location where the custom control macro is saved.

9. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for storing your individual custom control macros to a storage device.
Saving Individual S&T 3D Sequences

Use this procedure to copy and save individual S&T 3D sequences from the switcher to a storage device:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.

   ![Disk Menu](image)

   The Current Switcher Setup Chosen item indicates which setup on which drive is being used to store or recall the setups.

3. Press Dest/Source to display the Dest/Source Menu.

   ![Dest/Source Menu](image)

   4. Select the storage device that you want to use to store the files:
      - Use the top knob to select the drive you want to store the files on. You can select between the following:
        - Hard Drive — This option allows you to store the files on the internal hard disk drive.
        - USB — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
      - If you are saving to the internal hard drive, use the Set Names knob to select a Setup, or location, for the recall of the files.

4. Press Store Individual to display the Disk Store Individual Items Menu.

   ![Operating Tip]
   There are 100 (00 through 99) Sets available to store files. For information on naming a Setup, refer to the section “Naming a Setup” on page 9–25.
Notice that the Storing To item below the Menu name indicates the current storage device and setup that the file will be stored to.

6. Press S&T 3D Sequence to display the Disk Store Individual S&T 3D Sequence Menu.

The Sequence Legend indicates the meaning of the icons that appear by the files.

7. Select the Source and Destination for the files as follows:
   - Use the From switcher knob to select the current switcher memory location that you wish to save.
   - Use the To disk knob to select the name on the disk to save the register as.

8. Press Store Item to store the memory register file to the Dest/Source you selected. If you store a sequence that has been previously saved in the current Setup, you will be asked if you wish to overwrite that register.

When the file is saved, a file icon will appear beside the drive location where the S&T 3D sequence is saved.

9. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for storing your individual S&T 3D Sequence files.

**Saving Individual Bus Maps**

Use this procedure to copy and save individual bus maps from the switcher to a storage device:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.
The **Current Switcher Setup Chosen** item indicates which setup on which drive is being used to store or recall the setups.

3. Press **Dest/Source** to display the **Dest/Source Menu**.

4. Select the storage device that you want to use to store the files:
   - Use the top knob to select the drive you want to store the files on. You can select between the following:
     - **Hard Drive** — This option allows you to store the files on the internal hard disk drive.
     - **USB** — This option allows you to store the files on a USB key plugged into the switcher panel USB port.
   - If you are saving to the internal hard drive, use the **Set Names** knob to select a **Setup**, or location, for the recall of the files.

5. Press **Store Individual** to display the **Disk Store Individual Items Menu**.

**Operating Tip**

There are **100 (00 through 99)** **Setups** available to store files. For information on naming a Setup, refer to the section “**Naming a Setup**” on page 9–25.
Notice that the Storing To item below the Menu name indicates the current storage device and setup that the file will be stored to.

6. Press Bus Map to display the Disk Store Individual Bus Map Menu.

7. The Bus Map Legend indicates the meaning of the icons that appear by the files.

8. Press Store Item to store the memory register file to the Dest/Source you selected. If you store a bus map that has been previously saved in the current Setup, you will be asked if you wish to overwrite that register.

9. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for storing individual bus maps.

Recalling Registers

The Synergy Q/MD/X switcher allows you to recall all categories of registers from a storage device or you can simply recall the desired individual category. Refer to the section “Naming a Setup” on page 9-25 for information on naming a setup.

If you are going to recall any set of registers, such as memory or custom control, ensure that your current on-line set of registers are stored to another storage device. If you have not stored them, they will be overwritten when you recall the files.

Use the following procedure to recall registers from a storage device:

**Important**

If you recall installation registers saved on a pre-6.0 software version switcher, your DSK source buttons may not map to the intended sources if you are currently using a button map other than the default. Check your DSK sources after recalling a setup that was saved on a pre-6.0 switcher.

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:

   • Press HOME ⇒ Disk.
The **Current Switcher Setup Chosen** item indicates which setup on which drive is being used to store or recall the setups.

3. Press **Dest/Source** to display the **Dest/Source Menu**.

4. Select the storage device that you want to use to recall the files from as follows:
   - Use the top knob to select the storage device you want to recall the files from. You can select between the following:
     - **Hard Drive** — This option allows you to recall the files from the internal hard drive.
     - **USB** — This option allows you to recall the files on a USB key plugged into the switcher panel USB port.
   - If you are recalling from the internal hard drive, use the **Set Names** knob to select a **Setup**, or location, from which to recall the files. There are 100 (**00** through **99**) setups available from which to recall files.

5. Press **Recall** to display the **Disk Recall Menu 1-2**.

Notice that the **Recalling From** item below the Menu name indicates the current storage device and setup that the file will be recalled from.
A **File Icon** above a softkey label (such as **Memories**), indicates that the current storage device contains a file of that type.

6. Select the category of registers that you want to recall:
   - Press **All** to recall all categories of registers from a storage device.
   - Press **Memories** to recall only **Memory Registers** from a storage device.
   - Press **Custom Controls** to recall only **Custom Control Registers** from a storage device.
   - Press **Personality** to recall only **Personality Registers** from a storage device.
   - Press **VTR Clips** to recall only **VTR Clip Registers** from a storage device.
   - Press **Installation** to recall only **Installation Registers** from a storage device.
   - Press **3D Sequences** to recall only **3D Sequence Registers** from a storage device.
   - Press **Bus Maps** to recall only **Bus Map Registers** from a storage device.

7. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for recalling your memory registers from a storage device.

**Recalling Individual Memory Registers**

| Note | Only registers stored with the “Store Individual” method, as outlined in the section “Saving Individual Memory Registers” on page 9-28, will be available to recall individually. |

Use the following procedure to recall individual memory registers from a storage device to the switcher:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the **Disk Menu** as follows:
   - Press **HOME ⇒ Disk**.

   ![Disk Menu](image)

   The **Current Switcher Setup Chosen** item indicates which setup on which drive is being used to store or recall the setups.
3. Press **Dest/Source** to display the **Dest/Source Menu**.

![Dest/Source Menu](image)

4. Select the storage device that you want to use to recall the files from as follows:
   - Use the top knob to select the device you want to recall the files from. You can select between the following:
     - **Hard Drive** — This option allows you to recall the files on the internal hard drive.
     - **USB** — This option allows you to recall the files on a USB key plugged into the switcher panel USB port.
   - If you are recalling from the internal hard drive, use the **Set Names** knob to select a **Setup**, or location, from which to recall the files.

5. Press **Recall Individual** to display the **Disk Recall Individual Items Menu**.

![Disk Recall Individual Items Menu](image)

Notice that the **Recalling From** item below the Menu name indicates the current storage device and setup that the file will be recalled from.

6. Press **Memory Register** to display the **Disk Recall Individual Memory Register Menu**.

![Disk Recall Individual Items Menu – Memories](image)

The **Memory Legend** indicates the meaning of the icons that appear by the files.
7. Select the source and destination for the files as follows:
   • Use the From disk knob to select the location (source) of the file.
   • Use the To switcher knob to select the switcher location to place the file.
8. Press Recall Item to recall the memory register file from the location you selected.
   When the file is loaded, a used icon (star) will appear beside the switcher location where
   the memory was recalled to.
9. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for recalling your individual memories from a storage device.

Recalling Individual Custom Control Macros

**Note**

Only macros stored with the "Store Individual" method are available to recall individually.

Use the following procedure to recall individual custom control macros from a storage device:

**Important**

If you recall a macro that references other custom control banks on a switcher with a different bank setup, the macros on the other banks will **not** be available.

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait
   at least 5 seconds to allow the system to recognize the USB key.
2. Navigate to the **Disk Menu** as follows:
   • Press HOME ⇒ Disk.

   ![Disk Menu](Image)

   **Disk Menu**

   The **Current Switcher Setup Chosen** item indicates which setup on which drive is
   being used to store or recall the setups.
3. Press **Dest/Source** to display the **Dest/Source Menu**.

   ![Dest/Source Menu](Image)

   **Dest/Source Menu**
4. Select the storage device that you want to use to recall the files from as follows:
   • Use the top knob to select the device you want to recall the files from. You can select between the following:
     ~ **Hard Drive** — This option allows you to recall the files on the internal hard drive.
     ~ **USB** — This option allows you to recall the files on a USB key plugged into the switcher panel USB port.
   • If you are recalling from the internal hard drive, use the **Set Names** knob to select a **Setup**, or location, from which to recall the files.

5. Press **Recall Individual** to display the **Disk Recall Individual Items Menu**.

   ![Disk Recall Individual Items Menu](image)

   Notice that the **Recalling From** item below the Menu name indicates the current storage device and setup that the file will be recalled from.

6. Press **CustCtrl Macro** to display the **Disk Recall Individual Custom Control Macros Menu**.

   ![Disk Recall Individual Items Menu – Custom Controls](image)

   The **Custom Control Legend** indicates the meaning of the icons that appear by the files.

7. Select the source and destination for the files as follows:
   • Use the **From disk** knob to select the location of the file.
   • Use the **To switcher** knob to select the switcher location to place the file.

8. Press **Recall Item** to recall the custom control macro file from the **Dest/Source** you selected.

   When the file is loaded, a used icon (star) appears beside the switcher location where the memory was recalled to.

   **Note**

   If all custom control registers are full, an error message is displayed and the custom control will not be loaded. In this case, you must delete one or more custom controls before you can load any new ones.
9. If you are using a USB key, you may now remove it from the USB port.
This completes the procedure for recalling your individual custom control macros from a storage device.

**Recalling Individual S&T 3D Sequences**

Use the following procedure to recall individual S&T 3D sequences from a hard drive to the switcher:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the **Disk Menu** as follows:
   - Press HOME ⇒ Disk.

3. Press **Dest/Source** to display the **Dest/Source Menu**.

4. Select the storage device that you want to use to recall the files:
   - Use the top knob to select the drive you want to recall the files from. You can select between the following:
     - **Hard Drive** — This option allows you to recall the files on the internal hard disk drive.
     - **USB** — This option allows you to recall the files on a USB key plugged into the switcher panel USB port.
• If you are recalling from the internal hard drive, use the Set Names knob to select a Setup, or location, for the recall of the files.

5. Press Recall Individual to display the Disk Recall Individual Items Menu.

```
Disk Recall Individual Items Menu
Recalling From: Hard Drive - SETUP (R2)

From disk:

To switcher:

<table>
<thead>
<tr>
<th>Recalling Item</th>
<th>From disk:</th>
<th>To switcher:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

Notice that the Recalling From item below the Menu name indicates the current storage device and setup that the file will be recalled from.

6. Press S&T 3D Sequences to display the Disk Recall Individual S&T 3D Sequences Menu.

```
Disk Recall Individual Items Menu – Sequences
Recalling From: Hard Drive - SETUP (R2)

Sequence Legend:
* = Sequence is used
□ = Sequence file exists on disk

From disk:

To switcher:

<table>
<thead>
<tr>
<th>Recalling Item</th>
<th>From disk:</th>
<th>To switcher:</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
```

7. The Sequence Legend indicates the meaning of the icons that appear by the files.

8. Select the Source and Destination for the files as follows:
   • Use the From disk knob to select the location of the file.
   • Use the To switcher knob to select the switcher location to place the file.

9. Press Recall Item to recall the sequence file from the Dest/Source you selected.
   When the file is loaded, a used icon (star) will appear beside the switcher location where the memory was recalled to.

9. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for recalling your individual sequences from a hard drive.
Recalling Individual Bus Maps

Note: Only registers stored with the "Store Individual" method, as outlined in the section “Saving Individual Memory Registers” on page 9-28, will be available to recall individually.

Use the following procedure to recall individual bus maps from a storage device to the switcher:

1. If you are using a USB key, insert it into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the Disk Menu as follows:
   - Press HOME ⇒ Disk.

   Disk Menu

The Current Switcher Setup Chosen item indicates which setup on which drive is being used to store or recall the setups.

3. Press Dest/Source to display the Dest/Source Menu.

   Dest/Source Menu

4. Select the storage device that you want to use to recall the files from as follows:
   - Use the top knob to select the device you want to recall the files from. You can select between the following:
     - Hard Drive — This option allows you to recall the files on the internal hard drive.
     - USB — This option allows you to recall the files on a USB key plugged into the switcher panel USB port.
   - If you are recalling from the internal hard drive, use the Set Names knob to select a Setup, or location, from which to recall the files.
5. Press **Recall Individual** to display the **Disk Recall Individual Items Menu**.

![Disk Recall Individual Items Menu]

Notice that the **Recalling From** item below the Menu name indicates the current storage device and setup that the file will be recalled from.

6. Press **Bus Map** to display the **Disk Recall Individual Bus Map Menu**.

![Disk Recall Individual Items Menu – Button Mappings]

The **Bus Map Legend** indicates the meaning of the icons that appear by the files.

7. Select the source and destination for the files as follows:
   - Use the **From disk** knob to select the location (source) of the file.
   - Use the **To switcher** knob to select the switcher location to place the file.

8. Press **Recall Item** to recall the button map file from the location you selected.

When the file is loaded, a used icon (star) will appear beside the switcher location where the memory was recalled to.

9. If you are using a USB key, you may now remove it from the USB port.

This completes the procedure for recalling your individual button mappings from a storage device.

**Quick Formatting a USB Key**

USB keys are typically pre-formatted and mountable as USB mass-storage devices under most computer operating systems and your Synergy Q/MD/X switcher. However, if you wish to quickly erase all the files on your USB key, you can perform a quick-format from the switcher panel.

Use the following procedure to perform a quick format on a USB key:

1. Insert the USB key you wish to format into the USB port on the front of the switcher. Wait at least 5 seconds to allow the system to recognize the USB key.

2. Navigate to the **Disk Menu** as follows:
   - Press **HOME → Disk**.
3. Press **Format USB**. You are asked if you wish to perform a quick-format of the USB key. You can select from the following:

- **Yes** — Select this option to perform a quick format on the USB key. Once the format is complete, you are returned to the **Disk Menu**.
- **No** — Select this option to not perform a quick format, and return to the **Disk Menu**.

This completes the procedure for performing a quick format of a USB key.

---

**Note**

You do not have to select the USB key as the device to format (using the **Dest/Source** button) as you cannot format the internal hard drive.
Custom Controls

In This Chapter

This chapter provides instructions for setting up and naming custom control banks, and programming, naming, and editing your custom control buttons. The following topics are discussed in this chapter:

- Custom Control Overview
- Programming Control Panel Functions
- Programming Special Functions
- Time Clock Functions
- Special Functions
- Editing Custom Control Macros
- Copying or Moving Custom Controls
- Deleting Custom Controls
- Saving and Recalling Custom Controls
Custom Control Overview

The Custom Control function of the Synergy Q/MD/X switcher allows you to program sequences of keystrokes (called “macros”) and other special switcher functions, and store them in dedicated buttons and banks in the Custom Control Group. Once programmed, a macro can be played back by pressing one button in the Custom Control Group. A custom control macro can be as simple as triggering an output GPI pulse, or as complex as recalling a specific memory register, performing a switcher transition, and flying a group of keys.

The figures below illustrate Custom Control Groups for each control panel. Note that sample labels are provided.

Synergy 4

A total of 35 custom control registers are provided, up to twelve of which can be assigned as banks to increase the total number of available registers to.

![Custom Control Group — Synergy 4 Control Panel, 2003 Edition](image)

Buttons are numbered to simplify the programming procedure. The numbering is 1 through 35 in ascending order, from left to right.

**Note**

If you have a Synergy 4 panel manufactured prior to the 2003 edition panels, a total of 32 registers are available, twelve of which can be assigned as banks.

Synergy 3

A total of 30 custom control registers are provided, up to twelve of which can be assigned as banks to increase the total number of available registers.

![Custom Control Group — Synergy 3 Panel, 2003 Edition](image)

Buttons are numbered to simplify the programming procedure. The numbering is 1 through 30 in ascending order, from left to right.

**Note**

If you have a Synergy 3 panel manufactured prior to the 2003 edition panels, a total of 32 registers are available, twelve of which can be assigned as banks.
Synergy 2

A total of 17 custom control registers are provided, up to twelve of which can be assigned as banks to increase the total number of available registers.

Custom Control Group — Synergy 2 Panel, 2003 Edition

Buttons are numbered to simplify the programming procedure. The numbering is 1 through 17 in ascending order, from left to right.

Note

If you have a Synergy 2 panel manufactured prior to the 2003 edition panels, a total of 24 registers are available, eight of which can be assigned as banks.

Synergy 1

A total of 24 custom control registers are provided, up to twelve of which can be assigned as banks to increase the total number of available registers.

Custom Control Group

Buttons are numbered to simplify the programming procedure. The numbering is 1 through 24.

Custom Control Functionality

Custom control functionality falls into several different categories:

- **Custom Control Banks** — Up to twelve banks can be enabled, and you can select any of the available Custom Control buttons on which to place the bank buttons themselves. Each bank stores a separate set of Custom Controls.

- **Control Panel Functions** — A custom control button can be programmed to play back a series of control panel button presses — such as recalling memory registers, initiating auto transitions, taking a selected source to air, bringing up a CG, and calling other custom control macros. In addition, the following functions are available:
  - **VTR Functions** — A custom control button can be programmed to perform a specific transport command such as play, cue and rewind. Commands apply to serial controlled devices such as VTRs, Video Servers and Audio Servers. The VTR
Remote Control, Video Server Control or Audio Server Control option must be installed, respectively. Any combination of options can be installed.

~ **Time Clock Functions** — A custom control button can be programmed to start, stop, or reset the preview overlay clock. The **Preview Overlay Option** must be installed.

~ **Special Functions** — A custom control button can be programmed to perform a variety of special functions controlling GPIs, audio external devices, menu retrieval, transitions, and inserting pauses and holds to the custom control.

~ **PIP II Functions** — A custom control button can be programmed to send messages to devices using this optional software feature.

~ **Router Functions** — A custom control button can be programmed to send message to routes.

~ **Character Generator Functions** — A custom control button can be programmed to send commands to character generators.

~ **Monitor Wall Functions** — A custom control button can be programmed to send commands to monitor walls.

• **Naming Custom Controls** — A custom control macro can be named for quick reference in the menus and, if installed, on the mnemonic displays.

• **Editing Custom Controls** — A custom control macro can be viewed and modified by inserting or deleting events as desired.

• **Saving and Recalling Custom Controls** — A custom control macro can be stored to and recalled from the internal hard drive or other storage device.

• **Copying and Moving Custom Controls** — Custom controls can be copied and moved between banks and buttons.

• **Deleting Custom Controls** — A custom control macro can be deleted from a button.

**Note**

When recording a memory recall in a custom control macro, it may be necessary to add a pause of between 1-10 frames after the memory recall in the macro.

While recording a custom control macro, pressing the custom control button of an existing macro will record only the call to that macro function, and will stop the recording in progress. Upon playback of the just-recorded macro, the called macro will be performed as the last function.

• Refer the chapter, “**Custom Controls**” of the *Synergy Q/MD* or *Q/MD-X Engineering Manual* for complete instructions on configuring the custom control environment.
# Programming Control Panel Functions

Use the following procedure to program a custom control button with basic functions:

**Important**

Memory recalls from custom controls will override the current Effects Dissolve, Keys Only, and Auto Recall settings to whatever settings were in place when the custom control was recorded.

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇒ Custom Controls**.

   ![Custom Controls Menu 1-2](image)

   - **Main Area**: Provides the status of the Custom Control buffer, as well as the name and status of the custom control selected on the menu. If you have already programmed one or more macros, a percentage value is displayed that indicates how “full” the buffers are.

   - **Scroll Area**: Provides lists of the enabled banks, and a full list of custom control buttons. Not all of the custom control buttons exist on every control panel.

2. Select the Custom Control bank and button that you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank that you want to record the custom control on.
   - Use the **Button** knob to select the custom control button that you wish to program. You can also press the button directly on the panel.

**Note**

Buttons with an asterisk (*) next to them in the list are already programmed, however, they can be edited. Refer to the section “Editing Custom Control Macros” on page 10-36 for details.
3. Press **Start Recording** to display the **Recording Menu**.

![Recording Menu]

**Custom Controls — Recording Menu**

- **Start Recording**
- **Cancel Recording**
- **Insert Recording**
- **Special Recording**

**Note**
Press **Cancel Recording** to terminate the programming procedure. The macro will not be recorded.

4. With the recording in progress, press the buttons on the control panel that you would like to have played back — in order. All subsequent keystrokes will be remembered, in the exact order that you press them. The following is a list of examples of custom controls that can be recorded:

**Important**
Custom Controls will not recall the sources assigned to a particular bus map, only the crosspoint buttons that were pressed. If you are using different bus maps, you must ensure that the same bus map is used when you run the custom control as when you created the custom control.

5. Insert any special functions you want. You can insert any of the following:

- **VTR Functions** — Refer to the chapters “VTRs (Betacam)” or “Video Servers (VDCP)” in the *Synergy Q/MD or Q/MD-X Engineering Manual*.
- **“Time Clock Functions”** on page 10–12 — Refer to the section “Time Clock Functions” on page 10–12.
- **“Special Functions”** on page 10–14 — Refer to the section “Special Functions” on page 10–14.
- **“Pbus”** on page 10–29 — Refer to the section “Pbus” on page 10–29.
- **Character Generator Custom Controls** — Refer to the chapter “Character Generators” in the *Synergy Q/MD or Q/MD-X Engineering Manual*.
- **Router Custom Controls** — Refer to the chapter, “Routers” in the *Synergy Q/MD or Q/MD-X Engineering Manual*.
- **Robotic Camera Custom Controls** — Refer to the chapter, “Robotic Cameras” in the *Synergy Q/MD or Q/MD-X Engineering Manual*.
- **Audio Server Custom Controls** — Refer to the chapter, “Audio Servers” in the *Synergy Q/MD or Q/MD-X Engineering Manual*.
- **Monitor Wall Custom Controls** — Refer to the chapter, “Monitor Walls” in the *Synergy Q/MD or Q/MD-X Engineering Manual*.

6. Press **Finish Recording** when you have finished recording the macro.
You will notice an asterisk next to the custom control you just recorded, indicating that this custom control contains information.

This completes the procedure for recording a normal custom control. To play back your macro, press the custom control button on the switcher panel. (This is the button you selected in step 2 above).

**Tips for Creating Custom Controls**

A control panel custom control allows you to automate a series of button presses into a single macro. There are, however, a number of things that you must keep in mind when creating a custom control in order to create a custom control that will produce the desired effect. These tips are as follows:

- If you are including a memory recall in the custom control, you must ensure the Auto Recall settings are the same as when the memory was stored. This ensures a consistent output.

- A custom control only records that a specific button was pressed, and does not record the state that the button was in. For example, if you create a macro that toggles a function such as a key modifier, the system will alternately turn that function on and off each time it is played.

- To program a custom control that will recall a memory and then perform a transition, you must recall the memory on the MLE you want to perform the transition on, then use the Cut or Auto Trans buttons to perform the transition. A custom control cannot record the movement of a fader.

- A custom control will not automatically compensate for the time a memory recall or transition will require to complete. In these cases, you must insert a custom control pause after the event that requires time to complete. Refer to the section “Custom Control Pauses” on page 10-28 for more information.

- You can insert a Custom Control Hold command into a custom control that will hold the custom control at a specific point until the continue command is received. The custom control is continued by either pressing the custom control button again, or by a GPI Input trigger. Refer to the section “Custom Control Holds” on page 10-25 for more information.

- You can create a Looping Custom Control by inserting a Loop CC event into the custom control.

- If you are creating a long or Looping Custom Control, you can stop that custom control by pressing the custom control button. This applies only to the custom control assigned to that button.

- You can insert a Run Custom Control command into a custom control that will automatically run another custom control. If the Multiple Custom Control feature is active, both custom controls can run at the same time. If the Multiple Custom Control feature is turned off, inserting a Run Custom Control command ends the recording, and playing, of the first custom control. Refer to the section “Running Multiple Custom Controls” on page 10-27 for more information.
Controls” on page 10-10 for information on running multiple custom controls. If a custom control starts multiple custom controls, you must stop each one individually, or use the Stop Other Custom Control command.

- You can run multiple custom controls at the same time by pressing the corresponding custom control button. If a custom control is already running, pressing the button again will stop it.

- You can insert a Select Custom Control Bank command into a custom control that will select a different custom control bank when the custom control is done. To insert the Select Custom Control Bank command into a custom control, double-press the custom control button for the bank you want to select as you are recording the custom control. This will end the recording of the custom control. A custom control can have only one Select Custom Control Bank or Run Custom Control command.

Relative Custom Controls

Important: Relative Custom Controls can only be properly recorded and recalled on upper MLEs that are re-entered onto the PGM/PST MLE. If the MLE is not re-entered, you will not be able to properly record or recall a relative custom control. Instead, the relative custom control will act like a normal custom control when recalled.

Relative Custom Controls store the MLE re-entry position so that they can be taken on-air from any MLE that is re-entered on the PGM/PST MLE. For example, if you have MLE 2 re-entered into MLE 3 (Configuration 1), of a Synergy 2.5 Q/MD switcher, and Record a Custom Control on MLE 2, you can only recall that custom control on MLE 2, in the same configuration. If, however, you have MLE 1 re-entered into MLE 3 (Configuration 2), the Relative Custom Control will be recalled on MLE 1.

Relative Custom Controls are not MLE specific, as normal custom controls, but instead are re-entry specific. This means that the re-entry order, or levels that the Relative Custom Control was recorded on, do not need to be the same in order to recall that custom control. For example, if we again record a Relative Custom Control on MLE 2, of a Synergy 2.5 Q/MD, which is re-entered into MLE 3 (Configuration 1), we can recall that Relative Custom Control with more or fewer MLEs. If we have MLE 1 re-entered into MLE 2 and MLE 2 re-entered into MLE 3 (Configuration 3), the Relative Custom Control will be recalled on MLE 1. If we have no MLEs re-entered, (Configuration 4) the Relative Custom Control will be recalled on MLE 3.
Use the following procedure to program a relative custom control button with basic functions:

1. Set up your MLE re-entry configuration to record the relative custom control at the Re-entry level you want.

2. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

3. Select the Custom Control bank and button that you want to record to as follows:
   - Use the Bank knob to select the custom control bank that you want to record the custom control on.
   - Use the Button knob to select the custom control button that you wish to program. You can also press the button directly on the panel.

   **Note**
   Buttons with an at (@) next to them in the list are already programmed with a relative custom control, however, they can be overwritten or edited. Refer to the section “Editing Custom Control Macros” on page 10–36 for more information.

**Important**
If you record a relative custom control across multiple re-entered MLEs, at least the same number of MLEs must be re-entered in order to recall the entire custom control. For example, if a two MLE relative custom control is recalled on one MLE, the actions to be recalled on the second MLE will be ignored.

**Note**
You must record a relative custom control on an MLE that is re-entered onto the PGM/PST MLE for it to run properly.
4. Press **Start Relative Recording** to display the **Recording Menu**.

![Custom Controls (1-2)]

**Custom Controls Menu**

You will notice an “@” symbol next to the custom control you just recorded, indicating that this relative custom control contains information.

This completes the procedure for recording a relative custom control.

**Running Multiple Custom Controls**

The Multiple Custom Controls feature allows you to have a single custom control start multiple other custom controls, or you can manually start multiple custom controls using the corresponding custom control buttons. All the custom controls will continue to play out until they reach the end, or loop.

![Operating Tip]

You can insert a **Stop Other Custom Controls** command that will stop all other running custom controls, except the one that is currently running. Refer to the section “**Stop Other Custom Controls**” on page 10–25 for more information.

**Note**

Press **Cancel Recording** to terminate the programming procedure. The macro will not be recorded.

5. With the recording in progress, press the buttons on the control panel that you would like to have played back, in order. All subsequent keystrokes will be remembered, in the exact order that you press them.

6. Insert any special functions you want as follows:

- Press **Insert Special** to display the **Insert Special Menu 1-2**.
- Refer to the section “**Programming Special Functions**” on page 10–12 for information on inserting special functions.

7. Press **Finish Recording** when you have finished recording the macro.
If the Multiple Custom Controls feature is turned off, a Run Custom Control command ends the current custom control. Pressing another custom control button also stops the first custom control and starts the second.

You can turn the Multiple Custom Controls feature on or off from the Personality Menu. Refer to the section “Multiple Custom Controls” on page 4-12 for information on turning this feature on or off.
The following sections describe how to program your custom controls with various other special functions. Refer to the section “Editing Custom Control Macros” on page 10–36 for more information on inserting events into existing custom control macros.

The following functions are covered in this section:

- “Time Clock Functions” on page 10–12
- “Special Functions” on page 10–14
- “Pbus” on page 10–29

**Time Clock Functions**

The Synergy Q/MD/X switcher allows you to program custom control buttons with Time Clock functions.

Use the following procedure to program one or more custom control buttons with special Time Clock functions.

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press Time Clock to display the Insert Time Clock Menu. This menu allows you to choose specific Time Clock control functions to assign to the button.

- Operating Tip

As a recommendation, keep Time Clock functions grouped together on your physical custom control buttons.

6. Select a Time Clock function to insert as follows:
Use the **Function** knob to select the function that you want to assign to the custom control. Use the table “**Time Clock Custom Control Functions**” on page 10–13 to determine which function you want to insert.

**Note**
The middle **Reset Time** knob only applies to the insert **Reset** command. No value will be displayed for other commands.

### Time Clock Custom Control Functions

<table>
<thead>
<tr>
<th>Time Clock Functions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Count Up</td>
<td>Starts the Preview Overlay clock counting up from zero.</td>
</tr>
<tr>
<td>Count Down</td>
<td>Starts the Preview Overlay clock counting down from the preset time to zero.</td>
</tr>
<tr>
<td>Count Down/Up</td>
<td>Starts the Preview Overlay clock counting down from the preset time to zero, when it will then start counting up from zero until you press <strong>Reset</strong> or <strong>Stop</strong>.</td>
</tr>
<tr>
<td>Stop</td>
<td>Stops the Preview Overlay clock.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the Preview Overlay clock to the preset time.</td>
</tr>
</tbody>
</table>

**Operating Tip**

Time Clock functions can be strung together, allowing one custom control button to perform multiple functions when it is pressed. For example, you can have the **Reset** function following by the **Count Down** function, allowing a single custom control macro to reset the Time Clock and start it counting down.

7. Press **Insert** to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press **UP ONE** to display the **Recording Menu**.

10. Press **Finish Recording**, or the flashing custom control button, to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming one or more custom control buttons with special **Time Clock** functions.

To play back your macro, press the custom control button on the control panel that you recorded the custom control macro to.
Special Functions

Custom control buttons can be programmed to perform a variety of special functions for operational convenience and efficiency. These functions include the following:

- “Reset GPI” on page 10–14
- “Trigger GPI” on page 10–15
- “Automation” on page 10–17
- “Go To Menu” on page 10–18
- “Transition Keys and Cut Keys” on page 10–20
- “Run Sequence” on page 10–22
- “Safe Title” on page 10–23
- “Custom Control Loops” on page 10–24
- “Stop Other Custom Controls” on page 10–25
- “Custom Control Holds” on page 10–25
- “Custom Control Pauses” on page 10–28

The Notify End CC custom control is for internal use only. Only use this custom control if instructed to do so by Ross Video Technical Support.

For device specific custom controls, such as for robotic cameras, or audio mixer, refer to the applicable device chapter in the Synergy Q/MD or Q/MD-X Engineering Manual, Volume II.

Reset GPI

Use the following procedure to program a GPI reset:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press Start Recording to display the Recording Menu.
4. Press Insert Special to display the Insert Special Menu 1-2.
5. Press Special to display the Special Menu.

Operating Tip

As a recommendation, keep special functions grouped together on your physical custom control buttons.
6. Assign the reset GPI to a GPI output as follows:
   • Use the Selection knob to select Reset GPI.
   • Use the GPI Output knob to select the GPI output port you want to reset.

   **Note**
   The names that appear in the GPI Output list will also be shown when editing the custom control. The names are programmed on the GPI Output Setup Menu. Refer to the section “Standard GPI Setup” on page 11–17 for details.

7. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press UP ONE to display the Recording Menu.

10. Press Finish Recording to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming a GPI reset.

**Trigger GPI**

Use the following procedure to program a GPI output trigger:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   • Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   • Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   • Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button *directly* on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.

```
Special

GPI Output:
  Trigger GPI
  Assign Mode

Insert	Cancel
```

6. Assign the trigger GPI to a GPI output as follows:
   • Use the **Selection** knob to select **Trigger GPI**.
   • Use the middle **GPI Output** knob to select the GPI output port you want to trigger.

```
Insert Special — Special Menu
```

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.
8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.
9. Press **UP ONE** to display the **Recording Menu**.

**Operating Tip**
As a recommendation, keep special functions grouped together on your physical custom control buttons.

**Note**
The names that appear in the **GPI Output** list will also be shown when editing the custom control. The names are programmed on the **GPI Output Setup Menu**. Refer to the section “**Standard GPI Setup**” on page 11–17 for details.
10. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for programming a GPI output trigger.

**Automation**

Use the **Automation** function to create custom controls that accept commands from an external automation system.

Use the following procedure to create an Automation custom control macro:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇒ Custom Controls**.
2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.

**Operating Tip**

As a recommendation, keep special functions grouped together on your physical custom control buttons.
6. Assign an automation function to the selected custom control macro as follows:

   • Use the Selection knob to select Automation.
   • Use the Command knob to select the command you want the macro to perform. You can select between the following:
     ~ Keys Off Air — Select this option when you want all on-air Keys, on all MLEs, to be dissolved off-air when the custom control is run.
     ~ Act MLE Trans — Select this option when you want all MLEs that are contributing the PGM output, except for the PGM/PST MLE, to be transitioned according to the settings in the MLE Transition Group. For example, if MLE 1, of a Synergy 2.5 Q/MD Switcher, is re-entered onto MLE 2 and MLE 2 is re-entered onto MLE 3, the Active MLE Trans custom control will perform a transition on both MLE 1 and MLE 2.

7. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press UP ONE to display the Recording Menu.

10. Press Finish Recording to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for creating an automation custom control macro.

**Go To Menu**

Use Go To Menu to create custom controls that automatically display Squeeze & Tease MD menus. You must be flying a key when you run the custom control for the Squeeze & Tease MD menu to display.

Use the following procedure to create a Squeeze & Tease MD Go To Menu custom control macro:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   • Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

   ![Operating Tip]
   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.

![Insert Special — Special Menu]

6. Assign which menu is displayed from the selected custom control macro as follows:
   - Use the **Selection** knob to select **Go To Menu**.
   - Use the **Type** knob to select **3D**.
   - Use the **Menu** knob to select the menu you want to display when the custom control is run. You can select between the following:

   ![Note]
   When you run a **Go To Menu** custom control, the menu that is displayed will be determined by the current active MLE and **Keyer**. If **Key 2** is active on **MLE 2**, the menu will be displayed for **Key 2** on **MLE 2**.

   ~ **Position/Crop** — Select this option to display the **S&T MD Position/Crop Menu 1-2** for the active **Fly Key** when the custom control is run.
   ~ **Border** — Select this option to display the **S&T MD Border Menu** for the active **Fly Key** when the custom control is run.
   ~ **Sequence** — Select this option to display the **S&T Sequence Menu 1-2** for the active **Fly Key** when the custom control is run.
   ~ **Preprocessor** — Select this option to display the **S&T MD Preprocessor Menu** for the active **Fly Key** when the custom control is run.
   ~ **WARP** — Select this option to display the **S&T WARP Menu** for the active **Fly Key** when the custom control is run.
~ Ch Management — Select this option to display the Channel Management Menu for the active Fly Key when the custom control is run.

7. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press UP ONE to display the Recording Menu.

10. Press Finish Recording to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for creating a Squeeze & Tease MD Go To Menu custom control macro.

**Transition Keys and Cut Keys**

- **Note**
  
  The Trans Keys and Cut Keys functions cannot initiate a transition if a transition is already in progress on the associated MLE.

Use the Trans Keys or Cut Keys feature to perform key transitions with a custom control. Use the following procedure to perform key transitions with a custom control:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to as follows:
   - Use the Bank knob to select the custom control bank you want to record the custom control to.
   - Use the Button knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

- **Operating Tip**
  
  As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press Start Recording to display the Recording Menu.

4. Press Insert Special to display the Insert Special Menu 1-2.

5. Press Special to display the Special Menu.
6. Assign which key transitions to perform as follows:

- Use the Selection knob to select Trans Keys (to perform an auto transition) or Cut Keys (to perform a cut).
- Use the For knob to select the MLE or MultiDSK that you want to transition the Keys for. You can select between the following:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MLE 1 — Select this option to transition the Keys on MLE 1.</td>
<td></td>
</tr>
<tr>
<td>MLE 2 — Select this option to transition the Keys on MLE 2.</td>
<td></td>
</tr>
<tr>
<td>MLE 3 — Select this option to transition the Keys on MLE 3.</td>
<td></td>
</tr>
<tr>
<td>MLE 4 — Select this option to transition the Keys on MLE 4.</td>
<td></td>
</tr>
<tr>
<td>DSK 3/4 — Select this option to transition the MultiDSK Downstream Keyers.</td>
<td></td>
</tr>
</tbody>
</table>

- Use the To knob to select the Keys you want to transition. You can select between the following:

<table>
<thead>
<tr>
<th>Selection</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key1 Off — Select this option to have Key 1 dissolve off-air when the custom control is run.</td>
<td></td>
</tr>
<tr>
<td>Key2 Off — Select this option to have Key 2 dissolve off-air when the custom control is run.</td>
<td></td>
</tr>
<tr>
<td>Key1+2 Off — Select this option to have both Key 1 and Key 2 dissolve off-air when the custom control is run.</td>
<td></td>
</tr>
<tr>
<td>Key1 On — Select this option to have Key 1 dissolve on-air when the custom control is run.</td>
<td></td>
</tr>
<tr>
<td>Key2 On — Select this option to have Key 2 dissolve on-air when the custom control is run.</td>
<td></td>
</tr>
<tr>
<td>Key1+2 On — Select this option to have both Key 1 and Key 2 dissolve on-air when the custom control is run.</td>
<td></td>
</tr>
<tr>
<td>Key1 Only — Select this option to have the switcher dissolve Key 1 and Key 2 so that only Key 1 is on-air when the custom control is run. For example, if Key 1 is off-air and Key 2 is on-air, this custom control would dissolve Key 1 on-air, and at the same time dissolve Key 2 off-air.</td>
<td></td>
</tr>
<tr>
<td>Key2 Only — Select this option to have the switcher dissolve Key 1 and Key 2 so that only Key 2 is on-air when the custom control is run.</td>
<td></td>
</tr>
</tbody>
</table>

7. Press Insert to insert the selected command into the custom control and display the Insert Special Menu 1-2.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.
9. Press **UP ONE** to display the **Recording Menu**.

10. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for performing key transitions with a custom control.

**Run Sequence**

The Run Sequence custom control allows you to have a custom control run a sequence on the selected MLE and Keyer. This allows you to run a dissolve or wipe and still run a sequence in the same MLE.

Use the following procedure to insert a run sequence custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   • Press **HOME** ➔ **Custom Controls**.
2. Select the custom control button you want to record to as follows:
   • Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   • Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.
6. Insert a Run Sequence CC as follows:

   - Trans Keys
   - Run Sequence
   - Safe Title
   - MLE: MLE 1
   - MLE 2
   - Key: Key 1
   - Key 2

**Operating Tip**

As a recommendation, keep special functions grouped together on your physical custom control buttons.
• Use the **Function** knob to select **Run Sequence**.
• Use the **MLE** knob to select the MLE that you want to have the sequence run on.
• Use the **Key** knob to select the Keyer that you want to have the sequence run on.

7. Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu 1-2**.

8. Insert additional commands if needed. When you have finished inserting commands, proceed to the next step to complete the procedure.

9. Press **UP ONE** to display the **Recording Menu**.

![Custom Controls — Recording Menu]

10. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for inserting a run sequence custom control.

**Safe Title**

Use the **Safe Title** feature to program a custom control button to recall a specific user-configured safe title setting. Refer to Chapter 10, “Peripheral Control and More” in the **Synergy Q/MD/X Operator’s Manual** for more information on setting up the safe title.

**Note**

The safe title function will only recall a stores Safe Title setting and will not turn the safe title on or off.

Use the following procedure to recall a safe title setting with a custom control button:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   • Press **HOME ⇒ Custom Controls**.
2. Select the custom control button you want to record to as follows:
   • Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   • Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button *directly* on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

**Operating Tip**

As a recommendation, keep special functions grouped together on your **physical** custom control buttons.
3. Press **Start Recording** to display the **Recording Menu**.

4. Press **Insert Special** to display the **Insert Special Menu 1-2**.

5. Press **Special** to display the **Special Menu**.

> **Insert Special — Special Menu**

6. Assign a safe title to be recalled as follows:
   - Use the **Selection** knob to select **Safe Title**.
   - Use the **Safe ID** knob to select the stored Safe Title set up that you want to recall when you run the custom control.

7. Press **Insert** to enter the safe title into your custom control macro.

8. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

> **Custom Controls — Recording Menu**

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for recalling a safe title setting with a custom control button.

**Custom Control Loops**

The Loop Custom Control command allows you to have a custom control run continuously until you stop it, or a Stop Custom Control command is executed from another custom control.

Use the following procedure to insert a Loop Custom Control command into a custom control:

1. Navigate to the **Custom Controls Menus** as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the custom control button you want to record to.

3. Press **Start Recording ⇒ Insert Special ⇒ Special**.

4. Insert a Loop command into the custom control as follows:
   - Use the **Function** knob to select **Loop CC**.
5. Press **UP ONE** to display the **Custom Controls Menus**.

6. Press **Finish Recording** on the **Custom Control Menu 1-2** to finish recording to the custom control. The custom control button stops flashing.

This completes the procedure for inserting a Loop Custom Control command into a custom control.

**Stop Other Custom Controls**

The Stop Other Custom Control command allows you place a command in a custom control that will stop all other running custom controls, except the one the command is in. This can be used to stop other looping custom controls at a specific point.

Use the following procedure to insert a Stop Other command into a custom control:

1. Navigate to the **Custom Controls Menus** as follows:
   • Press **HOME ⇒ Custom Controls**.
2. Select the custom control button you want to record to.
3. Press **Start Recording ⇒ Insert Special ⇒ Special**.
4. Insert a Stop Other command into the custom control as follows:
   • Use the **Function** knob to select **Stop Other CC**.
   • Press **Insert** to insert the selected command into the custom control and display the **Insert Special Menu**.
5. Press **UP ONE** to display the **Custom Controls Menus**.
6. Press **Finish Recording** on the **Custom Control Menu 1-2** to finish recording to the custom control. The custom control button stops flashing.

This completes the procedure for inserting a Stop Other command into a custom control.

**Custom Control Holds**

Use the **Custom Control Hold** feature to place “holds” within a custom control sequence. When entered, these holds specify a point to stop and wait for a user button-press (of the same custom control) or an external trigger (Editor or GPI). The macro then executes from that point until it reaches its end or another embedded hold.

The **Hold CC** allows the user to manually determine in real time, how long a macro is stopped. For example, a macro is initiated by the operator and when it reaches the **Hold CC**, it stops playing. The operator then waits until the interview (or whatever) is finished, presses the macro button again, and the macro resumes playing.

**Note**

A hold is automatically inserted when you perform a Still-Store capture during the recording of a custom control.

Use the following procedure to place a **Hold CC** within a custom control sequence:
1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇒ Custom Controls**.

2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

3. Press **Start Recording** to display the **Recording Menu**.

4. Press **Insert Special** to display the **Insert Special Menu 1-2**.

5. Press **Special** to display the **Special Menu**.

6. Assign a Custom Control Hold as follows:
   - Use the **Selection** knob to select **Hold CC**.
   - Use the **Popup** knob to select the type of popup notification you want to appear when the hold is performed. You can select between the following:
     - **No Popup** — Select this option to have only a message displayed on the **Main Menu** or the **Custom Controls Menu** when a custom control hold is being performed.

---

**Operating Tip**

As a recommendation, keep special functions grouped together on your *physical* custom control buttons.

---

**Note**

When a macro is held, the name of the macro appears in the **Main Menu** and **Custom Controls Menu**. The **Hold CC** also extends the time that the associated custom control button will remain lit until the macro is continued or cancelled.

---
~ 1-Time Popup — Select this option to have a popup appear on any menu when a custom control is being held. This popup will only appear once.

7. Press **Insert** to enter the Custom Control Hold into your custom control macro.
8. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for placing a **Hold CC** within a custom control sequence.
Custom Control Pauses

Use the **Custom Control Pauses** feature to place “pauses” within a custom control sequence. With a pause inserted, a sequence can have a duration rather than being executed instantaneously. With multiple pauses placed in between macro events, controlled switching between sources becomes possible. Pressing the custom control button again during the wait time will immediately resume the macro.

Use the following procedure to place a pause within a custom control macro:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press HOME ➔ **Custom Controls**.
2. Select the custom control button you want to record to as follows:
   - Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   - Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button *directly* on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.
3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **Special** to display the **Special Menu**.

   ![Special Menu](image)

   **Insert Special — Special Menu**

6. Assign a pause to the custom control as follows:
   - Use the **Selection** knob to select **Pause CC**.
   - Use the **Seconds** knob to set the duration of the pause in seconds.
   - Use the **Frames** knob to set the duration of the pause in frames.

   **Operating Tip**
   As a recommendation, keep special functions grouped together on your physical custom control buttons.

   **Note**
   Similar to a Custom Control Hold, a Pause will display a message on the Main Menu or the Custom Control Menu indicating that the custom control is paused.
7. Press **Insert** to enter the Custom Control Hold into your custom control macro.

8. Press **UP ONE** to return to the Custom Controls Recording Menu.

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for placing a pause within a custom control macro.

### Pbus

A custom control button can be programmed to send messages to devices using the Pbus protocol.

**Note**

Ensure that the Pbus option is installed and that the Pbus device you want to control is properly connected and configured with the Synergy Switcher. Refer to the section “Pbus Protocol Setup” on page 9–11 for more information on setting up a Pbus device.

Use the following procedure to create a custom control that will send commands to devices using the Pbus protocol:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   
   - Press **HOME ⇒ Custom Controls**.
2. Select the custom control button you want to record to as follows:
   • Use the **Bank** knob to select the custom control bank you want to record the custom control to.
   • Use the **Button** knob to select the custom control button that you want to record a custom control macro to. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) or an (@) in the list have already been programmed.

   ![Custom Controls Menu 1-2](image)

   **Operating Tip**

   As a recommendation, keep special functions grouped together on your physical custom control buttons.

3. Press **Start Recording** to display the **Recording Menu**.
4. Press **Insert Special** to display the **Insert Special Menu 1-2**.
5. Press **PBUS** to display the **Insert PIP-II Menu**.

   ![Insert PIP-II Menu](image)

6. Assign a command to a Pbus device for the custom control as follows:
   • Use the **Selection** knob to select the Pbus device you want to assign a command to. You can select between the following:

   ![Note](image)

   **Note**

   The Ports are identified by the remote port on the Synergy control panel that the Pbus device is connected to. For example, if a Pbus device is connected to Remote Port 1 on the control panel, the ports for the Pbus device will be labelled as Port R1 DevXX.

   ~ **ALL** — Select this option to have the Pbus command sent to all Pbus devices connected on the selected remote port.

   ~ **DevXX** — Select this option to have the Pbus command sent to a specific Pbus device (Dev 0 to Dev23) attached to the selected remote port.
• Use the **Command** knob to select the command you want to send to the selected Pbus device. You can select between the following:
  ~ **Trigger** — Select this option to have a specific trigger value (0 to 15) sent to the Pbus device when the custom control is run.
  ~ **Store** — Select this option to have the Pbus device store a specific memory value (0 to 4095) when the custom control is run.
  ~ **Recall** — Select this option to have the Pbus device recall a specific memory value (0 to 4095) when the custom control is run.

• Use the **Value** knob to select the **Trigger**, **Store** or **Recall** Value that you want.

![Note]

> Although the Pbus protocol allows for memories up to 4095, your specific device may not support this many. Refer to the documentation that came with your device to determine the number of memories you have available.

7. Press **Insert** to enter the Pbus command into your custom control macro.
8. Press **UP ONE** to return to the **Custom Controls Recording Menu**.

```
Custom Controls (1-2)
Recording...
Selected: Bank 1 Button 1 (Custom#1)
Custom Control Legend:
# = normal custom control button

Finish Cancel Insert
Recording Recording Recording
```

9. Press **Finish Recording** to finish recording to the selected custom control. The custom control button will stop flashing.

This completes the procedure for creating a custom control that will send commands to devices using the Pbus protocol.
Naming Custom Controls

A custom control button can be named for ready identification in the menus, and in the mnemonic displays if that option is installed.

Once your custom control buttons have been programmed, be sure to properly name and label them. Use the following procedure to apply a name to a custom control button.

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.
2. Select the custom control button you want to set the name for:
   - Use the Bank knob to select the custom control bank with the custom control you want to set the name for.
   - Use the Button knob to select the custom control button that you want to set the name for. You can also press the desired button directly on the control panel. Remember that buttons marked with an asterisk (*) in the list have already been programmed.
3. Press Modify Name to display the Custom Control Name Menu 1-2.

![Custom Control Name Menu 1-2, with Optional Mnemonic Field]

<table>
<thead>
<tr>
<th>Character</th>
<th>Horizontal</th>
<th>Vertical</th>
</tr>
</thead>
</table>
| a b c d e f g h i j k l m n o p q r s t u v w x y z | A B C D E F G H I J K L M N O P Q R S T U V W X Y Z | 0 1 2 3 4 5 6 7 8 9 + - _ & * () , . " |}

4. Assign a New Name to the custom control as follows, or continue to the next step to enter a Preset Name:

![Note]
The Synergy 1 Q/MD control panel does not support the Mnemonics Display option and does not show the Mnemonic preview in the Custom Control Name Menu.

![Operating Tip]
A Standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the System Control buttons and knobs.

- Use the Horizontal knob to move the cursor horizontally up or down a row to select a letter.
- Use the Vertical knob to move the cursor vertically up or down a column to select a letter.

![Note]
As you rotate the Horizontal and Vertical knobs, note that the MLE pushbuttons that correspond to each character (in sequence) light. If desired, you can press the MLE pushbutton to select a character.
• Press **Next Letter** to accept the currently selected letter and begin selection of the next letter.

**Note**
If you make a mistake, you can use the **Prev Letter** button to go back and adjust a letter.

• Press **Space** if you want to enter a space in the name.

5. Assign a **Preset Name** to the custom control as follows:

**Note**
If you start editing the name immediately, and then decide at some point to choose a *preset* name instead, *all characters* in the custom name will be replaced by the preset name.

• Press **Preset Names** to display the **Preset Names Menu**.

```
<table>
<thead>
<tr>
<th>Preset Names</th>
</tr>
</thead>
<tbody>
<tr>
<td>You are selecting a preset name.</td>
</tr>
<tr>
<td>Current Name: [Custom1]</td>
</tr>
<tr>
<td>T ID</td>
</tr>
<tr>
<td>DU E</td>
</tr>
</tbody>
</table>
```

**Preset Names Menu**

**Operating Tip**
A standard PS/2 keyboard can be used to perform the same actions as pressing or rotating the **System Control** buttons and knobs.

• Use the **Name** knob to select a preset name (a prefix) from the list of typical custom control names.

• Press **Select** to accept the preset name, or **Cancel** to return to the previous menu.

**Operating Tip**
You can edit a preset name on the **Custom Name Menu** just as you would a **New Name** you entered. Refer to step 4 above.

6. Press **Accept New Name** to save the new name.

**Note**
If you exit the installation menus without first pressing **Accept New Name**, the following screen is displayed.

The entry “ --- ” has changed to “ --- ”, abandon the changes?

• Press **Yes** to abandon changes and move to the new custom control number. The name reverts to its previous name as stored in memory.

• Press **No** to retain changes without moving to the new custom control number.

This completes the procedure for naming your custom controls.
Customizing Mnemonic Displays — Buttons

If the **Mnemonic Display** option is purchased and installed, use the following procedure to customize the display appearance:

1. Navigate to the **Custom Control Name Menu 2-2** as follows:
   - Press HOME ⇒ Custom Controls ⇒ Modify Name ⇒ MORE.

2. Adjust the appearance of the Mnemonic Display name for the custom control as follows:
   - Use the **Font** knob to select the size of the font. You can select from the following:
     - **Standard** — Select this option to use the default mnemonic format as set from the **Personality Menu**.
     - **Small** — Select this option to use a small font that permits up to 6 characters per line.
     - **Small Invert** — Select this option to use a small font that permits up to 6 characters per line, and draws light text on a dark background.
     - **Medium** — Select this option to use a medium font that permits up to 4 characters per line.
     - **Medium Invert** — Select this option to use a medium font that permits up to 4 characters per line, and draws light text on a dark background.
     - **Large** — Select this option to use a large font that permits only 2 characters per line.
     - **Large Invert** — Select this option to use a large font that permits only 2 characters per line, and draws light text on a dark background.
     - **NONE** — Select this option to use no font in the mnemonic display. The display will only show the selected background color, with no text.

**Note**
The Synergy 1 Q/MD control panel does not support the Mnemonic Display option and does not have the Custom Controls Name Menu (2-2).
• Use the Color knob to select the color of the display. You can select from the following:
  ~ **Standard** — Select this option to use the default mnemonic format as set from the Personality Menu.
  ~ **Green** — Select this option to set the mnemonic background to green.
  ~ **Yellow** — Select this option to set the mnemonic background to yellow.
  ~ **Orange** — Select this option to set the mnemonic background to orange.
  ~ **None** — Select this option to turn the mnemonic background off and not have it illuminated.

3. Select how the name will appear in the mnemonic display as follows:
   • Press **Next Start Pos** to adjust the point in the name where the text on the mnemonic display starts. For example, if you have the name **Custom01**, you can press the **Next Start Pos** button until the cursor is over the 0 to have only **01** appear on the mnemonic display.
   • Press **Prev Start Pos** to move the cursor in the opposite direction as the **Next Start Pos**.

4. Press **Accept New Name** to save the display style in memory.

   **Note**
   If you exit the installation menus without first pressing **Accept New Name**, the following screen is displayed.

   This entry “ --- ” has been changed to “ --- ”. Abandon the changes?

   • Press **Yes** to abandon changes and move to the new custom control number. The name reverts to its previous name as stored in memory.
   • Press **No** to retain changes without moving to the new custom control number.

This completes the procedure for naming and customizing the look of your custom controls.
Editing Custom Control Macros

After your custom control buttons have been programmed, you may wish to review and edit the contents. Events can easily be inserted or deleted through the Custom Controls Menu.

Use the following procedure to edit a custom control button:

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the Custom Control bank and button that you want to edit as follows:
   - Use the Bank knob to select the custom control bank that you want to edit the custom control on.
   - Use the Button knob to select the custom control that you wish to edit.

   **Note** Buttons with an asterisk (*) or an “at” (@) next to them in the list are already programmed and can be edited.

3. Press Edit to display the Edit Custom Control Menu.

   **Note** If your macro includes pauses or holds, a timeline will be displayed showing these events.

   The main area displays the location of the custom control that you are editing (Bank 1 Button 1 [Custom01]), and the contents of the custom control, including the number of events, the duration of the macro, and details of the event highlighted in the scroll area.

   **Note** If the custom control has been programmed to recall a memory, as in the example above, the memory name is displayed in the main area. If memories from more than one MLE are being recalled, the name from the highest MLE is displayed.

   - The Scroll Area provides a list of the events currently programmed into the custom control button.
   - The Label Area provides softkeys for inserting, deleting, and running the events, as required. The can select between the following:
     ~ Go To Start — Select this function to go to the start of the macro.
~ **Insert Events** — Select this function to insert an event before the currently highlighted event. Refer to the section “Inserting Events” on page 10–38 for more information on inserting events.

~ **Delete Event** — Select this function to delete the currently highlighted event. This cannot be undone.

~ **Modify Event** — Select this function to modify the currently highlighted event. The Modify Event function will take you to the Insert Special - Special Menu that was used to create the event.

---

**Note**

Only certain functions found on the Special Menu, such as Pause CC, can be modified.

~ **Run Single Event** — Select this function to run the currently highlighted event. Only the selected custom control event will be played.

~ **Run From Here** — Select this function to run the custom control, starting from the currently highlighted position.

This completes the procedure for editing a custom control. Refer to the section “Inserting Events” on page 10–38 for more information on inserting an event into a custom control.

---

### Modifying Events

The Modify Event function allows you to modify certain events in an already existing custom control. Only events such as Pause CC can be modified.

Use the following procedure to modify an event in a custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press HOME ⇒ Custom Controls.
2. Select the Custom Control bank and button that you want to edit as follows:
   - Use the **Bank** knob to select the custom control bank that you want to edit the custom control on.
   - Use the **Button** knob to select the custom control that you wish to edit.

---

**Note**

Only buttons with an asterisk (*) or an “at” (@) next to them in the list are already programmed and can be edited.

3. Press **Edit** to display the **Edit Custom Control Menu**.

   ![Edit Custom Control Menu](image)

   **Edit Custom Control Menu**

4. Use the **Event** knob to select the event you want to modify.
5. Press **Modify Event** to display the **Modify Event Menu**.

![Modify Event Menu](image)

6. Modify the event in the same manner that you inserted it originally. Refer to the section “Programming Special Functions” on page 10–12 for more information on inserting special functions.

7. Press **Insert** to save your changes.

8. Press **UP ONE** to display the **Inserting Menu**.

![Inserting Menu](image)

9. Press **Finish Inserting** to finish inserting to the selected custom control.

**Operating Tip**

Press **Cancel Inserting** to return to the previous menu without recording any of the insertions you made.

This completes the procedure for modifying a custom control event.

### Inserting Events

The **Edit Custom Control Inserting Menu** provides a means by which you can append a variety of events to an already existing custom control macro. Events are inserted immediately before the event that is currently highlighted in the scroll area.

Use the following procedure to insert events into a custom control:

1. Navigate to the **Custom Controls Menu 1-2** as follows:
   - Press **HOME ⇒ Custom Controls**.

2. Select the Custom Control bank and button that you want to insert an event into as follows:
   - Use the **Bank** knob to select the custom control bank that you want to edit the custom control on.
• Use the **Button** knob to select the custom control that you wish to edit.

**Note**

Only buttons with an asterisk (*) or an “at” (@) next to them in the list are *already* programmed and can be edited.

3. Press **Edit** to display the **Edit Custom Control Menu**.

4. Select the location to insert an event into a custom control as follows:
   - Use the **Event** knob to select the location in the custom control macro that you want to insert an event. The new event will be inserted before the selected event.
   - Press **Insert Event** to display the **Inserting Menu**.

5. Insert any **Control Panel** events into the custom control macro as follows:
   - Enter the new event or events that you want to insert at the selected location in the same way you would record new events. Refer to the section “**Programming Control Panel Functions**” on page 10–5 for more information on inserting control panel events.

6. Insert any **Special** events into the custom control macro as follows:
   - Press **Insert Special** to display the **Insert Special Menu 1-2**.
• Enter the new event or events that you want to insert at the selected location in the same way you would record new events. Refer to the section “Programming Special Functions” on page 10–12 for more information on inserting special events.

• Press UP ONE to display the Inserting Menu.

<table>
<thead>
<tr>
<th>Inserting Menu</th>
</tr>
</thead>
<tbody>
<tr>
<td>Edit Custom Control</td>
</tr>
<tr>
<td>Bank 1 Button 1 (Custom01)</td>
</tr>
<tr>
<td>Inserting...</td>
</tr>
<tr>
<td>Insert</td>
</tr>
<tr>
<td>Special</td>
</tr>
</tbody>
</table>

7. Press Finish Inserting to finish inserting to the selected custom control.

**Operating Tip**

Press Cancel Inserting to return to the previous menu without recording any of the insertions you made.

This completes the procedure for editing your custom control buttons.
Copying or Moving Custom Controls

When a custom control has been programmed, the commands in that custom control can be copied, or moved, to any other custom control on the switcher. This allows you to duplicate custom controls on different banks, or re-organize the custom controls.

Use the following procedure to copy or move a custom control:

1. Navigate to the Manage Custom Controls Menu as follows:
   - Press HOME ⇒ Custom Controls ⇒ Copy/Move Macros.

2. Use the Source knob to select the custom control you want to copy or move. The name of the custom control is followed by the bank the custom control is on, and the number of the custom control.

3. Use the Destination knob to select the custom control that you want to copy, or move, the source custom control to. The name of the custom control is followed by the bank the custom control is on, and the number of the custom control.

4. Copy a custom control as follows:
   - Press Copy to copy the source custom control to the destination. Both custom controls will contain the same commands.

5. Move a custom control as follows:
   - Press Move to move the source custom control to the destination. The commands in the source custom control are moved to the destination. The source custom control will be empty after the move.

This completes the procedure for copying or moving a custom control.
Deleting Custom Controls

Use the following procedure to delete a custom control function from a button.

1. Navigate to the Custom Controls Menu 1-2 as follows:
   - Press HOME ⇒ Custom Controls.

2. Select the Custom Control bank and button that you want to delete to as follows:
   - Use the Bank knob to select the custom control bank that you want to edit the custom control on.
   - Use the Button knob to select the custom control that you wish to edit.

3. Press Delete Macro.

   ![Confirmation — Delete Custom Control]

   Do you really want to delete this custom control?

   Yes  No

   Confirmation — Delete Custom Control

   - Press Yes to delete the custom control macro.
   - Press No to cancel the procedure without deleting the macro.

This completes the procedure for deleting custom control macros.
Saving and Recalling Custom Controls

For archive purposes and simply to keep safe backup copies of your valuable macros, it is recommended that you store your custom control functions to the switcher hard drive or a USB key. This also allows you to keep a library of custom functions that can be recalled as required for your current production configuration.

- Refer to the section “Saving Registers” on page 9–27 for instructions on saving custom control (and other types of) registers.
- Refer to the section “Recalling Registers” on page 9–35 for instructions on recalling custom control (and other types of) registers.

Note

You cannot store to or recall from the hard drive or a USB key while a custom control function is playing.
Proc Amps and RGB Color Correctors

In This Chapter

This chapter provides instructions for configuring Process Amplifiers (Proc Amps) and RGB Color Correctors options and using them to modify the appearance of input and output video signals both individually and on a per video bus basis.

The following topics are discussed in this chapter:

- Video Signal Correction Overview
- Operating Modes
- Correction Parameters
- Using Proc Amp and RGB Color Correctors
Video Signal Correction Overview

Video inputs do not always look the same. Varying lighting conditions, different cameras or video sources, and studio versus outdoor locations are only a few of the variables that affect the look of a video signal. Similarly, output video streams destined for different destinations may appear significantly different. On-set plasma monitors may display an image far differently than your broadcast output. The ability to correct or alter input and output video signals provides not only consistent video appearance across all sources, but also allows for the quick production of special colorizing effects.

Processing Amplifiers (Proc Amps) apply changes to incoming video to meet your broadcast requirements. Proc Amps allow you to quickly apply corrections to both the luminance and chrominance components of a video signal.

If you prefer to work in the RGB color space, the Synergy Q/MD/X switcher can convert a video signal into RGB components. You can apply RGB color corrections to these signals and the switcher will then convert the corrected signal back to a Y-Cr-Cb (luminance, chrominance) signal for broadcast.
Operating Modes

There are a number of ways to use Proc Amp and RGB color correctors depending on your production needs. Proc Amp and RGB color correctors may be applied in three modes:

- Input-based
- Bus-based
- Aux Bus Output-based

Color corrections are additive. You may apply any combination of Proc Amp and RGB color corrector adjustments to an input and when that output is selected on a bus that has been configured with bus-based corrections, the input-based corrections are applied and then the bus-based corrections are applied.

Input-based Corrections

Ensuring a consistent look across all video inputs is an important part of video production. Some inputs may need to have corrections applied in order to match the desired look of a production. These corrections need to be applied every time the input is selected, regardless of which video bus they are selected on.

Input-based corrections allow each input on the Synergy Q/MD/X switcher to have individual Proc Amp and RGB color corrector adjustments applied. These corrections are unique to each input and are applied to the input regardless of the bus it is displayed on.

Input based corrections are not affected by memory register recalls. Once corrections are applied to an input, they will continue to be applied to an input after a memory recall regardless of whether they were active when the memory register was stored.

Bus-based Corrections

You may wish to have Proc Amp and RGB color corrector adjustments applied consistently across a specific video bus. This is useful for creating special effects (e.g., desaturating a bus to create a black and white effect) and for ensuring video consistency across various output displays such as on-set plasma screens. If your facility uses different buses to provide different outputs, you may need to apply bus-wide corrections to ensure that the display looks the same regardless of the device it is being displayed upon.

Bus-based corrections allow each video bus on the Synergy Q/MD/X switcher to have Proc Amp corrections applied. These corrections are applied to any input when it is selected on that bus.

If an input also has individual corrections applied, those corrections are applied first, and then the bus-based corrections are applied.

Bus-based corrections are stored in memory registers and can be used in effects dissolves. Refer to Chapter 9, “Memory and Disk Functions” for information on storing and recalling memory registers and effects dissolves.
Aux Bus Output-based Corrections

Applying corrections to Aux Bus outputs is handled a bit differently than input or bus-based corrections. You may only apply corrections to as many Aux Buses as you have MLEs on your switcher (e.g., a Synergy 4 Q/MD-X switcher may apply Proc Amp or RGB color corrections to 4 Aux Buses simultaneously).

Available correctors must be assigned to Aux Buses where you wish to display Proc Amp and RGB color corrections. Aux Buses without an assigned corrector will output uncorrected video.

Once you assign a corrector to an Aux Bus, you may apply bus-based corrections as you would to any other video bus. Inputs will also display with any input-based corrections applied.

Aux Bus corrections are not affected by memory register recalls. Even if bus-based corrections are applied to an Aux Bus, they are not saved in memory registers and, therefore, you cannot perform effects dissolves on Aux Bus-based corrections.
Correction Parameters

The Synergy Q/MD/X switcher utilizes two types of color correctors: Proc Amp color correctors and RGB color correctors. Proc Amp color correctors work on the luminance and chrominance components of the video signal while RGB color correctors work on a video signal that the switcher first converts to an RGB format.

**Note**

Proc Amp and RGB color corrector options are separate. You must activate both options in order to apply both types of corrections. See the section “Installed Options” in Chapter 6 of the *Synergy Q/MD or Q/MD-X Engineering Manual* for information on activating and verifying installed options.

**Proc Amp Color Correctors**

The Proc Amp Color Corrector option provides the following parameters for video signal correction:

- Overall, Chrominance, Luminance, Cr, and Cb Gain
- Black, Cr, and Cb Offset
- Luminance Gamma
- Hue Rotation

The graph below illustrates a video signal with no Proc Amp adjustments applied. The horizontal axis represents signal values before any changes are applied and the vertical axis represents signal values after any changes are applied. The solid black line running from A to B represents an unmodified video signal where A is the minimum signal value and B is the maximum. You can look at any point on the line and the output value matches the input value. This line is represented in the graphs throughout the remainder of this section to provide a standard which serves to illustrate the effects of various Proc Amp color corrector adjustments.

In practice, video generating equipment have limits to the signals they produce. These limits are represented by the Output Min and Output Max lines in the graph. Some Proc Amp color corrector adjustments cause the video signal to be *clipped*. This occurs when the modifications to the video signal result in a signal value that is outside the range that the equipment can generate. Any further modifications to the video signal cause no further changes and it remains at the limit. The signal is said to be *clipped*. 
**Gain**

Gain represents the range of signal values present in a video signal from a lowest to a highest point (from black to white for example). Increasing gain expands this range while decreasing gain compresses this range. Clipping occurs if applied gain changes cause output signal values to fall outside the allowable range. The graph below illustrates the general effect of increased and decreased gain.

![Gain Graph](Image)

**General Effects of Increased and Decreased Gain**

The Synergy Q/MD/X switcher can perform five types of Proc Amp gain corrections:

- **Overall Gain** — Affects both chrominance and luminance video signal components simultaneously. Increasing overall gain causes an increase in contrast while also making colors more saturated and vivid. Decreasing overall gain causes a decrease in contrast while desaturating colors.

- **Chroma Gain** — Affects both chrominance video signal components (Cr and Cb) simultaneously. Increasing chroma gain causes the video signal colors to become increasingly saturated and more vivid. Decreasing chroma gain desaturates color form the video signal until it is black and white.

- **Lum Gain** — Affects the luminance video signal component. Increasing lum gain expands the contrast of the video signal (i.e. bright regions get brighter and dark regions get darker). Decreasing lum gain shrinks the contrast of the video signal (i.e. bright regions and dark regions tend towards a middle brightness region).

- **Cr Gain** — Affects the Cr component of the chrominance video signal. Increasing Cr gain causes the video signal colors to become increasingly saturated with red. Decreasing Cr gain desaturates red from the video signal.

- **Cb Gain** — Affects the Cb component of the chrominance video signal. Increasing Cb gain causes the video signal colors to become increasingly saturated with blue. Decreasing Cb gain desaturates blue from the video signal.

**Offsets**

Offsets shift the video signal by a set amount. Depending on the offset applied, different parts or all of the video signal may be affected. Clipping occurs if applied offsets cause output signal values to fall outside the allowable range. The graph below illustrates the general effect of adding positive or negative offsets to a video signal.
General Effects of Increased and Decreased Offset

The light gray line represents an offset applied to the entire video signal, causing the output signal values to be shifted by the offset amount from the input signal values.

The dashed line represents an offset applied to the B section of the video signal. The full offset is applied to the B end of the video signal and decreases down to no offset being applied at the A end of the video signal.

The dotted line represents an offset applied to the A section of the video signal. The full offset is applied to the A end of the video signal and decreases down to no offset being applied at the B end of the video signal.

The Synergy Q/MD/X switcher can perform three types of Proc Amp offset corrections:

- **Black Offset** — Affects the A section of the video signal and how much, if any, of the input video signal values are mapped to black in the output signal. Increasing the black offset increases the amount of input signal that is mapped to black in the output signal, thereby darkening the shadow areas. Decreasing the black offset decreases the amount of input video signal that is mapped to black in the output signal, effectively lightening the shadow areas. Further decreasing of the black offset decreases the output signal so none of it is black.

Effects of Increased and Decreased Black Offset

- **Cr Offset** — Affects the Cr component of the chrominance video signal. Increasing Cr offset causes the entire video signal to shift towards red, taking on a red tint. Decreasing Cr offset causes the entire video signal to shift away from red, taking on a green tint.
**Effects of Increased and Decreased Cr Offset**

- **Cb Offset** — Affects the Cb component of the chrominance video signal. Increasing Cb offset causes the entire video signal to shift towards blue, taking on a blue tint. Decreasing Cb offset causes the entire video signal to shift away from blue, taking on a yellow tint.

---

**Gamma**

The previous corrections are all linear. No matter which correction was applied, the output versus input mapping is still a straight line. Gamma corrections introduce non-linear corrections to a video signal. A gamma correction can be described as taking a point on the output versus input video signal line and pulling it perpendicularly away from the line. The result is a Bezier curve between the start, the new point and the end point. The graph below illustrates the effect of adding positive and negative gamma corrections to a video signal.
The point \( C \), called the **Gamma Offset** point can be any point along the \( AB \) line. The **Gamma Value** indicates how far perpendicularly off the line the Gamma Offset point is moved. Once the Gamma Offset point and Gamma Value are determined, a Bezier curve is drawn from point \( A \), through point \( C \) and ended at point \( B \).

The Synergy Q/MD/X switcher can perform gamma corrections to the luminance component of a video signal. Luminance gamma corrections allow for selective brightening or darkening of portions of the video signal. Generally, increasing the gamma value brightens the video signal in the location of the gamma offset point. Decreasing the gamma value, darkens the video signal in the location of the gamma offset point. Therefore, by moving the gamma offset point, you can select which part of the input video signal receives the most brightening or darkening.

**Hue Rotate**

Hue rotate affects the color of the entire video signal by rotating the input video hues. This produces an output video signal with colors that are shifted from their original hues. The diagram below shows a color wheel. Note that by rotating colors around the wheel, hue values will shift. The diagram shows a clockwise rotation where yellows become orange, reds become magenta, blues become green. The more rotation applied, the further around the wheel colors are shifted.

**RGB Color Correctors**

The RGB Color Corrector option provides the following parameters for video signal correction:

- Red, Green, and Blue Gain
- Red, Green, and Blue Offset
- Red, Green, and Blue Lower Offset
- Red, Green, and Blue Gamma

RGB color correctors are provided as an alternative method for modifying color and brightness in a video signal. The Synergy Q/MD/X switcher converts the video signal values from Y-Cr-Cb (Luminance, Chrominance) to RGB. Once any corrections are applied to the RGB values, the switcher converts them back to Y-Cr-Cb.

The graph below illustrates a single channel (red in this case) of an RGB signal with no color corrections applied. The horizontal axis represents signal values before any changes are applied and the vertical axis represents signal values after any changes are applied. The solid black line running from \( A \) to \( B \) represents an unmodified video signal where \( A \) is the minimum signal value and \( B \) is the maximum. You can look at any point on the line and the output value matches the input value. This line is represented in the graphs throughout the remainder of this section to provide a standard which serves to illustrate the effects of various RGB color corrections.
Gain

Gain represents the range of signal values present in a video signal from a lowest to a highest point (from 0 to 100% for an RGB component). Increasing gain expands this range while decreasing gain compresses this range. Clipping occurs if applied gain changes cause output signal values to fall outside the allowable range. The graph below illustrates the general effect of increased and decreased gain.

Offsets

Offsets shift the video signal by a set amount. Depending on the offset applied, different parts of the video signal may be affected. Clipping occurs if applied offsets cause output signal values to fall outside the allowable range. The graph below illustrates the general effect of adding positive or negative offsets.
General Effects of Increased and Decreased Offset (Red Component)

The dashed line represents an upper offset applied to the B section of the video signal. The full offset is applied to the B end of the video signal and decreases down to no offset being applied at the A end of the video signal.

The dotted line represents a lower offset applied to the A section of the video signal. The full offset is applied to the A end of the video signal and decreases down to no offset being applied at the B end of the video signal.

The Synergy Q/MD/X switcher can perform upper and lower offsets on each RGB component

- **Offset** — Shifts the selected color component (R, G, or B) of the video signal by a set amount. The offset affects how much, if any, of the input video color component is mapped to 100% of that color and how much, if any, is mapped to 0% in the output signal. Increasing the offset increases the amount of input signal values that will be mapped to 100% and decrease the amount of input signal values that will be mapped to 0% in the output signal. Decreasing the offset decreases the amount of input video signal that will be mapped to 100% and increases the amount of input video signal that will be mapped to 0% in the output signal. It is possible to increase the offset so no part of the output signal contains 100% of the color component or decrease the offset so no part of the output contains 0% (i.e. some amount of color component is present in all output values).

- **Lower Offset** — Affects the A section of the video signal and how much, if any, of the input video color component (R,G, or B) is mapped to 0% (i.e., no color component) in the output signal. Increasing the lower offset decreases the amount of input signal values that will be mapped to 0%. It is possible to increase the lower offset so all parts of the video signal contain some of the color component (i.e., there are no output values with a 0% color component). Decreasing the lower offset increases the number of input video signal values that will be mapped to 0%.

**Gamma**

The previous corrections are all linear. No matter which correction was applied, the output versus input mapping is still a straight line. Gamma corrections introduce non-linear corrections to a video signal. A gamma correction can best be described as taking a point on the output versus input video signal line and then pulling it perpendicularly away from the line. The resulting line is a Bezier curve that flows smoothly from the start, through the new point and then continues to the end point. The graph below illustrates the effect of adding positive and negative gamma corrections to an RGB component of a video signal.
The point $C$, called the **Gamma Offset** point can be any point along the $AB$ line. The **Gamma Value** indicates how far perpendicularly off the line the Gamma Offset point is moved. Once the Gamma Offset point and Gamma Value are determined, a Bezier curve is drawn from point $A$, through point $C$ and ended at point $B$.

Generally, increasing the gamma value adds more of the component to the video signal in the location of the gamma offset point. Decreasing the gamma value, reduces the amount of the component in the video signal in the location of the gamma offset point. Moving the gamma offset point allows you to select which part of the input video signal receives the gamma correction. For example, if you increase the red gamma correction to the part of the video signal that has no red component you will add red to those areas while having little effect on areas that already contain a significant amount of red. This allows you to add a red tint to the image while minimizing the amount of red-clipping that occurs.

The Synergy Q/MD/X switcher can perform gamma corrections on each RGB component.
Using Proc Amp and RGB Color Correctors

Accessing the Video Correction Menu

All Proc Amp and RGB color corrector adjustments are applied by using the Video Correction Menu. Use the following procedure to access the Video Correction Menu before any of the procedures described in the remainder of this section:

1. Navigate to the Effects Menu 2-2 as follows:
   - Press HOME ⇒ Effects ⇒ MORE ⇒ Video Correction.
2. Press Video Correction to display the Video Correction Menu 1-2.

Operating Tip

You can quickly access the Video Correction Menu 1-2 by double pressing any crosspoint button on any bus.

Video Correction Menu 1-2

If you accessed the Video Correction Menu by double pressing a crosspoint button, that crosspoint and bus will be indicated at the top of the menu. If you navigated to the Video Correction Menu from the Main Menu, the last crosspoint button pressed (and the bus it was pressed on) will be indicated at the top of the menu.

Caution

You can switch which input and bus will be modified while using the Video Correction Menu by pressing crosspoint buttons on the switcher. Be aware when pressing crosspoint buttons on buses which are on-air as unwanted changes to your program output may occur.

This completes the procedure for accessing the Video Correction Menu.

Applying Proc Amp Corrections

Gain

Use the following procedure to adjust the gain for a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).
2. Access the Proc Amp Menu to perform either an input-based or bus-based Proc Amp correction by performing one of the following:
   - To perform an input-based correction, press Input Proc Amp.
   - To perform a bus-based correction, press Bus Proc Amp.
3. Press Gain to display the Proc Amp Gain Menu.

![Proc Amp Gain Menu (Input-Based)](image)

4. Use the Gain knob to change the luminance and chrominance gain simultaneously. The Lum, Cr, and Cb graphs update (gain alters the slope of the line) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.
5. Use the Chroma Gain knob to change the chrominance gain. Both components (Cr and Cb) of the chrominance signal are modified simultaneously. The Cr, and Cb graphs update (gain alters the slope of the line) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.
6. Use the Lum Gain knob to change the luminance gain. The Lum graph updates (gain alters the slope of the line) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

The Enabled modes list is updated to show that a Proc Amp correction has been applied.

![Overall Gain Applied (Input-Based)](image)

This completes the procedure for adjusting the gain for a specific input or video bus.

**Cr and Cb Gain**

Use the following procedure to adjust the Cr and Cb gain for a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).
2. Access the **Proc Amp Menu** to perform either an input-based or bus-based Proc Amp correction by performing one of the following:
   - To perform an input-based correction, press **Input Proc Amp**.
   - To perform a bus-based correction, press **Bus Proc Amp**.

3. Adjust either the Cr or Cb chrominance component of the video signal by performing one of the following:
   - Press **Cr Adjust** to adjust the Cr component and access the **Cr Adjust Menu**.
   - Press **Cb Adjust** to adjust the Cb component and access the **Cb Adjust Menu**.

![Proc Amp Cr Adjust Menu (Input-Based)](image)

4. Use the **Cr Gain** or **Cb Gain** knob to change the Cr or Cb gain. The Cr or Cb graph updates (gain alters the slope of the line) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

The **Enabled modes** list is updated to show that a Proc Amp correction has been applied.

![Cr Gain Applied (Input-Based)](image)

This completes the procedure for adjusting the Cr and Cb gain for a specific input or video bus.

**Cr and Cb Offset**

Use the following procedure to adjust the Cr offset for a specific input:

1. Access the **Video Correction Menu 1-2** (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).

2. Access the **Proc Amp Menu** to perform either an input-based or bus-based Proc Amp correction by performing one of the following:
   - To perform an input-based correction, press **Input Proc Amp**.
   - To perform a bus-based correction, press **Bus Proc Amp**.
3. Adjust either the Cr or Cb chrominance component of the video signal by performing one of the following:

- Press Cr Adjust to adjust the Cr component and access the Cr Adjust Menu.
- Press Cb Adjust to adjust the Cb component and access the Cb Adjust Menu.

![Proc Amp Cr Adjust Menu (Input-Based)](image)

4. Use the Cr Offset or Cb Offset knob to change the Cr or Cb offset. The Cr or Cb graph updates (offset moves the line towards the top left or bottom right corner) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

The Enabled modes list is updated to show that a Proc Amp correction has been applied.

![Cr Offset Applied (Input-Based)](image)

This completes the procedure for adjusting the Cr and Cb offset for a specific input.

**Hue Rotate**

Use the following procedure to apply a hue rotation to the colors of a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).
2. Access the Proc Amp Menu to perform either an input-based or bus-based Proc Amp correction by performing one of the following:
   - To perform an input-based correction, press Input Proc Amp.
   - To perform a bus-based correction, press Bus Proc Amp.
3. Press Hue/Black Level to access the Hue/Black Level Menu.
4. Use the **Hue Rotate** knob to rotate the color wheel, altering the video colors as follows:
   - Increasing hue rotation values turn the color wheel clockwise.
   - Decreasing hue rotation values turn the color wheel counter-clockwise.

The **Lum**, **Cr**, and **Cb** graphs do not change when a hue rotation is applied but if the input you are correcting is visible on a monitor, you can see the changes as you make them.

The **Enabled modes** list is updated to show that a Proc Amp correction has been applied.

This completes the procedure for applying a hue rotation to the colors of a specific input or video bus.

**Black Level**

Use the following procedure to adjust the Black Level offset for a specific input or video bus:

1. Access the **Video Correction Menu 1-2** (see the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).
2. Access the **Proc Amp Menu** to perform either an input-based or bus-based Proc Amp correction by performing one of the following:
   - To perform an input-based correction, press **Input Proc Amp**.
   - To perform a bus-based correction, press **Bus Proc Amp**.
3. Press **Hue/Black Level** to access the **Hue/Black Level Menu**.

4. Use the **Black Level** knob to change the black level. The **Lum** graph updates (black level acts as a luminance offset and moves the line towards the top left or bottom right corner) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

The **Enabled modes** list is updated to show that a Proc Amp correction has been applied.

This completes the procedure for adjusting the black level offset for a specific input or video bus.
**Luminance Gamma**

Use the following procedure to adjust the luminance gamma for a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).

2. Access the Proc Amp Menu to perform either an input-based or bus-based Proc Amp correction by performing one of the following:
   - To perform an input-based correction, press Input Proc Amp.
   - To perform a bus-based correction, press Bus Proc Amp.

3. Press Lum Gamma to access the Lum Gamma Menu.

4. Use the Gamma Value knob to change the luminance gamma value.

5. Use the Gamma Offset knob to change the luminance gamma offset point.

   The Lum graph updates (the gamma offset value moves the offset point along the Lum graph line and the gamma value alters how much perpendicular offset is applied to the offset point) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

   The Enabled modes list is updated to show that a Proc Amp correction has been applied.

This completes the procedure for adjusting the luminance gamma for a specific input or video bus.
Applying RGB Color Corrections

Component Gain

Use the following procedure to adjust the red, green, or blue component gain for a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).

2. Access the RGB Menu to perform either an input-based or bus-based RGB color correction by performing one of the following:
   - To perform an input-based correction, press Input RGB.
   - To perform a bus-based correction, press Bus RGB.

3. Access the Component Adjust Menu for the color component you wish to adjust by performing one of the following:
   - Press Red Adjust to access the Red Adjust Menu.
   - Press Green Adjust to access the Green Adjust Menu.
   - Press Blue Adjust to access the Blue Adjust Menu.
   - Press MORE and then RGB Adjust to adjust all three color components simultaneously

4. Use the Gain knob to change the gain on the selected component of the video signal. The appropriate color component graphs update (gain alters the slope of the line) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

   The Enabled modes list is updated to show that an RGB correction has been applied.

This completes the procedure for adjusting the red, green, or blue component gain for a specific input or video bus.
**Component Offset**

Use the following procedure to adjust the red, green, or blue component offset for a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).

2. Access the RGB Menu to perform either an input-based or bus-based RGB color correction by performing one of the following:
   - To perform an input-based correction, press **Input RGB**.
   - To perform a bus-based correction, press **Bus RGB**.

3. Access the Component Adjust Menu for the color component you wish to adjust by performing one of the following:
   - Press **Red Adjust** to access the Red Adjust Menu.
   - Press **Green Adjust** to access the Green Adjust Menu.
   - Press **Blue Adjust** to access the Blue Adjust Menu.
   - Press MORE and then **RGB Adjust** to adjust all three color components simultaneously.

4. Use the Offset knob to change the offset of the selected component of the video signal. The appropriate color component graphs update (offset moves the line towards the top left or bottom right corner) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

   The Enabled modes list is updated to show that an RGB correction has been applied.

This completes the procedure for adjusting the red, green, or blue component offset for a specific input or video bus.
Component Lower Offset

Use the following procedure to adjust the red, green, or blue component offset for a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).

2. Access the RGB Menu to perform either an input-based or bus-based RGB color correction by performing one of the following:
   - To perform an input-based correction, press Input RGB.
   - To perform a bus-based correction, press Bus RGB.

3. Access the Component Adjust Menu for the color component you wish to adjust by performing one of the following:
   - Press Red Adjust to access the Red Adjust Menu.
   - Press Green Adjust to access the Green Adjust Menu.
   - Press Blue Adjust to access the Blue Adjust Menu.
   - Press MORE and then RGB Adjust to adjust all three color components simultaneously.

4. Use the Lower Offset knob to change the lower offset of the selected component. The appropriate color component graphs update (lower offset moves the minimum point on the graph along either the vertical axis or horizontal axis) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

   The Enabled modes list is updated to show that an RGB correction has been applied.

This completes the procedure for adjusting the red, green, or blue component lower offset for a specific input or video bus.
Component Gamma

Use the following procedure to adjust the red, green, or blue component gamma for a specific input or video bus:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).
2. Access the RGB Menu to perform either an input-based or bus-based RGB color correction by performing one of the following:
   • To perform an input-based correction, press Input RGB.
   • To perform a bus-based correction, press Bus RGB.
3. Access the Component Adjust Menu for the color component you wish to adjust by performing one of the following:
   • Press Red Gamma to access the Red Gamma Menu.
   • Press Green Gamma to access the Green Gamma Menu.
   • Press Blue Gamma to access the Blue Gamma Menu.
   • Press MORE and then RGB Gamma to adjust all three color components simultaneously.
4. Use the Gamma Value knob to change the selected component gamma of the selected input.
5. Use the Gamma Offset knob to change the selected component gamma offset point.

The appropriate color component graphs update (the gamma offset value moves the offset point along the graph line and the gamma value alters how much perpendicular offset is applied to the offset point) to reflect the changes you are making and if the input you are correcting is visible on a monitor, you can see the changes as you make them.

The Enabled modes list is updated to show that an RGB correction has been applied.

This completes the procedure for adjusting the red, green, or blue component gamma for a specific input or video bus.
Aux Bus Output Correctors

Aux Buses are not automatically assigned Proc Amp or RGB color correctors. Rather, your Synergy Q/MD/X switcher has a set number of correctors that are shared among Aux Buses. Each full MLE on your switcher provides one Aux Bus corrector. You use Aux Bus mode to assign correctors to specific Aux Buses.

Assigning Correctors to Aux Buses

Use the following procedure to assign a corrector to a specific Aux Bus:

1. Ensure that the Aux Bus buttons on your switcher are configured to the correct assign and bank settings for the Aux Bus you wish to assign a corrector to. Refer to the section “Aux Bus Setup” in the chapter, “Additional Installation Steps” of the Synergy Q/MD or Q/MD-X Engineering Manual for more information on configuring Aux Bus settings.

2. Access the Video Correction Menu 1-2 by double-pressing a Crosspoint button on your Aux Bus.

   ![Video Correction Menu 1-2 (Aux Bus Mode)]

The Aux buses assigned to correctors list shows which Aux Buses have an assigned corrector (there are no assigned correctors in the above figure). If no corrector is assigned to the current Aux Bus, the other Proc Amp and RGB color correction buttons are unavailable.

3. Press Assign Corrector to assign an available corrector to the current Aux Bus.

   ![Video Correction Menu 1-2 (Corrector Assigned)]

The Aux buses assigned to correctors list is updated to show the Aux Bus and newly assigned corrector. Bus-based corrections may now be assigned to this Aux Bus and input-based corrections will be displayed on it.

This completes the procedure for assigning a corrector to a specific Aux Bus.
Removing Correctors from Aux Buses

Use the following procedure to remove a corrector from a specific Aux Bus:

1. Ensure that the Aux Bus buttons on your switcher are configured to the correct assign and bank settings for the Aux Bus you wish to remove the corrector from. Refer to the section “Aux Bus Setup” in the chapter, “Additional Installation Steps” of the Synergy Q/MD or Q/MD-X Engineering Manual for more information on configuring Aux Bus settings.

2. Access the Video Correction Menu 1-2 by double-pressing a Crosspoint button on your Aux Bus.

The Aux buses assigned to correctors list shows which Aux Buses have an assigned corrector.

3. Press Remove Corrector to assign an available corrector from the current Aux Bus.

This completes the procedure for removing a corrector from a specific Aux Bus.

Copying Corrections Between Inputs and Video Buses

Once you have applied Proc Amp and RGB color corrector adjustments to a specific input or video bus, you can copy them to other inputs or buses to save you from having to manually duplicate your settings.
Copying Corrections Between Inputs

Use the following procedure to copy Proc Amp and RGB color correction settings from one input to another:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu). Note that the input you are copying settings from is displayed at the top-left of the menu. If you wish to copy from a different input, press the corresponding Crosspoint button.

2. Press MORE to display the Video Correction Menu 2-2.

3. Press Copy Input to copy all input-based Proc Amp and RGB color corrections for the selected input. A brief message will appear confirming the copy.

4. Press the Crosspoint button for the destination input you wish to copy the settings to. Note that this input is displayed at the top-left of the menu.

5. Press Paste Input to paste the settings into the destination input. A brief message will appear confirming the paste.

Caution

Be aware when pressing crosspoint buttons on buses which are on-air as unwanted changes to your program output may occur.

The Enabled modes list will update to show that the destination input now has the same corrections applied as the source input.

This completes the procedure for copying Proc Amp and RGB color correction settings from one input to another.
Copying Corrections Between Video Buses

Use the following procedure to copy Proc Amp and RGB color correction settings from one video bus to another:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu). Note that the video bus you are copying settings from is displayed at the top-left of the menu. If you wish to copy settings from a different video bus, press a Crosspoint button on the bus you wish to copy from.

2. Press MORE to display the Video Correction Menu 2-2.

3. Press Copy Bus to copy all bus-based Proc Amp and RGB color corrections for the selected video bus. A brief message will appear confirming the copy.

4. Press a Crosspoint button on the destination video bus you wish to copy the settings to. Note that this video bus is displayed at the top-left of the menu.

   Caution

   Be aware when pressing crosspoint buttons on buses which are on-air as unwanted changes to your program output may occur.

5. Press Paste Bus to paste the settings into the destination video bus. A brief message will appear confirming the paste.

   The Enabled modes list will update to show that this destination video bus now has the same corrections applied as the source video bus.

This completes the procedure for copying Proc Amp and RGB color correction settings from one video bus to another.
Returning to Default Settings

You may wish to remove Proc Amp or RGB color corrector adjustments from an input, a series of inputs, or a video bus. Rather than stepping through each correction menu, a number of methods are available to quickly return settings to their default values.

Returning an Input to Default Settings

Use the following procedure to return all Proc Amp settings to default values for a specific input:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu) for the input you wish to return to default values.
2. Press Input Proc Amp to access the Proc Amp Menu.

All Proc Amp adjustments are removed from the input.

This completes the procedure for returning all Proc Amp and RGB color correction settings to default values for a specific input.

Use the following procedure to return all RGB color correction settings to default values for a specific input:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu) for the input you wish to return to default values.
2. Press Input RGB to access the RGB Menu 1-2.
3. Press MORE to access the RGB Menu 2-2.
4. Remove RGB color corrections from any or all of the RGB components as follows:
   - Press **Default Red** to remove red component corrections.
   - Press **Default Green** to remove green component corrections.
   - Press **Default Blue** to remove blue component corrections.
   - Press **Default RGB** to remove all component corrections.

This completes the procedure for returning all RGB color correction settings to default values for a specific input.

**Returning a Video Bus to Default Settings**

Use the following procedure to return all Proc Amp settings to default values for a specific video bus:

1. Access the **Video Correction Menu 1-2** (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu) for the input you wish to return to default values.
2. Press **Bus Proc Amp** to access the **Proc Amp Menu**.

![Input Mode Proc Amp Menu](image)

3. Press **Default**.

   All Proc Amp adjustments are removed from the video bus.

This completes the procedure for returning all Proc Amp and RGB color correction settings to default values for a specific video bus.

Use the following procedure to return all RGB color correction settings to default values for a specific video bus:

1. Access the **Video Correction Menu 1-2** (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu) for the input you wish to return to default values.
2. Press **Bus RGB** to access the **RGB Menu 1-2**.
3. Press **MORE** to access the **RGB Menu 2-2**.

![RGB Menu 2-2](image)
4. Remove RGB color corrections from any or all of the RGB components as follows:
   - Press Default Red to remove red component corrections.
   - Press Default Green to remove green component corrections.
   - Press Default Blue to remove blue component corrections.
   - Press Default RGB to remove all component corrections.

This completes the procedure for returning all RGB color correction settings to default values for a specific video bus.

**Returning all Inputs to Default Settings**

Use the following procedure to return all Proc Amp and RGB color correction settings for all inputs to default values:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu).
2. Press MORE to display the Video Correction Menu 2-2.
3. Press Default All Inputs. A confirmation message will be displayed prompting you to either confirm or cancel the defaulting procedure.
4. Press Confirm (press Cancel if you wish to abort the procedure).

All Proc Amp and RGB color correction settings for all inputs are set to default values.

This completes the procedure for returning all Proc Amp and RGB color correction settings for all inputs to default values.

**Returning an Input and Video Bus to Default Settings**

Use the following procedure to return all Proc Amp and RGB color correction settings for a specific input and a specific video bus to default values:

1. Access the Video Correction Menu 1-2 (refer to the section “Accessing the Video Correction Menu” on page 11–13 if you need help accessing the menu) for the specific input and video bus you wish to return to default values.
2. Press MORE to display the Video Correction Menu 2-2.

   **Important** This procedure does not remove any input-based Proc Amp and RGB color corrections from any other inputs.
3. Press **Default Bus & Input**. A confirmation message will be displayed informing you of the specific input and bus being defaulted. You must either confirm or cancel the defaulting procedure.

4. Press **Confirm** (press **Cancel** if you wish to abort the procedure).

   All Proc Amp and RGB color correction settings for the specific input and video bus are returned to default values.

This completes the procedure for returning all Proc Amp and RGB color correction settings for a specific input and a specific video bus to default values.
Glossary of Terms

**Active Video Lines** — All video lines not occurring in the vertical blanking interval. The portion of the video signal that contains picture information.

**Aspect Ratio** — The numerical ratio of picture width to height, for example, 4:3 or 16:9.

**Auto Transition** — An automatic transition in which the manual movement of the fader handle is simulated electronically. The transition starts when the AUTO TRANS button is pressed and takes place over a pre-selected time period, measured in frames.

**Border** — Effects created around the edges of a pattern or on a keyer. If an optional dual border generator card is installed, several border, shadow, and outline effects are available on that keyer as well.

**Border Generator** — Circuitry that generates various border effects on keys created by the switcher.

**Chroma Key** — An effect in which video from one source replaces video of a specific hue in a second video source. The blue and green hues are most commonly used for chroma keying.

**Chrominance** — The “depth” or saturation of a color. The three characteristics of a TV color signal are chrominance, luminance and hue.

**Cut** — An instantaneous switch from one video signal to another.

**Dissolve** — A transition from one video signal to another in which one signal is faded down while the other is simultaneously faded up. The term “mix” is often used interchangeably with “dissolve”.

**Downstream Keyer (DSK)** — A keyer that places a key “downstream” of the MLE effects system output. This “top level” effect usually consists of a character generator title.

**External Key** — A video input (non-primary video) used to produce a key effect. Examples of external key sources are character generators and cameras.

**Fade-to-Black** — A controlled change of the on-air picture signal level down to black level.

**Field** — One half of a complete picture (or frame) interval containing all of the odd, or all of the even lines in interlaced scanning. One scan of a TV screen is called a “field”; two fields are required to make a complete picture (which is a “frame”).

**Field Frequency** — The rate at which one complete field is scanned, approximately 50 times per second in 625 video, or 60 times per second in 525 video.

**Frame** — One complete picture consisting of two fields of interlaced scanning lines.

**GPI** — An abbreviation for General Purpose Interface, a device which typically allows switcher automatic transition functions to be controlled remotely.
Hue — The characteristic of a color signal that determines whether the color is red, yellow, green, blue, purple, etc. (the three characteristics of a TV color signal are chrominance, luminance, and hue). White, black, and gray are not considered hues.

Internal Key — The use of a primary input to produce a key effect.

Key — An effect produced by “cutting a hole” in background video, then filling the hole with video or matte from another source. Key source video cuts the hole, key fill video fills the hole. The video signal used for cut and fill can come from the same or separate sources.

Key Fill — A video input which is timed to “fill the hole” provided by the key source video. An example of key fill is the video output of a character generator.

Key Invert — An effect that reverses the polarity of the key source so that the holes in the background are cut by dark areas of the key source instead of bright areas. The KEY INV push-button selects this effect.

Key Mask — A keying technique in which a pattern is combined with the key source to block out unwanted portions of the key source.

Key Source — The video signal which “cuts a hole” in the background video to make a key effect possible. Also called “Key Video”. In practice, this signal controls when a video mixer circuit will switch from background to key fill video.

Key Video — See Key Source.

Linear Keys — Linear keys make it possible to fully specify the transparency of a key from opaque, through transparent, to fully off. The transparency is specified by the key signal (also known as the “hole cutter” or “alpha channel”) that is associated with the key fill. A keyer capable of a linear key converts the key signal voltage directly to the transparency effect on the screen. The KEY MEM button allows the user to store the CLIP and GAIN settings required to match the incoming key signal to your requirements.

Line Frequency — The number of horizontal scans per second. For 525 line 60 Hz systems, this is approximately 15734 scans per second.

Luminance Key — An effect in which video from one source is replaced by video that exceeds a set level in a second video source.

Mask — See Key Mask.

Matte — A solid color signal that is generated by the switcher and can be adjusted for hue, saturation, and luminance levels.

Matte Key — A key effect in which the fill video is a matte, provided by one of the internal matte generators.

Memory — The memory feature provides storage and recall of complete switcher setups.

MIX — See Dissolve.

MLE — An abbreviation for multi-level effects.

PGM Output — The on-air video output of the system.

Primary Input — Video sources selected by the control panel push-buttons for the crosspoint buses. These buses are normally labeled “KEY”, “PGM”, and “PST”.

PV Output — A switcher output that shows the scene that will go on-air when the next automatic or manual transition takes place.

Self Key — A key effect in which the same video signal serves as both the key signal and key fill.
**Soft Edge** — A pattern edge effect produced by mixing key source and key fill signals in such a way that the edge of the pattern is not sharp.

**Split Screen** — An effect in which a wipe pattern provides the key source signal. This is known as a “preset pattern” key.

**Tally** — An indicator which illuminates when the associated push-button or control is selected or is on-air.

**Termination** — A means of closing a circuit by connecting a resistive load to it. In video systems, a termination is typically a 75 ohm resistive load.

**Transition** — A controlled change from one video input to another video input or black. The change can occur through a wipe, cut, dissolve or “DVE Send” effect.

**Transition Preview** — A transition seen only on the preview monitor. It may be observed and adjusted without disturbing the program or “on-air” output.

**Video** — The electrical signal produced by a television camera, character generator or other image source. The signal amplitude varies in relation to the tonal scale from black to white presented at the source. White produces the highest amplitude; black produces the lowest signal amplitude.

**Wipe** — A transition from one video signal to another, in which the change proceeds according to the shape of a specific pattern. A moving transition line separates the two picture signals.
Index

Numerics
360 Systems Digicart ............................................. 9-9
3D Pattern Button Assign option ......................... 4-19
3D Sequence registers .......................................... 9-9
3D Squeeze & Tease DVE .................................. 1-22

A
Abbreviations .......................................................... 1-5
ACTIVE LED
keyer off ........................................................... 5-6
next transition ....................................................... 5-12
states ................................................................. 5-13
transitions .......................................................... 5-3
Active MLE Transition, Custom Contro ........ 10-18
A-D, definition ....................................................... 1-5
Adjust
matrix wipes ......................................................... 6-9, 6-10
pattern aspect ratio ........................................... 6-6
pattern border ..................................................... 6-6
pattern rotation ................................................... 6-7
pattern softness ................................................... 6-6
wipe ................................................................ 6-6
Adjust display contrast ........................................ 3-7
Advanced border generator ................................ 1-24
Advanced Chroma Keying ................................... 1-8
Advanced mode .................................................... 7-26
ALL
button ................................................................. 9-4
global memory system group .......................... 9-4, 9-7
Alpha source, key ................................................ 7-2
Arm mode, ROLL VTR .................................. 1-27, 1-29, 4-14
Arrows, up/down .................................................. 5-2, 5-6
Aspect
button ................................................................. 6-6
knob ................................................................. 6-6
ratio ................................................................. 6-6
Assignment, key button ....................................... 2-9
ATTRIB .......................................................... 9-8, 9-12, 9-14
Attributes Menu ................................................... 9-18
Audio Cut Only, Personality setting .................. 4-4
Audio Mixer audio transition .............................. 4-5
Audio Mixer option
ganged ............................................................ 1-28

large ................................................................. 1-28
small ............................................................... 1-28
Audio Server
control option .................................................... 1-9, 1-29
Audio server
clip ................................................................. 9-8
clip, recall register ............................................. 9-13, 9-14
Auto Key
clip and gain .................................................... 7-24
KEY MEM function .......................................... 7-24
Auto Recall .......................................................... 9-21
Auto Remove Key ............................................... 4-6
AUTO SELECT .................................................. 7-6
Auto Select Key .................................................. 7-21
FLY KEY ......................................................... 7-25
notes ............................................................... 7-25
performing ....................................................... 7-23
setup menu ....................................................... 7-24
transitions ......................................................... 7-25, 7-28, 7-33
AUTO TRANS .................................................. 2-12, 5-5, 5-9, 5-14, 7-11, 7-68
Auto Transition
Performing .......................................................... 5-11
rate ................................................................. 7-68
rules ............................................................... 7-68
Auto transition
notes ............................................................... 7-71
rules ............................................................... 5-14
set DSK rates ................................................... 7-68
set fade to black rates ....................................... 4-40
set from Global Memory Systems Group ....... 5-14
set from MLE Memory Systems Group ........ 5-16
set MLE Key rates ............................................... 7-69
set MLE rates ................................................... 5-16, 7-70
set program/preset rates ................................... 5-14
Automation Custom Control ......................... 10-17
Aux Bus
assign group ..................................................... 2-8
group ............................................................. 2-8
Aux Mix Key Setup Menu .................................. 7-65
Aux Mixer/Keyers ........................................... 7-65
Aux Mixers .......................................................... 7-65
Aux panels, remote, see Remote aux panel
Aux, definition .................................................. 1-5
AuxKey Mode, MLE 1 ........................................... 7-65
AuxKeys .......................................................... 1-21, 7-64
applications ..................................................... 1-22, 7-64
Aux Key Rate ................................................... 7-67
Aux MLE Rate ................................................... 7-67
AuxKey Mode .................................................... 7-65
clip and gain .................................................... 7-66
highlights .......................................................... 1-9
Mixer/Keyers ................................................... 7-65
Mixers ............................................................ 7-65
operation ......................................................... 7-64
performing ....................................................... 7-65
Setup Menu ................................................. 7-65
AuxKeys option ........................................... 1-21, 7-64

B
Background
  bus .......................................................... 2-8
  color menu ............................................ 6-25
  cuts .................................................... 5-10
  dissolves ............................................. 5-11
  transitions .......................................... 5-1
  wipes ............................................... 6-8
Background/Preset transition group ................. 2-9
Bad memory recall .................................... 9-16
BANK ................................................................ 9-6
Bank 0 Lit .................................................... 4-7
Banks
  Select Custom Control Bank event ............ 10-8
  Banks, for custom control functions ...... 10-3
Basic mode ................................................... 7-26
Basics
  crosspoints .......................................... 4-22
  switcher ................................................ 4-22
Before starting, reset switcher ..................... 4-2
BKGD
  1 KEY 1 ................................................ 6-19
  2 KEY 2 ................................................ 6-19
  bus ..................................................... 2-8, 2-9
  button ............................................... 5-3, 5-6
  type, wash ........................................... 6-23, 6-27
BLACK ....................................................... 4-23
BORD
  button ................................................ 7-9, 8-8
  OFF ................................................... 7-10, 8-8
BORD 1 button ........................................... 6-20
BORD 2 button ........................................... 6-20
Border
  adjust color .......................................... 6-20
  control section .................................... 7-20
  density (transparency) ......................... 8-9, 8-10
  density knob .................................... 7-20
  glow (softness) .................................. 8-9, 8-10
  glow, knob ......................................... 7-20
  key .................................................. 7-9
  menu ................................................ 7-20
  move two simultaneously .................... 8-12
  notes ................................................ 8-11
  position ........................................... 8-9, 8-10
  width ............................................. 7-20, 8-9, 8-10
BORDER button ........................................ 6-6
Bordering keys ......................................... 8-8
BOTTOM knob ........................................... 7-19
Box Mask ................................................... 8-3

Bus
  background .......................................... 2-8
  indicators .......................................... 4-30
  key ................................................ 2-8, 2-9
  LED indicators .................................... 4-30
  peripheral bus II ................................ 1-29
  preset ................................................ 2-8
  preview .......................................... 2-7
  program/preset ................................ 2-7
Bus Hold Clear, Personality setting ............. 4-7
Bus Maps
  assigning to multiple buses ................. 4-26
  individual bus assignment .................... 4-24
  recall individual from a storage device ...... 9-43
  registers ............................................ 9-9
  save individual to disk ..................... 9-33
  storing ............................................ 9-28
Buses
  Swap Program and Preset ....................... 4-17
Buttons
  FLY KEY ................................................ 1-23
  KEY OVER ......................................... 5-19
  mnemonic displays ................................ 10-34
  press and hold .................................... 4-22
  programming a custom control button ...... 10-5
  ROLL VTR .......................................... 1-27, 1-29
  SHIFT .............................................. 4-23
  VTR CLIP .......................................... 1-27
Buttons, Next Transition ............................ 2-9, 2-11
Buttons, Transition Type ........................... 2-9, 2-11

C
Cabling the control panel .......................... 1-19, 1-31
Call Custom Control event ......................... 10-7
Camera Controller option, robotic .......... 1-28
CAT5 control panel cable ........................ 1-19
Cb gain .................................................. 11-6
CENTER, positioner ................................. 8-9, 8-10, 8-16
CG, definition ........................................... 1-5
Change Memory Name Menu ...................... 9-19
Change Name Menus, Keyboard ................. 9-19
Change Name Menus, Keyboard ................. 2-21
CHAR GEN
  button ............................................. 2-12, 7-10
  Key 2 group ....................................... 7-3
  programming ...................................... 8-12
Character Generator Interface option .......... 1-10
Chroma gain .......................................... 11-6
CHROMA KEY ............................................ 7-7
Chroma Key ............................................... 7-21, 7-26
  choosing a mode .................................. 7-26
  clip and gain .................................... 7-27, 7-32
  color map ........................................ 7-28, 7-29, 7-34
  creating, advanced mode .................... 7-26, 7-32
features ............................................................. 1-19
KEY MEM .......................................................... 7-42
knobs ................................................................. 7-20
lighting tips .......................................................... 7-42
memory .............................................................. 1-19, 7-42
setup menu, advanced ......................................... 7-32
setup menu, basic .................................................. 7-27
shadow ................................................................. 7-36
Classic wipes ....................................................... 6-13
Clean feed
  downstream keyers ............................................. 2-10
  outputs ................................................................ 1-14
Clean feed, also see FlexiClean
Clear Bus Hold .......................................................... 4-7
Clip
  adjust ................................................................ 7-22
  delegate keypad .................................................. 4-10
  Digicart .................................................................. 9-9
  recall audio server register ................................... 9-13, 9-14
  recall video server register .................................... 9-13, 9-14
  recall VTR register .............................................. 9-13, 9-14
  VTR and server .................................................... 9-8
Clip and Gain, AuxKeys ......................................... 7-66
CLIP knob ............................................................... 7-20
Clipping .................................................................. 11-5
COLOR
  BKGD 1 .................................................................. 4-23, 6-26
  BKGD 2 .................................................................. 4-23, 6-26
Color
  knobs, matte .......................................................... 6-20
  map .................................................................. 7-28, 7-29, 7-34
  scheme ................................................................ 2-22
  wash .................................................................. 6-20
Color Map
  Ultra Chrome ......................................................... 7-29
Continuous Pattern Rotation ................................ 6-11
Continuous rotation knobs ....................................... 4-32
Contrast, adjust display .......................................... 3-7
Conventions, documentation .................................. 1-3
Creating
  color background colors ....................................... 6-25
  matte fill and pattern border colors ................................ 6-25
  washes ................................................................ 6-22
Creating Custom Controls, tips ................................ 10-7
Crosspoints
  buttons ................................................................ 4-22
  press and hold ....................................................... 4-22
  re-entry ............................................................... 4-33
  SHIFT .................................................................. 4-23
Custom control
  bank functions .................................................... 10-3
  control panel functions ....................................... 10-3
  deleting functions from buttons ................................ 10-4
  Digicart clips ....................................................... 10-3
  editing functions .................................................. 10-4
  group .................................................................. 2-8, 10-2
  group, Synergy 2, 3, 4 ........................................... 10-2
  naming functions .................................................. 10-4
  PIP-II protocol functions ....................................... 10-4
  recall individual from a storage device ..................... 9-39
  registers .............................................................. 9-9, 9-28
  save individual ...................................................... 9-30
  saving and recalling functions ................................ 10-4
  Server functions ................................................... 10-3
  special functions .................................................. 10-4
  time clock functions ............................................. 10-4
  VTR functions ..................................................... 10-3
Custom Controls
  Active MLE Transition ........................................... 10-18
  Automation .......................................................... 10-18
  automation function .............................................. 10-17
  buffer status .......................................................... 10-5
  cancel recording .................................................... 1-3, 10-6, 10-10
  control panel functions ......................................... 10-5
  copying ................................................................. 10-4, 10-41
  cut keys ................................................................ 10-20
  deleting macros ..................................................... 10-42
  editing macros ....................................................... 10-36
  finish recording ..................................................... 10-6, 10-10
  Go To Menu .......................................................... 10-19
  go to menu ........................................................... 10-18
  Go To Start ............................................................ 10-36
  Hold ................................................................. 10-26
  hold function .......................................................... 10-25
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acronyms</td>
<td></td>
</tr>
<tr>
<td>Cut</td>
<td>5-4, 7-11</td>
</tr>
<tr>
<td>Cut button</td>
<td>5-8, 7-11</td>
</tr>
<tr>
<td>Cut soft</td>
<td>5-11</td>
</tr>
<tr>
<td>Cut to black</td>
<td>4-39</td>
</tr>
<tr>
<td>Cut using</td>
<td>5-10</td>
</tr>
<tr>
<td>Cut with fader off limit</td>
<td>7-71</td>
</tr>
<tr>
<td>Cycle Max, Mem Bank</td>
<td>4-11</td>
</tr>
<tr>
<td>Digital</td>
<td></td>
</tr>
<tr>
<td>Digital inputs</td>
<td>1-11</td>
</tr>
<tr>
<td>Disk</td>
<td></td>
</tr>
<tr>
<td>format USB</td>
<td>9-44</td>
</tr>
<tr>
<td>recall individual S&amp;T MD sequences</td>
<td>9-41</td>
</tr>
<tr>
<td>save custom control macros</td>
<td>10-43</td>
</tr>
<tr>
<td>save individual Bus Map</td>
<td>9-33</td>
</tr>
<tr>
<td>save individual S&amp;T MD Sequence</td>
<td>9-32</td>
</tr>
<tr>
<td>store menu</td>
<td>9-28, 9-32, 9-34, 9-42, 9-44</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>adjust contrast</td>
<td>3-7</td>
</tr>
<tr>
<td>fade to black</td>
<td>4-39</td>
</tr>
<tr>
<td>global memory system</td>
<td>9-4</td>
</tr>
<tr>
<td>manual and automatic</td>
<td>3-2</td>
</tr>
<tr>
<td>system control</td>
<td>3-2</td>
</tr>
<tr>
<td>transition rate</td>
<td>5-2, 5-6</td>
</tr>
<tr>
<td>Displays and Indicators</td>
<td>1-18</td>
</tr>
<tr>
<td>DISS</td>
<td>5-4, 5-8</td>
</tr>
<tr>
<td>Dissolve</td>
<td>5-11</td>
</tr>
<tr>
<td>Documentation</td>
<td></td>
</tr>
<tr>
<td>conventions</td>
<td>1-3</td>
</tr>
<tr>
<td>related publications</td>
<td>1-6</td>
</tr>
<tr>
<td>terms</td>
<td>1-4</td>
</tr>
<tr>
<td>Door, frame</td>
<td>2-28</td>
</tr>
<tr>
<td>Double Click Rate</td>
<td>4-7</td>
</tr>
<tr>
<td>Downstream Key</td>
<td></td>
</tr>
<tr>
<td>assigning sources</td>
<td>7-53</td>
</tr>
<tr>
<td>FLY KEY</td>
<td>7-50</td>
</tr>
<tr>
<td>key bus</td>
<td>7-50</td>
</tr>
<tr>
<td>key type selection</td>
<td>7-53</td>
</tr>
<tr>
<td>notes</td>
<td>7-50</td>
</tr>
<tr>
<td>performing</td>
<td>7-50</td>
</tr>
<tr>
<td>section</td>
<td>2-10</td>
</tr>
<tr>
<td>setup menu</td>
<td>7-51</td>
</tr>
<tr>
<td>transitions</td>
<td>7-52</td>
</tr>
<tr>
<td>Downstream Keyer 1 and 2</td>
<td>7-58</td>
</tr>
<tr>
<td>Downstream Keyer 3 and 4</td>
<td>7-56, 7-57</td>
</tr>
<tr>
<td>DSK</td>
<td></td>
</tr>
<tr>
<td>auto cut mode</td>
<td>4-8</td>
</tr>
<tr>
<td>definition</td>
<td>1-5</td>
</tr>
<tr>
<td>external, system option</td>
<td>1-22</td>
</tr>
<tr>
<td>grab both</td>
<td>7-54</td>
</tr>
<tr>
<td>installation menu</td>
<td>7-12</td>
</tr>
<tr>
<td>Digital</td>
<td></td>
</tr>
<tr>
<td>system</td>
<td>1-7</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>1-11</td>
</tr>
<tr>
<td>Disk</td>
<td></td>
</tr>
<tr>
<td>format USB</td>
<td>9-44</td>
</tr>
<tr>
<td>recall individual S&amp;T MD sequences</td>
<td>9-41</td>
</tr>
<tr>
<td>save custom control macros</td>
<td>10-43</td>
</tr>
<tr>
<td>save individual Bus Map</td>
<td>9-33</td>
</tr>
<tr>
<td>save individual S&amp;T MD Sequence</td>
<td>9-32</td>
</tr>
<tr>
<td>store menu</td>
<td>9-28, 9-32, 9-34, 9-42, 9-44</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>adjust contrast</td>
<td>3-7</td>
</tr>
<tr>
<td>fade to black</td>
<td>4-39</td>
</tr>
<tr>
<td>global memory system</td>
<td>9-4</td>
</tr>
<tr>
<td>manual and automatic</td>
<td>3-2</td>
</tr>
<tr>
<td>system control</td>
<td>3-2</td>
</tr>
<tr>
<td>transition rate</td>
<td>5-2, 5-6</td>
</tr>
<tr>
<td>Displays and Indicators</td>
<td>1-18</td>
</tr>
<tr>
<td>DISS</td>
<td>5-4, 5-8</td>
</tr>
<tr>
<td>Dissolve</td>
<td>5-11</td>
</tr>
<tr>
<td>Documentation</td>
<td></td>
</tr>
<tr>
<td>conventions</td>
<td>1-3</td>
</tr>
<tr>
<td>related publications</td>
<td>1-6</td>
</tr>
<tr>
<td>terms</td>
<td>1-4</td>
</tr>
<tr>
<td>Door, frame</td>
<td>2-28</td>
</tr>
<tr>
<td>Double Click Rate</td>
<td>4-7</td>
</tr>
<tr>
<td>Downstream Key</td>
<td></td>
</tr>
<tr>
<td>assigning sources</td>
<td>7-53</td>
</tr>
<tr>
<td>FLY KEY</td>
<td>7-50</td>
</tr>
<tr>
<td>key bus</td>
<td>7-50</td>
</tr>
<tr>
<td>key type selection</td>
<td>7-53</td>
</tr>
<tr>
<td>notes</td>
<td>7-50</td>
</tr>
<tr>
<td>performing</td>
<td>7-50</td>
</tr>
<tr>
<td>section</td>
<td>2-10</td>
</tr>
<tr>
<td>setup menu</td>
<td>7-51</td>
</tr>
<tr>
<td>transitions</td>
<td>7-52</td>
</tr>
<tr>
<td>Downstream Keyer 1 and 2</td>
<td>7-58</td>
</tr>
<tr>
<td>Downstream Keyer 3 and 4</td>
<td>7-56, 7-57</td>
</tr>
<tr>
<td>DSK</td>
<td></td>
</tr>
<tr>
<td>auto cut mode</td>
<td>4-8</td>
</tr>
<tr>
<td>definition</td>
<td>1-5</td>
</tr>
<tr>
<td>external, system option</td>
<td>1-22</td>
</tr>
<tr>
<td>grab both</td>
<td>7-54</td>
</tr>
<tr>
<td>installation menu</td>
<td>7-12</td>
</tr>
<tr>
<td>Digital</td>
<td></td>
</tr>
<tr>
<td>system</td>
<td>1-7</td>
</tr>
<tr>
<td>Digital inputs</td>
<td>1-11</td>
</tr>
<tr>
<td>Disk</td>
<td></td>
</tr>
<tr>
<td>format USB</td>
<td>9-44</td>
</tr>
<tr>
<td>recall individual S&amp;T MD sequences</td>
<td>9-41</td>
</tr>
<tr>
<td>save custom control macros</td>
<td>10-43</td>
</tr>
<tr>
<td>save individual Bus Map</td>
<td>9-33</td>
</tr>
<tr>
<td>save individual S&amp;T MD Sequence</td>
<td>9-32</td>
</tr>
<tr>
<td>store menu</td>
<td>9-28, 9-32, 9-34, 9-42, 9-44</td>
</tr>
<tr>
<td>Display</td>
<td></td>
</tr>
<tr>
<td>adjust contrast</td>
<td>3-7</td>
</tr>
<tr>
<td>fade to black</td>
<td>4-39</td>
</tr>
<tr>
<td>global memory system</td>
<td>9-4</td>
</tr>
<tr>
<td>manual and automatic</td>
<td>3-2</td>
</tr>
<tr>
<td>system control</td>
<td>3-2</td>
</tr>
<tr>
<td>transition rate</td>
<td>5-2, 5-6</td>
</tr>
<tr>
<td>Displays and Indicators</td>
<td>1-18</td>
</tr>
<tr>
<td>DISS</td>
<td>5-4, 5-8</td>
</tr>
<tr>
<td>Dissolve</td>
<td>5-11</td>
</tr>
<tr>
<td>Documentation</td>
<td></td>
</tr>
<tr>
<td>conventions</td>
<td>1-3</td>
</tr>
<tr>
<td>related publications</td>
<td>1-6</td>
</tr>
<tr>
<td>terms</td>
<td>1-4</td>
</tr>
<tr>
<td>Door, frame</td>
<td>2-28</td>
</tr>
<tr>
<td>Double Click Rate</td>
<td>4-7</td>
</tr>
<tr>
<td>Downstream Key</td>
<td></td>
</tr>
<tr>
<td>assigning sources</td>
<td>7-53</td>
</tr>
<tr>
<td>FLY KEY</td>
<td>7-50</td>
</tr>
<tr>
<td>key bus</td>
<td>7-50</td>
</tr>
<tr>
<td>key type selection</td>
<td>7-53</td>
</tr>
<tr>
<td>notes</td>
<td>7-50</td>
</tr>
<tr>
<td>performing</td>
<td>7-50</td>
</tr>
<tr>
<td>section</td>
<td>2-10</td>
</tr>
<tr>
<td>setup menu</td>
<td>7-51</td>
</tr>
<tr>
<td>transitions</td>
<td>7-52</td>
</tr>
<tr>
<td>Downstream Keyer 1 and 2</td>
<td>7-58</td>
</tr>
<tr>
<td>Downstream Keyer 3 and 4</td>
<td>7-56, 7-57</td>
</tr>
<tr>
<td>DSK</td>
<td></td>
</tr>
<tr>
<td>auto cut mode</td>
<td>4-8</td>
</tr>
<tr>
<td>definition</td>
<td>1-5</td>
</tr>
<tr>
<td>external, system option</td>
<td>1-22</td>
</tr>
<tr>
<td>grab both</td>
<td>7-54</td>
</tr>
<tr>
<td>installation menu</td>
<td>7-12</td>
</tr>
<tr>
<td>Topic</td>
<td>Page(s)</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>isolate</td>
<td>4-9</td>
</tr>
<tr>
<td>key bus</td>
<td>7-12</td>
</tr>
<tr>
<td>key groups</td>
<td>7-4</td>
</tr>
<tr>
<td>lock/unlock crosspoints</td>
<td>7-55</td>
</tr>
<tr>
<td>rate, global memory system group</td>
<td>9-8</td>
</tr>
<tr>
<td>setup menu</td>
<td>7-54, 7-55, 7-62</td>
</tr>
<tr>
<td>setup source bus</td>
<td>7-53</td>
</tr>
<tr>
<td>show DSK1/DSK2</td>
<td>7-54</td>
</tr>
<tr>
<td>source reveal</td>
<td>7-51</td>
</tr>
<tr>
<td>split key</td>
<td>7-47, 7-48</td>
</tr>
<tr>
<td>store setup</td>
<td>7-54</td>
</tr>
<tr>
<td>DSK 1</td>
<td>5-6, 7-13, 7-18</td>
</tr>
<tr>
<td>DSK 2</td>
<td>5-7, 7-13, 7-18</td>
</tr>
<tr>
<td>DSK auto cut</td>
<td>4-8</td>
</tr>
<tr>
<td>DSK, MultiDSK</td>
<td>7-56</td>
</tr>
<tr>
<td>Dual Border Generator</td>
<td>1-25</td>
</tr>
<tr>
<td>BORD button</td>
<td>7-9, 8-8</td>
</tr>
<tr>
<td>control section</td>
<td>7-20</td>
</tr>
<tr>
<td>DVE</td>
<td></td>
</tr>
<tr>
<td>button</td>
<td>2-7, 6-4</td>
</tr>
<tr>
<td>definition</td>
<td>1-5</td>
</tr>
<tr>
<td>send and remote control option</td>
<td>2-7</td>
</tr>
<tr>
<td>DVE SEND</td>
<td>5-4, 5-8</td>
</tr>
<tr>
<td>DVR, definition</td>
<td>1-5</td>
</tr>
<tr>
<td>Editing control functions</td>
<td>10-4</td>
</tr>
<tr>
<td>EDITOR</td>
<td>9-8</td>
</tr>
<tr>
<td>Editor interface</td>
<td>9-8</td>
</tr>
<tr>
<td>Editor Interface option</td>
<td>1-27</td>
</tr>
<tr>
<td>Editors</td>
<td></td>
</tr>
<tr>
<td>Trans Rate, Personality setting</td>
<td>4-8</td>
</tr>
<tr>
<td>EFF DISS</td>
<td>9-5, 9-13, 9-14, 9-20, 9-21</td>
</tr>
<tr>
<td>Effects</td>
<td></td>
</tr>
<tr>
<td>control assignment section</td>
<td>7-17</td>
</tr>
<tr>
<td>control group</td>
<td>2-13, 7-15</td>
</tr>
<tr>
<td>dissolve</td>
<td>9-5, 9-20, 9-21</td>
</tr>
<tr>
<td>recall from a storage device</td>
<td>9-35</td>
</tr>
<tr>
<td>save to a storage device</td>
<td>9-27</td>
</tr>
<tr>
<td>Effects Dissolve</td>
<td></td>
</tr>
<tr>
<td>behavior table</td>
<td>9-23</td>
</tr>
<tr>
<td>using Auto Recall</td>
<td>9-21</td>
</tr>
<tr>
<td>Effects, pre-built</td>
<td>1-24</td>
</tr>
<tr>
<td>End stop knobs, re-synchronize</td>
<td>4-32, 6-6</td>
</tr>
<tr>
<td>End-of-life disposal</td>
<td>1-viii</td>
</tr>
<tr>
<td>ENTER</td>
<td>9-6</td>
</tr>
<tr>
<td>Environmental Information</td>
<td>1-viii</td>
</tr>
<tr>
<td>Event memory system</td>
<td>1-17</td>
</tr>
<tr>
<td>Extended Tallies option</td>
<td>1-30</td>
</tr>
<tr>
<td>Extra Effects Processor, XFX</td>
<td>1-25</td>
</tr>
</tbody>
</table>

**F**

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>FADE</td>
<td>4-39</td>
</tr>
<tr>
<td>button</td>
<td>4-39</td>
</tr>
<tr>
<td>cut with off limit</td>
<td>7-71</td>
</tr>
<tr>
<td>displays</td>
<td>5-6</td>
</tr>
<tr>
<td>operations</td>
<td>5-2, 5-6</td>
</tr>
<tr>
<td>section</td>
<td>5-2, 5-6</td>
</tr>
<tr>
<td>Favorite CG</td>
<td>7-10</td>
</tr>
<tr>
<td>button</td>
<td>7-10</td>
</tr>
<tr>
<td>CHAR GEN</td>
<td>7-10, 8-12</td>
</tr>
<tr>
<td>programming</td>
<td>8-12</td>
</tr>
<tr>
<td>Features</td>
<td></td>
</tr>
<tr>
<td>control panel</td>
<td>1-10</td>
</tr>
<tr>
<td>copy function</td>
<td>1-13</td>
</tr>
<tr>
<td>custom control macros</td>
<td>1-17</td>
</tr>
<tr>
<td>displays and indicators</td>
<td>1-18</td>
</tr>
<tr>
<td>event memory system</td>
<td>1-17</td>
</tr>
<tr>
<td>FlexiClean</td>
<td>1-14</td>
</tr>
<tr>
<td>Global-Store</td>
<td>1-12</td>
</tr>
<tr>
<td>keyboard port</td>
<td>1-17</td>
</tr>
<tr>
<td>matte generators</td>
<td>1-13</td>
</tr>
<tr>
<td>outputs, configurable serial digital</td>
<td>1-11</td>
</tr>
<tr>
<td>pattern generators</td>
<td>1-13</td>
</tr>
<tr>
<td>preview overlay</td>
<td>1-15</td>
</tr>
<tr>
<td>reference input</td>
<td>1-12</td>
</tr>
<tr>
<td>serial digital inputs</td>
<td>1-11</td>
</tr>
<tr>
<td>serial digital outputs</td>
<td>1-11</td>
</tr>
<tr>
<td>swap function</td>
<td>1-13</td>
</tr>
<tr>
<td>File disk icons</td>
<td>9-32, 9-34, 9-42</td>
</tr>
<tr>
<td>Fill</td>
<td></td>
</tr>
<tr>
<td>matte</td>
<td>7-8</td>
</tr>
<tr>
<td>signal</td>
<td>7-2</td>
</tr>
<tr>
<td>FlexiClean</td>
<td>7-13</td>
</tr>
<tr>
<td>features</td>
<td>1-14</td>
</tr>
<tr>
<td>menu</td>
<td>7-13</td>
</tr>
<tr>
<td>MultiDSK</td>
<td>7-13, 7-14</td>
</tr>
<tr>
<td>FLIP FLOP button</td>
<td>6-5</td>
</tr>
<tr>
<td>Flip-flop, operation</td>
<td>4-26</td>
</tr>
<tr>
<td>Floppy disk drive</td>
<td>1-17</td>
</tr>
<tr>
<td>Flow of video through the switcher</td>
<td>2-14</td>
</tr>
<tr>
<td>Fly Key</td>
<td>8-7</td>
</tr>
<tr>
<td>FLY KEY button</td>
<td>7-9</td>
</tr>
<tr>
<td>FLY KEY1, positioner</td>
<td>8-17</td>
</tr>
</tbody>
</table>
FORCE ................................................................. 7-19
Frame
boards menu ............................................... 3-12
installing the frame door ......................... 2-28
power fail LED ........................................ 4-3
power supply ............................................. 1-30
size ............................................................... 1-7
spare parts kit .............................................. 1-31
FTB display mode ........................................ 4-8
Full
reset ......................................................... 2-23
software reset ............................................ 2-25

G
Gain
Cb ............................................................... 11-6
chroma ...................................................... 11-6
Ct ............................................................... 11-6
lum ............................................................ 11-6
overall ......................................................... 11-6
GAIN knob .................................................. 7-20
Ganged Audio Mixers Option ..................... 1-28
General Purpose Interface, see GPI
Global memory system group
display ............................................................. 9-4
features .......................................................... 9-2
functions ......................................................... 2-6
include section ............................................. 9-8
keypad ............................................................ 9-6
recall section ............................................... 9-4
remote section ............................................. 9-8
store section .................................................. 9-7
Synergy 1 ...................................................... 9-4
Synergy 2 ...................................................... 9-3
Synergy 3 ...................................................... 9-3
Synergy 4 ...................................................... 9-2
Global-Store .................................................. 1-8, 1-12, 1-20
Memory Recall Mode, Personality ............... 4-13
GLOW
knob ............................................................. 7-20
positioner .................................................... 8-9, 8-11
Glow, border ................................................. 8-9, 8-10
Go to menu, custom control ....................... 10-18
Go To Start, custom controls ...................... 10-36
GPI
description
global memory system group ....................... 9-8
inputs .......................................................... 1-18
outputs ......................................................... 1-18
reset outputs via custom control ................ 10-14
trigger outputs via custom control ............... 10-15
Grab both DSKs ............................................ 7-54

Group
aux bus ......................................................... 2-8
background/preset transition ..................... 2-9
custom control ............................................. 2-8
downstream key .......................................... 7-4
downstream keyers ...................................... 2-10
effects control ............................................. 2-13, 7-15
fade to black .............................................. 2-10
global memory system ............................... 2-6, 9-2
key 1 ............................................................ 7-3
key 2 ............................................................ 7-3
matte .......................................................... 6-17, 6-24
matte control .............................................. 2-13
MLE key 1 .................................................... 2-12
MLE key 2 .................................................... 2-12
MLE keys ..................................................... 7-4
MLE memory ............................................... 2-13
MLE transition .......................................... 2-11
pattern control ......................................... 2-7, 6-2
positioner ................................................. 2-10, 8-9, 8-10
preview bus .............................................. 4-35
preview overlay ......................................... 2-10, 9-9
program/preset transition ......................... 2-9
system control ........................................... 2-6

H
Half MLE ....................................................... 1-12
Hard disk drive .......................................... 1-17
HD, definition ............................................. 1-5
Help
features ....................................................... 3-8
menu ............................................................ 3-8
more info menu .......................................... 3-8
pop-up ......................................................... 3-8
Highlights
AuxKeys ...................................................... 1-9
compact size ............................................. 1-7
compatibility ............................................. 1-10
ethernet ....................................................... 1-8
MD input matrix ......................................... 1-7
MD-X input matrix ....................................... 1-7
Media-Cache ............................................. 1-8
MLEs ......................................................... 1-9
mnemonics ............................................... 1-8
multi-definition ......................................... 1-7
MultiDSK .................................................... 1-9
Squeeze & Tease MD ................................. 1-8
Still-Store .................................................. 1-8
UltraChrome ............................................... 1-8
HMULT ......................................................... 6-5
Hold CC ...................................................... 10-25
Hold, inserting in custom control ............... 10-25
HSL ............................................................. 6-24
HUE
  knob ...........................................6-20, 7-20
  wash ........................................7-24

I
Icon
  disk file ..........................................9-32, 9-34, 9-42
  Disk Store menu ..................................9-28
  positioner ........................................3-6, 8-15, 8-16
  ID, definition .....................................1-5
  INCL DVE ........................................9-8
Include
  ATTRIB ........................................9-8, 9-12, 9-14
  INCL DVE .........................................9-8
  KEYS ONLY ......................................9-5
  section ..........................................9-8
Indicators
  arrow down ......................................5-2, 5-6
  arrow up .........................................5-2, 5-6
  bus LEDs .........................................4-30
  key control ......................................4-28, 4-31
  N/S .................................................4-30, 4-31
  ON AIR ..........................................4-30
  tally .............................................4-30
Inputs
  reference ........................................1-12
  serial digital, optional .......................1-19
Insert
  events, custom controls .......................10-38
  PIP-II ..........................................10-30
  special .........................................10-6, 10-10
  special functions, custom controls ..........10-14
  special menu 2 ..................................10-14, 10-16
  time clock menu ................................10-12
Insert Special, Automation .....................10-18
Insert Special, CC Hold ..........................10-26
Insert Special, Go To Menu ....................10-19
Insert Special, Pause CC ........................10-28
Insert Special, Safe Title .......................10-24
Insert Special, Trans Keys ......................10-21
Installation
  menu, DSK ......................................7-12
  registers .......................................9-9
  registers, storing .............................9-28
  serial numbers ..................................3-10
Installed
  frame and option boards .......................3-12
  options menu 1 ..................................3-10
  panel boards ....................................3-11
  software options ..............................3-10
Introduction to keying ..........................7-2
INVERT ............................................7-20

Invert
  keys ..............................................7-9
  mask .............................................7-20
  using ...........................................8-6

K
KEY
  assignment button ..............................2-9
  bus ..............................................2-8, 4-28, 4-29
  MASKING ..........................................8-3
  MEM, auto select key .........................7-24
  MEM, chroma key ..............................7-42
  OVER ........................................2-12, 5-4, 5-8, 5-19, 7-3, 7-10
  PV ..............................................7-10
  rate, global memory system group ..........9-7, 9-8
Key
  adjust border color ..........................6-20
  adjust hue ......................................7-20
  adjust reject ..................................7-20
  adjust suppress ................................7-20
  adjusting clip and gain .......................7-22
  adjusting transparency .......................7-22, 7-24
  assignment button ............................2-9
  Auto Select ....................................7-21
  auto select ....................................7-6
  basic rules ....................................7-2
  border .........................................7-9, 8-8
  border off .....................................7-10, 8-8
  bus .............................................2-8, 2-9
  bus control ....................................4-28, 4-29, 4-31
  bus ON AIR .....................................4-28, 4-29
  bus section, DSK ...............................7-12
  bus selection buttons .........................4-29
  bus, bright and dim ...........................4-28
  bus, downstream ................................7-50
  Chroma ..........................................7-21
  chroma ..........................................7-7
  clip ...............................................7-20
  control LEDs ...................................4-28, 4-31
  control section ................................7-20
  cut ...............................................7-11
  cut with fader off limit .....................7-71
  dissolve ........................................7-11
  DSK split ........................................7-47, 7-48
  functions .......................................7-6
  gain .............................................7-20
  group 1 .........................................7-3
  group 2 .........................................7-3
  group basics ....................................7-2
  introduction to ................................7-2
  invert ..........................................7-9
  layer ............................................7-2
  mask .............................................7-9
mask section ...................................................... 7-18
matte fill ............................................................ 7-8
memory ............................................................... 7-8
modifier section 1 .................................................... 7-8
modifier section 2 .................................................... 7-9
modifier section, DSK .................................................. 7-12
modifiers, using .................................................... 8-2
outline ................................................................. 7-10, 8-8
performing a chroma key ........................................ 7-26
performing a downstream key ..................................... 7-50
performing a preset pattern key ................................. 7-44
performing a self key .............................................. 7-21
performing a split key .............................................. 7-47
performing a split video ............................................ 7-48
performing an auto select key ..................................... 7-23
Preset Pattern ..................................................... 7-21
preset pattern .......................................................... 7-7
preview section ...................................................... 7-10
priority ................................................................. 7-10
Reverse Key Shift Mode ........................................... 4-24
self ................................................................. 7-6, 7-21
shadow ............................................................... 7-9, 8-8
signal ................................................................. 7-2
transition section .................................................... 7-11
transition with custom control .................................. 10-20
transitions ........................................................... 7-23
type ................................................................. 2-10
type section .......................................................... 7-6
type selection, DSK .................................................. 7-53
using .............................................................. 7-21
using fly key .......................................................... 8-7
using invert ........................................................... 8-6
using matte fill ...................................................... 8-2
KEY 1 .................................................................. 5-3, 5-6
KEY 1, effects control group ..................................... 7-18
KEY 2 .................................................................. 5-3, 5-7
KEY 2, effects control group ..................................... 7-18
Key alpha source, selecting ....................................... 7-2
Key Cut then Fade ................................................... 4-9
KEY INV ............................................................... 7-9
KEY MEM ............................................................. 7-8
Key over ................................................................ 5-19
Key Rate, Aux .......................................................... 7-67
Key sequences ......................................................... 1-24
Keyboard
  Change Name Menu .................................................. 2-21
  System Control Menus .......................................... 2-20, 3-5
Keyboard port ............................................................ 1-17
Keyboard to Panel Key equivalents ................................ 2-21
Keyer Rate
  Vision 2 .............................................................. 5-14
Keys ................................................................. 1-12
  Key Cut then Fade .................................................. 4-9
  Swap Cut and Auto ................................................. 4-16
Keyframe programming ............................................. 9-21
Keypad ................................................................ 9-6
Keys Off Air, Custom Control .................................... 10-18
KEYS ONLY ......................................................... 9-5, 9-13, 9-14
Knob
  BOTTOM ............................................................ 7-19
  CLIP .............................................................. 7-20
  DENSITY .......................................................... 7-20
  GAIN ............................................................. 7-20
  GLOW ............................................................ 7-20
  HUE ............................................................... 7-20
  LEFT ............................................................... 7-19
  REJECT ............................................................ 7-20
  RIGHT ............................................................. 7-19
  SUPPRESS ......................................................... 7-20
  TOP ................................................................. 7-19
  WIDTH ............................................................. 7-20
Knobs
  continuous rotation ................................................ 4-32
  end stop ............................................................. 4-32, 6-6
  hierarchy ............................................................ 3-4
  re-synchronize ...................................................... 4-32, 6-6
  scroll ................................................................. 3-4
  types of ............................................................ 4-32

L
Label area .............................................................. 3-4
Large display menu .................................................. 3-7
Layer .................................................................. 7-2
LCD screen ............................................................ 2-6, 3-2
LED
  ACTIVE ............................................................. 5-3, 5-6, 5-12
  ACTIVE states ....................................................... 5-13
  indicators ............................................................ 4-30
  N/S ............................................................... 2-7, 2-8, 2-10
  N/S, key ............................................................. 7-11
  ON AIR .......................................................... 2-7, 2-8, 2-10
  ON, key ............................................................. 7-10
LED indicator
  frame ................................................................. 4-3
  Panel ................................................................. 4-3
  Power Fail ........................................................... 4-3
  LEFT knob ........................................................... 7-19
  Lighting .............................................................. 1-23
  Lighting tips for Chroma Key ................................... 7-42
  Limit, Matte ......................................................... 4-11
  Limit, Transition .................................................... 5-20
  Lock memory
    feature ............................................................. 9-16
    global memory group ........................................ 9-17
    name memories menu ........................................ 9-18
  LOCK MENU ......................................................... 3-5
  Lock/Unlock DSK crosspoints .................................. 7-55
  Log OverDrive Messages, Personality ........................... 4-30
  Look Ahead Preview ............................................. 4-37
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Looping Custom Controls</td>
<td>10-7</td>
</tr>
<tr>
<td>lowable</td>
<td>11-6</td>
</tr>
<tr>
<td>LUM</td>
<td>6-20</td>
</tr>
<tr>
<td>Luminance</td>
<td>11-6</td>
</tr>
<tr>
<td>matte</td>
<td>6-20</td>
</tr>
<tr>
<td>wash</td>
<td>6-24</td>
</tr>
<tr>
<td>Macro</td>
<td>2-8</td>
</tr>
<tr>
<td>Macro, See Custom control</td>
<td></td>
</tr>
<tr>
<td>Macros</td>
<td></td>
</tr>
<tr>
<td>custom control, editing</td>
<td>10-36</td>
</tr>
<tr>
<td>Main</td>
<td></td>
</tr>
<tr>
<td>area</td>
<td>3-3</td>
</tr>
<tr>
<td>menu, software version</td>
<td>3-3</td>
</tr>
<tr>
<td>Manual transitions</td>
<td>5-9</td>
</tr>
<tr>
<td>MASK</td>
<td></td>
</tr>
<tr>
<td>button</td>
<td>7-9</td>
</tr>
<tr>
<td>keys</td>
<td>8-3</td>
</tr>
<tr>
<td>Mask</td>
<td></td>
</tr>
<tr>
<td>Box</td>
<td>8-3</td>
</tr>
<tr>
<td>force</td>
<td>7-19</td>
</tr>
<tr>
<td>invert</td>
<td>7-20</td>
</tr>
<tr>
<td>Pattern</td>
<td>8-4</td>
</tr>
<tr>
<td>section</td>
<td>7-18</td>
</tr>
<tr>
<td>Utility Bus</td>
<td>8-5</td>
</tr>
<tr>
<td>Matrix</td>
<td></td>
</tr>
<tr>
<td>wipe, adjust</td>
<td>6-9</td>
</tr>
<tr>
<td>wipes</td>
<td>6-14</td>
</tr>
<tr>
<td>Matrix Tile Size</td>
<td>6-9</td>
</tr>
<tr>
<td>Matrix wipe</td>
<td>6-5</td>
</tr>
<tr>
<td>Matte</td>
<td></td>
</tr>
<tr>
<td>assign MLE</td>
<td>6-18</td>
</tr>
<tr>
<td>assignment section</td>
<td>6-18</td>
</tr>
<tr>
<td>BKGD 1 KEY 1</td>
<td>6-19</td>
</tr>
<tr>
<td>BKGD 2 KEY 2</td>
<td>6-19</td>
</tr>
<tr>
<td>BORD 1</td>
<td>6-20</td>
</tr>
<tr>
<td>BORD 2</td>
<td>6-20</td>
</tr>
<tr>
<td>color knobs</td>
<td>6-20</td>
</tr>
<tr>
<td>control group</td>
<td>2-13</td>
</tr>
<tr>
<td>creating color background colors</td>
<td>6-25</td>
</tr>
<tr>
<td>creating matte fill colors</td>
<td>6-25</td>
</tr>
<tr>
<td>creating pattern border colors</td>
<td>6-22</td>
</tr>
<tr>
<td>creating washes</td>
<td>6-22</td>
</tr>
<tr>
<td>destination section</td>
<td>6-19</td>
</tr>
<tr>
<td>fill, using</td>
<td>8-2</td>
</tr>
<tr>
<td>group</td>
<td>6-17</td>
</tr>
<tr>
<td>HUE</td>
<td>6-24</td>
</tr>
<tr>
<td>LUM</td>
<td>6-20</td>
</tr>
<tr>
<td>PATT</td>
<td>6-20</td>
</tr>
<tr>
<td>SAT</td>
<td>6-20</td>
</tr>
<tr>
<td>WASH 1</td>
<td>6-20</td>
</tr>
<tr>
<td>WASH 2</td>
<td>6-21</td>
</tr>
<tr>
<td>wash menu</td>
<td>6-22</td>
</tr>
<tr>
<td>wash section</td>
<td>6-20</td>
</tr>
<tr>
<td>MATTE FILL</td>
<td>7-8</td>
</tr>
<tr>
<td>Matte generators</td>
<td>1-13</td>
</tr>
<tr>
<td>Matte Limit</td>
<td>4-11</td>
</tr>
<tr>
<td>MD, definition</td>
<td>1-5</td>
</tr>
<tr>
<td>Media-Cache</td>
<td>1-8</td>
</tr>
<tr>
<td>MediaCache</td>
<td>1-20</td>
</tr>
<tr>
<td>Mem Bank Cycle Max</td>
<td>4-11</td>
</tr>
<tr>
<td>Memory</td>
<td></td>
</tr>
<tr>
<td>Bank 0 Lit</td>
<td>4-7</td>
</tr>
<tr>
<td>Bank Cycle Max</td>
<td>4-11</td>
</tr>
<tr>
<td>lock</td>
<td>9-16</td>
</tr>
<tr>
<td>lock, using global memory group</td>
<td>9-17</td>
</tr>
<tr>
<td>lock, using name memories menu</td>
<td>9-18</td>
</tr>
<tr>
<td>name memory registers</td>
<td>9-18</td>
</tr>
<tr>
<td>Memory BAD message</td>
<td>9-16</td>
</tr>
<tr>
<td>Memory LOCKED message</td>
<td>9-17</td>
</tr>
<tr>
<td>Memory registers</td>
<td></td>
</tr>
<tr>
<td>definition</td>
<td>9-9</td>
</tr>
<tr>
<td>recall individual from a storage device</td>
<td>9-37</td>
</tr>
<tr>
<td>recalling</td>
<td>9-12</td>
</tr>
<tr>
<td>recalling, global memory system</td>
<td>9-12</td>
</tr>
<tr>
<td>recalling, MLE memory group</td>
<td>9-14</td>
</tr>
<tr>
<td>save individual</td>
<td>9-28</td>
</tr>
<tr>
<td>storing</td>
<td>9-9, 9-28</td>
</tr>
<tr>
<td>storing, global memory system</td>
<td>9-10</td>
</tr>
<tr>
<td>storing, MLE memory group</td>
<td>9-11</td>
</tr>
<tr>
<td>MENU</td>
<td></td>
</tr>
<tr>
<td>function off</td>
<td>8-15</td>
</tr>
<tr>
<td>function on</td>
<td>8-15</td>
</tr>
<tr>
<td>positioner</td>
<td>8-16</td>
</tr>
<tr>
<td>Menu</td>
<td></td>
</tr>
<tr>
<td>attributes</td>
<td>9-18</td>
</tr>
<tr>
<td>auto select key setup</td>
<td>7-24</td>
</tr>
<tr>
<td>background color</td>
<td>6-25</td>
</tr>
<tr>
<td>border</td>
<td>7-20</td>
</tr>
<tr>
<td>change memory name</td>
<td>9-19</td>
</tr>
<tr>
<td>Change Name, Keyboard</td>
<td>2-21</td>
</tr>
<tr>
<td>chroma key setup, advanced</td>
<td>7-32</td>
</tr>
<tr>
<td>chroma key setup, basic</td>
<td>7-27</td>
</tr>
<tr>
<td>control buttons</td>
<td>3-4</td>
</tr>
<tr>
<td>custom control</td>
<td>10-36</td>
</tr>
<tr>
<td>disk</td>
<td>9-25</td>
</tr>
<tr>
<td>disk store</td>
<td>9-28, 9-32, 9-34, 9-42</td>
</tr>
<tr>
<td>downstream key setup</td>
<td>7-51</td>
</tr>
<tr>
<td>DSK installation</td>
<td>7-12</td>
</tr>
<tr>
<td>DSK setup</td>
<td>7-54, 7-55, 7-62</td>
</tr>
<tr>
<td>frame boards</td>
<td>3-12</td>
</tr>
<tr>
<td>go to, in custom control</td>
<td>10-18</td>
</tr>
<tr>
<td>help</td>
<td>3-8</td>
</tr>
<tr>
<td>HOME</td>
<td>3-4</td>
</tr>
<tr>
<td>insert Pbus</td>
<td>10-30</td>
</tr>
</tbody>
</table>
IX–10  • Index  Synergy Q/MD/X Operator’s Manual (v9.1 MD)
Synergy 1 .......................................................... 7-58
Synergy 2 .......................................................... 7-57
Synergy 3 and 4 .................................................... 7-56
Transparency ..................................................... 7-60
Multiple channels effects dissolve ...................... 9-23
Multiple Custom Controls ............................ 4-12, 10-7
 running ..................................................... 10-10

N

N/S
 indicators ............................................. 4-30, 4-31
 LED ............................................................. 2-7, 2-8, 2-10
 LED, key .......................................................... 7-11
 Name Memories Menu ...................................... 9-18
 Naming control functions ................................ 10-4
 Naming custom controls ................................... 10-32
 Network Still & Clip Server Option ................... 1-21
 Next transition
 buttons ................................................... 5-2, 5-12
 eight easy steps .......................................... 5-13
 section ............................................................ 5-6
 working with ....................................... 5-12
 Next Transition Buttons ................................. 2-9, 2-11
 Next Transition, MultiDSK ............................... 7-60
 Non-sync, indication ........................................ 4-30, 4-31
 NORM button ................................................ 6-5
 Normal/reverse direction wipe ......................... 6-5
 Notify End reverse control .............................. 10-14

O

Offset .................................................................. 11-6
ON AIR
 indicators ............................................. 4-30
 indicators during dissolve .................................. 5-11
 indicators during wipe ...................................... 6-9
 LED ............................................................. 2-7, 2-8, 2-10
 ON LED, key ................................................... 7-10
 Operations
 AuxKeys .................................................. 7-64
 before starting .............................................. 4-2
 crosspoints .................................................. 4-22
 cuts ............................................................... 5-10
 dissolves ...................................................... 5-11
 flip-flop ......................................................... 4-26
 MultiDSK ..................................................... 7-58
 next transition ............................................. 5-13
 preset black ............................................... 5-17
 re-entry ........................................................ 4-33
 Reverse Key Shift mode .................................. 4-24
 SHIFT .......................................................... 4-23
 switcher basics ............................................. 4-22
 wipes ............................................................ 6-8

Option
 3D Pattern Button Assign ............................... 4-19
 Audio mixer
   audio transition MLE assignment .................. 4-5
   audio server control .................................. 1-9
   character generator .................................... 1-10
   FTB Display Mode ...................................... 4-8
   mnemonics display .................................... 4-20
   Squeeze & Tease Mode .................................. 4-15
   Store Mode ................................................. 4-16

Options
 audio mixer, ganged .................................... 1-28
 audio mixer, large ........................................ 1-28
 audio mixer, small ....................................... 1-28
 audio server control .................................... 1-29
 AuxKeys ..................................................... 1-21, 7-64
 cable, control panel ..................................... 1-31
 cable, remote aux panel ................................ 1-27
 camera control ............................................. 1-28
 DVE send and remote control ......................... 2-7
 editor interface ........................................... 1-27, 9-8
 extended tallies ........................................... 1-30
 installed frame boards ................................... 3-12
 installed panel boards .................................... 3-11
 installed software ........................................ 3-10
 MediaCache .................................................. 1-20
 mnemonics ................................................... 1-17, 1-24
 MultiDSK ..................................................... 1-22
 network still & clip server ............................. 1-21
 peripheral bus II .......................................... 1-29
 preview overlay ........................................... 2-10, 10-4
 redundant power ............................................. 1-30
 remote aux panel ......................................... 1-25
 routing switcher .......................................... 1-28
 serial digital inputs ....................................... 1-19
 serial digital outputs ..................................... 1-20
 serial port expander, control panel .................. 1-20
 serial tally .................................................... 1-29
 spare parts ..................................................... 1-31
 Squeeze & Tease MD ........................................ 1-22
 still store ..................................................... 1-28
 video server control ....................................... 1-29
 VTR remote control ........................................ 1-27
 OUTL ....................................................... 7-10, 8-8
 Outline key .................................................. 7-10, 8-8

Outputs
 configurable serial digital ................................ 1-11
 serial digital, optional ................................... 1-20
 Overall Gain .................................................. 1-16
 OverDrive Roll VTR ........................................ 4-14
 Overlay
 SMPTE safe formats ........................................ 1-16
 source identification ........................................ 1-16
 VTR timecode ................................................. 1-16
Override, aux panel ............................................. 1-27
Overview .................................................................. 1-7

P
Panel boards menu ............................................... 3-11
Panel Key to Keyboard equivalents .......................... 2-21
Panel power fail LED ......................................... 4-3
Panel sleep time .................................................. 4-12
PATT
button ................................................................ 6-20
positioner .......................................................... 8-16
Pattern
adjustment section .............................................. 6-6
aspect ratio ........................................................ 6-6
assignment section ............................................ 6-4
border .................................................................. 6-6
control group .................................................... 2-7, 6-2
control groups .................................................... 6-2
direction section ............................................... 6-5
rotation and softness ........................................ 6-7
selection section ............................................... 6-5
user .................................................................... 6-5
wash .................................................................. 6-23
Pattern generators, features ............................ 1-13
Pattern Mask .................................................... 8-4
Pattern Parameters
Matrix Tile Size .................................................. 6-9
Rotation ............................................................. 6-11
continuous ...................................................... 6-11
transition ......................................................... 6-12
user .................................................................... 6-12
Wipe Modulation ................................................ 6-10
Pause, inserting in custom control ................... 10-28
Pbus Memory ....................................................... 4-13
Performing, AuxKeys ........................................ 7-65
Peripheral Bus II option .................................. 1-29
Personality
3D Pattern Button Assign option .................. 4-19
Audio Cut Only .................................................. 4-4
audio transition MLE assignment .................. 4-5
Auto Remove Key ............................................. 4-6
Bank 0 Lit .......................................................... 4-7
Clear Bus Hold .................................................. 4-7
clip entry .......................................................... 4-10
Double Click Rate ............................................ 4-7
DSK auto cut mode ........................................ 4-8
Editor Trans Rate .............................................. 4-8
FTB Display Mode ............................................. 4-8
isolate dsk ........................................................ 4-9
Key Cut then Fade ............................................ 4-9
keypad .............................................................. 4-10
Log OverDrive Messages ............................... 4-10
Matte Limit ....................................................... 4-11
Mem Bank Cycle Max ...................................... 4-11
menu .............................................................. 4-4, 5-3, 5-7
Multiple Custom Controls ............................. 4-12
panel sleep time ............................................... 4-12
Pbus Memory ..................................................... 4-13
Recall Global-Store Memory Mode ................. 4-13
Recall MLE-Store Memory Mode .................. 4-13
roll VTR mode ................................................ 4-14
Squeeze & Tease Mode .................................. 4-15
Standard Mnemonics option ......................... 4-20
store mode option ........................................... 4-16
Swap Program and Preset ............................ 4-17
UltraChrome
default color .................................................... 4-18
default mode .................................................... 4-18
wakeup on command ...................................... 4-19
Personality Menu .............................................. 4-4
Personality registers
description .................................................... 9-9
storing ........................................................... 9-28
PGM
bus ............................................................... 2-7, 2-9
definition ........................................................ 1-5
MLE ............................................................... 1-12
PIP-II
custom controls ............................................ 10-30
PIP-II protocol custom control functions ......... 10-4
Planar Controls, advanced ......................... 1-24
Planar Transforms ........................................ 1-23
Play mode, ROLL VTR ................................. 1-27, 1-29, 4-14
Pop-up Help .................................................. 3-8
Position border .............................................. 8-9, 8-10
Positioner
3-axis ........................................................... 8-15
assignment section ........................................ 8-14
CENTER ....................................................... 8-16
FLY KEY 1 .................................................... 8-17
function ......................................................... 8-12
function section 1 ........................................... 8-16
function section 2 .......................................... 8-15, 8-16
group .......................................................... 2-10, 8-9, 8-10
icon, circular .................................................. 3-6, 8-16
icon, left-right ............................................... 3-6, 8-16
icon, up-down ................................................ 3-6, 8-16
icons ............................................................. 3-4, 3-6, 8-15
MENU .......................................................... 8-16
MENU function off ................................... 8-15
MENU function on ...................................... 8-15
operation ....................................................... 8-15
PATT ............................................................ 8-16
Power
fail LED ........................................................ 4-3
fail overview ................................................... 4-3
failure recovery .............................................. 4-3
Pre-Roll VTR ......................................................... 4-14
Presets
black ................................................................. 5-17
bus ................................................................. 2-7, 2-8
Preset names menu .......................................................... 9-19
Preset Pattern Key ............................................. 7-21
clip and gain ............................................................. 7-45
performing ............................................................. 7-44
setup menu ............................................................. 7-45
transitions .............................................................. 7-46
Press and hold .......................................................... 4-22
Preview
bus ................................................................. 2-7
bus group .............................................................. 4-35
bus rules .............................................................. 4-36
button types ........................................................... 4-35
key .................................................................... 7-10
overlay ................................................................. 2-8
overlay group ....................................................... 2-10, 9-9
overlay option ..................................................... 2-10, 10-4
TRANS PV ............................................................. 5-17
Preview Overlay
Safe Title Custom Control ........................................... 10-24
Preview overlay
features .............................................................. 1-15
mask preview ....................................................... 1-16
SMPTE safe formats .................................................. 1-16
source identification .................................................. 1-16
time clock .............................................................. 1-16
VTR time code .......................................................... 1-16
Preview, Look Ahead ..................................................... 4-37
Priority, key ............................................................ 7-10
Proc Amp
aux bus corrections ............................................... 11-4
bus based corrections ............................................. 11-3
clipping ............................................................... 11-5
corrections ........................................................... 11-5
gain .................................................................... 11-6
input based corrections .......................................... 11-3
offset ................................................................. 11-6
operating modes ..................................................... 11-3
overview .............................................................. 11-2
Processor effects ...................................................... 1-23
Product
highlights ............................................................. 1-7
overview .............................................................. 1-7
Program/Preset
bus ................................................................. 2-7
transition group ................................................... 2-9, 5-2
Programming control panel functions ..................... 10-5
Programming keyframes ........................................... 9-21
PST
BLACK .............................................................. 5-3, 5-7, 5-17
bus ................................................................. 2-7, 2-8, 2-9
PATT ................................................................. 7-7
PATT2 ............................................................... 6-4, 8-16
PST BLACK .......................................................... 5-3, 5-7
PST PATT, definition .................................................. 1-5
PST, definition .......................................................... 1-5
PV
bus group .............................................................. 2-7
definition .............................................................. 1-5
R
Rate
Double Click ..................................................... 4-7
DSK, global memory system group ......................... 9-8
fade, global memory system group ......................... 9-8
key, global memory system group ......................... 9-7, 9-8
Rates, Transition
Vision 2 .............................................................. 5-14
Recall
configurations from a storage device ....................... 9-35
custom control functions ...................................... 10-4
factory, procedure ................................................. 4-2
individual bus map ................................................... 9-43
individual custom control ...................................... 9-39
individual memory registers .................................. 9-37
individual S&T MD sequences from disk .................. 9-41
memory registers, global memory system ................. 9-12
memory registers, MLE memory group ..................... 9-14
registers ............................................................... 9-4
registers from a storage device ................................ 9-35
registers, notes .................................................... 9-15
section ............................................................... 9-4
RECALL DVE ..................................................... 9-5
Recall MLE-Store
Memory Recall Mode, Personality ......................... 4-13
Recording
cancel custom control ........................................... 1-3, 10-6, 10-10
custom controls .................................................... 10-6
finish custom control ........................................... 10-6, 10-10
Recording custom controls ..................................... 10-5
Recovery from power failure ................................... 4-3
Red green blue wash ............................................. 6-24
Redundant Power option ....................................... 1-30
Re-entry .............................................................. 4-33
Re-entry buttons ...................................................... 2-8
Reference input ..................................................... 1-12
Registers
3D sequences ....................................................... 9-9
Bus Maps ............................................................. 9-9
custom control ..................................................... 9-9, 9-28
installation ........................................................... 9-9, 9-28
lock/unlock .......................................................... 9-17
memory ............................................................ 9-9, 9-28
name ................................................................. 9-18

Synergy Q/MD/X Operator’s Manual (v9.1 MD)  Index • IX–13
personality .................................................. 9-9, 9-28
recall ......................................................... 9-4
recall from a storage device ......................... 9-35
recall, MLE memory group .......................... 9-14
recalling .................................................... 9-12
recalling, global memory system ................. 9-12
save individual ........................................... 9-28
save(99,523),(105,528) to a storage device ........................ 9-27
storing ...................................................... 9-7, 9-9
storing, global memory system .................... 9-10
storing, MLE memory group ......................... 9-11
VTR clip ..................................................... 9-28
VTR clips .................................................. 9-9
REJECT knob .............................................. 7-20
Related publications .................................. 1-6
Relative Custom Controls ......................... 10-9
Remote
aux panel .................................................. 1-25
Aux panels, Synergy 3 ................................ 1-26
section ...................................................... 9-8
Remote aux panel
 cable, custom ............................................ 1-27
remote override ......................................... 1-27
Remote aux panels .................................... 1-25
assignable ................................................ 1-26
comparison .............................................. 1-26
positioning .............................................. 1-26
Repair policy ............................................. 1-vii
Reset
full ......................................................... 2-23
software ................................................. 2-24, 2-25, 4-2, 9-5, 9-7
switcher registers ...................................... 4-2
system ..................................................... 2-23
system, notes ........................................... 9-16
Reset GPI outputs via custom control .......... 10-14
Resetting individual MLEs ...................... 2-24, 2-25, 9-5, 9-7
Restart, full .............................................. 2-23
Re-synchronize knobs ............................... 4-32, 6-6
REV .......................................................... 6-5
Reverse direction wipe ............................... 6-5
Reverse Key Shift Mode ............................. 4-24
RGB ......................................................... 6-24
RGB Color Corrections .............................. 11-9
gain ......................................................... 11-10
offset ....................................................... 11-10
RGB Color Correctors
aux bus corrections .................................. 11-4
bus based corrections ............................... 11-3
input based corrections ........................... 11-3
operating modes ................................... 11-3
overview .................................................. 11-2
RGB Gain .................................................. 11-10
RGB offset .............................................. 11-10
RIGHT knob ............................................. 7-19
ROLL VTR
arm mode ................................................. 1-27, 1-29, 4-14
button ..................................................... 5-3, 5-7
OverDrive ............................................... 4-14
play mode .............................................. 1-27, 1-29, 4-14
Rotary wipes ........................................... 6-5, 6-14
ROTATION
button ..................................................... 6-7
knob ....................................................... 6-7
Rotation .................................................. 6-11
continuous ........................................... 6-11
transition .............................................. 6-12
user ....................................................... 6-12
Rotation, pattern ..................................... 6-7
Routing Switcher Interface option ............. 1-25
Routing Switcher option ............................ 1-28
RU, definition ........................................... 1-5
Run Custom Control event, insert ............... 10-7
Run Sequence Custom Control ................. 10-22
S
S&T 3D
go to menu custom control macro .......... 10-18
S&T MD
sequence, recall individual from disk .... 9-41
sequence, registers, storing ...................... 9-28
sequence, save individual to disk ............ 9-32
S&T WIPES button ................................... 6-4
Safe Title Custom Controls ..................... 10-24
SAT ......................................................... 6-20
Saturation
matte ...................................................... 6-20
wash ....................................................... 6-24
Save
custom control macros to disk ............... 10-43
effects to a storage device ....................... 9-27
individual Bus Map to disk ..................... 9-33
individual custom control macros ........... 9-30
individual memory registers .................. 9-28
individual S&T MDSequences to disk ...... 9-32
registers to a storage device .................. 9-27
Saving custom control functions ............... 10-4
Screen capture menu process .................... 3-13
Screen, LCD ............................................. 2-6
Scroll
area .......................................................... 3-4
knobs ..................................................... 3-4
SD, definition ........................................... 1-5
Section
aux bus group ........................................ 2-8
border control ....................................... 7-20
custom control group ............................. 2-8
downstream keyers ................................ 2-10
Select Custom Control Bank event, insert .................. 10-8
SELF KEY ...................................................... 7-6
Self Key ................................................................ 7-21
FLY KEY ......................................................... 7-23
performing ....................................................... 7-21
setup menu ..................................................... 7-22
Serial digital inputs ........................................... 1-11, 1-19
Serial digital outputs .......................................... 1-11, 1-20
Serial numbers .................................................. 3-10
Serial Port Expander ......................................... 1-20
Serial Tally option ............................................. 1-29
Server
audio option .......................................................... 1-9
clip ....................................................................... 9-8
custom control functions ........................................... 10-3
Service .................................................................. 1-32
SET USER .............................................................. 6-6
Setup
DSK sources ..................................................... 7-53
menu, DSK ............................................................. 7-54
Setup, MultDSK .................................................... 7-58
Shadow
croma key ........................................................... 7-36
d ................................................................. 7-9, 8-8
SHDW ............................................................. 7-9, 8-8
SHIFT
crosspoint button .................................................. 4-23
SHIFT crosspoint button ........................................ 4-23
Show DSK1/DSK2 .................................................. 7-54
Shutdown, switcher ............................................. 2-27
Signal
fill signal ............................................................... 7-2
d key signal ......................................................... 7-2
Sleep mode ............................................................ 2-30, 4-12
SmartConversion
Converter Assignments ........................................... 4-43
Converting Video .................................................. 4-41
Overriding Input Format ........................................... 4-41
Status ................................................................. 4-42
Using ................................................................. 4-41
SOFT ............................................................... 6-6
Soft cut ................................................................. 5-11
Soft key
buttons ............................................................... 3-4
d menu function .................................................. 3-4
Soft key labels ....................................................... 1-3
Softness, key border ............................................. 8-9, 8-10
Software
options menu ........................................................ 3-10
reset ................................................................. 2-24, 2-25, 4-2, 9-5, 9-7
version on main menu ........................................... 3-3
Source reveal, DSK ................................................ 7-51
Spare Parts Kit option ............................................. 1-31
Special
custom control functions ........................................... 10-4
program automation ............................................. 10-17
program custom control pauses .............. 10-28
program GPI resets ............................................. 10-14
program GPI triggers ........................................... 10-15
wipes ................................................................. 6-15
Special Functions, custom controls .............. 10-14–10-28
Split
key, DSK ............................................................. 7-47, 7-48
key, introduction ................................................. 7-47
key, performing ................................................. 7-47
video ............................................................... 7-47
video, performing .............................................. 7-48
Squeeze & Tease
2D wipes .............................................................. 6-15
3D wipes .............................................. 6-15
Fly Key ............................................... 7-9
Mode ................................................. 4-15
wipes .................................................. 6-4
Squeeze & Tease MD .............................. 1-8, 1-22
border generator, advanced picture frame ... 1-24
effects, pre-built .................................. 1-24
features .............................................. 1-23
fly key .............................................. 1-23
highlights .......................................... 1-8
key sequences .................................... 1-24
planar controls, advanced ...................... 1-24
planar transforms with lighting ................ 1-23
processor effects .................................. 1-23
timelines, user-built ................................ 1-24
Standard features ................................ 1-10
Standard wipes ................................... 6-5
Static discharge .................................. 1-vi
Still Store option ................................. 1-28
Stop Custom Control ............................ 10-7
Stop Other Custom Controls ................. 10-25
Storage Device
formatting ......................................... 9-44
recall configurations from ................. 9-35
recall individual bus map ...................... 9-43
recall individual custom control macros .... 9-39
recall individual memories ................... 9-37
recall individual registers .................... 9-35
save custom control macro ................... 9-30
save effects ....................................... 9-27
save individual memory ....................... 9-28
Store
DSK setup .......................................... 7-54
memory registers ............................... 9-9
memory registers, global memory system ... 9-10
memory registers, MLE memory group ...... 9-11
mode option .................................... 4-16
registers ......................................... 9-7
section ........................................... 9-7
Support, technical ................................ 1-32
SUPPRESS knob ................................ 7-20
Swap Keyers Cut & Auto ...................... 4-16
Swap Program and Preset Buses ............. 4-17
Swap Trans Cut & Auto ......................... 4-17
Switcher
basics ............................................. 4-22
crosspoint buttons .............................. 4-22
Powering Off .................................... 2-27
re-entry .......................................... 4-33
reset registers .................................. 4-2
Shutting Down ................................. 2-27
timeout .......................................... 2-30
video flow ..................................... 2-14
Switcher Personality
Audio Cut Only .................................. 4-4
Auto Remove Key ............................... 4-6
Clear Bus Hold .................. 4-7
Editor Trans Rate ...................... 4-8
Key Cut then Fade ............................. 4-9
Log OverDrive Messages ................. 4-10
Pbus Memory .................................. 4-13
Recall Global-Store Memory Mode ........ 4-13
Recall MLE-Store Memory Mode ........... 4-13
UltraChrome
default color .................................. 4-18
default mode .................................. 4-18
Switcher Restart ............................... 2-23
Switcher shutdown ...................... 2-27
Switcher snapshots .......................... 1-17
Synergy
color scheme .................................. 2-22
custom control group ....................... 10-3
global memory system group ............. 9-4
matte group .................................. 6-18
MultiDSK ..................................... 7-58
positioner group ............................. 8-14
video flow .................................. 2-19
Synergy 1.5
custom control panel ....................... 2-5
defade to black group ................ 4-38, 4-39
preview bus group ..................... 4-36
Synergy 2
custom control group ....................... 2-5
downstream key group .................... 7-5, 7-6
effects control group ..................... 7-17
defade to black group ................ 4-38, 4-39
global memory system group ........... 9-3
matte group ................................ 6-18
MultiDSK ..................................... 7-57
pattern control group ................... 6-3, 6-4
positioner group ............................. 8-14
power reset .................................. 4-3
preview bus group .................... 4-36
video flow .................................. 2-17
Synergy 2.5
custom control panel ....................... 2-4
defade to black group ................ 4-38, 4-39
preview bus group .................... 4-35
Synergy 3
control panel .................................................. 2-4
custom control group ........................................ 10-2
downstream key group .......................................... 7-4
effects control group ............................................. 7-16
fade to black group .............................................. 4-38
global memory system group ................................ 9-3
matte group .......................................................... 6-17
MultiDSK ............................................................. 7-56
pattern control group ............................................ 6-2
positioner group ................................................. 8-13
power reset .......................................................... 4-3
preview bus group ................................................. 4-35
remote aux panels .................................................. 1-26
video flow .............................................................. 2-16

Synergy 3.5
control panel .................................................. 2-3
fade to black group .............................................. 4-38
preview bus group ................................................. 4-35

Synergy 4
control panel .................................................. 2-3
custom control group ............................................ 10-2
downstream key group .......................................... 7-4
effects control group ............................................. 7-15
fade to black group .............................................. 4-38
global memory system group ................................ 9-2
matte group .......................................................... 6-17
MultiDSK ............................................................. 7-56
pattern control group ............................................ 6-2
positioner group ................................................. 8-13
preview bus group ................................................. 4-35
video flow .............................................................. 2-14

System
custom display ................................................... 3-2
custom group ....................................................... 2-6
digital ................................................................. 1-7
frame power supply ............................................ 1-30
reset ................................................................. 2-23
reset notes .............................................................. 9-16
reset Synergy 2 & 3 .................................................. 4-3
size ..................................................................... 1-7
timeout ................................................................. 2-30

System control area .............................................. 1-17
System Control Menu ............................................. 2-20, 3-5
System Options. See Options

T
Tallies
extended tallies option .......................................... 1-30
Outputs ................................................................. 1-18
Tally
indicators .............................................................. 4-30
MLE ................................................................. 4-30

TD, definition ............................................................. 1-5
Technical support ..................................................... 1-32
Time clock
custom control functions ......................................... 10-4
insert menu ............................................................ 10-10
program custom control functions ......................... 10-12
table of custom control functions ......................... 10-13
Time Clock Source ................................................... 4-17
Time Clock UMD Number ......................................... 4-18
Timelines, user-built ............................................. 1-24
Timeout ................................................................. 2-30
TOP knob .............................................................. 7-19
TRANS LIMIT
button ............................................................. 5-4, 5-8, 5-20
recall memory registers ...................................... 9-15
TRANS PV ............................................................ 5-4, 5-8, 5-17
Transition
timeout .................................................................. 2-30
Transition Rate, MultiDSK ........................................ 7-60
Transition Rotation, Pattern ..................................... 6-12
Transition selection ............................................... 2-9, 2-11
Transition Type buttons ......................................... 2-9, 2-11
Transitions
Rates
Vision 2 ............................................................... 5-14
Transparency
adjusting ........................................................... 7-22, 7-24
border ............................................................... 8-9, 8-10
Trigger GPI outputs via custom control .................. 10-15
Index

U

UltraChrome .......................................................... 7-21
Default Color, Personality ........................................ 4-18
Default Mode, Personality .......................................... 4-18
highlights .................................................................. 1-8
performing .................................................................. 7-26
UNLOCK memory ...................................................... 9-5, 9-15
Unlock memory
feature ....................................................................... 9-16
global memory group ............................................... 9-17
name memories menu ............................................... 9-18
UP ONE ....................................................................... 3-4
Up/Down Converter Display ......................................... 2-11
Upgrade
software ..................................................................... 1-10
USB
formatting .................................................................... 9-44
port ............................................................................. 9-9
User
wipe menu .................................................................... 6-13
wipe patterns .............................................................. 6-5
wipes ......................................................................... 6-12
User Controlled Pattern Rotation ..................................... 6-12
Using
auto select key .......................................................... 7-23
auto transition ........................................................... 7-68
chroma key ............................................................... 7-26
custom control, basics ................................................. 10-5
cuts ............................................................................. 5-10
dissolves ..................................................................... 5-11
downstream key .......................................................... 7-50
invert key ...................................................................... 8-6
key borders .................................................................... 8-8
key modifiers .................................................................. 8-2
keys ............................................................................. 7-21
manual transitions ...................................................... 5-9
matte fi l ......................................................................... 8-2
preset pattern key ....................................................... 7-44
preview bus ................................................................... 4-35
self key ......................................................................... 7-21
split key ....................................................................... 7-47
transition limit ........................................................... 5-20
transition preview ........................................................ 5-17
wipes .......................................................................... 6-8
Using key over ................................................................ 5-19
Utility Bus Mask ............................................................. 8-5

V

VCR, definition .......................................................... 1-5
VDCP Protocol ........................................................... 1-21
Version, on main menu ................................................. 3-3

Video

flow through the switcher .............................................. 2-14
matte wash ................................................................. 6-23, 6-27
server clip .................................................................... 9-8
server clip, recall register ............................................ 9-13, 9-14
Synergy 1 fl ow ............................................................. 2-19
Synergy 2 fl ow ............................................................. 2-17
Synergy 3 fl ow ............................................................. 2-16
Synergy 4 fl ow ............................................................. 2-14
Video server control .................................................... 1-21
Video Server Control option ......................................... 1-29
Video Signal
crapping ..................................................................... 11-5
correction ..................................................................... 11-2
gain .............................................................................. 11-6
offset ............................................................................ 11-6
RGB Gain ..................................................................... 11-10
RGB offset .................................................................... 11-10
VMULT ........................................................................... 6-6
VTR
clip ............................................................................ 9-8
clip registers ............................................................... 9-9
clip, recall register ...................................................... 9-13, 9-14
custom control functions .......................................... 10-3
VTR Remote Control option ......................................... 1-27
custom control functions .......................................... 10-3
custom control functions .......................................... 10-3
clip, media ID ............................................................. 1-27
clip, timecode ............................................................. 1-27
ROLL VTR .................................................................... 1-27, 1-29
VTRs
Pre-Roll ...................................................................... 4-14
Roll VTR and OverDrive ............................................ 4-14

W

Wakeup on command .................................................... 4-19
Warranty ..................................................................... 1-vii
Wash
background menu ...................................................... 6-23, 6-27
color 1 menu .............................................................. 6-24
create ......................................................................... 6-22
default colors ............................................................. 6-23
HSL .............................................................................. 6-24
hue, luminance, saturation .......................................... 6-24
menu .......................................................................... 6-22
pattern ......................................................................... 6-23
red, green, blue .......................................................... 6-24
RGB ............................................................................. 6-24
section ......................................................................... 6-20
size menu ..................................................................... 6-24
video matte ............................................................... 6-23, 6-27
WASH 1 ......................................................................... 6-20
WASH 2 .............................................................. 6-21
WIDTH knob ...................................................... 7-20
Width, border ...............................................8-9, 8-10
WIPE ................................................................5-4
  button ............................................ 2-7, 2-10, 5-8
  pattern control button ......................... 6-2
PP1 ........................................................6-4, 8-16

Wipe
  2D Squeeze & Tease ......................... 6-15
  adjust matrix wipes .......................6-9, 6-10
  adjust pattern ........................................ 6-6
  aspect ratio ........................................ 6-6
  border ................................................ 6-6
  classic ................................................. 6-13
  flip flop direction .......................... 6-5
  generators ....................................... 1-12
  matrix ................................................ 6-14
  matrix, rotary, standard ................... 6-5
  normal direction .............................. 6-5
  reverse direction .............................. 6-5
  rotary ............................................... 6-14
  rotation ............................................ 6-7
  select direction ............................... 6-5
  select MLE .......................................... 6-4
  select pattern .................................... 6-5
  softness ........................................... 6-6
  special ............................................. 6-15
  Squeeze & Tease .............................. 6-4
  user ................................................ 6-12
  user menu ........................................ 6-13
  using ................................................ 6-8
Wipe Modulation ...................................... 6-10

Wipes
Parameters
  Matrix Tile Size ................................. 6-9
  Rotation ........................................ 6-11
    continuous 6-11
    transition 6-12
    user 6-12
  Wipe Modulation .......................... 6-10

X

XFX Extra Effects Processor ...................... 1-25